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T Introduction

1.1 About KIX 18

KIX version 18 is a browser-based open source service management system for IT teams, technical service,
maintenance, after sales services and facility management. As an open source ticket system, KIX offers the
right service solution for every company size and requirement, from SMEs to public or state institutions and

authorities to multinational corporations:

KIX Start

Software-based service management
ideal for beginners.
Y U W W e v
. 0 0. 0.0 1

Basic solution
easy to integrate
free of charge & immediately ready for use
for small service organisations

KIX Pro

The comprehensive business package for professional
professional IT and technical service.

I Y W W
WH W™

customised & cross-departmental
incl. Self Service Portal and
diverse additional modules
for medium-sized and large companies
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KIX Cloud

Our cloud offer (SaaS) for KIX Pro.
Intuitive, flexible, including full managed services

Seslr e v

immediate provision
high cost transparency
incl. Self Service Portal
optimal for SMEs

z CERTIFEDS  ITIL® 4 Certified
T00L15£” ertifie

SERVICE MANAGEMENT VERSION IV

The IT service management system KIX Pro 18 has been awarded SERVIEW
Certifiedtool for 15 out of 19 possible ITIL® 4 practices. This makes KIX Pro 18
the world's most functionally powerful certified open source tool for the ITSM
sector.

In order to make the use of ITIL® 4 as easy as possible for users, the add-on

"ITIL Practices" was developed. These are templates with which changes can
be made, problem cases, services and management tasks can be processed

and numerous reports can be produced.

Optional extensions for KIX:

Field Agent App

Mobile app for iOS and Android for on-site technical service.
Can be used for KIX Start and KIX Pro.
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Add-on "ITIL Practices"

Add-on for process management and
for the automation of workflows.
Can be used for KIX Pro.

Maintenance Plan

Add-on to support
recurring maintenance tasks.
Can be used for KIX Pro.

1.1.1 Additional modules from the KIX Connect product line:

The KIX Connect product line can only be used with KIX Pro.

Connect Database

Use of external database
connections as a data source.

Issued on: 26.02.2024

-EN - KIX Start
Introduction
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Connect Webservice

Integration of HTTP/s web services
in KIX (without direct database access)

Connect Opsi

Provision of asset data
in KIX on the basis of the
inventory solution opsi

Connect Baramundi

Provision of asset data
in KIX on the basis of the
inventory solution Baramundi

1.2 Community

KIX is a dynamically growing software that is subject to a constant process of further development. As an
open source company, it is important to us that we do not do this alone. We cordially invite you to become
part of our KIX community and to support us with helpful hints for the further development of KIX and the

user information.
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1.3 About this manual

This manual covers the administration of KIX version 18 via the GUI of the Admin module and is intended for
all users who have been entrusted with the administration of KIX 18. It is intended to serve as a reference
work in their daily work and to enable them to manage the administrative tasks of KIX 18 (hereafter KIX).

The manual is divided into the sections "KIX Start" and "KIX Pro". The section "KIX Start" deals with the
administration of KIX Start and the basic functions. The section "KIX Pro" is intended as a supplement to the
KIX Start manual and describes the administration of the additional functions contained in KIX Pro as well as
the KIX Pro add-on modules.

For users of KIX 18 we have created a separate manual, which is also divided into the sections "KIX Start"
and "KIX Pro". The user manual is intended for all agents and KIX users who are charged with service
provision.

Note: This manual contains configuration examples to explain the respective topics. If you transfer these
examples to your system, you do so at your on own responsibility. We do not assume any liability for this.

Further documentation on KIX versions 17 and 18 can be found at https://docs.kixdesk.com/.

() This edition of the manual refers to the release status: see Release Information (see page 911)

1.4 To comprehension

In these instructions, the masculine form according to the grammar is used in a neutral sense. It always
appeals to all male, female and diverse readers. Gender variants are not used for reasons of legibility and
understanding of the text. We ask all readers for their understanding for this simplification in the text.
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2 Glossary
Term Explanation
Action KIX distinguishes between ticket actions and item actions. Ticket

Add-on

Admin

Agent

Article

Assets

Attribute

actions are displayed in the ticket detail view as buttons in the action
line and are available in the agent portal and/or the self-service portal,
depending on the configuration. Article actions are available as a
lateral label on the right side margin of an article, depending on the
user's authorisation.

Independent software component which, once installed, extends the
scope of KIX. Add-ons are not included in the scope of delivery as
standard.

Person with advanced user rights who manages the system, assigns
user rights, and enforces usage guidelines

A user of the agent portal, e.g. a service employee or an employee
who processes an inquiry.

Describes a work step within a process/ticket.

Is a documented communication or comment generated by an agent
or received from a user.

Any operating resource that has a function within the business
processes, e.g. computers, software, servers, telephones, machines,
vehicles, rooms, buildings, and contracts. Assets can also be referred
to as: configuration item, config item, and ClI.

Property or characteristic that can be assigned to an object (e.qg.
asset).

Issued on: 26.02.2024
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To comprehension

Usage

E.g. in the
ticket

E. g. Add-on
"ITIL Practices"

Separate
module within
KIX

E.g. when
creating a
ticket

In the ticket

In the Assets
module

In the
Advanced
Search, in
the class
definition of
assets
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Term

Channel

CMDB

Configuration

Item, Config

Item, ClI

Contact

Customer

Dialog

Drag & Drop

Failure Time
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Explanation

Determines the method of communication (e.g. email, note, etc.)

The Configuration Management Database is referred to as the Asset
Database in KIX. It was developed for access to and management of
assets.

Any operating resource that has a function within the business
processes, e.g. computers, software, servers, telephones, machines,
vehicles, rooms or buildings, and contracts.

Configuration items are also referred to assets.

A contact person within the customer's organization. The contact is
allocated to a ticket as the contact person.

An organization/your customer.

Separate window (overlay) with form fields or additional information.

Computer function enabling you to click/select graphical
elements (e.g. icons, passages in a text, etc.), and drag them across
the screen with the mouse, and drop them somewhere else.

Represents the period of time during which an asset or service is not
available during the agreed service time.

Issued on: 26.02.2024
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To comprehension

Usage

E.g.inthe
ticket

In the Assets
module

In the Assets
module

E.g. when
creating a
ticket

E.g. in the
Customer
Dashboard

E.g. send email
from within
ticket,

Form dialogs
in Admin
module
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FAQ

Field Agent
App

First Response
Time

Icon

Impact

Incident

ITIL

Lane
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Explanation

Knowledge database for compiling information:

+ Particularly frequently asked questions
+ Treatment of frequently occurring problems
+ Manuals, product data sheets, documentation etc.

Mobile application for fitters, service technicians, etc. Tickets can be
processed by the technician on site.

If a service fails within a company, an agent must respond to this
failure within a specified period of time. The time begins with the
notification of the incident and ends with first contact with the
customer.

Symbol, graphical illustration of an element or menu item.

Describes the extent of the consequences that an incident or problem
has on a work process.

Describes an incident or other issue relating to an IT service or asset.

IT Infrastructure Library.
Collection of "best practice" for the delivery of (IT) services.
KIX is increasingly looking at the agile process models of ITILv4.

Blocks of information dealing with similar topics in the zoom view;
can be expanded and collapsed.

Issued on: 26.02.2024
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Usage

Separate menu
item on the
Home
Dashboard

In the ticket

E.g. menu bar
on the Home
Dashboard

Add-on "ITIL
Practices"

Contain
aspects such
as master data
information,
version details,
assignments,
permissions,
etc.
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Object

Organisation

Overlay

Owner

Pattern

Permission

Person
Responsible

Priority

Queue

Response
Time
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Explanation

Technical designation for items saved in the system such as tickets,
assets, etc. and for technical system components e.g. dynamic
fields.

Brings together all data for a company and can be allocated to
individual contacts.

Separate window (dialog) with form fields or additional information.

Person who owns the ticket and/or is actively processing it.

Basic character string used for translation purposes.

Permissions define which work steps and actions an agent may
execute, and which objects and information a user may view.

Person who can define which employees should process the ticket.
They are notified when the process is being worked on. The person
responsible can also be the owner.

Priority levels denote different levels of urgency and can be used to
categorize tickets. They are indicated by a traffic light color code.

Element used to classify requests. The use of multiple different
queues (e.g. for specific departments) enables inbound tickets to
be categorized and organized. In KIX, queues are referred to as
teams.

Another word for First Response Time.
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Usage

E.g.inthe
Admin module

In the
Customer
module

E.g. send email
from within
ticket, form
dialogs in
Admin module

In the ticket

In the Admin
module

In the Admin
module

In the ticket

In the ticket

In the ticket
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Role

Self Service
Portal

Service

Service Level
Agreement
(SLA)

Sidebar

Solution Time

State

SysConfig

Team
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Explanation

This is where you assign the permissions that define what the agent

is allowed to/not allowed to edit in the system. Agents can have
several roles.

Client portal, which is connected to KIX.
Only usable with KIX Pro

Stands for a service/performance that a company offers. Services
are part of Service Level Agreements (SLA).KIX Pro includes the
asset class "Service" to manage services.

Agreement between a service provider and its customer. An SLA
regulates which services the provider provides and which service
standards are defined that the provider undertakes to comply with
(e.g. response time to enquiries, resolution time in the event of
problems, etc.).

Additional information at the edge of the screen, which can be
expanded and collapsed as required.

Period of time during which a failed service must be restored. The

time begins with the notification of the incident and ends once it has

been resolved. To mark ticket as resolved, set the ticket state
“closed".

The state defines the processing state of a ticket.

Abbreviated term denoting the system configuration of KIX.

Element used to classify requests. The use of multiple different
teams enables inbound tickets to be categorized and organized.
Another word for team is queue.
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Usage

In the Admin
module

In the ticket,
e.g.
maintenance
or repair
services

E.g.in the
ticket

E.g. the digital
notepad

E.g.in the
Admin module

In the ticket

In the Admin
module, menu
System >
SysConfig

In the ticket
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Template

Ticket

Ticket Lock

Type/Ticket
Type

Update Time

User

Widget
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Explanation

Individually configured input mask for the creation of application or
incident-related tickets (malfunction, average, holiday request, etc.).
Individual templates are only possible in KIX Pro. KIX Start contains a
customisable default template for all tickets.

A service operation including the totality of all its communication and
documentation steps in the form of incoming and outgoing emails,
documented calls, notes or customer feedback via the web front end.
They

+ are requested by a contact (organisation).

« are assigned to a team (queue) as well as a processor and
responsible agent.

+ have a priority as well as a type and status.

Means that special actions for a ticket can only be performed by the
owner. This is designed to prevent the ticket from being processed by
several people at the same time, or make this less likely.

Classifies the nature of a request, e.g. incident, problem, service
request, etc.

Describes the time during which communication (call, email) with the
customer (organization) must take place. If there has been no
communication with the customer upon reaching the update time on
the ticket, the ticket is considered escalated.

A person who works with the system.

For example, an agent, the admin, a contact with system rights, a user
of the Self Service Portal.

Term for small, separate windows in a program; a portmanteau of the
words "window" and "gadget".
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Usage

In the ticket

In the Ticket
module

In the Ticket
module

In the Ticket
and Admin
modules

In the ticket

Diagram
widgets, table
widgets,
sidebar
widgets
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Workflow

KIX 18 Admin Manual - EN - KIX Start
Glossary
To comprehension

Explanation Usage
A workflow describes the concatenation of different, consecutive E. g. Add-on
steps within a business process. "ITIL Practices"

In the Admin Module, the administration of templates, actions and
rule sets can be found under Workflow.
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3 Help and Contact

We hope that this manual provides you with sufficient support for the administration of KIX 18. If you still
have questions about KIX 18, please ask them in our forum: https://forum.kixdesk.com. There you will also
find a range of information that can help you answer your questions.

You can also find help, tips and tricks on the Welcome page, which you can access at any time. To do so,
click on the question mark in the header area of KIX:

You can also find a German-language quick start guide as well as other German-language videos on the KIX
on our YouTube channe'l (5.

Alternatively, you can use the KIX Service Software GmbH conclude a service contract and thus take
advantage of our competent support service. Please contact us by email or telephone.

+ E-Mail: info@kixdesk.com?
+ Telefon: 03 71/2 70 95-620

1 https://www.youtube.com/watch?v=CqCNIvdhayo&list=PLyKz2PdXNIw3b13FZEPP9CcFMTFRVvFQh-
2 mailto:info@kixdesk.com
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4 |nstallation

You can choose between different ways of
using KIX 18:

KIX 18 On Premises: Local installation
on your own server

KIX 18 Cloud: Application in the KIX
Cloud - without installation
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Content on this page:

System requirements for a client (see page 26)
« KIX On Premises Installation (see page 27)

KIX On Premises Update (see page 29)
+ GitHub (see page 30)

4.1 System requirements for a client

For the host environments of KIX 18 we recommend the following operating systems / environments:

CentOS/RHEL
Debian
Ubuntu
MacOS

4.1.1 Screen sizes

Monitor
Resolution

Format

4.1.2 Supported browsers

4.1.2.1 Client KIX 18: Agent Portal

Supported Browsers (JavaScript enabled)

Mozilla Firefox

v
[P S

Minimum requirement

Desktop: 1280px x 720px

Desktop: 16:9
Tablet: 10"

Versions

103+
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Supported Browsers (JavaScript enabled)
Chrom/Chromium

MS Edge (Chromium based)

4.1.2.2 Client KIX 18: Self Service Portal

Supported Browsers (JavaScript enabled)
Mozilla Firefox
Chrom/Chromium

MS Edge (Chromium based)

4.1.2.3 Field Agent App

Supported operating systems (smartphone)
i0S

Android

4.2 KIX On Premises Installation

KIX 18 Admin Manual - EN - KIX Start
Installation
KIX On Premises Installation

Versions

103+

107+

Versions

103+

103+

101+

Versions

15+

10+

KIX is installed via already pre-configured Docker containers and brings its own operating environment and
database. This facilitates the use of the software on the various operating systems. Only a compatible
Docker version (correctly and completely installed) must be present and running on the host environment.
Therefore, we recommend checking whether the planned host environment supports the use of Docker
before installing KIX 18. The use of KIX 18 requires Docker version 20.x and Docker Compose 2.1. More
information at docker.com?® or https://docs.docker.com/engine/install/linux-postinstall/.

For the installation of KIX 18 on your own server, use the files deposited in GitHub. For productive use, we
recommend an installation under Linux. Below you will find a very compact quick guide for on-premises

3 http://docker.com
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installation. You can find detailed installation instructions at https://github.com/cape-it/kix-on-premise/blob/
master/deploy/linux/README.md.

Docker is operated via the console (terminal). Use the following console commands.
@ The user on the command line must have execution rights to the Docker service.

How to install KIX (short version):

1. Install Docker and Docker Compose on the host system (usually "localhost" / hereinafter
"your.docker.host"):
+ Docker: https://docs.docker.com/engine/install/
+ Compose: https://docs.docker.com/compose/install/

@ 7he scripts require Docker-Compose as a standalone installation, although newer Docker
versions already include Compose as a plugin.

2. Retrieve the initial Docker environment:
* cd /opt
+ git clone https://github.com/cape-it/kix-on-premise.git

3. Change to the unpacked Linux or Windows directory.
+ cd kix-on-premise/deploy/linux

+ cd kix-on-premise/deploy/windows

4. Recommendation: Make a backup copy of the following files:
* environment
*+ proxy/non-ssl.conf

+ proxy/ssl.conf

5. SSL Setup
+ Add your SSL certificates to the Docker environment in the following files:

+ Certificate: proxy/ssl/certs/server.crt

+ Key: proxy/ssl/certs/server.key

+ Using SSL instead of non-SSL
+ Disable all server entries: in file proxy/non-ssl.conf (viacomment #)

+ Enable all server entries: in file proxy/ssl.conf (byremoving #)
+ Note: If this setup is selected, application ports defined in BACKEND_PORT,
FRONTEND_PORT, SSP_PORT are used as drop-in replacements.

+ Using SSL in addition to non-SSL
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+ Activate all server entries: in file proxy/ssl.conf (by removing #)
+ Change port setting: in file proxy/ssl.conf
« from 80 to 443
from 8080 to 8443
« from 9080 to 9443

6. Start or stop KIX

+ Change to the unpacked Linux or Windows directory
* ¢d /kix-on-premise/linux
*+ cd /kix-on-premise/window

+ Execute the start script:
+ Windows: start.ps1
* Linux: ./start.sh

* Run stop script:

Windows: stop.psl

* Linux:./ stop.sh

7. After starting KIX18, log into the system. With unchanged configuration of the environment file
with the following data:

+ Portal access
+ Agentenportal: http://your.docker.host:20001
- Self Service Portal (nur KIX Pro): http://your.docker.host:20001
+ REST-API Backend: http://your.docker.host:20000/

+ Registration data for initial registration:
+ User: "admin”
+ Password: "PasswO0rd"

8. Then use the Setup Assistant (see page 58) to set a new admin password and a "Super User" and to
carry out the basic configuration of KIX.

@ Info

Information on the installation of KIX Pro to KIX.Cloud as well as on the additional modules can be
found under: Installing KIX Pro

4.3 KIX On Premises Update

To update an existing KIX environment, please update the Docker configuration. The instructions can also be
found under: https://github.com/cape-it/kix-on-premise/blob/master/deploy/linux/README.md.
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How to update KIX (short version):

1. Update Docker Configuration
* user@DockerHost: /opt/kix-on-premise/# git pull

2. Update KIX
* user@DockerHost: /opt/kix-on-premise/deploy/linux# ./stop.sh
* user@DockerHost:/opt/kix-on-premise/deploy/linux# ./start.sh

& Important!

Update KIX with every update! The releases interlock and build on each other. Skipping versions can
lead to functional gaps and malfunctions.

() Please Note

Note that Docker takes a conservative approach to cleaning up unused objects. The objects are
generally not removed, which can lead to memory overflow. A cleanup can be done using the
prune command. You can find more information on the page: https://docs.docker.com/config/
pruning/.

4.4 GitHub

On GitHub we provide you with a range of information and scripts for KIX 18 and also for KIX 17: https://
github.com/kix-service-software
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4.5 MigrationKIX17>KIX 18

You can transfer the data
from KIX 17 to KIX 18. In
KIX Start this is done by
executing a console
command in the System>
Console menu. KIX Pro
users can start the
migration automatically via
the GUI.

You can perform the
migration completely or
limit it to individual objects
by specifying appropriate
parameters in the console
command.

The migration is carried out
by KIX 18. KIX 18 (active
system) fetches the data
from the source system
KIX 17 (passive system).
You must be logged into

Content on this page:

Notes on Migration (see page 32)
Migration requirements (see page 33)
Preparations (see page 34)
+ Contact data sources (see page 34)
+ Organisation/customer numbers (see page 34)
+ Other notes (see page 34)
Migration flow chart (see page 35)
Which data are transferred? (see page 35)
Notes on the transferred data (see page 36)
Perform the Migration (see page 44)
+ 1. Activate PSK mode in KIX 17 (see page 44)
+ 2. Start the migration via the KIX 18 console (see page 45)
+ 3. Deactivate pre-shared mode (see page 50)
+ 4. Check and edit the transferred data (see page 51)
+ 5. Post-processing and cache cleaning (see page 51)
+ 6. Advanced configuration transmission (see page 51)

KIX 18 as a user with admin rights in order to be able to carry out the migration (roles: system admin,

superuser).

You are welcome to contact our support if you have any questions about migration or need help.

e 44

Fig .: The migration via the console

u ﬁé
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It is possible to continue working during the migration. However, keep the following note in mind:

& Hint

The migration will take some time, depending on the volume of data, and leads to an increased
system load on both KIX systems as well as on the hardware and network. You should therefore
schedule the migration at a quiet time (weekends, public holidays).

4.5.1 Notes on Migration

KIX 18 answers various scenarios differently than KIX 17 and discards some of the historically grown
structures. Please note that not all KIX17 features and behaviors have a 1:1 equivalent in KIX 18. KIX18 is
largely a standalone product. Below you will find some information on relevant aspects.

+ Permissions Structure: The permissions system in KIX 18 is rebuilt from the ground up (see also

Permission concept KIX 18 (see page 645) ). For necessary support during the migration, please contact
our support.

+ Customer and Agent Users: In KIX 18, "Contacts" form the basis for contact persons and agents. A
contact can be assigned a user account. This makes the contact a user and he can log on to the Self
Service Portal or as an agent to the system. The migration creates

+ from each KIX 17 customer contact a KIX 18 contact with the usage context
"customer" (access to the Self Service Portal)

- from each KIX 17 agent user, a KIX 18 contact with the usage context "Agent" (access to the
Agent Portal).

« If aKIX 17 login identifier exists as both a "customer user" and an "agent user", the resulting
KIX 18 user receives both usage contexts.
The basis for the migration is the existing customer and agent users in the KIX 17 database
(see Preparations below).

+ Contacts and Organisations: In KIX 18, contacts do not necessarily have to be assigned an
organisation. The tickets for these contacts do not need an organisation either. Therefore, when
migrating contacts and tickets, no organisation will be created if the contact or ticket does not have
an assigned organisation.

If no customer company is created for the CustomerID of a contact, the assignments are not
transferred and the contacts exist without any assignment.

(@ Until further notice, the following applies: For the use of the SSP, the assignment of an
organisation is required.
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+ Article types: KIX 18 no longer uses item types. Instead, communication channels are offered. The
item type "Telephone" is no longer available in the standard and is replaced by the item type "Note".
As aresult, conversations are generally documented as conversation notes - regardless of whether
they were conducted by telephone or face-to-face.

! Specific item types are also replaced by communication channel "Note".

+ Config Item Attachments: KIX 17 offers two options for Cl attachments. The recommended and still
existing one is the use of Cl attributes of the type Attachment. Changing these attachments will
continue to create an asset version in KIX 18. The non-versioning attachments known from KIX 17 will
not be continued in assets. Any attachments are adopted and converted into versioning attributes.

! Please note that the operation will change as a result.

+ Link Types: KIX 17 uses some link types and relationships that do not seem plausible. In KIX 18,
therefore, all link types between any objects are no longer permitted. The migration creates such links
as "Relevant To" links.

+ Text modules: Text modules no longer contain subject lines in KIX 18.

+ Configuration settings: Configuration settings are not transferred and require specific consideration
(see below: Advanced configuration transmission (see page 51) ).

+ Ticket status types: If your KIX installation uses its own ticket status types, the ticket statuses must
first be changed to the default ticket status types.
! Specific custom ticket status types can block the migration and must be removed before the
migration.

4.5.2 Migration requirements

« Current KIX 17 system (version 17.14.0 - or higher)

+ defined and activated pre-shared key (see page 44) mode in KIX 17

« KIX 17 from version 22 is required as the source system for the correct migration of SLA times
(Target time and Fulfillment time). Otherwise, only the SLA master data will be transferred, but not the
times.
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4.5.3 Preparations

4.5.3.1 Contact data sources

The migration uses the entries in the customer_user table as the basis for transferring the contact records. If
specific customer data source tables have been created in the KIX-DB, their contents must be transferred to
the table "customer_user". Only data that corresponds to the predefined structure of the table will be
transferred. l.e. if extended attributes (additional columns in the DB table customer_user) have not already
been created as dynamic fields, they must first be converted into dynamic fields. Please contact our support
if you need assistance.

If the source system uses an LDAP/Active Directory connection as a source for contact data, its contents
must first be synchronised into the database table "customer_user" of KIX17. A script included in KIX17
(https://github.com/kix-service-software/kix17-start/blob/rel-17/scripts/syncLDAP2DB.pl) can be used for
this purpose.

4.5.3.2 Organisation/customer numbers

KIX18 requires that organisations and thus customer numbers are explicitly stored in the system. In KIX17,
this corresponds to the "Customer Companies". However, KIX18 no longer allows contacts without an
organisation assignment. For this purpose, the migration automatically creates an organisation in KIX18 for
each customer number from KIX17. For the correct transfer of ticket customer numbers and asset properties
with attribute type "CustomerUserCompany", it is also mandatory to observe the notes of the previous
section.

4.5.3.3 Other notes

Ticket statuses will only be migrated successfully if they correspond to the predefined status types. KIX18
does not support custom status types without in-depth configuration. If the source system uses specific
ticket status types, therefore, change the statuses in the source system to usually existing status types
before the migration starts.

KIX17 allows many configurations, some of them quite specific, which were sometimes also created with
direct interventions in the database. There is a realistic chance that these configurations will cause problems
in the migration of the data. If you are unsure, please contact our support.

A Hint

Follow the instructions for preparing the migration to avoid incorrect or incomplete data.
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4.5.4 Migration flow chart

+ Activate PSK mode in KIX 17 and define pre-shared key.

+ Open console in KIX 18, select console command and specify transfer parameters, start execution
+ Deactivate PSK mode in KIX 17 by deleting the pre-shared key

+ Check and edit the transferred data.

4.5.5 Which data are transferred?

KIX 18 actively queries the content to be migrated from the KIX 17 instance. The retrieved content is adapted
to the structures (e.g. new IDs) of KIX 18. Below you will find a list of which data is transferred. Individual
attributes and system additions used in KIX 17 are not transferred. To do this, please contact our support.

These data are transmitted:

+ Configuration data
+ Ticket status
+ Ticket types
+ Queues / Teams (the signatures are included)
+ Dynamic Fields Configurations
+ General Catalog classes
+ Asset class definitions
+ Business data
+ Organization
+ Contacts (Customer User)
+ Contacts (Agent User)
+ Assets (Config Items) including versions
+ FAQs including attachments
« SLAs
+ Tickets
+ Article including attachments
+ Ticket history
+ Dynamic fields
+ Replacement of IDs
+ The IDs from KIX 17 are replaced by new IDs in KIX 18
+ Connections
+ Assets for tickets
+ Assets to assets
+ Services (KIX Pro)
+ Assets of class services
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4.5.6 Notes on the transferred data
Ticket data

+ After the migration, all tickets of the source environment are present in the target environment,
including their properties:
+ Articles: all articles incl. attachments and respective channel.
+ History: Entries in the ticket history refer to the migrated objects.
« Time entries: The times recorded on the ticket are migrated.
+ Lock status: Tickets that a user has locked are also locked for him in KIX 18.
+ Ticket statuses and types: Newly created statuses and types in the target environment will be
invalidated after the migration.
« The deactivation of statuses and types occurs because ticket status workflows no longer exist
and the old values are initially only retrieved for reasons of backward/history compatibility.
- Priority: Mapping is applied for the following source priorities (source => target).
« "1 very low" =>"5 very low"
« "2low" =>"4 low"
+ "4 high" =>"2 high"
« "5 very high" =>"1 very high"
+ Aninterrupted migration can be resumed. Only the tickets that have not been migrated or that have
been partially migrated are considered.
+ Note: The "Watch" flag on the ticket will not be migrated, i.e. a watched ticket has to be set to "Watch"
again after migration.

Text modules

+ After the migration, the text modules of the source environment are available in the target
environment.
+ The categories of the KIX 17 text modules are stored in the keywords of the KIX 18 text
modules.
+ The names of the category levels are recorded as individual keywords.
- Spaces are replaced by an underscore ("_").

+ The placeholder substrings "<ORTS_" are replaced by "<KIX_".
* Note: The validity of placeholders is not verified.

Connections

+ After the migration, all links from the source environment are available in the target environment.
+ Config items for tickets
+ Config items to config items
+ Config items for FAQs
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+ Tickets to tickets
+ Tickets to FAQs
+ Link types that do not exist or are not permitted are replaced by "RelevantTo".

Queues / teams

+ After the migration, all "queues” of the source environment are available as "teams" in the target
environment.
+ The structure of the queues can be found in teams (upper / lower queues).
+ The signatures of the source environment are deposited with the teams.
+ older placeholders of the type <OTRS_xyz ...> have been replaced by <KIX_xyz ...
It may be that not all placeholders are compatible and require manual follow-up checks and
adjustments.

Cl class definitions

+ After the migration, all "Cl class definitions" (including all versions) of the source environment are
available as "asset class definitions" of the target environment.

+ If a class with the same name already exists in KIX 18, the migration class is given the prefix
"Migration-".

+ Cl attribute types that are no longer supported are displayed as attributes of the "Text" type.

+ After the migration, the previously existing Cl attributes of the type "EncryptedText" are available in
the KIX as "Text". This means that the passwords stored in it are visible to users with rights to the
assets.

+ To accommodate the non-versioned Cl attachments from KIX17, each asset class is additionally
given the attribute "ClAttachments" (last attribute) of the type "Attachment".

+ For fields whose type attribute is not identical to that in KIX17, there is another attribute
"MigratedType" in KIX18 with the respective value of the type attribute from KIX17.

+ Perl comments in the string of the class definition are lost because the string is converted into a Perl
structure and back to a string after the adjustment. The comments are then lost.

+ Note on corrections for migrations starting from KIX17.19 (or lower) or to KIX18 v24 (or lower):

If no archive versions of the assets are displayed after the migration, this can be corrected by
applying the following DB statement to the KIX18 database.

UPDATE xml_storage SET xml_type = REPLACE( xml_type,
'"ITSM: :ConfigItem::Archive:', 'ITSM::Configltem::Archive:') WHERE xml_type LIKE
'"ITSM: :ConfigItem::Archive:%';

Config items / assets including versions

+ After the migration, all "config items" including versions of the source environment are available as
"assets" with versions in the target environment.
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+ Attribute types that are no longer supported are displayed as text attributes

+ Unversioned Cl attachments are displayed as the version attribute "ClAttachments” in the latest asset
version.

+ Climages are not accepted.

CustomerCompany / Organizations

+ The "CustomerCompany" object in KIX 17 becomes "Organization" in KIX 18.
+ The attributes of the "CustomerCompany" in KIX 17 become the following attributes in KIX 18:

KIX 17 CustomerCompany Attributes  KIX 18 Organization Attributes

CustomerCompanyCity City
CustomerCompanyComment Comment
CustomerCompanyCountry Country

- ID (will be created upon transfer)

CustomerCompanyName Name
CustomerID Number
CustomerCompanyStreet Street
CustomerCompanyURL Url
ValidID ValidID
CustomerCompanyZIP Zip

Contact person / user

+ After the migration, all "CustomerUser" in the source environment are available as
"Contacts" ("IsCustomer") in the target environment.
+ Use of SSP is activated,
+ "Customer" role assignment exists
+ PW hash takeover
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After the migration, all "Agent Users" in the source environment are available as "Contacts" and
"Users" ("IsCustomer” && "IsAgent") in the target environment.
+ "Customer" role assignment exists
+ "Agent User" role assignment exists
+ Password hash has been adopted
+ If the login name of a KIX 17 user (agent) already exists in KIX 18, he is created as a new user
with the suffix "-migrate" (similar to asset classes).
When migrating a KIX17 environment to KIX18, the system user from KIX17 (UserID 1, usually
"root@localhost") is not migrated.
Instead, all its assignments are transferred to the system user of the KIX18 environment (log-in:
"admin"), i.e:
+ Tickets that are assigned to the responsible person or processor "root@localhost" in KIX 17
are assigned to the user "admin" in KIX 18.
+ In the history of tickets or assets, the user "admin" is also referenced instead of
"root@localhost".
The "CustomerUser" object in KIX 17 becomes "User" or "Contact" in KIX 18.
The attributes of "CustomerUser" in KIX 17 become the following attributes in KIX 18:

KIX 17 CustomerUser Attribute KIX 18 User/Contact Attribute

- Contact.AssignedUserID

(Will be created during transfer (User.ID))

UserCity Contact.City
UserComment Contact.Comment
UserCountry Contact.Country
UserEmail Contact.Email
UserFax Contact.Fax
UserFirstname Contact.Firstname

- Contact.Fullname

UserLastname Contact.Lasthame
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UserMobile

UserCustomerlDs

UserPhone

UserCustomerID

UserStreet

UserTitle

ValidID

UserZip

FAQ including attachments

KIX 18 Admin Manual - EN - KIX Start
Installation
Migration KIX 17 > KIX 18

KIX 18 User/Contact Attribute

Contact.Mobile

Contact.OrganisationlIDs

(Requires lookups on Organization.ID via
Organization.Shortname)

Contact.Phone

Contact.PrimaryOrganisationID
(Requires lookup on Organization.ID via
Organization.Shortname)

Contact.Street

Contact.Title

Contact.UserlD

Contact.ValidID

Contact.Zip

Contact.ID

(Will be created upon transfer)

+ After the migration, all FAQ categories of the source environment are available in the target

environment.

+ If alanguage is referenced in the source system that does not exist in the target environment, this is

set up in the target system.

+ The contents of FAQ articles, which are used as a symptom, cause, solution and comment by default
in the source system, are legible in the target system.

* Remain:
+ Richtext formatting
+ Inline images
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+ Attachments to the FAQ article
+ The identification as "public" or "external” in the source system leads to the setting of the flag "Show
in SSP".
+ The FAQ ratings can be omitted.

Dynamic fields

+ After migration, the following dynamic field data is available in the target environment:
Configurations
+ The values contained in the dynamic fields.
Referral data

Checklists:
Dynamic fields of type "Checklist" are mapped in "MobileProcessingChecklist[n]" after
migration.
Mapping of the values (KIX17 => KIX18):
+ closed => 0K

notok => NOK

pending => pending

open => -
Only the title and status of the checklist entries are transferred; the description is not
transferred.
The transmission of the statuses is limited to the checklist statuses of KIX 18.

Dynamic fields of unsupported object types
are deactivated in the target system (are set to "invalid")
receive the suffix "- DF Type not yet supported!" in the label.
+ The edit dialog opens and displays a message.

Dynamic fields are mapped as follows (KIX17 => KIX 18):

Field type KIX17 Object in KIX18 Field type in KIX18  Validity after migration
Attachment Ticket is not supported invalid
Captcha Ticket will not be valid
migrated!
Checkbox Ticket Selection valid
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Field type KIX17
Date

DateTime
Dropdown

DropdownGeneralCata
log

ITSMConfigltemSelect
ion

Multiselect

MultiselectGeneralCat
alog

ObjectReference/
CustomerCompany

ObjectReference/
CustomerUser

ObjectReference/User

RemoteDB

RichText

SingleSelection

Object in KIX18

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Field type in KIX18

Date

DateTime

Selection

Selection

AssetReference

Selection

Selection

OrganisationRefere
nce

ContactReference

ContactReference

Selection

is not supported

Selection
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Validity after migration

valid

valid

valid

invalid

valid

valid

invalid

valid

valid

valid

invalid

(Manual change to
DataSource (if necessary also

setup DataSource
andConnection) required).

invalid

valid
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Field type KIX17 Object in KIX18 Field type in KIX18  Validity after migration
Text Ticket Text valid

TextArea Ticket TextArea valid

TextArea/FAQ FAQ TextArea valid

Token Ticket Text invalid

General Catalog:

After the migration, all values of all General Catalog classes in the source environment are available in
the target environment.

General catalog classes that already exist in the target environment are supplemented by additional
selection values from the source environment.

If entries are received from the source system that already exist, they are left, but the references in
the incoming data are "reassigned" accordingly.

Service data

After the migration, all service entries are available as assets of the "Service" class in the target
environment

The entry "Assigned team/queue" is not accepted.

Criticality will not be accepted.

There is no migration of the existing data in the "Service" class.

SLA (KIX Pro):

After migration, all SLAs of the source environment are present in the target environment.

The SLA fulfilment times are transferred from the target environment to the source environment. The
SLA violation (yes/no) and SLA deviation (duration) information is based on KIX18 calculations,
starting from the creation/fulfilment time.

SLA start time calculations based on a dynamic field (DateTime) are not considered, the creation
time of the ticket applies.

The SLA properties "Type" and "Update Time" are omitted.

If a calendar is referenced in the source system that does not exist in the target environment, the
target system uses the default calendar.
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4.5.7 Perform the Migration

4571 1. Activate PSK mode in KIX 17

KIX 17 and KIX 18 support a PSK mode (PSK = pre-shared key). The PSK is a verification key to secure data
transmission. It prevents unauthorized access to the database. Migration only takes place if both systems
know this previously agreed key. KIX17 rejects requests if no or an incorrect PSK is transmitted.

The PSK is stored in the KIX 17 configuration file (Config.pm). In KIX 18, the PSK is given to the console
command as a parameter (e.g. "PSK = my_PSK_Password").

© Attention

If the PSK mode is activated, the system is open for external access. Unauthorized third parties can
gain access to the database if they know the key. The conventions for assigning a secure password
are therefore binding for the naming of the key!

After completing the migration, delete the key in both systems and deactivate the PSK mode to
prevent external access!

Use a PSK that does not contain any characters to be URL-encoded (https://www.w3schools.com/
tags/ref_urlencode.asp) or quote yourself in step 2 if such characters are used.

To enable PSK mode:

1. Open the configuration file in the KIX 17 file system. You can find it under: /opt/kix/Kernel/Config.pm.

2. Find the "insert your own config settings" here "section.

3. Add the following lines of code within the section. Remove the comments ("// PSK [...]"). Assign your
own secure password instead of "my_PSK_Password" and save your changes.

# Activate PSK-Modus
$Self->{'Migration::Active'} = 1;

# Name PSK
$Self->{'Migration::PSK'} = 'my_PSK_Password"';
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{DatabaseDSN} = "DBI:Pg:dbname=55elf->{Database};host=55elf-
>{CheckMXRecord} = 0;
(EONNY} = 'kallinpe

:Active']

{'Migration:
{"Migration::P5K'} =

-{DatabaseHost};";

4.5.7.2 2. Start the migration via the KIX 18 console

1. In the admin module of KIX 18, navigate to System> Console.

2. Inthe selection field select the command
Console: :Command: :Admin::Installation::Migrate: :Run

3. Enter the transmission parameters (see table below) in the command line.
Use the following scheme:

Command line scheme

--source ... —--source-id [--options ...] [-—type

[--filter ...(+)] [--workers ...]

Examples

...] [-—mapping-file ...

1. --source KIX17 --source-id mykix1l7 --options URL=http://myKIX17domain:Port/

kix/migration.pl,PSK=my_PSK_Password --type ticket
2.
migration.pl,AutoDeps=1,PSK=test123

--source KIX17 --source-id mykix1l7 --options URL=http://172.17.0.1:9990/kix/

Kommande ausflibren

[ Console:Command::Admin: nutalae.. ~source KIX1T ~saurce-id mydx 17 ~ootiars URL=ht:/ salnurter des 171 ol Ps=test 123 ~type tickst

57: Comanle::Command::Adwis: --oprices TBL-hitp:

+Inacalletiont :Migrace: :Rus. --sonece

Exic

Te1 1B

Conscler:Command:rhdningrInstallat

AT o i

Fmy-kix-conain unternehnen. de: 1712, ks migr.

Fig.: Example migration command

4. Start the migration by clicking on "Execute”. The migration can take some time.
5. The console will inform you of the migrated data when it is complete.
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@ Tip

You can get help on the console commands by entering —--help or clicking on
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Possible parameters:

Use the following parameters with 2 leading hyphens (e.g. —-source ). Parameters marked with a * are

mandatory.
Parameter Description
source* The type of source system from which the data is to be migrated (e.g. ——
source KIX17).
This must be a source supported by KIX 18.
source-id* Identifier for the concrete source system (e.g. ——source-id myKIX17).

In KIX18 it is possible to migrate from several sources. KIX18 uses the source-
id to distinguish from which system it has migrated which data.

() Please note:

If you want to perform a migration in the menu System > Migration KIX
17 (KIX Pro) and then clean up any errors via the console, please note:
+ When migrating via the console, the source-id is freely selectable.
However, it must be identical for further partial migrations.
+ When migrating via the GUI (KIX Pro), the source-id is the same as
the URL entered in the GUI, e.g. http: //

myKIX17domain.de:PORT/kix/migration.p |
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Description

Options for migration, e.g. server/host of the source system and PSK:
.--options URL=http://172.17.0.1:9990/kix/
migration.pl, AutoDeps=1, PSK=test123

Separate multiple options with commas.

Calling the console command
"Admin::Installation::Migrate::ListSources "shows
possible options.

@ The details of the source (URL) and the PSK are mandatory.

Possible Options:

URL: URL of the file "migration.pl" (e.g. http://
192.168.160.200:4711/kix/index.pl or http://
myKIX17domain.de/kix/index.pl ).
+ You can find the URL in the address line in the browser of your
open KIX17 system
+ Replace" index.pl "with" migration.pl "inthe command
line.
PSK: Enter the key specified in KIX17 (e.g. PSK = my_PSK_Password)
AutoDeps: Enables/disables the automatic migration of dependent data.
+ AutoDeps=1 : Dependent data is also migrated.
If, for example, you only want to migrate queues/teams, the
corresponding user and system address entries are also migrated.
! Use "AutoDeps=1" only with caution, as duplicate entries will
result if the "source-id" is incorrect.
+ AutoDeps=0 : Dependent data will not be migrated.
If, for example, you only want to migrate queues/teams, the
corresponding entries of user and system address will not be
obtained (useful if users and system addresses have already been
obtained in a previous run).
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Parameter Description

type By specifying this parameter, you can restrict the migration to selected objects
(tickets, organisations, assets, etc.). Separate multiple types with commas
(e.g. --type ticket,customer_company,configitem).
If no type is specified, all supported objects are migrated.

Usable types are (note dependencies among each other!):

+ configitem

+ configitem_definition
+ configitem_history_type
+ customer_company
+ customer_user

+ dynamic_field

+ dynamic_field_value
+ faqg_category

« fag_item

+ general_catalog

+ general_catalog_preferences
+ kix_text_module

+ link_object

+ link_relation

+ link_type

* queue

+ service*

+ sla*

+ sla_preferences*

+ system_address

+ ticket

« ticket_history_type
« ticket_priority

+ ticket_state

+ ticket_type

+ users

*The types marked with an asterisk are only available in KIX Pro.

Tip: The console (see page 271) command

Console: :Command: :Admin::Installation::Migrate::ListTypes

--source KIX17 "lists all available types.
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Description

The JSON file to use for mappings (use an existing object instead of creating a
new one).

The most important mappings (e.g. priority, status, etc.) are already available
internally.

One or more filter expressions. Format and content depend on the source
selected.

An SQL WHERE clause can be specified for each object type. Format: --
filter "ticket{user_id = 123 AND responsible_id in
[1,2,3]}"

Number of parallel processes to be used for the bulk objects such as tickets
etc.
Standard: 1

With the number of workers you determine the available system performance.
This has an impact on the performance of your server. The higher the number
of workers, the faster the migration process if the system is heavily loaded.
Avoid overloading your system!

@ Already 4 workers can utilise a host to 100% capacity. Therefore, KIX.Cloud
environments are limited to a maximum of 2 workers.

If this parameter is not specified, the default value 1 is used.

Show help for this command.

Suppresses the display of general information. Only error messages are
displayed in the console.

4.5.7.3 3. Deactivate pre-shared mode

When the PSK mode is activated, unauthorized third parties can gain access to the database as soon as
they gain possession of the key. It is therefore imperative to prevent access to the database again after the
migration has been completed (or canceled)!

To do this, delete the key and deactivate the pre-shared mode as follows:
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1. Open the configuration file in the KIX 17 file system. You can find it under: /opt/kix/Kernel/
Config.pm.

2. Findthe"insert your own config settings" here " section.

3. Within the section, delete the lines of code you inserted and save this change.

4.57.4 4. Check and edit the transferred data

The migrated data are marked with a migration prefix if an object with the same name already exists in the
target system, e. g. Class "Migration Computer, Migration User Name".

Check the transferred data, placeholders, signatures etc. and adjust them if necessary. You can edit these
individually manually or automatically by using a job.

& Note

After the data has been transferred, it is available. However, building the indices for full text
searches or number of tickets per team, assets per class or similar can take some time. Depending
on the volume of data (several 100,000 tickets), this can also take several hours.

45.7.5 5. Post-processing and cache cleaning

& Note

After completing the migration, a cache clean-up must be performed on the KIX18 environment to
avoid inconsistent data representation. To do this, execute the command

"Maint::Cache: :Delete "inthe System > Console menu, log out of the GUI and log back in.

4.5.7.6 6. Advanced configuration transmission

A tool is provided for the transfer of further configurations such as ticket or response templates, "generic
agents’, etc. It is continuously being developed and can be obtained from the forum: . It is being continuously
developed and can be obtained from the forum: https://forum.kixdesk.com/index.php?topic=11882.0.
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4.6 Backup and restore

4.6.1 Securing on-premises installation

To secure an on-premises installation, we recommend taking advantage of containerization and keeping it
simple. Accordingly, the backup of the contents of the Docker volumes represents the backup of your KIX.

1. Stop Docker services: see https://github.com/kix-service-software/kix-on-premise/tree/master/
deploy/linux#readme

2. Back up Docker volumes: on the Docker host, under Ubuntu (volumes in / var / lib / docker /
volumes /)

Backup of KIX Docker volumes

shell> tar cfvz /tmp/KIXDockerVolumes.$(date "+%Y-%m-%dT:%H:%M:%S").tar.gz /var/lib/
docker/volumes/kix_backend/ /var/lib/docker/volumes/kix_frontend/ /var/lib/docker/
volumes/kix_db/ /var/lib/docker/volumes/kix_shared/

3. Restart Docker services: see https://github.com/kix-service-software/kix-on-premise/tree/master/
deploy/linux#readme

4.6.2 Backup of the database

In addition to the Docker volumes, you can also back up the KIX database. You can use "pg_dump" of the DB
container for this. Attachments and content of articles are not saved!

Backup of the KIX database

shell> docker exec kix_db_1 pg_dump -U kix kix >> /tmp/KIXDB.S(date "+%Y-%m-9%dT:%H:
%M:%S") .sql

4.6.3 Recovery on-premises installation

Installation according to https://github.com/kix-service-software/kix-on-premise/tree/master/deploy/
linux#readme

1. Stop Docker services
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2. Replace Docker volumes with backup (on the Docker host under Ubuntu e.g. in: / var / lib / docker /
volumes /)
3. Restart Docker services

4.6.4 Backup KIX Cloud

Backups for KIX Cloud take place regularly and automatically.

A backup of the KIX Cloud can be made available for download on request. As part of their support contract,

users of the KIX Cloud can contact support@kixdesk.com? if a backup is required or to have the system
reset.

4 mailto:support@kixdesk.com
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4.7 Setting up a reference environment (on premises)

For an on-premises installation, it can be helpful to set up a reference environment, for example to prepare or
test configurations or to check updates before going live.

The recommended procedure is based on backing up the existing KIX installation and restoring it on another
Docker host.

The procedure is described step-by-step below. "Source" is the original environment. The "target" is the
additional Docker host or the copy of the original environment.

Step Environment Description
1 Source Deactivation of the Email collection (important!)
2 Source Create the backup according to the instructions in

Backup and Restore (see page 52)

3 Source Reactivate the Email collection

4 Aim Transfer of the backup to the host for the reference
environment, e.g. using rsync® or scp®

5 Aim Basic installation of a KIX18 with your registry ID
(Installation - KIX On Premises) (see page 26)

6 Aim Restore Backup according to the instructions in
Backup and Restore (see page 52)

5 http://manpages.ubuntu.com/manpages/jammy/en/man1/rsync.1.html
6 http://manpages.ubuntu.com/manpages/trusty/man1/scp.1.html
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Step Environment Description

7 Aim Configuration of the reference environment:

+ Deactivation of the Email dispatch (Outbox (see
page 219), recommended for test environments) or
adaptation of the sender address (see page 228)

+ Setup of reference/test Email accounts (Inbox (see
page 201) )

+ Adjusting the front-end, the back-end such as the
SSP host names (Setup assistant - step 1 (see page

58) )
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5 Initial Setup

When you log in for the first time, KIX 18 opens with the Setup Assistant (see page 58), which guides you
through the most important steps of the initial setup. The initial setup includes creating a Super User,
entering information about your company and configuring the incoming and outgoing mail. You can skip
individual installation steps and continue later. Until the initial setup is complete, the Setup Assistant will
open every time you start KIX 18.

Ausbienden €

Adiiiiietoation - By Setup Assistant

e Welcome

ipete the i 10 St the basic Tor KL Th section "Ind " also provides more information.
Setup Asststant B b i e -
2 ™ N i el

e e\ ’G'E' /E.p\ /ﬂ'\al (8
# putomatian v \‘_/ U k’/ g
# Communication Superuser Account Admin Password Inbax Outbox My Organlsation Mottications Template

* mternaticnalization
Create Superuser Account

* Knowledge Database
n - The user acmin is & system usar and noe recommended for active use, Please create a new user here. Thisone will also have complete permissions. idter successfully creating that account, please login again with the new usar.
System

* Tickst

# Uscr Management

* Loghn Namw; &

* Passwand:

Fig.: The Setup Assistent in Admin Module

© Attention!

+ The initial user for the first login works in the system as a root user with complete
authorization to all system areas. In order not to endanger the security of the system, you
must create a super user in the setup assistant and change the password for the initial user
(steps 1 and 2).

+ Do not delete the initial user, basic system functions are bound to it! Otherwise you would
lock yourself out of the system.

After the initial setup has been completed, KIX starts with the welcome page. You can open this page at any
time by clicking on the question mark icon in the header.

The welcome page contains current information on KIX 18 and links to the KIX manuals and the release
information in the forum.
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Hello Agent [TD]SystemAdmin

Welcome to KIX 18 - Thank you for your Intesest in KX, Get a look on its all new and
modern user interface. See how easly it can be adapted and custommized in crder to
match your services processes. May we invite you on a short introduction?

l:l Mo, thankyou |

Help, hints & tricks

4 FIELD AGENT APP E ORI,
i

Tips for getting started quickly with KIX can be found on the KIX YouTube
Technical Custamer Service mit KIX - work order documentation, checklists, charmel. In the forum you can also eschange ideas with other KIX users.
scheduling, offing information for maintenance ard repairs,

D cuick strt Guide

ﬁ‘ I Forum
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Latest releases

v28 - Feature-Liste KIX18 v28
w27 - Feature-Liste KIX18 va7
w26 - Feature Liste KIX18 v26

E ManuaLs

Far a ore intenslve introduction to the use and adrinlstration of KIX you
willtind the latest manuals in the online documentation.

. ;
& User Manual
:. Addenin Manual

2 solf sorvice Manual

Fig.: The welcome page of KIX 18

The further setup of the system is done directly in the Admin Module, which is only available to users with

admin rights. You will find the Admin Module in the module menu on the side

You can navigate to the individual administration areas via the explorer (see page 86) in the Admin Module.

There you will also find the Setup Assistant.
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5.1 Setup Assistant

When you log into KIX for the
first time, KIX opens with the
setup assitant. This will guide
you through the initial setup in
just a few steps.

You can switch between the
individual steps, skip individual
steps and interrupt the initial
setup at any time to continue at
a later point in time. Your
previous entries will be retained.
KIX therefore always starts with
the setup assitant until the
initial setup is complete if the
user logs in as the "admin" user
or with the "superuser” role.
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Content on this page:

* QOverview (see page 58)
* Preparation (see page 60)
+ Use the setup assistant (see page 61)

Step1: System (see page 61)

Step 2: Superuser Account (see page 62)
Step 3: Admin password (see page 62)
Step 4: Inbox (see page 63)

Step 5: Outbox (see page 67)

Step 6: Own Company (see page 70)
Step 7: Notification Layout (see page 72)

+ Reset the setup assistant or change the status (see page 74)

Depending on your user rights, you can also open the setup assitant at any time via the Explorer in the admin

dashboard.

O, Setup Assistant

Welcome

Please compete the following steps to set the basic configurations for KIX. The admin manual, section “initial Setup” also provides more information.

System Superuser Account

Set Password for admin

* Login Mame: @ admin

()
N

Admin Password Inbox

Set a different password for system user "admin” in order to prevent continued use of the initial password.

Qutbox My Organisation Notitications Template

3| skp&continue | Y  Save & Continue |

Fig.: The Setup Assitant

5.1.1 Overview

The setup assitant guides you step-by-step through the initial setup.

\F
| %
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Icon
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Description

System: Deposite of the FQDN

Superuser Account: Create a superuser

Admin Password: Change the access data for the initial
user

Inbox: Set up an email account for the email inbox

Outbox: Setting up an outgoing mail server for sending
emails

My Organisation: Store company reference data

Notifications Template: Customization of the HTML
template for notifications

To switch between the individual steps, click on the icons in the assitant. The color of the icons indicates the
progress in the assistant:

Icon

@
O
O

Description

White Icon: Step is still unprocessed

Blue Icon: currently open step

Yellow check mark: step is incomplete

Green check mark: step is complete

There are the following buttons in the setup assitant:
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Skip &
Continue
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Description

Skip this step and skip to the next open step.

Save & Logout  Saves the user as a new contact and logs the user out after completion (only step

"Superuser Account").

Save & Retrieve = Saves the configuration of the email account and retrieves the inbox from the server

Save &
Continue

Preview

("Inbox" step only).

Saves the user as a new contact and jumps to the next open step.

Shows a preview of the notification template (only KIX Pro).

5.1.2 Preparation

When setting up for the first time, you create a superuser, change the access data for the initial user,
configure incoming and outgoing mail and store the data on your organization (company). Have the
following information ready:

+ First name, last name, email address of the user "Superuser”
+ The URLs on which your KIX system is located and via which it can be reached.
+ Credentials for the incoming mail server

Login name of the email account

Password of the email account

Pick-up point of the email server (host: port)

Pick-up method with or without encryption (e.g. "IMAP" or "IMAPTLS")

with IMAP: Directory in which the incoming emails are located (usually "INBOX")

+ Credentials for the outgoing mail server

Address to the SMTP interface of the email server (e.g. "smtp.mailbox.org")
Number of the port over which the emails are sent

Username (login of the email account)

Password of the email account

+ Reference data of your company, such as address and contact details.

If you use the mail server of a service provider (GMail, IONOS, Strato etc.), you will receive the required login
information from them. If you use your own mail server, you should know the login information.
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5.1.3 Use the setup assistant

5.1.3.1 Step1: System

In this step you store the FQDN (Full Qualified Domain Name) for your KIX system. These details are set in
the SysConfig key "FQDN" and thus made available to the various mechanisms in KIX, e.g. in OAuth2 profiles
or in the web form.

£k, Setup Assistant

Welcome

Please compete the following steps to set the basic configurations for KIX. The admin manual, section "Initial Setup” also provides more infarmation.

o N
r’l ® r/. \'.
| J { }
'\\-/J‘ '\\v '/

— SR

System Superuser Account Admin Password

Webform - Feedback 4% New Webform

&
System Settings

setup_assistant_system_settings_text Webform Options

Default Values

* Frontend: @ your-frontend-host.example.com
Include this code into the <head> area of your webpage.

Backend: © yourbackend-host.examale.com Dirrat forget to replace the <YOUR_FRONTEND_HOST> placeholder (i it is not already)
* Customer Frontend: @ your-customer-frontend-host.example.com
¥ " e =script=var kikWebFormURL = 'hiips /fyour-frontend-host example comiintegrations’; </script=

<script sro="https Jiyour-frontend-host example comstatic/integration/kix-farm js"=</script>
<link href="https./your-frontend-host. example.com/static/integration/kix-form.css” rel="stylesheet"-

Replace the initial example URLs for the KIX Front- and Backend with the URLs via which your KIX system can
be reached. If you are working with KIX Pro, also enter the URL for the Self Service Portal under "Customer
Frontend".

Alternatively, you can set the FQDN in the SysConfig key "FQDN":

*Name: @  FQDN

Description: @  Defines the fully qualified domain names of the system. This setting is used as a variable, "<KIX_CONFIG_FQDN>" (refers to
"Frontend" value) which is found in all forms of messaging used by the application, e.g. to build links to the tickets within
your system.

4
* Validity: @ valid
Value: @  {"Backend":"your-backend-host.example.com”,"CustomerFrontend":"your-customer-frontend-
host.example.com”,"Frontend": "your-frontend-host.example.com"}
y
Default Value: @  {"Backend":"your-backend-host.example.com”,"CustomerFrontend":"your-customer-frontend-
host.example.com”,"Frontend": "your-frontend-host.example.com"}
P
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5.1.3.2 Step 2: Superuser Account

In this step you create a user with the role "Super User". The superuser is a system user at user level with
rights to the entire system. His rights are more extensive than those of the administrator ("System Admin"
role). This superuser is created in the User administration> User menu as a user with the data stored here. It
is automatically assigned to the "My Organization (MY_ORGA)" organization. You can change this data at any
time in the user administration. Then log in again as a user with the superuser. To do this, click the "Save &
Logout" button.

Create Superuser Account

The user admin is a system user and not recommended for active use. Please create a new user here. This one will also have complete permissions. After successfully creating that account, please login again with the new user.

* First Name: John
* Last Name: Smith
*Email: @ jsmith@nomail.org
Avatar: @ |.!.| Select image file
*Login Name: @  JSmith

* Password: © essssssssssssses

A Hint

The initial user "admin" works in the system as a root user with full authorization down to the lowest
system level. It is not intended to be used in the system! For the security of the system it is therefore
necessary that you create a user with the role "Super User".

5.1.3.3 Step 3: Admin password
In this step you define a new password for the initial user.

With the provision of KIX you will also receive the password for the initial user "admin”. To protect the system
from unauthorized access by third parties, you must replace the username and password. The admin
password can only be changed using the setup assistant, as the initial user is below the user level.

Set Password for admin

Set a different password for system user "admin” in order to prevent continued use of the initial password.

* Login Name: @  NewaAdministrator

*Password: @ sescssssssesssesees
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© Important!

Use a secure password with upper and lower case letters, special characters and numbers. Keep the
password safe and secure to prevent unauthorised access by third parties. If the password is
forgotten, you can lock yourself out of the system.

5.1.3.4 Step 4: Inbox

In this step you will set up an email account for the inbox.

KIX polls the inbox of your email server at regular intervals and generates new tickets from the incoming
emails. To do this, you need to specify an email account from which incoming emails will be retrieved. The
information required for this can be obtained from your web hoster or is available to you if you operate your
own mail server.

After you have entered the information, you can test the email reception. Click Save & Retrieve. If the delivery
fails, you will receive a notification message.

You can set up and edit additional email accounts in the Communication> Email> Email Accounts menu.

©@ Tip

You can skip this step if you, as a prospect, just want to get an overview of KIX.
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Add email account for incoming mails

Add an email account for fetching incoming emails. Additional accounts can be added in admin module "Communication/Email /Email Acc]
are fetched from the mailbox and deleted!

* User Name: @  info@mailbox.org
* Type: @ IMAP
*Password: @  sesesssssssssses
IMAP Folder: @ INBOX
*Host: @  imap.mailbox.org
* Accept KIX Header: @ O
* Dispatching: ® [ Chemnitz

Comment: @

* validity: @ valid

Field Description

Username Login of the email account whose inbox you want to access. For
example: info@mailbox.org

Password Password of the email account

Host Address for the collection interface of the incoming mail server
Usually there is a separate host URL for each pickup method: e.g.:
pop.mailbox.org or imap.mailbox.org
A special port can also be specified (host: port)
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Field

Type

IMAP-Folder

Allow KIX Headers
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Description

Transmission protocol for email retrieval.
The pick-up method is specified with the selected protocol. If necessary,
find out about the differences between POP3 and IMAP beforehand.

Supported protocols:

+ without encryption: IMAP or POP3
+ with SSL encryption: IMAPS or POP3S
+ with TLS encryption: IMAPTLS or POP3TLS

Recommendation: First test IMAP or POP3 without encryption. If the
wrong option is chosen, the authentication will fail. A corresponding
notification is issued.

Directory in which the incoming emails are on the server.

KIX picks up the inbox from this directory (usually the "INBOX" or "Inbox"
folder).

This option is only available if the retrieval is from an IMAP account.

When activated, information from the KIX email headers is applied (e.g.
ticket type, team, priority, etc.).

The email header is accepted, evaluated and the information it contains
processed, regardless of what is configured in the email account.

If not activated: The email header is discarded when the emails are
received and is ignored.

& Please note: The emails sent via KIX can be provided with a KIX
header. You can read these out if necessary and use them for
actions based on them.

But: Under certain circumstances, the header information
supplied by KIX may contradict the email handling you have
specified and lead to undesired actions or system errors!
Therefore, only activate this option if you trust the KIX header
(e.g. from other KIX systems) and know from which senders
the retrieved messages originate.
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Field Description
Dispatching Select the principle according to which the retrieved emails are to be
distributed:

+ Default Queue (SysConfig)

+ The retrieved emails are distributed to the default team. The
default team is the team that is stored in the SysConfig key
"PostmasterDefaultQueue”. In the delivery state, this is the
"Service Desk" team. You can specify a different team in the
SysConfig key.

+ If emails cannot be assigned to a team, the default team
serves as a fallback.

+ Recipient addresses (To, CC, etc.)

+ The distribution of retrieved emails is based on the email
recipient.

« If the recipient address is created as an email address
in the system, the ticket will be created in the team
that is stored at this system address.

+ If the address is unknown or the email cannot be
assigned to a team, the ticket will be created in the
standard team (see above).

+ Team

+ If this option is selected, you can specify a team in which the
collected emails will be created as new tickets.

+ All teams created in the system are available for selection.
Teams in light grey are (temporarily) invalid. They are listed
but cannot be selected.

For further information on distribution, see Notes on email
distribution. (see page 207)

Comment You can save your own notes.

Validity valid: The emails are retrieved and distributed to the assigned team.
Invalid / temporarily invalid: The inbox of the email account is not (no
longer) retrieved, so that no (further) emails are received via it. Emails
that have already been accessed are stored in the system as tickets and
can be processed.
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5.1.3.5 Step 5: Outbox

In this step you set up an outgoing mail server (Sendmail) and the standard email address for the outgoing
mail.

In order to be able to send emails from KIX, you must specify a mail server and a standard sender address
for the outgoing mail. You can obtain the required server information from your web hoster or are available to
you if you operate your own mail server.

Depending on your system rights, you can change this information at any time in the Communication> Email>
Outbox menu and in the Communication> Email> Email Addresses menu.

@ Tip

You can skip this step if you, as a prospect, just want to get an overview of KIX.

Setup email server

Please enter connection information for your outgoing email server. If you want to use team mail addresses as sender only, leave envelope inputs empty.

Type
* Type: @ SMTP
Host: @  greenmail
Port: @ 3025
User: @  support@mailbox.org
Password: @  eee sseee ]
Envelope

Envelope From: @  KIX-Service @mailbox.org
Notification Envelope From: @  KIX-Message@mailbox.org

Notification Envelope From Fallb...: @ 1

System Address

* Email Address: @  support@mailbox.org

* Display Name: @  KIX System
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Type

Host

Port

User

Password
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Description

Transmission protocol for sending emails (SMTP).
With the selected protocol you determine the transmission method. If
necessary, you can obtain detailed information from your web host.

Supported protocols:

+ without encryption: SMTP
+ with SSL encryption: SMTPS
+ with TLS encryption: SMTPTLS

Recommendation: First test SMTP without encryption.

Note: The "DoNotSendEmail" option does not send emails, it can be used
for test systems.

Address to the SMTP interface of the outgoing mail server, e.g.
smtp.mailbox.org

Port via which the emails with the previously selected "Type" are sent.
The port depends on the selected transmission protocol:

+ SMTP: 25
+ SMTPS: 465
+ SMTPTLS: 587

Username for logging into the outgoing mail server. This often
corresponds to the name of the email account. For example:
johndoe@example.de This value can also be cleared via port 25.

The password of the email account. This value can also be cleared via
port 25.
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Envelope

System address
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Description

You can put your outgoing emails in an "envelope” (optional). Only what
is written on the "envelope" can then be recognized by the mail transport.

Envelope from: You can specify a sender that should appear on the
"envelope’, e.g. sender@example.com. If no sender is specified, the
team's email address is used as the sender.

Notification Envelope from: You can enter an email address that will be
used as the sender header in outgoing notifications. If no address is
given, the header of the "envelope" is empty.

(Corresponds to the SysConfig key "NotificationSenderName (see page
193) ")

Notification Envelope from Fallback: If no
"SendmailNotificationEnvelopeFrom" is specified, this setting allows you
to use the sender address instead of a blank envelope sender (required in
certain mail server configurations).

KIX requires at least one valid email address for sending and is therefore
delivered with an initial standard address (kix@localhost). Replace this
with your standard email address for the outgoing mail (e.g. mail
out@my-company.com) and enter a sender ID for this email address.

KIX uses this address to send all outgoing emails if no further email
addresses are created or if sending via another address fails.
Alternatively, the sender address can also be changed in the
Communication> Email> Email Addresses menu.

The sender address must match an email account configured in KIX (see
above step 3 "Inbox" or menu Communication > Email > Email accounts).
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5.1.3.6 Step 6: Own Company

In this step you enter the reference data of your company.

For internal and external communication, KIX needs the master data for your company. This data is stored in
the system under the initial organization "MY_ORGA" or under the customer number you specified here. You
can change this company data at any time in the "Organizations" module.

You can optionally store additional company data in the configuration keys (SysConfig keys). These can be
used as a reference in various places. For example in text modules and email signatures or for dynamic
placeholder replacement in jobs and notifications.

Organisation Information
*CNO: @  MY_ORGANISATION
* Name: Cape IT GmbH
* Type: service provider
URL: https://www.cape-it.de
Postal Address
Street: Schénherrstralie &
Zip: 01193
City: Chemnitz
Country: Germany
Other
Auatar: & | # |  calectimacefils |
Field Description
Customer Informations KNR: The customer number or name under which KIX should manage

your company in the system. Enter a unique identifier. Numbers and
letters are allowed.

Name: The name of your company.

Type: The company type under which your company is to be managed in
the system (default: Service Provider).

URL: The URL of your company website.
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Adress

Avatar

Comment

Validity
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Description

The postal address of your company headquarters.

The avatar is an image file for symbolically identifying your company, e.g.
in the sidebar. You can optionally upload your own image file as an
avatar.

You can save individual notes.

When you save your company data, the setup assistant creates a new
organization with the ID specified under KNR. You can set this
organization to either valid or (temporarily) invalid.

valid: The organization can only be used in the system if it is set to
“valid".

Invalid / temporarily invalid: The organization cannot be used by the
system, e.g. for test purposes.
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Field Description

SysConfig Keys The information stored here is used in the team signature that is initially
set. This information can also be used in KIX placeholders. The setup
assistant saves this information in the SysConfig keys of the system
configuration. Alternatively, you can configure the individual keys in the
System> Sysconfig menu.

Organization: The name of your company for use in the KIX mail header.

OrganizationAddress: Street and house number of your company for use
in placeholders.

OrganizationDirectors: The registered director of your company. For use
in placeholders, e.g. in the email imprint

OrganizationHotline1: Your company's phone number. For use in
placeholders, e.g. in email signatures

OrganizationHotline2: Your company's fax number. For use in
placeholders, e.g. in email signatures

OrganizationLong: The name of your company for use in wildcards.

OrganizationRegistrationLocation: The place where your company is
registered according to the legal requirements. For use in placeholders.

OrganizationRegistrationNumber: Your company's registration number,
e.g. Commercial register number. For use in placeholders.

5.1.3.7 Step 7: Notification Layout

KIX can send automated notifications for certain ticket events so that agents are informed about these ticket
events (see chapter Notifications (see page 184) ).

In this step you can individually configure the standard layout provided by KIX for these notifications and
adapt it to your corporate identity. To do this, you need knowledge of HTML and CSS. You will find good help
at https://www.selfhtml.org (in German). Our support team will be happy to help you design the notification
layout.

You can also change the template at any time in the Automation> Notification Layout menu.
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Lorem ipsum dolor sit amet

Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat,

sed diam voluptua. At vero eos et accusam et justo duo dolores et ea rebum_ Stet clita kasd gubergren,

no sea takimata sanctus est Lorem ipsum dolor sit amet. Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore
et dolore magna aliquyam erat,

sed diam voluptua. At vero eos et accusam et justo duo dolores et ea rebum. Stet clita kasd gubergren, no sea takimata sanctus est Lorem ipsum dolor sit amet.

Lorem ipsum dalor sit amet,

consetetur sadipscing elitr,

sed diam nonumy eirmod tempor invidunt
ut labore et dolore magna aliquyam

Fig .: Example of an HTML email

The HTML source code displayed in the setup assitant shows the layout of the standard template. You can
change the text and style information to customize the layout. For easier editing, you can copy the source
code into an HTML editor (e.g. Notepad ++).

+ Contents between <style> and </style> define the formatting of the individual elements on the
page, such as page background, header and footer of the mail, display of headings and links, etc.

+ Contents between <body> and </body> form the page content. The page content is grouped in
individual containers. These containers are formed with <div> [...] </div>.

+ Contents between <! -and -> are comments. These notes are for your information and are not
taken into account in the email display. If you want, you can safely remove them.

* You should not change the lines [% Data.Subject | html%] and [% Data.Body [....]
%] . These are the HTML placeholders for the email subject and the content of the email.

Click on "Preview" to check the configuration you have changed before saving.
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5.1.4 Reset the setup assistant or change the status

If necessary, you can reset or change the status of the setup assitant to the initial state. This is done in the
SysConfig key "SetupAssistantState".

© Warning

Changes to the system configuration can lead to serious damage to the system and should only be
made by experienced KIX users or our support team!

The status can be set separately for each individual step in the setup wizard. You can thus explicitly reset
each step to its

+ reset to its delivery status, e.g. to enter the information again

+ set to "completed’, e.qg. if the information required in the step has already been stored elsewhere in
the system (e.qg. if the FQDN to be entered in step 1 has already been stored in the SysConfig key
"FQDN")

+ set to "skipped", e.g. if the information required in the step has not yet been entered completely or the
initial data does not need to be changed (e.g. if "admin" is sufficient as super user and no other super
user is to be set).

Parameters and states of steps

Parameter Description Possible values
steplD ID of the step (unique identifier) + System: setup-system-settings
+ Superuser Account:
SuperUserAccount

+ Admin Password: Mail

* Inbox: MailAccount

+ Outbox: setup-sending-email

+ My Organisation:
SetupMyOrganisation

+ Notifications Template: setup-
notification-template
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Parameter

completed

skipped

result

Description

Corresponds to a click on the button "Save
& Continue".
If true, this step is considered completed.

Corresponds to a click on the button "Skip
& Continue".

If true, this step is considered "skipped/not
completed". It can be edited again at a later
time.

Result of the setup step

Used for loading the values when the step
is opened again (e.g. "My Organisation”
step).

The extent to which the specified values
are evaluated depends on the respective
steps (code).

Basic configuration of the Setup Assistant
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Possible values

true | false

true | false

null or
individual data structure,
e.g. {"OrganisationID":1}

The following sample configuration contains all configuration parameters of the Setup Assistant and sets all
steps in the Setup Assistant to "unedited".

Example 1 - Basic configuration

"stepId":"setup-system-settings",
"completed": false,
"skipped":false,

"result": null

"stepId": "SuperUserAccount",
"completed": false,
"skipped": false,

"result": null
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"stepId": "Mail",
"completed": false,
"skipped": false,
"result": null

1,

{

"stepId": "MailAccount",
"completed": false,
"skipped": false,
"result": null

1,

{

"stepId": "setup-sending-email",
"completed": false,

"skipped": false,

"result": null

1,

{

"stepId": "SetupMyOrganisation",
"completed": false,

"skipped": false,

"result": null

1,

{
"stepId":"setup-notification-template",
"completed":false,
"skipped":false,

"result":null

}

]

Reset the status of the assistant:

1. Navigate to the System> SysConfig menu.
2. Find the key "SetupAssistantState" and open it.

3. Click "Reset to Defaults," then click Save.
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The status of the Setup Assistant has now been reset to the delivery status. The delivery status is an empty

value.

Change the status of the assistant:

1. Navigate to the System> SysConfig menu.
2. Find the key "SetupAssistantState" and open it.
3. Copy either the value of the SysConfig key or the code example 1 (partially or completely) into a JSON

editor (e.g. jsonformatter.io”).

4. Setthe parameters completed and/or skipped to true or false asrequired.

7 http://jsonformatter.io
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If necessary, set the parameter result to null or store a data structure for values there (see
code example 2).

Minimize the JSON string by removing double spaces and line breaks.

Copy the minimized JSON string to the clipboard.

Switch back to the configuration key and replace the value with the JSON string from the clipboard.
Save your change.

The status of the Setup Assistant now corresponds to your manual configuration.

Deactivate Setup Assistant:

If KIX has already been set up, the Setup Assistant will still be displayed when a user with superuser role logs
in until it has been "clicked through" once. To disable this, proceed as follows:

a > wn =

© o N o

Navigate to the System > SysConfig menu.

Find the key "SetupAssistantState" and open it.

Copy the code example 1 or 2 into a JSON editor (e.g. jsonformatter.io®).

Set the parameter completed to true for all steps.

If necessary, set the parameter result to null or store a data structure for values there (see
code example 2).

Minimise the JSON string to remove double spaces and line breaks.

Copy the minimised JSON string to the clipboard.

Switch back to the configuration key and replace the value with the JSON string from the clipboard.
Save your change.

The individual steps in the Setup Assistant are now considered to have been completed, so the Setup
Assistant will no longer be displayed from now on. It can be called up again at any time via the Admin menu.

Note: The Setup Assistant will be displayed again after an update if additional steps have been added. This
ensures that all required information can be entered in the Setup Assistant. You can deactivate the Setup
Assistant again if you also set the completed parameter to true for the new steps.

Example 2 - Configuration with values

{
"stepId": "setup-system-settings",
"completed": true,
"skipped": false,
"result": null
1,

8 http://jsonformatter.io
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{
"stepId": "SuperUserAccount",
"completed": true,
"skipped": false,
"result": {
"contactId": 999,
"userId": 999
}
1,
{
"stepId": "Mail",
"completed": false,
"skipped": true,
"result": null
1,
{
"stepId": "MailAccount",
"completed": true,
"skipped": false,
"result": {
"accountId": 2
}
1,
{
"stepId": "setup-sending-email",
"completed": true,
"skipped": false,
"result": {
"systemAddressId": 1
}
1,
{
"stepId": "SetupMyOrganisation",
"completed": true,
"skipped": false,
"result": {
"organisationId": 1
}
1,
{
"stepId": "setup-notification-template",
"completed": false,
"skipped": true,
"result": null
}
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After the initial setup using the Setup Assistant, you can further customize KIX to your specific requirements
in the Admin module. Due to dependencies in the system, we recommend that you do this in the following

order:

Required initial setup (alternative to Setup assistant):

Sequence

1a

1b

1c

1d

Te

What do | have to do?

Set up the user
"Superuser”

Change the Admin
Password

Set up Inbox

Set up the Outbox

Set up the own
organization

Where do | configure this?

Admin module > User
Management > Users

Required role: Super User

in the Setup assistant

Admin module >
Communication > Email >
Inbox

Admin module >
Communication > Email >
Outbox

alternatively: Admin module
> System > SysConfig

Organisation module >
Customer "My_Orga"

Issued on: 26.02.2024

Which chapter in the
manual?

Creating and Editing a
User and Assigning
Roles (see page 664)

Setup Assistant (see page
58)

Inbox (see page 201)

Outbox (see page 219)
Configuring the Email
Dispatch

(SysConfig) (see page 222)

In the user manual
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Further system setup in recommended order:

Sequen
ce

e

What do | need to do?
(mandatory)

Set up agents and
assign roles
(see note below)

Set up additional
Email accounts if
necessary (Inbox)

Set up Email addresses

(outbox)

Set up Teams (Queues)

Set up Default
Team (Default Queue)

Where do | do that?

Admin module > User
Management > Users

Admin module >
Communication > Email >
Email Accounts

Admin module >
Communication > Email >
Email Addresses

Admin module >
Ticket > Teams

Admin module >
System > SysConfig >
key
"PostmasterDefaultQ
ueue"
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KIX 18 Admin Manual - EN - KIX Start
Initial Setup
Guide

Which chapter in the manual?

Users (see page 661) et seqq.
Creating and Editing a User

and (see page 664) Assigning

Roles (see page 0)
Authentication/Authorisation and
Connection to Active

Directory (see page 671)
Roles/Permissions (see page

632) et seqq.

Inbox (see page 201)

Email Addresses (see page 228)

Teams (see page 617)

Setting Up the Default Team (see

page 625) (Default Queue) (see page
0)
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Sequen What do | need to do?
ce (mandatory)

6 Create/import
organization data

Where do | do that?

"+ New" button

> "New Organisation”
tab

Customer module >
Overview
Organisations >

button: "New
Organisation" /
"Import"
7 Create/import contact "+ New" button
data >"New Contact" tab
Customer module >
Overview Contacts >
button: "New
Contact" / "Import"
8 Set up FAQ categories Admin module >
Knowledge Database >
9 Update content of FAQ FAQ module
Optional and in any order:
What do | can | do? Where do | do that?
(optional)
Configure asset classes Module Admin > Assets >

Asset Classes

KIX 18 Admin Manual - EN - KIX Start
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Which chapter in the manual?

In the user manual

In the user manual

+ Knowledge Database (see page 267)

In the user manual

Which chapter in the manual?

+ Asset Classes (see page 120)

+ Creating or Editing an Asset
Class (see page 123)

+ Class Definition (see page 126) et

seqq.
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What do | can | do?
(optional)

Edit ticket settings

Create text modules

Set ticket notifications

Configure email filters

Maintain multiple languages

Create automated jobs

| "%

Where do | do that?

Module Admin > Ticket >
Priority | States | Types

Module Admin > Ticket > Text
Modules

Module Admin > Automation
> Notifications

Module Admin >
Communication > Email >
Email Filter

Module Admin >
Internationalisation >
Translations

Module Admin > Automation
> Jobs
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Which chapter in the manual?

States (see page 614) et seqq.
Priorit (see page 611) ies (see page
611) et seqq.

Types (see page 629) et seqq.

Text Modules (see page 626)

Notifications (see page 184)
Creating or Editing a Ticket
Notification (see page 186)

Email Filters (see page 231)
Configuring an Email Filter (see page
233)

Translations (see page 264)

Jobs (see page 170)
Creating or Editing a Job (see page
175)
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5.3 Language settings

The initial system language of KIX is English. The German language translation of the system is included.
You can change the system language in the "Preferences".

To do so, click on the gear icon in the header area. In the dialog that opens, select the desired language
under "Localization > Language" and save your selection.

Fig.: The gear icon for language selection

4 # Home X | X & Preferences X [ 3
n £ Preferences
Change Password

=]

Current Password:

New Password: @
Confirm New Password: @
Localisation
* Language: @ Language b
German
Favorites Enda's}j{b
My Teams: &
Motifications
Enr Tickatc- & A £ Tickoias PAPIL] T

Fig.: Selecting the language in the personal settings

Further information on language settings: Translations (see page 264)
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6 Basic Information

The chapter "Basic Information" provides you with an overview of the structure of KIX and is intended to
familiarise you with the user interface in the Admin module.

+ Overview of the Admin Module (see page 85)
« The Admin Dashboard (see page 86)
+ Elements of programme interface (see page 95)
+ Keyboard Navigation (see page 111)
« KIX Architecture (see page 113)
« Scheme KIX Database (see page 115)
+ Version numbers (see page 116)
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Overview of the Admin Module
[

The Admin module is part of the agent portal and is opened via the "Admin" button in the module menu
on the left. It is only available to users with the roles "Superuser" and "System Admin".

In the Admin module, you make the basic settings for KIX, administer the user rights and configure the views

and functions for the agent portal and for the Self Service Portal' according to your company-specific
requirements. The Admin module supports you in:

Administration of the company's internal infrastructure (machines, devices, buildings, vehicles,
contracts, etc.)

User and rights management

Setting up e-mail communication

Administration of ticket properties

Control and automation of tickets

Modification of the user interface (GUI)

Creation and integration of additional input and selection fields

Configuration of the additional modules of KIX Pro

and much more,

1) The Agent Portal is the application area that agents work with. The Self Service Portal is the customer
portal and can only be used with KIX Pro.
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6.1.1 The Admin Dashboard

The Admin Dashboard opens after clicking on the Admin
module in the left module bar .

The left sidebar (see page 97) contains the module
explorer "7 . It contains

+ the Setup Assistant (see page 58), which guides
you through the initial setup of KIX. It is displayed
after the first login and can be opened again at
any time.
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Content on this page:

* Overview (see page 87)
* Determine IDs (see page 92)
+ Mobile View of KIX 18 (see page 94)

+ the KIX administration menu in an alphabetically ordered menu tree. This is used for the
administration and individual configuration of the agent and self-service portal.

Select a menu item in the tree to load the content into the content area (see page 102) ‘8 . The table
displayed there contains the individual configuration objects. Clicking on a table entry takes you to
the zoom view (see page 105) of the selected object or to its editing mode (see page 107) .

+ the configuration options for the additional modules and extensions you have purchased.

If you are using a small monitor, the sidebar is displayed collapsed. Click on the double arrow at the top of

the sidebar to expand and collapse the sidebar.

Due to authorisation checks, loading the Admin module may be delayed by a few seconds in low-

performance environments.

(@ Note to the admin manual

Both the structure of the table of contents and the navigation links in the chapters of the admin
manual are based on the structure of the KIX menu tree. In the manual we refrain from the explicit
reference that a menu item is located below KIX and use, for example, "Navigate to System >
SysConfig" instead of "Navigate to KIX > System > SysConfig".
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6.1.1.1 Overview

4 # HomeX & Admin: Asset Classes X (§

Hide €
T ] Name = Comment Validity
Setup Asslstant LI Building -3 walid
S 2 [0 computer [l 5 valid
B Assets [ Hardware o walid
Asset Classes [l Location 9 wvalid
Geners| Catalog [ Hetwork & valid
“ ek O] Roam . valid
* Automation o »
[ software @ wvalid

+ Communication
 Internationalisation
* Hnowledge Database
* System

* Ticket

¥ User Management

Q) KD 18 (Buikd: 3961-0.1600-0) | Logged in:
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T 7

T Created at

05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM

05/04/2022, 01:18 FM

Imprint

(s e | (* @ 8 a'a e ® a'a =
e o - | 5% Y iet S f

Created by

not assigned
nat assigned
not assigned
not assigned
not assigned
not assigned

not assigned

a' a =:'|
o

a2 80? ®

P X

£ New Class

Changed at

05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM
05/04/2022, 01:18 PM

05/04/2022, 01:18 PM

Changed by

nat assigned
not assigned
nat assigned
nat assigned
nat assigned
not assigned

nat assigned

Fig.: Structure of Admin Dashboard

No Area
1 Header
2 green Plus-Button and

Fulltextsearch

3 Quick access to important
functions and views of the
logged-in user

Description

KIX header with logo and toolbar for frequently
used functions

Create new objects (tickets, assets,
organisation, contact, FAQ).

The selected object also defines the context for
further actions, e.g. the fulltext search.

Quick access to frequently used agent
functions (see user manual "Home Dashboard").

Personal views (favourites, kanban,

calendar)
Tickets

Watched tickets
Locked tickets
News and Error notes
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No Area

4 Tools

KIX 18 Admin Manual - EN - KIX Start
Basic Information
Overview of the Admin Module

Description

Complex search for selected object
properties

Personal settings of the user

Welcome page with help, tips & tricks and
link to manuals.

Logout

Tip: The links to the manuals support voice
control. This means that the URL to the manuals
can vary according to the language used. This
may be necessary if, for example, you have
created additional languages in the SysConfig
key "DefaultUsedLanguages”. In the following
SysConfig keys, you can specify one URL per
language:

KIX::SelfServiceManual
KIX::UserManual
KIX::AdminManual
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No

Area

Tab bar
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Description

Contains the open dialogues in one tab each.

You can move the tabs in their order by dragging
and dropping.

To close the tab, click on the cross in the tab or
click on the tab with the middle mouse button.

IE‘A pin marks the tab as pinned. Pinned tabs
are retained after logout. Double-click on a tab

to pin or unpin it.

Note: In order to ensure that configurations are
completed, subsequent dialogues cannot be
pinned:

+ Create/Edit Job

+ Create/edit actions (KIX Pro)

+ Create/edit templates (KIX Pro)
+ Create/edit report definition

+ Import organisations

+ Import of contacts

+ Collective actions

|E| The reload icon in the tab indicates a
change in the tab content. Clicking the tab again

reloads the tab content and removes the icon.

E Click on the X on the right side of the tab bar
to close all tabs.
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No Area
6 Module menu
7 Left Sidebar (see page 97)
8 Content Area (see page 102)
(Dashboard)
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Description

Switching between the KIX modules

+ Home Dashboard: Dashboard of the logged
in user

+ Tickets: Creation and editing of tickets

- Assets (CMDB): Management of the
company's own infrastructure and
resources (assets)

+ Organisations: Create and edit customers
and contacts

+ Service contracts: Create service contracts
(KIX Pro only)

+ FAQ: Administration of FAQ entries
(knowledge base)

+ Reports: Creation of reports

+ News: Create and manage messages to
agents and customers (KIX Pro only)

« Admin: Administration of the agent and self-
service portal as well as possible KIX Pro
add-on modules

The available modules depend on the rights of
the user who is logged in.

Explorer with administration menu in
alphabetical order.

Clicking on the double arrow opens or closes the
explorer.

Display of the page content, according to the
selected menu:

+ Dashboards

+ Overview tables with search and filter
functions

+ Detailed views

+ Creation and editing dialogues

The display of the page content can be
configured for the frontend (see configuration of
the user interface (see page 327) (GUI))
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No

(without)

Area

Right Sidebar (see page 97)

Footer
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Description

Contains widgets to provide various information.
A click on the double arrow shows or hides the
sidebar.

In the admin module, the sidebar is only
available in selected dialogues (e.g. "New e-mail
filter").

The widgets to be displayed in the frontend and
their contents can be configured. (see
Configuration of Sidebar (see page 412))

Program version (see page 116), user who is
currently logged in, and imprint.

You can store the link to the imprint in the
SysConfig key "ImprintLink" (menu System >
SysConfig)
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6.1.1.2 Determine IDs

When configuring KIX, you will need the ID of objects (ticket, asset, organisation, contact, etc.). For example,
in placeholders, when configuring roles or to reference a specific object directly. You can determine the IDs
in different ways:

Determine ID via the URL of the address bar

Every open tab, every view, every search etc. has a unique URL. Each object can be called up directly using
the URL. For example, calling up the organisation with the ID "1": http://

your.agentenportal.kix.cloud/organisations/1.

The URL is displayed in the address bar of the browser. It contains both the object type of the opened object
(e.g. organisations) and its ID (e.g. 1).

You can also use the URL to call up the current view in a different context or via other services (see also
Using the browser URL (see page 605) ).

= My Organisation (MY_DRGA) % ;e

= c @] Jorganisations/1 bk =

4 i Organisations X My Organisation (MY_.. ¥ P X

My Organisation (MY_ORGA) A4 New Organisation

# Edit fE] Duplicate & New Contact 4 NewTicket 45 New Assel

nT Organisation iformation [

CND Name Tvpe Validlity
ﬁ MY_ORGA My Organisation service provider valid

Fig.: Object ID in the address bar of the browser

Reading the ID in the browser footer
You can also read the ID of an object in the footer of the browser, e.g. to determine the ID of the priority.

- Navigate to the overview of the desired object (e.g. Ticket > Priorities or System > Dynamic fields or
Ticket > Status etc.).

+ Move the mouse pointer over the name of the desired entry.

+ Read the ID in the footer of the browser. The ID is the last parameter (last number).

+ This works with every object and in all overviews.
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Hide &

AT ATion ™ £k, Ticket: Priorities (5) I:

| IR 4 Name - Comment Validity Created

Setup Assistant Lvery high [ ] valid 11/16/)

& Kix

+ Assets

2 high ) valid 11/16/
3 :‘.:‘ al valid 11/16/

Alow s valid 11/16/

5 very low [ | valid 11/16/

#+ Automation

O DN O O @i

+ Communication
' Internationalisation
+ Knowledge Database
+ Service Catalog
+ System
[ ]
i B Ticket
Priorities
States
Teams
Text Modules

Types

+ User Management

KiX 2013 - BT R T | prioiti

Fig.: The Object-ID in the footer of the browser
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6.1.1.3 Mobile View of KIX 18
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The appearance of KIX depends on the screen size. On smaller screens, the content area takes up the entire
width of the screen and the menu and header lines are minimised:

Button

Hamburger Button

v

. left double arrow

u Dropdown-Button

New-Button

right double arrow

Description

Displays the module menu.
Displays the open tabs below the module menu.

Opens the left sidebar with the Explorer.

Opens the toolbar for fast access.

Opens the dialogue for creating new objects.

Opens the right sidebar with widgets (frontend
only).
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6.1.2 Elements of programme interface

The programme interface contains various, partly configurable, elements such as

+ Sidebars (see page 97)
+ Widgets (see page 101)
* Lanes (see page 97)

+ Detailed views (see page 105)

- etc.

The following chapters provide an overview.

Elements of programme

interface

Description

Personal Home Dashboard

On the personal home dashboard, agents can find a quick overview of all
events.

Module menu

All available modules (e.qg. tickets, assets, FAQ) can be easily accessed from
any page via the module menu with just one click.

Explorer

On dashboards, the explorer in the left sidebar helps you to keep an
overview. This has the familiar tree structure and guarantees easy navigation
even in extensive structures.

Tables

Clear tables, which you can sort and filter according to your needs, help you
optimally with your daily work processes.
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Elements of programme Description
interface

Lanes

On the detail pages of the individual objects (e.g. ticket, asset) you will find a
lot of information, which is neatly arranged in several lanes to save space.

Sidebars

Various additional information (e.g. contact details) are discreetly located in
the right sidebar, which you can easily show and hide.

Various additional information (e.g. contact details) are discreetly located in
the right sidebar, which you can easily show and hide.
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The sidebars are located to the left and right of the content area (see page 102) . They can be shown or hidden

by clicking on the double arrow.

You can configure (see page 412) the widgets (see page 101) contained in the sidebars and their contents in the
menu System > SysConfig according to your own needs.

Left sidebar

The left sidebar contains the module explorer. The module explorer in the admin module includes the
administration menu in an alphabetical tree structure. Here, all configuration options of KIX are grouped
thematically. Click on a menu item to load the page content into the content area.

4 # Home X d Admin: Asset Classes X

Hidle ¢

| v [ Name & Comment
[ . Buildi
Setup Assistant e [ g -
© hssets [J Computer [}
Asset Classas [ Hardware -
General Catalog [ Location 9
Import/Export [ Metwork &
* -
Automation I—_ Room .
# Communication
[ Software ®
# Internationalization
# Knowlodgs Database
* System

* Ticker

# User Management

Validity |T
walid
walid
walid
walid
walid
walid

valid

| (A

Created at

03/26/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 06:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM

03/28/2022, 08:43 AM

Created by

not assigned
not assigned
not assigned
not assigned
not assigned
nat assigned

not assigned

&£ Mew Class

Changed at

03/28/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM
03/28/2022, 08:43 AM

03/28/2022, 08:43 AM

Changed by
not assigned
nat assigned
not assigned
nat assigned
not assignexd
nat assigned

not assigned

Fig.: The left sidebar with the "Administration” module explorer.

Menii Aufgabenbereiche

Setup Assistant

Assets Device database (formerly: CMDB);

Starts the Setup Assistant for the initial setup of KIX

1. Asset classes (create and maintain equipment)
2. General Catalog (create selection values)
3. Import/Export (CSV import and export of assets)

v
[P S
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Internationalization

Knowledge
Database

Service Catalog (KIX
Pro)

System

Ticket

User Management
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Aufgabenbereiche

Automate KIX functions:

1. Set up system notifications
2. Set layout of system notifications
3. Set up automated jobs

Set up communication channels:

1. E-mail (set up inbox, outbox and distribution, set up team e-mail addresses).
2. Web form (create contact form)

Maintain multilingualism of the system

Create and manage FAQ categories

Establishment of Service Level Agreements (SLA)

Configure system settings

Create dynamic fields

Manage icons (KIX Pro)

Execute console commands

Viewing log files

Migration from KIX 17 (KIX Pro)

Configure the system and customise the user interface

A e

Make basic settings for tickets

Make basic ticket settings (priorities, status)
Create and manage teams (queues)

Manage text modules

Create and manage ticket types

Set up ticket actions and ticket templates (KIX Pro)

ok w2

—_

Create and manage users
2. Assign roles and permissions
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Right sidebar

The right sidebar contains various widgets (see page 101) with additional information. In the Admin module, the
right-hand sidebar is initially only available in selected dialogues (e.g. the "New E-mail filter" dialogue).

4 o & Admin:EmailFilter X % © Mew Mall Fitter X ]
» Ausblenden
£ New Mail Filter 7 Help
Email Filter Information Incoming emalls can be dispatched or filtered based on email
hesders. Matching using Regular Expressions is possible. If you want
* Name: Spam to match only the email address. use
e EMAILADDRESS:info@example.cam in From, To ar Cc. if you use
Stop after match; u] Regular Expressions, you can set the matched pattern in ., [1* and refer
; ta this by adding .[***]" in the "Set value® action. (only works for ane
Comment: = (¥ -areument) Filterconditions ars AND-linked,
n P
Validity: lid
Filter Conditions
v Email Header: ¥ Negate: ¥ Pattern: ¥
Set Email Headers
# Set Email Header: T Set Value: ¥
a o

Fig.: The right-hand sidebar with the help widget in the "New e-mail filter" dialogue box
In the modules, the sidebar contains several folding widgets with various information for agents:

+ Inthe home dashboard: the Notes widget, where agents can leave personal notes.

+ In the ticket views: initially 4 configurable widgets with information about the Contact, Affected
assets, Suggested FAQ entries and the tickets of the contact.

+ In form dialogues: texts for help and - if configured - further widgets with information.
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| T Tickess: [T-TEAM-DHL. % | X T New Ticket X »

. 3 Aushlenden
T O
* contact: e -y

" Owganisation: ¢ e g oot 9 T Open Tickets of Contact

Affected Asset: & T Open Tickets of Orzanisation

* Type: @ T Tickets for Assets -

Tickat# Title

Assign Team: Nothing found,

* Channel: |E él < »

T Tickets for Contact

Owner: © Title e

* Priority: 3 mormal Nothing found.

“State; T & apen § Suggested FAQ) -
ﬂ“ Cancel -. u Sane Nothing found,

Fig.: The right sidebar in the ticket new dialog with 4 widgets
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6.1.2.2 Widgets

Widgets are containers with configurable content. A distinction is made between

Card widget (object information card widget)
Contain text or image elements that are displayed column- and row-wise.
e.g. widget "Contact Information" in the sidebar or "Ticket Information" in the upper lane of the
detail view.

- Table widget (table widget)
Contain object tables
e.g. widget "Suggested FAQ" or the tables in the content area

The widgets are configured by adjusting the corresponding SysConfig keys in the System > SysConfig menu
(see Practical section > The configuration of widgets (see page 336) ). (see page 336)

4 Contact Information -

John Moresby

#% EM Automotive GmbH & Co. KG

(P +4912345678

= contact360@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

Fig.: The "Contact Information” card widget

¢ Suggested FAQ (3) -

Title

Product Information

Technical Information

CRNCRNG
L I I

User Manual

Fig.: The "Suggested FAQ" table widget
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6.1.2.3 Content Area

The content area is the content and work area. In the admin module, it opens only after selecting a menu in
the module explorer of the left sidebar.

The contents of the selected menu are displayed in tables. The table entries are displayed in alphabetical
order by name. You can reverse the sort order by clicking on a column header.

You can limit the table entries displayed by entering filter terms:

« Filter by table content: Enter the filter term in the search field in the table header and click on the filter
symbol next to it.

« Filter by column content: Click on the filter symbol in the column header and enter the filter term in
the text field that opens.

For performance reasons, large tables are not loaded automatically (e.g. SysConfig). A full text search (see
page 103) is available to limit the table to the relevant table entries.

Clicking on a table entry takes you to the zoom view (see page 105) or to the editing mode. (see page 107)

fissblenden 4

Administration - Q. Assets: ssel Classes (8) | ¥ (n £ New Class
. T [] Mame = Comment Aalidity T| Created at Created by Changed at Changed by
ki At O uildirg & walid DA/ERI021, 1E6 P Mot ausigned 0642272021, 126 P not BssiEned
B assers [ Comguter 'l walldl 04/Z2/2021, T26PM  natassigned O6/22/7021, 1:36PM  notassigned
Bt Tavves ] Hardhware o walid 06/22/2021, B26PM ot assigned G6/22/7021, L26PM ot assigned
Geweral Cataloe [J Location ] elicl 08222001, 36 PM ot assipred OB/, 126PM  not assigned
AmncioE g [ wetwork & walid DA/I2/2071, 24 PM not sssigned O8/22/7021, 1-26PM  not assigned
* —
n Almeron [ Room . valid O8/ZRA2L, BZ6PM ot assigned 0642272021, 126 PV not assigned
* Communication
[ Sobwere ] valicl 042272021, £26 P nat assigred OB, 126PM not assizned

* Intermationalmation
# knowledps Database
# sypem
* Ticket

# User Manapement

Fig.: Content Area

Click on the column Search filter across activates create a
header to sort the table the entire table the filter new object

open and close

Actions table

Titel line

£, Assets: Asset Cli sses (8) T & New Class

] Name (_”_)mmment - Created at Created by Changed at Changed by

. Building & 12/01/2020, 9:13 AM not assigned 12/01/2020, 213 A4 not assigned
] computer -] 12/01/2020, 9:13 AM not assigned 12/01/2020, #:13AM not assigned
[ Hardware [-] 12/01/2020, 9:13 AM not assigned 12/01/2020, #:13 AM not assigned
ml

\cation 0 ali 9:13 AM not assizned 01/2020, 13 AhA

select all change the Click on row to open details Search filter above the
table entries column width or to edit element respective column

Fig.: Structure and Functions of Content Area

() Please note
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The table in the content area lists the name of an object exactly as it was created. However, the
zoom view is translated into the language used by the user who is logged in. If German users use
English designations, for example, it is therefore possible that the table in the content area will list
the English designations, that these designations are translated into German in the zoom view, but
that the form dialog displays the name in English again (exactly as it was created). This is not an
error in the program, but is due to the way in which the languages are managed.

Full text search

A search function is available in very extensive overviews. The search function allows you to search for a

specific term or to limit the table entries to be displayed from the outset. This is the case, for example, in the
user or SysConfig tables. Enter the search term in the search field and click on "Search" or press ENTER.

Unknown parts of the search term can be replaced with wildcards (*) anywhere in the search phrase (e.qg.

"ticket-new*", "mu*man’, "*stern"). If you only enter the asterisk in the search field, all table entries will be
listed. Loading all table entries may take a moment.

£, System: Sysconfig (18)

ticket-details”

Name &
ticket-details
ticket-details-affected-asset-tickets

ticket-details-article-attachments-overlay

ticket-details-article-list-table-confie

Modified

Context

kix18-web-frontend
kix18-web-frontend
kix18-web-frontend

kix18-web-frontend

Metadata Access Le...
Context internal
Widget internal
Widget internal

Tablewidzet internal

Validity
valid
valid
valid

valid

Value
{"id":"ticket-details","name":"Ticket Details","ty...

{"id":"ticket-details-affected-asset-tickets","nam...

{"id":"ticket-details-article-attachments-overlay”...

{"id";"ticket-details-article-list-table-confiz"."na..

+ Reload Fronten...

Search

Changed at

06/22/2021, 1:33 PM
06/22/2021, 1:33 PM
06/22/2021, 1:33 PM

06/22/2021, 1:33 PM

Changed by
not assigne
not assigne
not assigne

not assisne

Fig.: Search function for very extensive tables

(@ Note on wildcard search in organizations and contacts

For the search for users as well as for customers and contacts in the agent portal, no asterisks have
to be set as wildcards. KIX automatically sets an asterisk internally after the search term (wildcard

suffix). The same applies to the autocomplete fields.
The asterisk before the search term (wildcard prefix) is not initially set automatically. It can be set
manually when entering the search term.

For contacts and organisations, you can set whether the wildcard prefix should be set

automatically (see page 588) . This is done in the keys "ContactSearch::UseWildcardPrefix" and
"OrganisationSearch::UseWildcardPrefix" of the system configuration.

CSV Export

You are able to export the table or selected table entries to other programs in the form of a CSV file. To do
s0, select required table entries and click "CSV-Export" in table header. In browser dialog that opens, select
how you would like to use CSV file.
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£, Assets: Asset Classes (8) | B & NewClas: [B CsvExport ~
[®] Name Comment & Validity Created at Created by Changed at Changed by

[J Building & valid 12/01/2020, 9:12AM  not assigned 12/01/2020, 9:13AM  not assigned
B Computer -] valid 12/01/2020, 9:13 AM not assigned 12/01/2020, 9:13 AM not assigned
Hardware - valid 12/01/2020, 9:13 AM not assigned 12/01/2020, 9:13 AM not assigned
[0 Location e valid 12/01/2020, 9:13 AM not assigned 12/01/2020, 9:13 AM not assigned
[0 Network & valid 12/01/2020, 9:13 AM not assigned 12/01/2020, 9:13 AM not assigned
[0 Room L ] valid 12/01/2020, 9:13 AM not assigned 12/01/2020, 9:13 AM not assigned

Fig.: Exporting Selected Assets to a CSV File

n Y i x Issued on: 26.02.2024 Page 104




KIX 18 Admin Manual - EN - KIX Start
Basic Information
4 Overview of the Admin Module

6.1.2.4 Zoom Views

The zoom views display additional information on an object (asset, agent, team, etc.) and enable you to edit
the corresponding master data. Object zoom views open when you click the object in the table in the content
area.

4 @& Home X & Admin: Asset Classes X
Ausblenden €€

T T [ Name a Comment validity \ﬂ Created at
et it [C] Building & valid 06/22/2021
up SI!

O Assets 0| cc B valid 06/22/2021)
Asset Classes 0 Hardware F.Y valid 06/22/2021
General Catalog [ Location Q? valid 06/22/2021]
Import/Export [ Network & valid 06/22/2021]

% :

Atttomaon ] Room Y valid 06/22/2021

#* Communication .

[] Software (0] valid 06/22/2021

#* Internationalisation

Fig.: Opening Zoom View of "Computer" Asset

Structure of Zoom View

The information listed in the detail view includes reference data, authorisations, assignments, versions,
execution plans, etc.. These are displayed grouped in so-called lanes.

The first lane always contains the reference data of the selected object. It is always labelled "[object
designation] information". It can contain additional tabs, such as the "History" in the detailed view of a job.

All other lanes contain variable contents depending on the selected object. Each lane contains a small white
arrow at the top right edge with which you can expand and fold the lane.

d  # Home X & Admin: AssetClasses X | & Computer X

Computer 3 rew Class

# Edit = Print

Asset Class Information

2 Hame: Computer Comment: Created at: 04/22/3021, 1:24 P Charsged at: 04/22/2021, 1:26 PM 4
fean: ] alicity: valid Craated by: ok avsigned Changed by: not assigned
Owerview Versions (1] =
-~
Version ¥ Created by Created at 4
3 1 et assigned D6/22/7021, 1:26 PM iCurrent dafinidon]
~
i
L =» 'SectionGeneral’
Hams = ‘General Informaticn’,

Customeryisible == g,

Fig.: Structure of Zoom View
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Description

Displays the object that has been opened and the buttons

« for creating a new object
+ for editing the object that has been opened
« for printing or duplicate the current screen view

The first lane of the detail page always contains the reference data
of the opened object.

Further tabs are possible, e.g. "History" in the menu "Automation >
Jobs".

This lane is shown for objects that have been assigned a version,
e.g. asset classes. Expanding a version lets you view the class
definition for an asset class, for example. If required, you can copy
it to the clipboard for use as a template when creating a new class.

For expanding and folding the lane.
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6.1.2.5 Form Dialogs

Form dialogs always open when you create something new or edit something. They open in what is
known as an overlay and contain form fields for entering and selecting the data.

€ Edif Team
Team iedormatinn
“Mame Wt
wone @[] select image e
Parent Tears: &
* Follow Up on Tickots: ' reaw s
Unlock Timaout: © st

* $onder Address [Emaill: ©

Fig.: Form Dialog for Editing a Team

The fields shown in the form vary depending on the context from which the form was opened. However,
some form elements are included in almost every form:

Form element Description

R - | Fields with a red border indicate that information is missing here.
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invalid
invalid-temporarily
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Comment: ®  Team Service Desk
Ll v
Team Infarmation
Name: Service Desk
ko X

Comment: ®  Team Service Desk
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Description

By selecting the validity, you define whether or not an element can be
used by the system.

Data cannot be deleted once it has been saved in the system, as doing so
would eliminate the underlying basis for tickets, assets, or teams. Instead,
you can set the validity to "invalid" or "invalid-temporarily". If you select
either of these options, the element will no longer be used. The two are
differentiated in terms of their context only: Whereas selecting "invalid"
means the system permanently refrains from using the element, selecting
"invalid-temporarily" means the system only

temporarily refrains from using it. This may be the case for a guest

user, for example, who is only permitted to work with the system for a
limited period of time.

Please note: (Temporarily) invalid elements are not displayed or used in
the agent portal or self-service portal. In the Admin module, invalid
elements are grayed out but can still be selected.

The comment fields are always optional. They enable you to

save explanatory notes for the element that you are currently editing
or creating. These comments are only visible in the Admin module.
The comments are not shown in the agent portal. You can scale
comment fields at the bottom right corner.

Forms often contain blocks of content where the form fields are grouped
by topic. There are small white arrows at the edge of these information
blocks for expanding and folding the blocks of content as required.

You can enter formatted text in the editor. The use of KIX placeholders is
possible.
The editor can be scaled at the bottom right corner (triangle symbol).

Clicking the question mark displays information about a form field.
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Form element Description

Al Bl Selection fields on the ticket (e.g. contact, responsible person, affected
assets, related tickets, etc.) expect at least 3 characters to be entered in
order to make a preselection for display in the selection field. You can use
o | the asterisk (*) as a wildcard for unknown text parts. Possible

7 | combinations for a search for "Anderson” would be, for example: *An,
wil*an*, An*. You can enter 3 asterisks (***) if no part of the text is known
or if all elements are to be displayed. This may take a moment.

........

You can also find information on General Function Descriptions in the KIX
Start Users Manual.

Ability to Select Invalid Elements

In the Admin module and in the Advanced Search, you are also able to select and edit invalid elements. This
means you can set up jobs or notifications as part of preparatory work, for example.

Example: You select a (temporarily) invalid guest agent who should receive several ticket notifications.
At the relevant point in time, all you need to do is set the guest agent to "valid" for them to receive all
ticket notifications — as permitted by their roles.

Invalid objects can also be selected in jobs — for example, a job can be run using an invalid team. Likewise, in
the Advanced Search it is possible to find tickets with services that are no longer being offered. Furthermore,
you can edit invalid elements such as deactivated SysConfig keys or users and set them to "valid"

again. Invalid elements are grayed out in tables and selection fields.

Recipients

Send to: @

Send to these agents: @
Send to all role members: @
Send despite out of office: @

Once aday: @

sela: @
n Create Article: @ i1l [TD-R-024] FAQ Reader without category

Notification Methods i1 [TD-R-025] Ticket Reader without queue

Email: i1 [TD-R-026] System Admin Update-only

i1l [TD-R-027] System Admin Create-only

Additional recipients:
i i1 [TD-R-028] System Admin without Tickettypes

Subject with Ticketnumber: 7 [TN-R-0291KXX?018-20R0
[] Select all Submit
Notification Text

German: Fas

Fig.: Selecting Invalid Agents When Creating a New Notification
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(@ Please note

If, however, invalid dynamic fields are specified in notifications, for the search function, or to
filter tickets in jobs, they will not be used when these options are executed.
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6.1.3 Keyboard Navigation

Below you will find an overview of the keyboard commands and shortcuts that you can use in KIX:

Key/Shortcut

[Esc]

[Enter]

[Space]

[Tab]

[Shift]+[Tab]

[Shift]+[Navigation]

[Ctrl]

[Ctri[+[Tab]

[CtrI]+[Enter]

[Ctrl]+[right arrow key]

[Ctrl]+[left arrow key]

[End]

Function

Closes the dialog or selection area without saving (the same as
"Cancel"). The focus moves off the field when doing so.

Selects the value that is currently highlighted; confirms and closes the
field.
In single selection fields: Switches to the next field.

In single selection fields: Selects the entry and closes the field. In
multiple selection fields: Selects or deselects the value that is in the
focus, leaves the field open.

In single selection fields: Selects the entry, closes the field, and switches
to the next field.

In multiple selection fields: Switches to the next functional element (field
or button); sets the focus in the list filter.

Jumps to the previous field.

Highlights all values that are in the focus

Shifts the focus of the keyboard control to the dialog

Switches tabs in the browser (if several tabs have been opened)

Save/start search

Next page

Previous page

Jumps to the last value in the selection field.
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Key/Shortcut Function

[Home]

Jumps to the first value in the selection field.

[Page Up] or [PGUP] Jumps up 10 values in the selection field.
[Page Down] or [PGDN] Jumps down 10 values in the selection field.
() Notes

+ The keyboard control only works if the focus is also in the dialog/form or in the relevant

element. If the focus is elsewhere, the control will not respond either.

+ To edit a form with multiple pages, the navigation changes as follows:

[Ctrl]+[Left arrow] - jumps to the beginning of the word
[Ctrl[+[Right arrow] - jumps to end of word
With [Ctrl]+[Arrow left] and [Ctri]+[Arrow right] you can NOT change the page of the
form.
Switching between the individual tabs via keyboard control is not possible.
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6.2 KIX Architecture

The development of KIX 18 (hereafter KIX) is based on Docker with a consistent focus on container
deployment (analogy: like an .exe file for a Docker Swarm Runtime environment). This allows us to efficiently
further develop KIX and thus expand the range of functions with each new release. In addition, container
deployment allows us to provide customised KIX for on-premises solutions as well as the simple inclusion of
KIX extensions such as KIX Connect.

You can use KIX as a cloud solution or host it yourself (on-premises). KIX is available in different versions:
KIX 18 Start, KIX 18 Pro, KIX 18 Cloud (see introduction (see page 13) ). KIX Start is also available free of charge
for self-operation with a reduced range of functions. Regardless of the operating model and range of
functions, all KIX versions are subject to open source software licences, which are based on the same
technology and are maintained in the same way.

System requirements and information on the on-premises installation of KIX Start/Pro can be found

at: Installation (see page 26) . KIX Pro customers can also request access to release candidates (RC) before the
final release versions are published. Please note that the use of release candidates is not recommended for
productive environments.

Container images are provided for use in in-house operations. The required Docker Compose Environment
can be obtained from https://github.com/kix-service-software/kix-on-premise (see also Installation (see page
26) ). Further instructions for use in Kubernetes or OpenShift environments can be found at:

+ https://kubernetes.io/docs/tasks/configure-pod-container/translate-compose-kubernetes/
+ https://kompose.io/getting-started/

KIX includes various services as delivered:

+ Frontend: Graphical user interface (GUI) for the agent portal 2

- Backend: The heart of KIX, accessible via the REST APl interface 2

+ Database: KIX's own PostgreSQL database

Alternative database: You can specify a different DBMS in the environment file during the 1st start-up.

+ only for on-premises installations
+ only PostgreSQL version 12 or higher recommended
+ Long-term support for other DBMSs is not guaranteed.

+ Cache

+ Self Service Portal (customer portal, KIX Pro required)

KIX can access various external services:

+ LDAP-based directory services such as Active Directory (several possible)
- external web services (KIX Pro extension)
+ various external database management systems (KIX Pro extension KIX Connect Database)
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i

KIX Frontend i
(Agentenportal) PostgreSQL
: i

i

i

i

KIX Cache

Fig.: KIX Architecture
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6.2.1 Scheme KIX Database

For the SQL statement in report definitions or for the configuration of individual components, it is helpful to
know the structure and naming within the KIX database. In the following, we provide you with information on
this.

Information on the structure of the KIX database:

+ as SVG graphic: https://github.com/kix-service-software/kix-backend/blob/master/doc/database/
KIX.svg
(Full screen: click on "Raw"; then use zoom and scroll functions of the browser)

+ as XML schema: https://github.com/kix-service-software/kix-backend/blob/master/scripts/
database/kix-schema.xml

Users of on-premises installations can also create the SQL database schema using various tools such as

« DBSchema: https://dbschema.com/?AFFILIATE=144826&__c=1

+ Documentation DBSchema: https://dbschema.com/documentation/

+ SchemaSpy: https://dev.to/mostalive/how-to-visualize-a-postgresql-schema-as-svg-with-
schemaspy-516g

In Ubuntu Linux environments, the database schema can be generated with the following script:

# extract SQL schema from backend container...

dockerhost$ docker exec -it kixpro-backend-1 /opt/kix/bin/kix.Console.pl

Dev::Tools: :Database: :XML2SQL --database-type postgresql --source-path /opt/kix/
scripts/database/kix-schema.xml --target-filename /tmp/kixdb.sql.postgresql.sql
dockerhost$ docker cp kixpro-backend-1:/tmp/kixdb.sql.postgresql.sql.postgresql.sql /
tmp/

# dinstall SQL translator on docker host...
dockerhost$ apt install libsql-translator-perl

# prepare SQL schema...
dockerhost$ sed -i.orig '/--\|SET/d' /tmp/kixdb.sql.postgresql.sql

# apply SQL translator on docker host to generate SVG (filter non-relevant tables)...
dockerhost$ sqlt-graph -o /workspace/KIX.svg -t svg -f PostgreSQL --show-datatypes --
skip-tables-1like "(auto_response.x|pm_.+|process_id|package_repository|
system_maintenance|kix_ticket.x|kix_dep_dynamic_field_prefs|kix_dep_dynamic_field]|
addressbook|customer_portal_group|acl.x|attachment_storage|virtual_fs_db]|
smime_signer_cert_relations)" /tmp/kixdb.sql --layout sfdp --fontname courier --show-
sizes —--show-datatypes —--show-constraints —--node-shape "record" --edgeattr
"color=#a9a9a9" --edgeattr "arrowhead=crow" --edgeattr "style=dashed" --graphattr
"overlap=false" --graphattr "rankdir=LR" --graphattr "ratio=0.5" --graphattr
"splines=true"
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6.3 Version numbers

KIX pursues a rolling release strategy and consists of several components such as the

+ Backend / core
« Agent portal
+ Self-Service Portal (KIX Pro).

The versions (Build) of the agent portal and the kernel (Backend) are displayed in each installation after
logging into the agent portal in the lower screen area. Both together clearly identify the software version. We
dispense with additional coding of this information in the form of a release number.

The build numbers are supplemented by the patch release numbers. The patch release numbers are
separated from the build numbers by a hyphen. They are incremented by 1 with each published patch release
and reset to 0 with each new build.

Example: KIX 18 (Build: 3888-0.1565-0)

+ 3888-0: The first number is the build number of the agent portal (3888), followed by the patch number
of the agent portal (-0).

+ 1565-0: The second number is the build number of the backend (1565), followed by the patch number
of the backend (-0).

4 #Home X F Release Informationen X » X

Welcome to K1 18

Hello Agent [TD]TicketAgent

e :
Help, hints & tricks
FIELD AGENT APP E COMMUNITY E MANUALS
Tips fior getting started quicdy with KIX tn be found on the KIX YouTube Far & mare intensive introduction to the use and administration of KIX, yous
Technical Customer Service mit KIX - work order documentation, checklists, chanrel. In the farum you can ase exchange ideas with other KIX users. will find the latest marnais in the ooline docsmentation.
scheduling, offfine information for maintenance ard repairs.
DD uick Start Guide & s Manial
s Downlosd on the " caTmon o L ] i <
[ 4 App Store rg Google Play “ KIX Farum alim Admin Manaal
B seitservies maruial
(Build: 4195-0.1718-0)

Fig .: The version number in the footer

The description of the content or the changes contained in the respective build can be found in our forum,
eg: https://forum.kixdesk.com/index.php?board=22.0 A Google search for, for example, "3663.1415" usually
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also leads for the information you require. The build numbers correspond to the announced releases and
allow a very precise identification of the installed software version.

With this approach it is also possible to provide smaller patch or interim releases.

The build and patch numbers can also be output via console command. Navigate to System > Console and
start the command Console: :Command: :Admin::Installation::ListPlugins.

Administrators of an on-premises installation can also determine the software version directly from the front-
end or back-end containers.

Determine the version number of the front end from the Docker host:

root@ubuntu20:/opt/kix-on-premise/deploy/linux# docker exec -it kix_frontend_1 cat /
opt/kix/RELEASE

PRODUCT = KIX

VERSION = 18

BUILDDATE Mon, 21 Feb 2022 09:48:51 +0200

BUILDHOST = git.intra.cape-it.de

BUILDNUMBER = 3888

PATCHNUMBER = 0

Determine the version number of the backend from the Docker host:

rootCubuntu20:/opt/kix-on-premise/deploy/linux# docker exec -it kix_backend_1 cat /
opt/kix/RELEASE

PRODUCT = KIX

VERSION = 18

BUILDDATE = Mon, 21 Feb 2022 09:50:08 +0200

BUILDHOST = git.intra.cape-it.de

BUILDNUMBER = 1565

PATCHNUMBER = 0
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7 Assets - The Asset Device Database

Under the menu item Assets you will find the Configuration Management Database (CMDB), i.e. the asset
database of KIX. Here, all resources and resource information are managed that are required for service
provision. These can be, for example, locations, buildings, rooms, machines, hardware and software, but also
telephones, small devices or contracts.

All these resources are created as so-called assets in the system. In order to map these assets in a
structured way, they are assigned to different asset classes. The characteristics of the asset classes are
flexible and depend on the respective application. They are distinguished by their properties (attributes). KIX
offers a number of existing asset classes as delivered. Asset classes are also referred to as Config ltem
classes, Cl classes, in ITIL also as "Cl types".

Changes to asset classes and their attributes are recorded in class definitions. These definitions are subject
to versioning. Changing the attributes of an asset class does not have a destructive effect on inventory data.
These remain in the previous form and content.

Changes to asset information are historicised and also versioned. It is possible to look back to a previous
version of the asset information at any time, regardless of whether the referenced asset class definition is
out of date or not.

The authorisation check when accessing assets is carried out according to the authorisation concept.
Access to assets requires access rights to the resource "configitems" and to the asset itself.

Asset Classes

The sub-menu Asset Classes is where all asset classes are created and configured. The individual
assets (operating resources) are assigned to these classes. Agents see the asset classes and
corresponding assets in the "Assets" module menu in the agent portal.

General Catalog

The General Catalog is a directory that can hold all kinds of values. For instance, it is where you can
save individual selection values for asset classes. For example, you can save the vehicle types "Truck’,
"Car", and "Van" for the asset class "Vehicles". When creating or editing asset classes, the values in the
General Catalog can be referenced in the class definition. This means that when agents create an asset
of the "Vehicles" class, they can select from these values and thus narrow down the type of vehicle.

Import/Export

The sub-menu Import/Export enables you to import multiple assets in one go and create them under the
relevant asset classes. You are also able to export all assets of a class, in order to edit them in a table
and subsequently import them back in as a mass update, or in order to import them into other systems.

Issued on: 26.02.2024 Page 118



KIX 18 Admin Manual - EN - KIX Start
Assets - The Asset Device Database
Version numbers

@ Tip
+ If you prefer to use the term "Config Items" or "Cl" instead of "assets", you can save a pattern
for doing this under Internationalisation > Translations and thus amend the term in the

system.
+ KIX Pro users can visualise the relationships between assets in a graph and start a failure

simulation if required (see user manual).
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Asset Classes

machines, devices, or even contracts, are referred to as assets and created as such in the system. To provide
structure when they are mapped in KIX, they are assigned to asset classes. For example, all buildings in the
company are combined under the asset class "Building", all computers in the company are combined under
the asset class "Computer”, and so on. Synonyms for assets are also: config item, (technical) resource,

device, configuration object.

Database

Asset classes

[

L g

¥

g g

L

b 4

Assets

PCO1
PCO2

Ubuntu 18.04 LTS
_ Libreqfﬁge

Office Chemnitz

Dfﬁce Eerlin

Carl

Van 1

Car 2

Fire extinguisher 1

Fire extinguisher 2

Machine 1
Machine 2
Machine 3

Fig.: Scheme Asset-Database > Asset classes > Assets

To manage these asset classes, go to menu Assets > Asset Classes. This is where you can create new asset
classes, edit them, and see the corresponding details.

HIX
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KIX comes supplied with a small selection of asset classes, which enables you to create your rooms,
buildings, and some of your devices as operating resources in the system. You can create additional asset
classes to also record all other operating resources that your company uses. The table in the Dashboard lists
the asset classes created in the system.

P — »

Admiistration - By fssmt: Auset Clmsses (0] T 23 tew tlam
v [ Hame = Comment ity T Created st Cresten Iy Changed ranged by

[ Buiding walld DHO4/Z021, T4LPM notassigned DRI T2 PM notassgned

Setvn fsstart

[ Computer waid DH/D4/P021, 44 PM  motassigned DA/M4/IIL T4 P notassgned

O s

[ Harhwars valid DAL, Z4EPM ot assigned DRM/IDAL Z44PM  motassigned
DAD4/D021, 244PM not assigned DR/M/IDAL 2447 rotassigned

waild DAMA/Z021, TLLPM  notamsigned DRGA/IHIL 244 PM ot assigned

wad DE/D4/P021, TALPM  motassigned DE/D4/IL 244 P notassigned

2 @& ® © 0 wm B
g

i DAMA/ZO, TLLPM  motassigned DR/GA/IIL T4 PM notassigned
* intersbizealastion

# Wncededze Dotsase

Fig.: Overview of Assets (Example)

Agents can find the asset classes in the Asset Explorer. The names of the asset classes are translated into
the language of the user, provided that a pattern for this is stored in the system (menu Internationalisation >
Translations).

4 & Admin: AssetClasses X 4 | & Admin: Asset Classes X X = Asset X

Ausblenden ¢ Ausblenden <«

Name &
T o g T * Name:
: [] | Building P
Setup Assistant & Building + Deployment State: @

© Assets L1} Comprute B Computer

- * Incident state: ®
Asset Classes [ Hardware © Hardware

General Catalog [ Location ? Loration General Information:

Import/Export ] Network & Network

* Parent Location:

+ Automation - ® Room

] Room :

® Communication = . ® Software Global Location Number:
[} Software

# internationalisation “ Note:

Fig.: The asset classes maintained in the Admin module are available in the asset explorer.

(@ Notes

When creating a new asset class, KIX automatically creates the corresponding new CSV mapping.
This mapping enables you to automatically import the assets belonging to the class into KIX (also
see the chapter Import/Export (see page 152) )

7.1.1 Zoom View of Asset Classes

You are able to view the details of an asset class (master data, class definitions, versions). Navigate to
Assets > Asset Classes. In the content area, a table listing all asset classes saved in the system opens. In
table, click an asset class to open associated zoom view.

Alongside the lane containing the general asset class information, the zoom view also contains the
"Versionsdetails" (Version Details) lane. It contains a list of all versions of the asset class, as well as the
respective class definition (see page 126) for each version. If required, you can copy the class definition of a
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version and use it as a reference class definition when creating new asset classes. You can use the small
arrow buttons on the right-hand side of a version to expand and collapse the information displayed for the
class definition.

The buttons in the title bar of the detail view allow you to edit and create new asset classes.
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Fig.: Details of "Computer" Asset Class
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7.1.2 Creating or Editing an Asset Class

KIX comes supplied with a small selection of asset classes that you can use to create some of your
buildings, rooms, and devices as operating resources in the system. You can create other asset classes to
record all other operating resources that your company uses.

An asset class is defined by the source code in your class definition. The properties of a class are specified
there using attributes. These attributes generate the form fields for creating/editing an asset. When you
create a new asset class, you need to save a class definition. To do so, you can either write the source code
of the class definition yourself, or use the class definition of an existing asset class as a reference.
Additional information on the class definition and source code is provided in chapter "Class Definition (see

page 126)

‘ & Admin X & Computer X K @ Edit Asset Class X ’

B Edit Asset Class (Computer)

*Name: @  Computer
Icon: @ ‘_'!‘_| Select image file

[ A
{
Key => "SectionGeneral’,
Name =2 'General Information’,

* Class Definition: @

CustomerVisible =>0,

Input
n Comment: @

=

* Validity: @ valid

l ’ Cancel Save

Fig.: Editing the "Computer" asset class.

() Notes

Each change made to a class definition generates a new version. Old versions cannot be
reactivated. If you need to access an old version, you need to copy the old class definition into the
current class definition, thus generating a new version.

It is not possible to delete an asset class, because doing so would eliminate the underlying basis for
the assigned assets. However, you can set the asset class concerned to "invalid". It will then not be
possible to create any more assets for this class.

When creating a new asset class, a new mapping with the same name will be generated for
automated asset imports and exports (menu Import/Export (see page 152) ).
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To create a new asset class based on a reference class, proceed as follows:

1.

o g s W

10.

Navigate to Assets > Asset Classes. In the content area, a table listing all asset classes saved in the
system opens.

In table, click asset class to be used as reference for new asset class. The zoom view opens.

The lane "Overview Versions" in the zoom view contains one or more versions of the class definition.
Open version to be used as reference. To do so, click small arrow button on its edge.

Copy source code of class definition to clipboard.

Switch back to the zoom view and click on "New class" there. A form dialog for creating the new asset
class opens. Under "Name", enter meaningful name for new asset class and optionally select icon for
identifying asset class in asset explorer.

Paste source code from clipboard into "Class Definition" field.

Optionally edit source code of class definition (also see "Class Definition (see page 126) " et seqq.).
Optionally add comment, and then set new class to "valid".

Click "Save" to save new class.

The new asset class has now been created, meaning assets can be created for this class or imported via the
menu Assets > Import/Export.

To create a new asset class with its own source code, proceed as follows:

1.

5.
6.

Navigate to Assets > Asset Classes. In the content area, a table listing all asset classes saved in the
system opens.

In table, click "New Class". A form dialog for creating the new asset class opens.

Under "Name", enter meaningful name for new asset class and optionally select icon for identifying
class in asset explorer.

Write source code in "Class Definition" field (also see "Class Definition (see page 126) " et seqq. and
"Source Code of Class Definition (see page 128) ").

Optionally add comment, and then set new class to "valid".

Click "Save" to save new class.

The new asset class has now been created, meaning assets can be created for this class or imported via the
menu Assets > Import/Export.

To edit an existing asset class, proceed as follows:

1.

5.

Navigate to Assets > Asset Classes. In the content area, a table listing all asset classes saved in the
system opens.

In table, click asset class to be edited to open associated zoom view.

In opened zoom view, click "Edit". A form dialog opens displaying the data that has already been
saved as well as the current class definition.

Amend the data and/or class definition as required (also see "Class Definition (see page 126) " et seqq.
and "Source Code of Class Definition (see page 128) ").

Click "Save" to apply changes.

Your changes now take effect for this asset class and, thus, in all new and existing assets of this class.
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(@ Notes

Making changes to the class definition automatically updates the corresponding mapping. For this
reason, you may need to export the CSV file again if you are maintaining the assets manually (menu
Import/Export (see page 152) ).

After changing a class definition, the corresponding CSV mapping is only updated automatically if
the SysConfig key "ImportExport::CSVMappingAutoCreate###ForceCSVMappingRecreation" has
been set accordingly.

The form dialog contains the following input fields, among others:

Field Description

(selection)

Name Name of class

Icon The selected icon is used to graphically identify the class in the asset explorer.

You can choose an icon from one of the provided libraries or upload a graphic file.

Class Enter source code for class definition or change it if required (also see "Source Code of
Definition Class Definition (see page 128) ").
Each class is defined by its source code. It sets out the structure and make-up of the
form elements when creating an asset.

Validity valid: The class is permanently available. Other assets can be
created for this class. Tickets can be linked to assets of
this class.

invalid/ The class is (temporarily) unavailable.
invalid-temporarily: No more assets of this class can be created.

No tickets can be linked to assets of this class.
(Temporary) Invalid asset classes are not available for
the search for "class" in the complex search.
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7.1.3 Class Definition

The class definition is the basic structure of an asset class. It contains attributes which map the properties
of an asset class. Each asset class has its own class-specific attributes. For example, the "Computer” class
contains attributes for aspects such as the manufacturer, model, and serial number, whereas the "Room"
class contains attributes for aspects such as the building, story, and room type.

You can change these attributes (properties) by adding or removing attributes in the source code of the class
definition or by changing their properties. In the agent portal, these attributes then make up the form fields
available when creating or editing an asset.

All changes made to the class definitions are logged in the history and assigned a version. The zoom view of
an asset class enables you to view a previous version at any time.

Key =»> 'SectionGeneral®’,
Ha => '"General Informatiocn®,
Input => [
Type => 'Dummy’, @ Home X K @ Asset X

sub = [

Key

Searchable . * Mame:
Input
Type [ ltatalog',
Class ' ConfigIltem: :Computer::Type', B Computer

Translation ® Incident state:
© Hundwiw

& Bullding * Deployment State:

¥ Locatlon General Information:

Key B Typa:
Name =» dor" /
Searchable => 1,
Input = {
TYpe
MaxLength =
# example for CI ibute RegEx check...
#RegEX RBC. 47,
#RegExErrorMessage => 'Valus must start with \"asc\"!',

Location;

Description:

* hote:

Eay 'Model’,
Name > "Model!,
Searchable 1,

Input i
Type => 'Text’,
MaxLength =» 50,

Fig.: Class Definition Generates Form Fields
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( Migration notes KIX 17 > KIX 18

The Cl attributes of type "Encrypted Text" existing in KIX 17 are available as asset attributes
of type "Text" after migration in KIX 18. This makes passwords visible to users with
permissions on assets.

Perl comments (#) in the class definition code are removed during migration.

After migration, all Cl class definitions including all versions of the source environment are
present in the target environment as asset class definitions. If there is already a class of the
same name, the migration class gets the prefix "Migration-".

Cl attribute types that are no longer supported are represented as "Text" attributes.

Each asset class additionally contains an attribute "ClAttachments” (last attribute) of the
type "Attachment" to hold the unversioned Cl attachments from KIX 17.

Eeach asset class additionally contains an attribute "ClAttachments” (last attribute) of the
type "Attachment" to include the non-versioned Cl attachments from KIX17.

On fields whose type attribute is not identical to the one in KIX17, there is an additional
attribute "MigratedType" in KIX18 with the respective value from the type attribute from
KIX17.
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7.1.3.1 Source Code of Class Definition

The class definition of an asset class consists of a Perl source code. It specifies which form fields are
available when creating or editing an asset. If you need other form fields or if the form fields need to be
rearranged, for example, you can change the source code accordingly. However, you cannot change the
basic elements of an asset, such as the name, deployment state, incident state, or asset link.

© Attention!

Changing the class definition may cause system errors. You should be familiar with how to
handle source code and take great care when making your changes. Please do not hesitate to
contact us if you require any assistance.

The following example of a class definition comes from the "Computer" asset class.

L [

Key =>
Name =>
Input =>

Type

(=]

T b
2 Sub => [
{

'SectionGeneral',
'General Information', 1
{
=> 'Dummy’,
Key => 'Type’',
Name => 'Type', 2
Searchable => 1,
Input => {
Type => 'GeneralCatalog',
Class => 'ITSM::ConfigItem::Computer::Type',
Translation => 1,
e
Key => 'Vendor',
Name => 'Vendor', 3
Searchable => 1,
Input => {
Type => "Text',
MaxLength => 50,
# example for CI attribute RegEx check..
$RegEx => TAARC.*',

#RegExErrorMessage => 'Value must start w__h \"ABC\"!',

e

e
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Description

Start of a form group. In this example, it
concerns the group "General Information”.

A group contains additional form elements (attributes) such as
text fields, drop-down
lists, buttons, etc.

This block of code generates a drop-down element with the
corresponding text label.

In this example, the drop-down contains all the computer types
created in the General Catalog.

You can copy such a block of code, paste it at the relevant point,
and amend it as required.

This block of code generates a text field with the corresponding
text label.

In this example, it concerns the "Vendor" field with a width of 50
pX.

You can copy such a block of code, paste it at the relevant point,
and amend it as required.

Lines of code preceded by a hash (#) indicate comments. They
are not taken into account by the system.

Lines initially commented out are notes and examples or
attribute properties already prepared for you. If necessary,
remove a hash mark to activate the corresponding line of code.

You can write your own comments or notes in the code, e.g. to
mark individual code blocks or to note notes on the code block.
Place a hash mark in front of each comment line.

The example opposite shows prepared regular expressions
(RegEx).
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7.1.3.2 Editing a Class Definition

You can change the class definition of an asset class by changing the corresponding source code. In doing
so, you specify which form fields (attributes) are available when creating/editing an asset, what they look
like, and how they are grouped. However, you cannot change the basic elements of an asset, such as the
name, deployment state, incident state, or asset link.

‘ & Admin: Asset Classes X @& Computer X X = Edit Asset Class X }

B Edit Asset Class (Computer)

*Name: @  Computer

lcon: @ |_‘!‘_| select image file

* Class Definition: @ [ 2
{
Key =>"SectionGeneral',
Name =>'General Information’,
CustomerVisible =>0,
Input =>[

Type == "Dummy’,

L
Sub =>[

<

N

Comment: @

* Validity: @ valid

l:’ Cancel Save

Fig.: Class Definition of "Computer” Asset Class

© Attention!

Changes made to the class definition constitute a direct intervention in the KIX system! Therefore,
you should preferably be familiar with how to handle source code, and you should take great care
when making your changes

To change the source code of a class definition you can, for example:

+ change the existing attributes and values directly in the source code

+ copy parts of the source code, paste them at a different point in the source code, and then amend
them if required

+ write your own lines in the source code

+ delete or replace parts of the source code

+ delete or replace the entire source code.

To change the class definition, proceed as follows:

1. Navigate to Assets > Asset Classes. In the content area, a table containing all asset classes created in
the system opens.
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In table, select asset class with class definition to be changed. The zoom view of the selected asset
class opens.

3. In title bar of zoom view, click "Edit" to open form dialog for editing asset class. In the form dialog,
you will find the "Class Definition" field containing the source code of the class definition.

To make it easier to edit the class definition, click and hold bottom right-hand corner of text field and
drag it to desired size.

Alternatively, copy source code to external text editor (e.g. Notepad++ or https://jasonformatter.io),
edit code there, and copy code back into form.

Change source code by adding other lines of code or changing existing data. To do so, also read
chapters "Source Code of Class Definition (see page 128) ", "Attributes of a Class Definition (see page
132) ", "Attribute Types in Class Definition (see page 136) ".

Then click "Save" to save your changes.

Your changes take effect immediately in all new and existing assets of this class.

a

®

Important

When making changes, ensure that the syntax in the source code is correct! For example,

place character strings in inverted commas, end each line with a comma, and close all opened
brackets. If you copy parts of the source code, ensure that you paste them back in at the right

place in the syntax. Observe the hierarchy of any opened brackets when doing so. We would be glad
to assist you should you require any support.

Notes

+ If you use your own attribute designations, you can maintain the translations for them
yourself. To do so, navigate to the menu Internationalisation > Translations and enter the
corresponding patterns there.

+ To display form fields in the Self Service Portal (KIX Pro), set the attribute

'CustomerVisible' = 1 (see also Controlling visibility in the SSP)

Issued on: 26.02.2024 Page 131


https://jasonformatter.io

KIX 18 Admin Manual - EN - KIX Start
Assets - The Asset Device Database
Asset Classes

7.1.4 Attributes of a Class Definition

The attributes of a class definition generate the form fields for creating assets. The properties and values
of the attributes and how they are arranged and grouped define how the form fields are arranged and what
they look like — which, in turn, defines the structure of the form. Below you will find a selection of attributes
that you can use in the source code of a class definition:

Type => 'Dummy',
},
Sub => [
{
Key => 'Type',
Name => 'Type',
Searchable => 1,
Input => {
Type => 'GeneralCatalog',
Class => 'ITSM::ConfiglItem: :Computer: :Type',
Fig.: Attributes in Class Definition
Attribute Description Values Examples
CountDefault Default number of entries (if array 0..n CountDefault =>
attribute) 0,
CountMax Maximum of entries (if array 0..n CountMax => 1,
attribute)
CountMin Minimum of entries (if array 0..n CountMin => 0,
attribute)
CustomerVisibl  Controls the visibility in the Self 011 CustomerVisible
e Service Portal => 1,

0 = invisible (false) | 1 = visible (true)
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Attribute

Input

Key

MaxLength

Description

Describes the data structure of the
object.

Can be included other attributes such
as Type, Size, MaxLength, RegEx, etc.

Internal identifier of the attribute.

The form field is saved under this
designation in the database. For this
reason, the keyword must be unique
and may only contain letters and
numbers. If it is changed
retrospectively, it will no longer be
possible to read the data from old
definitions.

Maximum length of the entry in the
field
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Values

Hash

String alphanumeric
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Examples
Input => {
Type =>
'Text',
Size => 50,
MaxLength =>
55,
Translation
=> 1,

Required => 0

Key =>

"Model',

MaxLength =>

55,
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Attribute

Name

Required

Searchable

Translation

Size

Description Values

Labeling of the field in the form. String

It generates the text label shown in
front of a form field.

The name may comprise letters,
numbers, blanks, hyphens, and
underscores.

Please do not use any control
characters such as single or double
inverted commas or brackets as this
would cause discrepancies with the
source code.

For German users, for example, we
recommend that you use English
words so that you can manage the
translations using patterns
(Internationalisation menu).

Defines required fields 01
0 = no required (false) | 1 = required

(true)

Defines whether the field is 01
searchable.

0 = not searchable; 1 = searchable

@ njobs or actions, only attributes
that are searchable are available for

selection ( 'Searchable' => 1).

Value translation yes/no? 0|1

0 = The text in the field is not
translated automatically.
1 = The text in the field is translated.

Only possible for fields with
predefined values.

Size of the input field 1..n
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Examples

Name => 'Model',

Required => 1,

Searchable =>

1,

Translation =>

1,

Size => 50,
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Attribute Description Values Examples
Sub =>1..] Creates a subordinate structure. As a Sub => [ {
result, the form elements are nested Key =>
like in a tree structure. The sub- , ,
. . Type',
element can, in turn, contain further
Name =>
sub-elements.
'Type',
Searchable =>
l 3
Input
=> {...}
]
Type Defines the attribute type (also read String without space/  Type => 'Text',
"Attribut Types in the Class special character
Definition (see page 136) ").
For example:

+ Text = single-line text field

+ General Catalog = selection field

« TextArea = multi-line text field

+ CustomerCompany = selection
field/selection of customer user

+ Date = date field

+ DateTime = selection of date and
time

UniqueForCl The value must be unique within
several selection values (CountMax).

UniqueForCICla = The value must be unique within the
ss asset class.
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7.1.5 Attribut Types in the Class Definition

Attribute types and their values specify the attributes in the
class definition. For example, they define the type of a text
field (input), how many characters can be entered, or where
the data in a selection field is referenced from. Below you
will find a selection of attribute types for the "Type"
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Attribute types:

Attachment (see page 136)
ClClassReference (see page 137)
Contact (see page 139)

Date (see page 139)

DateTime (see page 140)
Dummy (see page 140)

General Catalog (see page 142)
(Integer) (see page 143)
Organisation (see page 143)
SLAReference (see page 143)
Text (see page 144)

TextArea (see page 145)

Searchable

IO
=> 1,
o {

=»> 'Text',

MaxLength => 50,

7.1.5.1 Attachment

Enables file attachments to be saved for asset versions.
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Fig.: The "Text" attribute type generates a text field, in this case with a maximum length of 50 px.

Page 136




KIX 18 Admin Manual - EN - KIX Start
Assets - The Asset Device Database
Asset Classes

Example configuration Notes
{ + A maximum of 1 file per attribute can be attached.
'Key' => 'Attachment', If several files are to be attached, this must be mapped

via the array structure of Cl attributes.
+ If no specific attribute type is used for attachments, they
are not versioned.

"Name' => 'Attachment',
"Input' => {

'"Type' => 'Attachment',
b

'"CountMin' => 0,

They cannot be restored in earlier versions.

'CountMax' => 5,

s

7.1.5.2 ClIClassReference

Reference to other asset classes. Enables the selection of valid asset classes.
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Example configuration

'"CountDefault' => 0,
'CountMax' => 1,
'CountMin' => 0,
'CustomerVisible' => 0,
"Input' => {
'ReferencedCIClassLinkDirection'
=> 'Reverse',
'ReferencedCIClassLinkType' =>
'"Includes',
'ReferencedCIClassName' => [
'"Location',
'Building',
'"Room'

1,

'ReferencedCIClassReferenceAttributeKey

' => 'Name',
'Required' => 1,
'"Type' => 'CIClassReference'
b
'Key' => 'ParentlLocation',
"Name' => 'Parent Location',
'Searchable' => 1
b
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Notes

ReferencedClClassName: n asset classes
can be specified as a range of values in the
form of an array.
If only one asset class is to be used, it can be
specified as a single string.
ReferencedClClassReferenceAttributeKey:
Optional specification.
Controls the resolution of values for the
import/export of asset classes

« If specified:

+ Export: Names/values of the
referenced objects are output
instead of their IDs.

*+ Import: The imported values
are resolved based on the
specified asset attribute
("Name" for asset name).
Class-specific attribute keys
can also be specified, e.g.
"SerialNumber" for referenced
class "Computer".

+ If not specified: The number of the
referenced object is output.
+ Parameter:

+ Name: Outputs the name of the
referenced object instead of its
ID.

+ Inthe example
opposite, the name of
the asset referenced in
the "Parent location"
field is exported and not
its asset number (ID).

+ Key of a class-specific
attribute: The value of the
object referenced in the asset
is exported.
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Example configuration Notes

+ Example:
'ReferencedCIClassRefe
renceAttributeKey' =>
'GLN/,

The value specified in
the "Global location
number" field is output
(for reference to class
"Building").

+ If several entries exist,
the first entry of the
attribute is used.

+ If the attribute is not set
on the asset, the asset
number is used.

7.1.5.3 Contact

Allows you to store a valid contact stored in the system (filterable selection list) and is the basis for
assigning personal devices to contacts. Selection via filterable selection list.

Example configuration Notes

{ Assigned user
'Key' => 'OwnerUser',
"Name' => 'Assigned User',
'"Input' => {
'"Type' => 'Contact',
I
b

7.1.5.4 Date

Enables a date value to be saved (calendar selection).

In the backend, the date is saved in the format YYYY-MM-DD hh:mm:ss, whereby the time value is fixed at
00:00:00.
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Example configuration Notes
{ + YearPeriodPast: selectable values in past
'Key' => 'FirstUsageDate’, * YearPeriodFuture: selectable values in future

"Name' => 'First Usage Date',

'Searchable' => 1,

"Input' => {
'"Type' => 'Date',
'Required' => 1,
'YearPeriodPast' => 20,
'YearPeriodFuture' => 10,

I

7.1.5.5 DateTime

Enables a time stamp to be saved (calendar/time selection). The entry is made via a calendar time selection.
In the backend, the date is saved in the format YYYY-MM-DD hh:mm:ss .

Example configuration Notes
{ + YearPeriodPast: selectable values in past
'Key' => 'SeomDateTime', * YearPeriodFuture: selectable values in future

"Name' => 'Some Date with Time',

'Searchable' => 1,

"Input' => {
'Type' => 'DateTime',
'Required' => 1,
'YearPeriodPast' => 20,
'YearPeriodFuture' => 10,

b

b

7.1.5.6 Dummy

Does not contain a value; is used to structure subordinate attributes.
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Example configuration

I

X

'Key' => 'SectionOwner',

"Name' => 'Owner Information',

"CustomerVisible' => 1,

"Input' => {
'Type' => 'Dummy'
I
'Sub' => [
{
'Key' => 'OwnerOrganisation',
"Name' => 'Assigned Organisation',

'Searchable' => 1,

"CustomerVisible' => 0,

'"Input' => {
'"Type' => 'Organisation'

s

'"Key' => 'OwnerContact',

"Name' => 'Assigned Contact',

'Searchable' => 1,

'CountDefault' => 1,

'CountMin' => 0,

'CountMax' => 25,

"CustomerVisible' => 1,

'"Input' => {
'"Type' => 'Contact'
b

I

1,
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Allows you to store values from the General Catalogue (see page 146) . These are displayed as a filterable
selection list.

B Asset

' Name: Name
* Deployment State:
* Incident state: @ |
General Information:
Types

i Desktop
Vendor (Computer):

¥ Laptop
Model: i
od i Other

Location: £ phone
Description:

* Note:

Example configuration

'"ITSM::ConfigItem::Computer::Type',

s

'CountDefault' => 0,
'CountMax' => 1,
'CountMin' => 0,
"CustomerVisible' => 0,
'"Input' => {

'Class' =>

'"Translation' => 1,
'Type' => 'GeneralCatalog',
b
'Key' => 'Type',
"Name' => 'Type',
'Searchable' => 1

Issued on: 26.02.2024

Notes

+ Class: Reference to the General Catalog class,
which defines the value range.

+ Translation: Selection values are translated

+ ValueDefault: Preselect selection value from list
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7.1.5.8 (Integer)

! The "Integer" type has been dropped and is replaced by the "Text" type with the corresponding RegEx
configuration. Integer enabled the selection of integers (without comma) in a single selection list.

7.1.5.9 Organisation

Enables the storage of a valid customer (organisation) stored in the system and is the basis for assigning
customers to devices. Selection via filterable selection list.

Example configuration Notes

{ Organisation (company) of a customer
'Key' =>'CustomerCompany',
'"Name' => 'CustomerCompany',
"Input' => {
'"Type' => 'Organisation',
T
by

7.1.5.10 SLAReference

Allows the entry of valid SLAs on asset versions. (KIX Pro only). The entry is made via a filterable selection
list. The behavior in input, search and display corresponds to that of the CIClassReference.

In the specified asset classes, the SLA stored on an asset is used when entering the SLA "SLA by Affected
Asset" on a ticket. For this purpose, only one SLA may be entered.
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Example configuration

{
'"CountDefault' => 0,
'CountMax' => 1,
'CountMin' => 0,
'CustomerVisible' => 0,
"Input' => {

'"Type' => 'SLAReference'

b
'"Key' => 'AssignedSLA',
"Name' => 'Assigned SLA',
'Searchable' => 1

I

7.1.5.11 Text

Enables the entry of single-line, short, unformatted texts. Youcan specify a regular expression and/or a
maximum length that the text must correspond to.

Example configuration Notes
{ + Size: Length input field
'Key' => 'IPAddress’', « MaxLength: Max. input length
'Name' => 'IP Address' + RegEx: Regular expression on which input is
’ checked

'S hable' => 1
SRIrENEY LE ’ + RegExErrorMessage: Display if reg.

1 1 =
Input' => { expression does not apply

'"Type' => 'Text',

'RegEx' => '"A(?2:[0-9]{1,3}\.){3}
[0-9]{1,3}$',

'RegExErrorMessage' => 'Please
enter your full IP address:
123.123.123.123."',

'"MaxLength' => 40,

I
I
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7.1.5.12 TextArea

Enables the entry of multi-line, relatively long, unformatted texts. You can specify a regular expression
that the text must correspond to.

Example configuration

{
'Key' => 'Description',
"Name' => 'Description',
'Searchable' => 1,
"Input' => {
'Type' => 'TextArea',
'RegEx"' => '"\.$',
'RegExErrorMessage' => 'Please enter full stop.',
b
b
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7.2 General Catalog

The General Catalog is a values catalog in which you can save a wide range of values for reuse elsewhere. It
is often also referred to as an overall catalog or universal catalog. The General Catalog can be found in the
Assets > General Catalog menu.

It enables you to save selection values for drop-down lists, such as attributes of asset classes or

event states for assets (e.g. deployment state or incident state). It is also possible to save assembly series,
model types, device types, building types, etc. You can reference these selection values in the class definition
of an asset class so that they are available to agents when creating new assets.

4 =t Admin: General e % 3
ausblenden %
m @, Assats: Genprs Catalog 190 ¥ 73 sow ks £
= [ cims tamo & Commare alidity Changed 2 Chargad by o
[ ITSt=Configitem::somare Ty sudmia Tocl walid ONZZIILARIPM ot assigned
O 1msM=Configtem:Service: Type Back End Service fype ‘Back End” walid I WL, 130 PM not avigred
[ ITSM=Contigtem:: Hardware=Type Backun Dewce alid 04227021, 1:29 FM nat avsiged
[ meM=Configtem:Hardware=Typa Beamar valid 042272074, 1:29PM not azsigned
[ ITSM=Configtem::Location: Type Bulding alid O&227M71. 1:2% FM nct assigned
[ MSM=Cotighom:Hardwar=Typa Carars walid OSLMIL L2FPM notassigned

[ MSM=Contigiem:vanicies: Typa car walid O&/ZATHIIL 44FPM not asiigned

Fig.: Overview of General Catalog

Example: By navigating to the menu Assets > Asset Classes, you create a separate asset class
called "Vehicles" and save the selection values for the "Vehicle type" (Truck, Car, Van) in the General Catalog.

4 = & Admin; General Cat.. X

Ausblenden €€

£, Assets: General Catalog (90) whi

v ] Class Name & Comment Validity

) [7]  ITsM::Configitem::Vehicles:: Type Car valid

Setup Assistant
uD ASSIE

B Assets [] ITSM::Configltem::Vehicles:: Type Truck valid

Asset Classes ] ITSM::Configitem::Vehicles::Type Van valid
General Catalog
Import/Export

#* Automation
n #* Communication

Fig.: Separate "Vehicles" Class with Different Values in General Catalog

In the class definition for the asset class "Vehicles", you then integrate a drop-down which references the
vehicle types saved in the General Catalog.
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4 & Vehicles X X = Edit Asset Class X

B Edit Asset Class (Vehicles)

*Name: @  wvehicles

lcon: @ [_‘!‘.I Select image file

* Class Definition: @ 'CustomerVisible® => 0,
"Input’ ==>{
Type' => 'GeneralCatalog’,
‘Class’ == 'ITSM::Configltem::Vehicles:: Type',
iransianon == 1,

L

Comment: @

Fig.: In Class Definition, Reference Values of "Vehicles" Class

Afterward, agents are able to create new assets of the class "Vehicles" and select from the vehicle types in

the drop-down menu.
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4 & HomeX Xum Asset X
Auvsblenden €€
Asset Classes “~ B Asset
| | T * Name:
| & [TD-ASC-001] Test class * Deployment State: @ 1o 0ymen State
T & Building
) * Incident state: @ . jont crate
B Computer Incident state
L © Hardware General Information:
ah ? Location
- Type:
& Network f !
T z i Car
o ® Room Wendor:
i Truck
e Model:
3 Van
@ Software
Location:
i Vehicles

Fig.: When creating a new asset of the class "Vehicles', agents are able to select from the vehicle types saved
in the General Catalog.
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7.2.1 Adding an New Value to the General Catalog

The General Catalog comes supplied with a selection of values which are used by the system/the initial data.
You can add other values or set superfluous values to "invalid". It is not possible to delete values from the
General Catalog. The table in the Dashboard lists all the values contained in the General Catalog.

4 = & Admin; General Cat.. X

Aushlenden <«

L4, Assets: General Catalog (90) ehi
v

[ | Class MName & Comment Validity
) [7]  ITsM::Configitem::Vehicles:: Type Car valid
Setup Assistant
B assets [ ITSM::Configltem: :Vehicles:: Type Truck valid
Asset Classes 7] ITSM::Configitem::Vehicles::Type van valid
General Catalog
Import/Export

#* Automation
n #+ Communication

Fig.: New class "ITSM::Configltem::Vehicles:: Type" with values ("Car’, "Truck", "Van")

To create a new value, proceed as follows:

1.

2.
3.
4.

In explorer, navigate to Assets > General Catalog. In the content area, a table listing all the values
created in the General Catalog opens.

In table, click "New Value". A form dialog for creating the new value opens.

Complete form (see table below) and set validity to "valid".

Click "Save" to save new value. The new value has now been created.

You can then create a new asset class in the menu Assets > Asset Classes, for example, and access the
values saved here in the class definition.
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4 & Vehicles X X = Edit Asset Class X

B Edit Asset Class (Vehicles)

*Name: @  wvehicles

lcon: @ | .‘!‘.| Select image file
* Class Definition: @ 'CustomervVisible’ => 0,
'Input’ == {

Type' == "GeneralCatalog’,
‘Class’ == 'ITSM::Configitem::Vehicles:: Type',
Iransiacon == 1,

L

Comment: @

Fig.: Providing values of the General Catalogue via the class definition

(@ Note
If newly created values are to be translated by the system, the patterns for this must be stored in the

Internationalisation > Translations menu.

To edit a value, proceed as follows:

1. In explorer, navigate to Assets > General Catalog. In the content area, a table listing all the values

created in the General Catalog opens.
2. Intable, click value to be changed. A form dialog for editing the value opens.

3. Amend information as required and click "Save" to apply changes.

Your changes take effect immediately. The agents may need to refresh their browser page to see

the changes.
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The form dialog contains the following input fields, among others:

Field (selection)

Class

Name

Icon

Validity

Description

Enter text of your choosing or select value from drop-down list. You
can reference this designation in the source code of the asset class
definition.

If you enter a free text (e.g. "ITSM::Configltem::Vehicles::Type"), a
new class is automatically created. You can create further values
for this class after saving. It is available after saving in the "Class"
selection field

£ New General Catalog * Class Definition: &

»
° Class: T 1TSMConfigibem: ve hices: Type

! = TS Confighem:Vehickes: Type'
eralCatalog’.

Enter selection value, e.g. "Truck” or "Car". Create several entries
with same General Catalog class and different names to define a
list of selection values.

* Incident state: T

Genaral Information:

£ New General Catalog

= Type:
* lass: ® MahAConfigltam=ishiclasTypa

o
*Name: ®  Car
Maodel;

Location:

Select icon for identifying the class.

You can choose an icon from one of the provided libraries or upload
a graphic file.

+ valid: the class is valid and can be used.

+ invalid-temporarily: it is temporarily not possible to use the
class.

+ invalid: the class is invalid and cannot be used.
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/.3 Import/Export

The menu Assets > Import/Export enables you to simultaneously import multiple assets from a CSV file

or export them to a CSV file. With this you can create or change all assets of a class in one go in an elegant
way. This makes it easier and quicker to set up a new system and maintain assets that were created
previously (mass update).

The imports and exports are performed using CSV mappings, which contain the assignment definitions for
exchanging the data. KIX automatically creates a separate mapping for each asset class under the same
name. Optionally, you can also create mappings using the console (see page 271) .

‘ & Admin: Asset Classes X

‘ & Admin: Import/Export X

Ausblenden ¢«

-
Name Y

Ausblenden ¢«

T

1%, Assets: Asset Classes (9) &, Assets: Import/Export (9)

Name «

[TD-ASC-001] Test class (auto-

Automatically created (Definitig
created map)

Setup Assistant Setup Assistant

Building

O assets
Asset Classes
General Catalog
Import/Export

+ Automation

* Communication

# Internationalisation

# Knowledze Database

* system

Computer
Hardware
Location
Network
Room
Software

Vehicles

OO0O0OO0OD0ODO0ODOO0OOD0OaOd

D O @ $ o & m &

O assets
Asset Classes
General Catalog
Import/Export

+ Automation

# Communication

# Internationalisation

# Knowledge Database

*systen

OO0OO0OO0OO0ODODODO DO O

Building (auto-created map)
Computer (auto-created map)
Hardware (auto-created map)
Location (auto-created map)
Network (auto-created map)
Room (auto-created map)
Software (auto-created map)

Vehicles (auto-created map)

Automatically created (console
Automatically created (consolef
Automatically created (consolef
Automatically created (consolef
Automatically created (consolef
Automatically created (consolef
Automatically created (console|

Automatically created (Definiti

+ Ticket + Ticket

# User Management * User Management

Fig.: KIX automatically creates a CSV mapping for all asset classes.
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The table in the Dashboard lists all mappings created in the system. By checking off relevant option, select
mapping with asset class into which you want to import assets or with assets you wish to export. Only then
are the buttons "Import" and "Export" activated. You can only ever select one mapping.

1 Hon |

4, Assets: Import/Export (9) T 8 import [+ Export
B Name ~ Ccomment validity Changed at Importstate

TD-ASC-001] Test class (auto-

[ ] { Automatically created (Definition create event) valid 08/04/2021, 2:47 PM

created map)

Building (auto-created map) Automatically created (console command) valid 08/04/2021, 2:46 PM
Computer (auto-created map) Automatically created (console command) valid 08/04/2021, 2:46 PM

Hardware (auto-created map) Automatically created (console command) valid 08/04/2021, 2:46 PM

tod 1 s Heall b [, L Al Lidl ORINAIINDA Q:AL DA

Fig.: Overview of Mappings in Dashboard

() Notes

In the SysConfig key "ITSMCIAttributeCollection::Organisation::Content" you can specify which
attribute (ID, Number or Name) of an organisation is to be output during import/export. The
default is "Number".

Please note: The attribute must be the same for export and subsequent import! This means
that if the name of the organisation is imported, the SysConfig key should also be set to
“Name". Otherwise you will receive an error message "Could not import Organisation: no
Organisation ID found for [attribute (value)]". The value in the import file must then be
changed accordingly.

If the name or a class-specific attribute is to be used instead of the ID for the objects
referenced on the asset, you can specify this in the class definition (see Attribut Types in the
Class Definition (see page 136) > Attribute type "CIClassReference")

KIX Pro users can have the asset numbers replaced with their own identifiers during import
using a job (see Change Asset Numbers during Import)
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Import/Export
7.3.1 Importing Asset Data
When importing data in the menu Assets > Import/Export, the
data of several assets are read in from an existing CSV file. You Content on this page:
can use an existing CSV file for this or create a CSV file + Conditions for the

beforghand via the export function, which you can then import import (see page 154)
back in an edited form.
+ Perform the asset

When you create an asset class, KIX automatically creates a CSV import (see page 156)
mapping that contains the data structure of the asset class. The 2
data structure in the mapping controls the assignment of source

and target data. After changes to the class definition of an asset _
class, the associated CSV mapping is automatically updated if options (see page 158)
the associated SysConfig key

CSV import via script
with extended

"ImportExport::CSVMappingAutoCreate###ForceCSVMappingRecreation" is set to 1 (default: 0).

L2 * f st Explarer
K 3 e Administration L, Assets: Import/Ex.., T -
1 |Number i -
2 | 174000282 a r | Hame & Comment view Mumiber of Assets
3 | 174000281 0 =
. ] [TD-ASC-001] Test class (auto-c...  Automatically created | ="

17000280 o G Setup Assistant & B Overview fssets .
5 | 1740002729 ThinChent257 Production a [l Buidi i
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Fig.: Assets are read out from a CSV file and created under the asset class using mappings

When importing the data, existing asset data is overwritten or new asset data is added. The decisive element

for determining which one applies is the asset ID in the CSV file.

+ If the ID already exists in KIX, the corresponding asset data will be overwritten. This is advantageous

if you want to make changes to multiple existing assets.
+ If the ID does not exist yet in KIX, the asset will be created using the next sequential ID. This ID is

generated internally by the system. This is advantageous if you want to create multiple new assets in

KIX in one go.

7.3.1.1 Conditions for the import

For a successful import, it is imperative to comply with the conditions for the CSV file. Otherwise, the data
cannot be correctly assigned and the import will fail.

+ All texts must be setin " " (double apostrophe).

+ The attribute "Name" must be specified.

+ Multiple attributes must be separated by semicolons ";".

+ The column names must be set in double apostrophe and separated by semicolons.

+ Date fields expect the format: yyyy-mm-dd. If the format is, for example, dd.mm.yyyy, the asset is
imported but the date is not processed.

+ The data structures of the source (CSV file) and the target (KIX) must match exactly.
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+ If necessary, the MIME type of the file must be corrected in the browser. Permitted are: application/
vnd.ms-excel, text/plain, text/csv.

| Service (auto-created map)_202306021147 - Editor

Datei Bearbeiten Format Ansicht Hilfe
rNumber";"Name";"Deployment State™;"Incident State";"SectionGeneral::1";"SectionGeneral::1::Parentservice”;"Sectio

"48116000004" ; "customerloginl service”;"Production”;"Operational™;;;;"3-support process™; ;5533333333335
"48116000003"; "ServiceAssetHH"; "Production”;"Operational™;;;;"3-support process™;"1";;;55553333333333

"48116000002" ;" [TD-A-102] Service 2";"Production”;"Operational™;;;;"1-existential™;;; 5535333333353

Fig.: Example CSV file for import/export

Furthermore, please note:

Attribute Conditions and notices

Number Specification of the asset ID

+ The ID must be mandatory.

+ Import of new assets: The asset ID specified under
"Number" must not yet exist in KIX and must not be "0".

+ Import of existing assets: The asset ID specified under
"Number" must be identical to the asset ID in KIX.

+ If a"Number" in the CSV file is identical to an existing
asset ID in KIX, the asset data will be overwritten
(update of asset data).

+ If the "Number" and the Asset ID do not match, the
asset data will not be updated, but a new import will
take place.

Name Name/designation of the asset.
The name must be mandatory.

OwnerOrganisation Name of the organisation.
The organisation is only set if it already exists in KIX.

OwnerContact KIX ID of the contact.
The contact is only set if it already exists in KIX.
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Attribute Conditions and notices
General Catalog values e.g. hardware
like: SectionGeneral::1::Type + The specified values must already be created in the

General Catalogue.
+ The designation must match the exact designation in
the General Catalogue; translations are not possible.

Linking of assets e.g. location, building, room

like: SectionGeneral::1::ParentLocation + The asset number must be indicated without a
preceding "A#".
+ If such dependencies are to be specified, the asset
classes that do not
« first import the asset classes that do not have
dependencies, or
+ the dependent asset classes are not specified
in the CSV file, in order to subsequently enter
them manually.

7.3.1.2 Perform the asset import

For the asset import, the data structure of the imported CSV file must match the data structure in the
mapping. This applies in particular to the column structure and column designations. Otherwise the import
will fail. As an aid, you can export an asset class in which at least one asset is created.

1. Export CSV file (optional):

1. Inthe Explorer, navigate to Assets > Import/Export. A table opens in the content area listing all
CSV mappings created in the system.

2. Select the desired asset class with a tick. Only now are the "Import" and "Export" buttons
active.

3. Click on "Export" and save the CSV file in your local file system.
The exported CSV file has the necessary data structure for a correct allocation of source and
target data.

2. Adding assets

1. Open the exported CSV file and use it as a template for structure and layout.
Manually add more assets to the CSV file (2) or make changes to the exported assets (1).
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A B
1 |Number Mame
2 177000006 Entrance P
3 177000005 Entrance O
4 177000004 Building F
3 177000003 Building G
6 177000002 Building A
T 177000001 Building B
8 99999393999 Entrance A
9 99999999999 Entrance C
10 99999999999 Entrance G
11 99999999999 Entrance |

]

T

D

F G H |

Deployment Incident Stat SectionGene SectionGene SectionGene SectionGene Sectio

Production
Production
Production
Production
Production
Production
Production
Production
Production
Production

Operational
Operational
Operational
Operational
Operational
Operational
Operational
Operational
Operational
Operational

© Tip

If you would like to simultaneously import multiple assets, give each asset a
numerical ID that is as high as possible, e.g. 9999999999. All assets can have the
same ID. When importing the data, KIX will detect that this ID does not exist yet and
will create the asset sequentially under the next available ID. As a result, you do not

need to monitor the sequence of the IDs yourself.

2. Save your changes to the CSV file.

& Notice

Microsoft Excel removes the inverted commas when saving the CSV file. We
therefore recommend using Libre Office. Libre Office also offers the possibility of
specifying filter options in "Save as...". to specify filter options.

Before importing, check the CSV file for a correct structure (e.g. with a text editor).

Import CSV file:

1. Inthe Explorer, navigate to Assets > Import/Export. A table opens in the content area listing all
CSV mappings created in the system.

2. Click on "Import" in the table header. A file selection dialogue opens.

3. In this dialogue, navigate to the directory in which the CSV file with the asset data is located

and select it with "Open". The data import starts.

4. If the import was successful, a success message (green) is displayed.
5. If the file type does not match the expected type or if the file contained errors, a corresponding
error message (red) is displayed.

The imported assets are now available in the Assets menu of the agent portal.
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@ Tip
KIX Pro offers the possibility to replace the asset numbers generated by KIX with own identifiers
during import. This is done with a job of the type "Asset".

7.3.1.3 CSV import via script with extended options

The import of asset data is also possible via command line and the tool https://github.com/kix-service-
software/kix18sync. Both CSV data without explicit attribute mapping in the header line and those with can
be used. Please note that the header line must contain the technical identifiers and field indices as generated
by the asset CSV export via GUI.

If you have a CSV file without suitable headers as attribute mapping, you can use the option " =—uam " (use

asset mapping) when calling the script (kix18.CSVSync.pl®). A column-to-attribute mapping is then assumed,
which must be contained in the configuration file used (see example https://github.com/kix-service-
software/kix18sync/blob/master/config/kix18.CSVSync.cfg). The file to be imported must not contain a
header line. All lines are interpreted as asset data.

Example configuration for the "uam" option on the asset class computer

/opt/kix18sync$ ./bin/kix18.CSVSync.pl --config ./config/kix18.CSVSync.cfg --ot Asset
--if ./sample/AssetData04_Computer_Sample.csv --ac Computer --uam

For data imports from external sources and updates in the KIX CMDB, sometimes no KIX asset numbers are
available. If you use unique asset names, you can then use the option " ——anl " (asset name lookup) option.
This option allows you to search for asset names if no or an invalid asset number is specified.

Example configuration for the option "anl" on the asset class computer

/opt/kix18sync$ ./bin/kix18.CSVSync.pl --config ./config/kix18.CSVSync.cfg --ot Asset
--if ./sample/AssetData04_Computer_Sample.csv --ac Computer --anl

9 https://github.com/cape-it/kix18sync/blob/master/config/kix18.CSVSync.cfg

Issued on: 26.02.2024 Page 158


https://github.com/kix-service-software/kix18sync
https://github.com/cape-it/kix18sync/blob/master/config/kix18.CSVSync.cfg
https://github.com/kix-service-software/kix18sync/blob/master/config/kix18.CSVSync.cfg

KIX 18 Admin Manual - EN - KIX Start
Assets - The Asset Device Database
Import/Export

7.3.2 Exporting Asset Data

The data export function provided under the menu Assets > Import/Export generates a CSV file listing
all assets of an asset class in the form of a table. You can save the CSV file in your file system and

+ manually edit or add assets, in order to then import them using a mass update

+ save it locally as a data backup

+ use it as a template for importing data import the asset data into other systems
+ read the asset data into other systems.
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Fig.: All assets of the "Software" class were exported to a CSV file.

To export the assets of a particular class to a CSV file, proceed as follows:

1. In explorer, navigate to Assets > Import/Export. In the content area, a table listing all the
CSV mappings created in the system opens.

2. By checking off relevant option, select mapping of asset class you wish to export. Only then are
the buttons "Import" and "Export" activated.

3. Intable, click "Export" to generate CSV file. Depending on which browser you are using, a dialog for
opening and/or saving the CSV file opens.

The exported CSV file contains the data of all assets from the selected asset class in the form of a
table. import the data into other systems.

© Tips

+ Use the export function to create local data backups, e.g. prior to a mass update. You will
then always have a copy of the data available in case of emergencies.
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+ If you want to export the name or a class-specific attribute instead of the ID for the objects
referenced on the asset, you can specify this in the class definition (see Attribut Types in the
Class Definition (see page 136) > Attribute type "CIClassReference")

/«é
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7.3.3 Using Mappings via the Console

You can have CSV import/export mappings created manually or automatically for all existing asset classes.
You can then use these to import and export asset data via console commands.

4| # Home X i Admin: Konsole X 4 x

»

System: Console

[ Console:Command::Admin::ImportExport: :CreateMapping ~file /tmp/CreatelmportExportMapping.json --replace Ausfiihren

Fig.: Using the console for import/export

Navigate to menu System > Console. Execute one or more of the following commands there as required:

Command Description

Admin::ImportExport::ListMappings Lists all mappings in the system.

Admin: :ImportExport::AutoCreateMapping Creates a new mapping for all asset classes,
whereby the mapping ID is permitted to change.

Please note: Mappings will only be newly created
and updated if the

key "ImportExport::CSVMappingAutoCreate###Fo
rceCSVMapping Recreation" has been set
accordingly in the SysConfig (default: "No").

Admin::ImportExport::AutoCreateMapping Creates a new mapping for the asset class with

——class ClassName the class name "ClassName".
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Command Description

1. Admin::ImportExport::CreateMapping 1. Creates a new CSV mapping for the export/
-—file /path/to/file.json import of asset data (supplementary to the
default mapping), e.g.:
--file /tmp/

2. Admin::ImportExport::CreateMapping

——file /path/to/file.ison --replace CreateImportExportMapping.json

2. Removes or replaces an existing mapping
with the same name, e.g.:
-—file /tmp/
CreateImportExportMapping.json --

replace

Can be used to perform e.g. partial config item
updates or combined asset imports of technical
device data (file1.csv) and cost centre data
(file2.csv).

The mapping description must be available as a
JSON file, e.g.:

Example: Mapping

{
"A Sample Mapping Name":

{ # Mapping Name
"Charset": "UTF-8",

# Character set encoding (required)
"ColumnSeparator": "Semicolon",

# Separation drawing for columns
"IncludeColumnHeaders": "1",

# Export with column headings? (0 =

no; 1 = yes)
"CountMax": "10",

# Max. number of array elements
"ClassName": "Computer",

# Asset class name
"DefaultDeploymentStateID":

"is", # Default Deployment

state (ID)
"DefaultIncidentStateID": "1",

# Default Incident state (ID)
"DefaultName": "",
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Command Description

"EmptyFieldsLeaveTheOldValues":
", # Transfer of old data from
previous version for partial update

"IdentifierAttribute": "Number",
# Column serving as identifier
column

"CSVRowMapping":

[ # Contains
the column mapping with didentifier
column
"Number",
|lNamel| ,
"DeplState",
"InciState",
"SectionGeneral::1",
"SectionGeneral::1::Type::1",
"SectionGeneral::1::Vendor::1"
]
}
}

Further attributes or their column names can be
obtained from the column labels of the default
mappings.

Call in the backend e.g. with:

I have no name!@1234f56f7890: /opt/
kix$ ./bin/kix.Console.pl

Admin: :ImportExport::CreateMapping
--file /tmp/
CreateImportExportMapping.json --
replace

@ Please note

The SysConfig provides a number of different configuration options for the mapping. All the
settings begin with "ImportExport::CSVMappingAutoCreate###[...]". Event registration begins
with "ITSMConfigltem::EventModulePost###910-CSVMappingAutoCreate".
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7.4 Configuration settings

You can influence the
behavior of the CMDB or Content on this page:
asset management
through numerous
configuration settings.
Here is an overview of the
most important:

+ Tracking link types (see page 164)

+ Define usage status (see page 165)

+ Define assignments and visibility in the SSP (see page 166)

+ Automatic linking of ticket and asset | service (see page 167)

+ System Monitoring (see page 167)

+ Search for assets (Supplement System Monitoring) (see page 168)

7.4.1 Tracking link types

Configuration key ITSM::Core::IncidentLinkTypeDirection

Defines which link types are followed in which direction in order to propagate the incident status of a
disturbed asset to dependent, linked assets.

The configuration contains N relevant link types and directions as key-value pairs:

Key: link type
+ Value: Link direction (Source | Target | Both).
If an asset is set to "Incident”, the link types configured here are tracked in order to also set the relevant

assets to "Incident". However, if such an asset is linked to other, non-disturbed assets, the asset in question
is not set to "Incident”, but to "Warning".

! The configuration is changed by manually executing the console command " Admin :: ITSM
IncidentState :: Recalculate "to update all incident statuses.
@ Tip

The simulation of the asset graph is generated in the backend and delivered in the form of a JSON
response. KIX uses this response to display the graph in the frontend. If necessary, you can couple
your own automatisms to the REST API in order to generate the simulation for your purposes.
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Example configuration

{
"DependsOn": "Both",
"ConnectedTo": "Target",
"Includes": "Source"
}

7.4.2 Define usage status

Configuration key GeneralCatalogPreferences###DeploymentStates

Defines the types of use status (productive, post-productive, pre-productive).

Agents must specify a deployment state when creating or editing assets. This describes the position of the
asset within its life cycle.

You can create further individual deployment states in the General Catalogue and assign them to the status
type (menu Assets > General Catalog).

Note: Assets (especially services) of the status type "post-productive" are not visible in the Asset Module and
can only be found via the Complex Search (see also: Service Contracts).

KIX is initially delivered with the following usage statuses:

Deployment state State type
Expired productive
Retired post-productive
Planned pre-productive
Repair productive
Maintenance productive
Inactive post-productive
Pilot productive
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Deployment state State type
Production productive
Review productive
Test/QA pre-productive
Example configuration
{
"Class": "ITSM::ConfigItem::DeploymentState",
"Data": {
"postproductive": "postproductive",
"preproductive": "preproductive",
"productive": "productive"
I

"Desc": "Deployment State Type.",
"Label": "Deployment State Type",
"PrefKey": "Functionality"

7.4.3 Define assignments and visibility in the SSP

Configuration key AssignedConfigltemsMapping

Controls

1. the assignment of assets to contacts or organisations in detail views or the sidebar "Assigned
Assets" as well as
2. the visibility of assets in the SSP (selectable in the "Affected Assets" field and the "Assets" module).

For more information on configuration, see Control visibilities in the SSP.
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Configuration key AssignedObjectsMapping

Controls which tickets, communication steps (articles) and FAQ articles are displayed in the SSP.

For more information on the configuration, see Control visibilities in the SSP.

7.4.4 Automatic linking of ticket and asset | service

Configuration key Ticket::EventModulePost###I TSMConfigltemLinkAdd

Automatically creates a link between ticket and asset or between ticket and service as soon as a change is
made to the dynamic field of type "Asset reference".

This event only creates links. Links can only be deleted manually.

Example configuration Affected asset

{

"Event": "(TicketDynamicFieldUpdate_AffectedAsset)",

"LinkType": "RelevantTo",

"Module": "Kernel::System::Ticket::Event::ITSMConfigItemLinkAdd"
}

Example configuration Affected service

{
"Event": "(TicketDynamicFieldUpdate_AffectedServices)",
"LinkType": "RelevantTo",
"Module": "Kernel::System::Ticket::Event::ITSMConfigIltemLinkAdd"
}

7.4.5 System Monitoring

Configuration key PostMaster::PreFilterModule###****-SystemMonitoring

Configuration for processing incoming emails for System monitoring (see page 736) (Focus: ITIL Practice
"Monitoring & Event Management").

Issued on: 26.02.2024 Page 167



KIX 18 Admin Manual - EN - KIX Start
Assets - The Asset Device Database
Configuration settings

"AffectedAssetName": "AffectedAsset",
"CloseActionState": "closed",
"CloseNotIfLocked": "o",
"ClosePendingTime": "172800",
"CloseTicketRegExp": "OK|UP",
"CreateChannel": "note",
"CreateSenderType": "system",
"CreateTicketQueue": null,
"CreateTicketSLA": null,

"CreateTicketState": "new",
"CreateTicketType": "Incident",
"DefaultService": "Host",

"DynamicFieldContent::Article": null,
"DynamicFieldContent::Ticket":
"SysMonXHost,SysMonXService,SysMonXAddress,SysMonXAlias,SysMonXState",
"FromAddressRegExp": '"sysmon@example.com",

"Module'": "Kernel::System::PostMaster::Filter::SystemMonitoringX",
"NewTicketRegExp": "CRITICAL|DOWN|WARNING",

"StopAfterMatch": "1",

"SysMonXAddressRegExp": "\\s*Address:\\s+(.*x)\\sx*x",
"SysMonXAliasRegExp": "\\s*Alias:\\s+(.*x)\\sx",
"SysMonXHostRegExp": "\\sxHost:\\s+(.*)\\sx",
"SysMonXServiceRegExp": "\\s*Service:\\s+(.*x)\\sx",
"SysMonXStateName": "SysMonXState",

"SysMonXStateRegExp": "\\s*State:\\s+(\\S+)",

"ToAddressRegExp": ".x"

7.4.6 Search for assets (Supplement System Monitoring)

Configuration key TicketAutoLinkConfigltem

Enables the targeted search for assets as a supplement to the system monitoring integration via mail filter.
The search is based on asset-identifying information stored in articles (especially emails) or fields, such as
IP addresses or FQDNs. The specific attributes of the asset classes are used as search criteria and searches
are only carried out in matching asset classes (Focus: ITIL Practice "Monitoring & Event Management").

For more information and SysConfig keys on this, see: System Monitoring (see page 736) .
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8 Automation

The menu Automation enables you to create and manage automated processes in KIX.

Notifications

KIX enables you to configure notifications so that, for example, agents are notified via email when there
are new tickets in their teams or new articles for their tickets. The settings for doing so can

be configured under Automation > Notifications. Under the option "My Teams" in their preferences,
agents can select the teams for which they would like to receive notifications. You can also pre-
configure which teams have been set for an agent under "My Teams" in the Admin module under User
Management > Users.

Notification Template

You can create an HTML template for notifications. With this template you design the appearance of
the emails sent by KIX. It is thus possible to adapt the notifications to your corporate identity. The basic
HTML structure for a template is already available in the Automation> Notification template menu. You
can adjust these as required.

Jobs

The menu Automation > Jobs enables you to configure event-based and time-based jobs that

KIX executes automatically. Examples of such jobs are anonymizing tickets after a certain period of
time in order to comply with data protection regulations, archiving closed tickets, or moving tickets to a
different team once assigned a certain state.
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8.1 Jobs

KIX enables you to configure both simple and assembled time-based and event-based tasks (actions)
using a graphical user interface without needing to use a script language. KIX executes these tasks
automatically.

This means you can, for example,

- automatically delete the spam in your junk folder (team) once a week

+ automatically close all tickets with the state "pending successful close” every Monday at 5:30 a.m.

+ automatically remove the customer assignments for all tickets that have been closed for at least 6
months (compliance with GDPR regulations)

+ create reports automatically.

+ etc.

Jobs (formerly Generic Agents) are created and configured in the menu Automation > Jobs. The table in
the content area lists all jobs created in the system along with their control parameters.

Jobs are executed by name. If jobs are triggered by the same event, their execution can be controlled by
assigning corresponding names (alphanumeric).

Administraticn = 0, futomation: Jobs 2] T B v iy

T O e Mame = BretBaend  TimeBamed Wumber of actions Lt eecuted at Comment vty Crosted ot Created by
1 Ticksa I Fabd Agerd - Mal.. - x Thits job resats cwnar and lock state of & tideet. when its .. valid CHATHE 1242 P not asdgned

 imrets K k] dupert - Mt - H Empties the nk foldes weekly om monday, 5:30 2,m. valic LML BEBPM ot smimred

Fig.: The Dashboard lists all jobs created in the system

Jobs initially delivered in KIX Start:

Job Description Notes

KIX Field Agent - Mobile This job is required for the Field A possibly blocked ticket could prevent

Processing Rejected Agent App. It enables users to the processor from being set. To avoid
return a rejected ticket to theteam  this, the actions are initially configured
so that it no longer appears in the in the following order:

user's tasks. 1. Set lock status: unlock

2. Setagent: 1 (admin)
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Job Description
Customer Response :: The job changes the status of a
reopen from pending ticket from "waiting" to "open” in

case of a customer feedback via
Self Service Portal.

Periodic Reports The job determines the reports to
be created periodically every 15
minutes and generates them in
CSV format. It forms the basis for
the up-to-dateness of the statistics
in the Home Dashboard.
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Notes

Tickets are often set to a waiting
status when a response from the
customer is expected. If the customer
responds at a later time via Self
Service Portal, the job sets the status
of the ticket to "open" and thus raises
the relevance of the ticket. In this way,
the ticket is not forgotten and can be
further processed or closed.

Initially, at least 5 minutes must pass
from the creation of the ticket to the
response before the status is changed.
You can change this time span if
necessary. If the filter parameter
"Created on" is removed, the ticket will
be set to "Open" with every reply.

You can adjust the execution times in
the job.

Important: Chart widgets - and thus the
statistics in the Home Dashboard - can
only evaluate reports with output
format CSV. In KIX Pro, JSON is also
possible. Other output formats are not
supported.

KIX Pro also comes with pre-prepared jobs that you can amend as required:

+ Synchronization of login and customer data from an LDAP directory service (Active Directory)

+ Anonymization of ticket data

+ Setting of default values for the fulfillment time

+ Set the incident status of a ticket for all affected assets
+ Setting time stamps for SLA compliance

+ etc.
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8.1.1 Zoom View for a Job

The zoom view enables you to view the details of a job, edit a job, and manually start a job.

Navigate to Automation > Jobs. In the content area, a table listing all the jobs created in the system opens. In
table, click job to open associated zoom view.
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Fig.: Zoom View for a Job

The zoom view of a job contains multiple lanes showing the following information:

Lane Description

Tab Lane + Tab "Job Information": Master data for the job, such as
validity, date created, and date changed.
+ Tab "History": Tracking of execution and download of job log
files (see below)

Execution Plan Shows the time parameters and event parameters that trigger the
execution of the job.

Filter Shows the filter criteria for the job.

Actions Shows the actions that are executed using the job.

The buttons in the title bar of the zoom view enable you to make changes to the job or start the job manually.
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Button Description

New Job Opens a form dialog for creating a new job.

Edit Opens a form dialog for changing the job parameters.
Run Click this button to manually start job.

8.1.1.1 History

KIX logs the execution of jobs. You can view the logs as a log file in the job history. This allows you to track
the execution of jobs and find valuable clues for troubleshooting.

Click on a table entry to display the log information or click on the icon in the "Log Download" column to
download the log file.

I s wormaton = 1 |
T
State Start by Start time & End Time. Download log
finlshad Martin Mustarmann 05/17/3021, 6O3TM  O5/17/201%, é03PM &
He & et I Priority Message Created at
1 info executing job “job_Testbericht” with 1 macros on £ objects. 05/17/2021. 6:03 PM
2 1 info executing macro "Macro for Job "job_Testbericht™ with 4 macro actions on Objectil 1, 05/17/2021, 6:03 PM
3 1 wrrar Couldn't croate ropart! (Mo autpat farmats requestad!| 05/17/2021, &:03 PR
4 1 rror Macro action “CresteReport” ratumed execution erroe, 05/17/2021, 6203 AM
5 infa epciting macro *Macra for Job “job_Tastharicht* - Actian: ExacutoMatre - 1621267027913 with 1 .. D5/17/2001, &:03 PM
infa job execution finished succassfully. 05/17/2021, &:03 PA
finished Martin Mustermann O5/1B/2021, 1111 AM  05/1B/2021 111 aM & hd

Fig.: Display of error information in the history of a job

8.1.1.2 Setlog level
Configuration key Automation::MinimumLogLevel

You can specify the level at which information should be logged and recorded in the log.
This is done in the SysConfig key "Automation::MinimumLogLevel" (Menu: System > SysConfig).
The following values are possible:

- Error: Only error messages are logged (default).
+ Debug: All log information is captured.

& Please note
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Some macro actions (e.g. KIX Pro: "LDAP 2 Contact") contain a debug option. If you activate
debugging, "Automation::MinimumLogLevel" must be set to " Debug ". Otherwise, the debug

information provided by the Macro Action will not be captured and will not be displayed in the job
history.
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8.1.2 Creating or Editing a Job

You can configure KIX to run automatic tasks (jobs) on certain time and event-based events. For example,
you can configure a job that deletes all tickets in the "Junk" team every Monday at 6:30 a.m. to clean the
system from spam mails.

In one job, several consecutive actions can be executed, so that, for example, after deleting the junk mails, a
new article with a completion note is generated.

When configuring jobs, you can use KIX Placeholders (see page 750) and Dynamic Fields (see page 274) . Invalid
or temporarily invalid dynamic fields are not taken into account during job execution.

The creation of a job is done step by step. To move to the next step or to switch between steps, click on the
small blue arrow buttons or on the blue dots in between. Please click on the "Save" button only at the end,
when you have entered all job parameters.

To create a new job, proceed as follows:

1. Inexplorer, navigate to Automation > Jobs. In the content area, a table listing all the jobs created
in the system opens.
2. Intable, click "New Job". A form dialog for creating the new job step by step opens (see below).
+ Step 1 (Job Information):
Set up job by selecting type of job and assigning job a meaningful name (mandatory fields).
Set validity to "valid" and optionally record a comment
- Step 2 (Execution Plan):
Set the parameters that trigger the job, e.g. a specific time and/or a specific ticket event.
- Step 3 (Filter):
Specify which tickets the job will be applied to. Select the parameters that the ticket should
have so that the job is applied to it.
For example, select the filter "Team" and the value "Junk" to apply the job only to tickets of the
Junk team.
+ Step 4 (Actions):
Determine which tasks are to be carried out with the job and in which order. Pay attention to a
sensible sequence. The tasks are processed in the order in which they are specified here -
from top to bottom.
3. Asthe last step, click "Save" to save new job. The job has now been created, is active immediately
and will be executed in line with its configured settings.

Note: To be able to duplicate a job, you need KIX Pro.
To edit a job, proceed as follows:

1. In explorer, navigate to Automation > Jobs. In the content area, a table listing all the jobs created
in the system opens.
2. Intable, click job to be edited. The zoom view for the job opens.
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Click "Edit" in title bar of opened zoom view. A form dialog for editing the job opens (see below). Use
small blue arrow buttons or dots to move to next step or jump between steps.

As the last step, click "Save" to save your changes. The job has now been changed, and if it has been
set to "valid" it will be active immediately.

To delete a job:

1.

In the Explorer, navigate to Automation > Jobs. A table opens in the content area listing all the jobs
created in the system.

Place a tick in front of the job to be deleted. You can select several jobs.

Click on "Delete" in the table header. The button is only active when at least one job is selected.
Answer the security question with "Yes" to start the deletion process. All actions, sub-macros and
execution plans are deleted recursively.

However, if internal references still exist, the job cannot be deleted. You will then receive a
corresponding message.

As an alternative to deletion, you can set a job to "invalid" or "temporarily invalid". Then the job is not
triggered. An invalid job can be reconfigured at any time and set to "valid" again in order to reactivate it.

o

Tip

With the console command

Console: :Command: :Maint: :Automation: :DeleteNotReferencedMacros you can
delete macros that are not used (menu System > Console). This deletes all macros that are not
referenced by any job and that are not sub-macros of other macros. Individual macros can be
excluded from deletion. To do this, enter the parameter ignore-macro-id - several times if
necessary.
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8.1.2.1 Configure the job

Job Information (Step 1)

Here you store general information about the job and define the type of job.

£3 New Job

Job Information
® >

@

* Type of Job: T Ticket
*Name: @  Empty Junk

Comment: @  Empties the junk folder on mondays, 5:30 a.m.

* Validity: @ valid

Field Description

Type of Job Select the type of the job. The job type defines on which object the job
will be executed:

+ Asset (KIX Pro): When importing assets, this job adapts the asset
numbers to its own number range.

+ Contact: The job is applied to contacts.
For example: create a ticket when a certain date is reached on the
contact (start an offboarding process when an employee leaves).

+ Reports: The job automatically creates reports based on an existing
report definition.
Please Note: The statistics in the Home Dashboard only evaluate
reports in CSV or JSON output format.

+ Synchronisation: The job syncs data (e.g. KIX contacts synced with
contacts from LDAP/AD in KIX Pro).

+ Ticket: The job is applied to tickets (e.g. deleting the junk folder,
moving tickets to selected queues, etc).
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Field Description

Name Enter a meaningful name for the job.

The sorting of the jobs and their order of execution is done according to
their names (alphanumeric). This means that the execution sequence of
jobs that are triggered by the same event can be influenced by their
names.

Example:

+ Scenario: 2 jobs that both react to "TicketStateUpdate" and create an
article (Job 1 has name "02_TestJob", Job 2 has name
"01_TestJob").

+ Result: The article of job 2 (01_TestJob) is created first, as the name
begins with "01".

Comment Optionally save a comment. If required, record what the job does so that
you can keep an overview if there are multiple jobs.

Validity + valid: The job is active and will be triggered based on a point
in time or an event in line with the configured settings.
« invalid/invalid-temporarily: The job is (temporarily) inactive and will
not be executed.

Execution Plan (Step 2)

Here you specify when the job is triggered (time or event).

£ New Job
Execution Plan
< o ?

Time Based Execution

Weekday(s): @ Monday
Time: @ 5:30

Event Based Execution

Events: @
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Description

Select the days of the week on which the job should be executed.
In addition, a time must be specified.

Select the time(s) at which the job should be executed.
In addition, the day of the week must be specified. For daily execution,
all weekdays must be selected.

Select the events that are to trigger the job. The job will be triggered as
soon as one of the events specified here occurs.

The standard events (e.g. ArticleCreate) and an update event for each
dynamic field are available for selection
(TicketDynamicFieldUpdate_NameDesDynamicField).

If you have not selected a point in time or an event, then the system will not automatically start
the job. However, you can start it manually at a time of your choosing by clicking "Run" in the

Zoom view.

Filter (Step 3)

With filters, you restrict the execution of the job based on certain criteria. Here you define which conditions
must be fulfilled for the job to be executed (e.g. all tickets in the "Junk" team).

You can combine the filters. The individual filter blocks are OR-linked. The filters within a filter block are AND-

linked. By means of the buttons D I:I you add or remove further filter blocks.

Example: Job is executed if

+ the ticket has the team "Service Desk" AND the affected asset "Computer 1" stored on it

OR:

* the ticket contains the team "Monitoring” AND the affected asset "KIX18".
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£+ New Job

Filter: &

Filter:

Team contained in

AffectedAsset (Affec...

OR

Team contained in

AffectedAsset (Affec...

contained in

contained In

Filter

& Service Desk

B A#174000005 - Computer 1

& Monitoring

B ARLT10000001 - KIX 18

The filters are specified analogously to the logic in the complex search (see user manual):

Column

Description

Filter attributes of the
object

(according to the
selected job type)

Search operators (see
page 884)

(e.g.: contained in,
begins with, ends with,
is equal to, etc.)

Formular fields and
values

Hints

Which filter attributes are available for selection depends on
the object (ticket, asset, contact, etc.) selected in step 1 under
"Job type".

In addition to the filter attributes of the object, Dynamic fields
(except type "Checklist") are also available for selection.

@ Only searchable attributes are available for selection in
asset jobs. If necessary, set the missing attribute in the class
definitionto 'Searchable' => 1.

The available search operators depend on the selected filter
attribute or dynamic field.

For dynamic fields of the type text and textarea the wildcard
search is additionally available (search with * as placeholder
for unknown text passages).

For date/time-based filter attributes, relative time
specifications can be defined (e.g. created within the last 24
hours).

KIX placeholders (e.g. <KIX_CURRENT_UserID>) can also be
specified as values, e.qg. to restrict the job to the current user.

If you specify multiple filters, the filters will be linked by a logical AND operation. Thus, you can specify that
the job is applied to all tickets that have the type "unclassified" AND the status "closed" AND are from the

team "support”.
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Hints:

+ If dynamic fields set to "invalid" are specified, they will not be used in the execution.

+ If you have selected an article-related event in the execution plan (step 2) (e.g. "ArticleCreate"), the
filters "Channel" and "Sender Type" are mandatory fields. With these you further restrict the filter.
Please select the options in such a way that you prevent "endless loops" that could occur when
sending notifications and creating articles at the same time.

Actions (Step 4)

Here you specify which actions are to be carried out with the job in which order.

£ New Job
Actions
4 [
* Macro: @ Ticket A
* 1. Action: @ Delete Ticket A
Skip: @ LJ

Field Description
Macro Corresponds to the selected job type (step 1) and cannot be changed.
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Description

Select which tasks (Macro Actions) the job should execute.

Several actions can be executed in one job. They are processed in the
specified order - from top to bottom. Actions can be nested. Therefore, pay
attention to a logical order. In the Macro Actions overviews, you will find
instructions on how to use the individual actions.

After you have selected an action, further input fields are displayed. These vary
depending on the selected action. For example, the action "Set agent” requires
the agent's name to be entered in order to set him as an agent on the ticket.

Further informations:

« Overview of Macro Actions for KIX Start (see page 804)
« Overview of Macro Actions for KIX Pro (see page 819)
+ Macro Actions (see page 802)

+ and the usage examples of Macro Actions

Using the buttons located at the edge, you can add further actions, remove
actions, or move the order of the actions using drag & drop:

Adds additional actions.

Removes the action.

Collapses or expands the input fields for an action.

Changes the sequence of the actions.
Click on double arrow, hold down left mouse button, and
drag action to different position. Place action in a dark gray area.

£ New lob

Actions
< .
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Description

Check off this option if the action should (temporarily) be skipped. The job
will be executed without this action. This enables you to exclude specific
actions from the execution without needing to reconfigure the whole job.
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8.2 Notifications

The menu Automation > Notifications enables you to specify for which ticket events email notifications
should be sent to which agents and specify what these notifications should contain.

For example, you can configure that the agent set as the owner on a ticket should be notified when the ticket
state changes. If this notification is set to "valid", an agent will always be notified when there is an updated
state for a ticket that they are the owner of, and when this ticket is located in a team that they have saved
under "My Teams". If the message has been created in multiple languages, KIX can take into account the
agent's language here.

KIX comes supplied with a selection of ticket notifications. You can amend these as required and add
additional notifications.

4| & Admin: Notifications X & Agent - New Note Notif.. X »
Ausblenden «
O aebratar - %, Automation: Notifications (11) T 3 New Notification
T [ Mame « Comment Walidity Created at Created by
e it | Agent - FUP Notification (if locked) valid 09/16/2021, 11:01 AM  not assigned
B Fasete | Agent - FUP Nofification (if unlocked) valid 09/16/2021, 11:01 AM ot assigned
B Automation "] Agent - Lock Timeout walid 09/16/2021, 11:01 AM  not assigned
Jabs | Agent - New Note Notification walid 09/16/2021, 11:01 AM ot assigned
Notifications | Agent - New Ticket Notification valid 09/16/2021, 11:01 AM  not assigned
Natifications Template 5 - 5
|| Agent - Owner Assignment walid 09/16/2021, 11:01 AM ot assigned
# Communication =
Agent - Reminder {if locked) valid 09/16/2021, 11:01 AM ot assigned
# Intenationalisation
| Agent - Reminder {if unlocked) walid 09/16/2021, 11:01 AM  not assigned
# Knowledge Database
® Syiem "] Agent - Responsible Assignment valid 09/16/2021, 11:01 AM  not assigned
# Ticket [ Agent - Ticket Move Notification walid 09/16/2021, 11:01 AM  not assigned
# User Management || Customer - New Ticket Receipt wvalid 09/16/2021, 11:01 AM  not assigned
< >

Fig.: "Notifications" Menu

You can set the sender information for notifications (see page 193) . To do this, navigate to the System>
SysConfig menu and define the sender information in the following keys:

* NotificationSenderEmail: Email address; Sender of the notification (e.qg .: kix-
notifications@example.de)
- NotificationSenderName: Name / designation of the sender (e.g .: "KIX message")

8.2.1 Zoom View for Notifications

You can view the details of a ticket notification. Navigate to Automation > Notifications. A table opens in the
content area that lists all notifications stored in the system. Click on a notification in the table to open its
detail view. Click on "Edit" in the title bar of the detailed view if you want to make changes to the notification.

The buttons in the title bar of the detail view allow you to edit and create new ticket notifications
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Agent - New Note Notification % New Notification

& Edit

Notification Information

Mame: Agent - New Note Notification Changed at: 09/16/2021, 11:01 AM Events:
Show in agent prefer_.. : MNo Changed by: not assigned Notificationaddiote
Agent Preferences To... :

Comment:

Validity: valid

Created at: 09/16/2021, 11:01 AM
Created by: not assigned

Filter
Recipients
Notification Methods
Notification Text -
A
German

Subject: Aktualisierung: <KIX_CUSTOMER_Subject_é&4> [<KIX_CONFIG_Ticket::Hook=<KIX_TICKET_TicketNumber>]
Body:
Ein neuer Artikel wurde angelegt: [=KIX_CONFIG_Ticket::Hook=>=KIX_TICKET_TicketNumber>]

<KIX_TICKET_Title=

Fig.: Zoom View of a Ticket Notification

The zoom view of a notification contains multiple lanes showing the following information:

Lane Description

Notification Information Reference data of the notification, as well as the events that
cause the message to be sent.

Filter Lists the filter conditions to which the sending of the
message is linked.

Recipients Lists the recipients of the message.
Notification Methods Lists additional recipients of the message.
Notification Text Displays the message text in the relevant language.
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8.2.2 Creating or Editing a Ticket Notification

You can configure KIX such that automatic emails are sent to agents if certain ticket events occur.
This means that agents can be automatically informed about various ticket events.

Events

Filter

Recipients

Send despite out of office: &

¥ Edit Nofification

Notitication Information

* Name: Agent - New Note Notification

Show in agent preferences: @ B

Agent Preferences Tooltip: @

Comment: & A

* validity: @ valid

* Event: @ MotificationAddMate

Send to: @ TicketOwner TicketResponsible

Send to these agents: &

send to all role members: @

=)
a

Once aday: @ |

Create Article: ®

Fig.: Editing a Ticket Notification

To create a new ticket notification, proceed as follows:

1.

3.
4.

In explorer, navigate to Automation > Notifications. In the content area, a table listing all

ticket notifications saved in the system opens.

In table, click "New Notification". A form dialog for creating the notification (in several languages if
applicable) opens.

In form, configure ticket notification (see table below) and set it to "valid".

As the last step, click "Save" to save your entries.

The new ticket notification has now been created and will be sent in line with the settings you
have onfigured.

To edit a ticket notification, proceed as follows:

1.

w

In explorer, navigate to Automation > Notifications. In the content area, a table listing all ticket
notifications saved in the system opens.

In table, click notification to be edited. The zoom view opens.

Click "Edit" in title bar of opened zoom view. A form dialog for editing the notification opens.
Change information/configuration as required (see table below) and as the last step, click "Save" to
apply your changes.
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The changes take effect immediately.

To delete a ticket notification, proceed as follows:

1. In explorer, navigate to Automation > Notifications. In the content area, a table listing all ticket
notifications saved in the system opens.
2. Place atick in front of the notification to be deleted. You can select several notifications as well.

w

Click on "Delete" in the table header. The button is only active if at least one notification is selected.

4. Answer the confirmation prompt. If you choose "Yes", the notification will be deleted and no longer be
sent in the future. Notifications that have already been sent remain on the tickets.

The form dialog contains the following input fields, among others:

Field (selection)

Name

Show in agent
preferences

Agent Preferences
Tooltip

Validity

Events

Description

Give the notification a meaningful name.

The notification is sent to all agents selected as recipients.

+ Activated: The agents designated as recipients can specify in their
personal settings whether they want to receive this notification.

+ Deactivated: Agents designated as recipients are required to receive this
notification. They cannot opt out of receiving the notification in their
personal settings.

You can specify that the agents should be informed by a tooltip about

the receipt of a Preferences notification. To do so, use this option to record
the Tooltip text that should be shown. If you have not saved a tooltip, the agent
will not be informed that a notification has been received.

« valid: The notification is active and will be sent as soon as the defined
event occurs.

+ invalid/invalid-temporarily: The notification is inactive and will not be
sent.

Select the ticket events that should cause the message to be sent. If one of
these events occurs, the message will be sent.

All valid events saved in the SysConfig are available for selection. You

can select more than one option.

Please note: When selecting article events, the specification of the filters
"Channel" and "Sender Type" is obligatory. This prevents "endless loops" when
sending notifications with simultaneous creation of articles.
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Field (selection) Description

Filter You can use filter conditions to narrow down the sending of the message
to tickets that have certain characteristics. An example could be when a new
ticket (event) arrives from a certain customer (filter). The filters are specified
in the same way as the logic in the complex search. The use of KIX
placeholders (e.g. <KIX_CURRENT_UserID>) is possible.

Events

* Event: @ NotificationAddhote

Filter

Contact contained in © Edward Wilson (contact505)

All ticket-based filters and dynamic fields (except checklist type) are available
for selection. The wildcard search is also available for dynamic fields of the
type Text and Textarea (search with * as a placeholder for unknown text
passages).

If you specify several filters, the filters are linked to one another by a so-called
logical AND link.

Please note:

+ If dynamic fields set to "invalid" are specified, they will not be used in the
execution.

+ If you have selected an article-based event under
"Event" (e.g. "ArticleCreate"), the filters "Channel" and "Sender Type" are
mandatory fields. You can use them to narrow down the filter further.
Please select the options such that you avoid "endless loops" that could
occur when sending notifications while simultaneously creating articles.

Recipients Select the recipients of the message. A combination of recipient groups,
individual agents, and role members can be selected.
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Description

Send to

Send to these agents
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Select the recipient or
recipient group of the
ticket notification
(multiple selection
possible).

Messages are sent
depending on the basic
permissions:

+ All agents wiht read
permission for the
ticket: Only
recipients with
READ permission
on the specific
ticket receive a
notification.

+ All agents with
update permission
for the ticket: Only
recipients with
READ and WRITE
permissions on the
specific ticket will
receive a
notification.

Select specific agents
as the recipients of the
message.

All valid agents created
in the system are
available for selection
(you can select more
than one option).
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Field (selection) Description

Send to all role members The message is sent to
the agents who all have
the selected roles.

All valid roles created in
the system are available
for selection (you can
select more than one
option).

Send despite out of office Check off the checkbox
if the message should
also be sent to
recipients with the state
"out of office" (e.g. if
they are on vacation).

Once a day For each ticket, a
notification is only sent
1x per day.

Create Article If you check off this
option, an article will
also Article be created
on the corresponding
ticket when generating
a notification. For
article-based events,
ensure that you do not
configure any "endless
loops".

If you do not check off
this option, the
message will be

sent but an article will
not be created.
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Notification Methods

Description

Additional recipients
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Enter additional email
addresses that should
also receive the
notification (optional).
You can choose from all
of the customer
contacts stored in the
system and you can
also enter external
email addresses
manually, provided the
addresses are valid.

KIX Pro: In order to
make the additional
recipients variable, you
can specify KIX
placeholders

for dynamic fields (see
page 281) of the type
"contact reference".
This can be used, for
example, to inform
other contacts stored
on the ticket about the
closing of the ticket.
The email address of
the contact is always
taken from the
placeholder, so you can
use the parameters
_Short and _Value:

+ <KIX_TICKET_Dyna
micField_myDFCont
actReference_Value
>: "Last Name, First
Name" <email>.
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Description

+ <KIX_TICKET_Dyna
micField_myDFCont
actReference_Short
> : email

A prerequisite for
correct use is that a
valid and syntactically
correct email address is
stored in the ticket in
the dynamic field.

Subject with Ticket number If this option is
selected, the ticket
number will be sent to
the additional recipients

in the subject line.

You can store the notification text in different languages. Therefore the users
receive the message in the language set for them. An editor is available for
each language created in SysConfig ("DefaultUsedLanguages" key).

With the selected "Content Type" you define the format of the notification:

*+ Richtext: Notification text with HTML formatting.
+ Plaintext: Notification text without HTML formatting (e.g. for technical
mails or interfaces)

You can use placeholders in both the subject and the message text to place
variable text fragments in the messages, such as the content of the ticket
subject.

E.g. Subject: "Update <KIX_CUSTOMER_Subject_64>
[<KIX_CONFIG_Ticket::Hook> <KIX_TICKET_TicketNumber>]".
E.g. Article text: "<KIX_AGENT_From> wrote: <KIX_AGENT_Body>

Hatification et

*Subject: ¥ Upcdate: <KIX_CUSTOMER_Subject_64 [<B1X_CONFIG Tichet:Hooks<Ki¢_TKCKET TicketNumbers]

B I U & x »|T |+ = = iR A E B & 2
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8.2.3 Standard address for notifications

Configuration key: Sender address: NotificationSenderEmail
Sender name: NotificationSenderName
Domain name: FQDN

KIX can send internal notifications as soon as certain ticket events occur. You can configure the default
sender name and address for these notifications.

Proceed as follows:

Navigate to the System > SysConfig menu.
Search for the keyword "notificationsender*". You will get the two relevant keys in the overview.
Select both keys with a check mark and click on "Edit".
Change the values in the keys:
1. NotificationSenderEmail:
« Enter the sender address from which notifications should be sent by default (e.g.
"info@myhost.example.de").
+ If the frontend FQDN was entered in the setup wizard, it is adopted here (hash value).
- Itis possible to use a KIX placeholder for the domain name (<KIX_CONFIG_FQDN> or
<KIX_CONFIG_FQDN_Frontend>). Then the domain is used which is stored in the
SysConfig key "FQDN".
2. NotificationSenderName:
+ Enter a freely definable sender name. The notifications are marked with this name by
default (e.g. "KIX message").
5. Save your changes.

Hwbdh =

The ticket notifications sent by KIX will now be sent from the changed default address with the sender
identifier you named.

NotificationSenderEmail
L 4
*Name: @  NotificationSenderEmail

Description: @ Specifies the email address that should be used by the application when sending notifications. The email address is used to build the complete display name for the notification master (i.e.
"KIX Notifications” kix@your.example.com). You can use the KIX_CONFIG_FQDN variable as set in your configuation, or choose another email address.
y

Vi

Default Value: ®  kix@<KIX_CONFIG_FQDN> >

Value: @  kix@yourhost.example.com

* validity: ® valid

Fig.: The Key for Default Sender Address
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* Name: @

Description: @

Value: @

Default value: @

* validity: @

MotificationSenderName
¢ ®
NotificationSenderName

Specifies the name that should be used by the application when sending notifications. The sender name is used to build the complete display name for the notification master (i.e. "KIX
Notifications" kix@your.example.com).

A
KIX Notifications

A
KIX Notifications

y

valid

Fig.: The Default Sender Name

*Name: @  FQDN
Description: @  Defines the fully qualified domain name of the system. This setting is used as a variable, KIX_CONFIG_FQDN which is found in all forms of
messaging used by the application, to build links to the tickets within your system.

Y

* Validity: @ valid

Value: @ hostname.example.com
A
Default Value: @  yourhost.example.com

Y

Fig.: The Key for Domain
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8.2.4 Notification Template

The layout for ticket notifications is provided by the standard template supplied with KIX. You can adapt this
standard template individually in order to achieve a uniform appearance for your corporate communication.
Afterwards, ticket notifications will be sent in the layout you have configured.

The standard template can be found in the Automation> Layout Notifications menu. The displayed HTML
source code forms the layout of the ticket notifications. You can change the text and style information. To do
this, you need knowledge of HTML and CSS. You will find good help at https://www.selfhtml.org (German
Website). Our support team will be happy to help you design the notification layout. For easier editing, you
can copy the source code into an HTML editor (e.g. Notepad ++).

+ Contents between <style> and </style> define the formatting of the individual elements on
the page, such as page background, header and footer of the mail, display of headings and links, etc.

+ Contents between <body> and </body> form the page content. The page content is grouped in
individual containers. These containers are formed with <div> [...] </div>.

+ Contents between <! - and -> are comments. These notes are for your information and are not
taken into account in the e-mail display. If you want, you can safely remove them.

+ You should not change the lines [% Data.Subject | html%] and [% Data.Body [....]

%] . These are the HTML placeholders for the email subject and the content of the email.

Click on "Preview" to check the configuration you have changed before saving.

Lorem ipsum dolor sit amet

Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore et dolore magna aliquyam erat,

sed diam voluptua. At vero eos et accusam et justo duo dolores et ea rebum. Stet clita kasd gubergren,

no sea takimata sanctus est Lorem ipsum dolor sit amet. Lorem ipsum dolor sit amet, consetetur sadipscing elitr, sed diam nonumy eirmod tempor invidunt ut labore
et dolore magna aliquyam erat,

sed diam voluptua. At vero eos et accusam et justo duo dolores et ea rebum. Stet clita kasd gubergren, no sea takimata sanctus est Lorem ipsum dolor sit amet.

Lorem ipsum dolor sit amet,

consetetur sadipscing elitr,

sed diam nonumy eirmod tempor invidunt
ut labore et dolore magna aliquyam

Fig .: Example of an HTML template

The following source code defines the initial standard template. With this you can replace your own template
if necessary and thus restore the starting point.
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<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/

xhtml1/DTD/xhtmll-transitional.dtd">
<html>
<head>

<style type="text/css'">

body {
width: 100%;
margin: 5px;
padding: Opx;
background-color: #efefef;

}

.bodyContent,

.bodyContent * {
color: #323232;
font-family: Arial;
font-size: 13px;
line-height: 150%;
text-align: left;

.bodyContent a:link,
.bodyContent a:visited,
.footerContent div a:link,
.footerContent div a:visited {
color: #1491D2;
font-weight: normal;
text-decoration: none

#templateFooter {
background-color: #FFFFFF;
border-top: 0Opx;

1

.footerContent div {
color: #707070;
font-family: Arial;
font-size: 13px;
line-height: 125%;
text-align: left;

#links {
background-color: #FAFAFA;
border: 0;
color: #008DD2
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}

links div {

text-align: center;

.bodyContent a {
color: #008DD2;

}

.bodyContent
.bodyContent
.bodyContent
.bodyContent
.bodyContent
.bodyContent
color: #04537D;
display: block;
font-weight: bold;
line-height: 100%;

}

margin-top:

hi,
h2,
h3,
ha,
hs,
he {

Opx;

margin-right: Opx;

margin-bottom: 5px;

margin-left: 0Opx;

bodyContent
font-size:

.bodyContent
.bodyContent
.bodyContent
.bodyContent
.bodyContent

}

margin-top:
margin-bottom: 5px;

hl {
26px;

h2,
h3,
h4,
h5,
he {
5px;

.bodyContent h2 {

}

}

}

}

font-size:

bodyContent
font-size:

bodyContent
font-size:

bodyContent
font-size:

22px;

h3 {
18px;

h4 {
16px;

h5 {
12px;
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.bodyContent h6 {
font-size: 12px;

}

.notifyHeader {
background: #04537D;
border-radius: 20px 20px Opx 0Opx;
padding: 20px;
line-height: 120%;
color: #ffffff;
margin: Opx;
font-family: Arial;
font-size: 18px;
font-weight: bold;
text-align: center;

}

</style>
</head>

<body>
<center>
<div id="templateBody" style="padding:0.5em;width:95%">

<div valign="top" class="notifyHeader">

<!-- THIS IS WHERE THE NOTIFICATION SUBJECT IS PUT -->

[% Data.Subject | html %]

<!-- EO THIS IS WHERE THE NOTIFICATION SUBJECT IS PUT -->
</div>

<div valign="top" class="bodyContent" style="background-color: #ffffff; padding:
15px; font-size: 13px;">

<!-=- THIS IS WHERE THE NOTIFICATION BODY IS PUT -->

% Data.Body

.replace('<p>', '<div>"')

.replace('</p>"', '</div>")

.replace('<div\s+type="cite"[A>]*>', '<div type="cite" style="background:
#f5f5f5; border: 1lpx solid #e0eQe® !important; color: #555; margin: 10px Opx Opx 0Opx;
padding: 10px;">")

.replace('border:none;border-
left:solid\s+blue\s+1l.5pt;padding:0cm\s+0cm\s+0cm\s+4.0pt', 'border: none; border-
left: 1px solid #f92 !dimportant; color: #555; margin: 10px 5px 10px Opx; padding: Opx
10px; ")

%]

<!-- EO THIS IS WHERE THE NOTIFICATION BODY IS PUT -->

</div>
</div>
</center>
</body>

</html>
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9 Communication

The menu Communication enables you to maintain and manage the communication channels for KIX.

Email

In the menu Communication > Email you can configure the incoming and outgoing of emails. Sending
and receiving emails are configured separately in the submenus Outbox (see page 219) and Inbox (see page
201) . Inbox and Outbox can alternatively be set up in the Setup Assistant directly after the installation of
KIX.

Under Email Addresses (see page 228) you create the system addresses. These are the sender addresses
for emails sent by the teams and are used to distribute incoming emails to the respective team.

Via Email Filter (see page 231), incoming emails can be distributed to the respective teams according to
filter conditions and created as tickets there. In the process, ticket information such as status or priority
can be automatically entered.

Webform

The menu Communication > Webform enables you to generate web forms (see page 253) that you can
integrate into your website. Your customers can then use these web forms to submit ticket-related
information such as error reports. These reports are created as new tickets in KIX.
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9.1 Email

One of the main tasks of KIX is the management of incoming and outgoing communication, e.g. emails.
Setting up email communication including distribution in the system is done in the menu Communication >
Email.

KIX distinguishes between incoming and outgoing mail. Both are configured separately from each other. The
inbox receives - like a house mailbox - all incoming emails. KIX empties this "house mailbox" and distributes
the emails to the respective teams according to the given configuration. There, they are either created as
new tickets - or in the case of replies - as a new item on the ticket. All outgoing emails are sent by KIX via the
outbox - like via a mailbox.

Alternatively, the communication channels can also be set up in the setup assistant (see page 58) directly after
installation. The setup assistant guides you through setting up your inbox and outbox.

Inbox

In order for KIX to receive emails, you must set up one or more email accounts in KIX. The setup is done
either in the setup assistant or in the Inbox submenu. KIX retrieves these email accounts at regular
intervals and creates new tickets in the assigned team folders from the emails retrieved. You can
specify how the distribution is to be carried out separately for each email account.

Email filter

Email filters (postmaster filters) are used for the granular distribution of incoming emails based on mail
header information. You can use them to process incoming emails in a targeted manner and distribute
them to specific teams, for example, based on their sender or subject. A typical example of this is
sorting out spam emails into the junk folder. The distribution of the inbox by means of email filters
takes place independently of the set standard and thus has priority over the standard distribution.

Email address

In the submenu "Email addresses” you set up the system addresses. These are the email addresses through
which the teams communicate with the outside world. Each team usually has its own email address, e.g.
support@mustermann-gmbh.de.

First create the required email addresses and then assign the addresses to the respective teams in the menu
"Ticket > Teams". Each email address must match an incoming mail account configured in KIX or be
retrieved from a collective mailbox.

Outbox

In order for KIX to be able to send emails, you need to set up an mail server. The setup is done either in
the setup assistant or in the outbox submenu. All outgoing emails are sent through this server.

The sender / reply address of an outgoing email is always the address that is stored on the team from
which the email was sent.
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9.1.1 Inbox

The inbox in KIX is automated by the regular retrieval of email mailboxes. In order for KIX to know which
mailboxes are to be retrieved, you must set up one or more email accounts in KIX. Retrieval can be from
POP3 or IMAP accounts - both encrypted and unencrypted.

The initial setup of the inbox is done in the Setup Assistant (see page 58) . You can add and edit further email
accounts in the menu "Communication > Email > Inbox".

The retrieved emails are created in the teams either as new tickets or as articles on an existing ticket. You
can define how the distribution is to take place separately for each email account. If the incoming emails are
to be distributed specifically on the basis of email headers, e.g. according to certain senders or keywords in
the subject, you can configure this via email filters (see page 231) (menu "Communication > Email > Email
Filters").
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9.1.1.1 Create or edit an email account
Menu KIX > Communication > Email > Inbox

You can create and manage email accounts for receiving incoming emails. KIX automatically retrieves these
email accounts at regular intervals. The retrieved emails are created as new tickets or new articles in the
respective teams. The distribution to the teams is done according to the option selected in the "Distribution”
field or the configured email filters. Each email account can be configured separately.

© Important!

Regardless of the account type, all emails are retrieved from the mail server and deleted. If this is
not desired, you must make the appropriate settings for this directly on the mail server. There is no
possibility to leave emails on an account. Please note this especially if you want to test KIX!

Have the following information ready:

+ Login information for the incoming mail server:
+ Login name of the email account
+ Password of the email account
+ Email server pickup location (host:port)
+ collection method with or without encryption (e.g. "IMAP" or "IMAPTLS")
+ for IMAP: directory where the incoming emails are stored (usually "INBOX")

To create a new email account, proceed as follows:

1. In explorer, navigate to Communication > Email > Inbox. In the content area, a table listing all email
accounts saved in the system opens.

2. Intable, click "New Account". A form dialog for creating the email account opens.

3. Complete form, assign account to team under "Dispatching", and set validity to "valid".

4. Click "Save" to save your entries.

The email account has now been created and the inbound emails will be created as tickets in the
assigned team. If required, you can specify the distribution of the emails more precisely under
Communication > Email > Email Filter.

After the setup, you can check the correctness of the data. To do this, click on "Retrieve now". If the retrieval
fails, you will receive a notification message.

To edit an email account, proceed as follows:

1. In explorer, navigate to Communication > Email > Inbox. In the content area, a table listing all email
accounts saved in the system opens.

2. Intable, click email account to be edited. The zoom view opens.

3. Click "Edit" in title bar of opened zoom view. A form dialog for editing the email account opens.
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Amend information as required and set validity to "valid". The changes take effect immediately.
To delete an email account, proceed as follows:

1. Inexplorer, navigate to Communication > Email > Inbox. In the content area, a table listing all email
accounts saved in the system opens.
2. Place a tick in front of the email account to be deleted. You can select several accounts as well.
The delete button is only active if at least one account is selected.
3. Click on "Delete" in the table header. The button is only active if at least one email address is selected.
4. Answer the security question with:
1. "Yes": The email account will be removed from the system. Afterwards, KIX cannot retrieve any
emails from this account.
2. "No": The email account is not deleted and remains ticked.

The form dialog contains the following input fields, among others:

Field (selection) Description
User name The email account whose inbox you would like to retrieve emails
from.

For example: info@mailbox.org
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Field (selection) Description

Type Transmission protocol for email retrieval.
The selected protocol specifies the retrieval method. If necessary,
find out about the differences between POP3 and IMAP beforehand.

Supported protocols:

Without encryption: IMAP | POP3
+ with SSL encryption: IMAPS | POP3S
+ with TLS encryption: IMAPTLS | POP3TLS
« for OAuth2 profiles: IMAPS_OAuth2 | IMAPTLS_OAuth2 |
POP3S_0OAuth2 | POP3TLS_OAuth2
Notes:
Outlook.de™® currently only supports IMAPS_OAuth2
Currently, POP3 SSL/TLS (POP3S) support with OAuth2
authentication is required to connect Office365
mailboxes (see: https://support.nhs.net/2023/08/
microsoft-365-alert-service-degradation-exchange-online-
some-users-may-be-unable-to-access-their-mailbox-
using-the-imap4-connection-method-within-exchange-
online/).

Recommendation: First test IMAP or POP3 without encryption. If the
wrong option is selected, authentication will fail. A corresponding
message is displayed.

Password The password that gives you access to the email account.

IMAP Folder Directory in which the incoming emails are located on the server.
From this directory KIX fetches the incoming emails (usually the
folder "INBOX" or "Inbox").

This option is only available if the retrieval is done from an IMAP
account.

Host Address for the incoming mail server pickup interface.
Usually there is a separate host URL for each pickup method: e.g.:
pop.mailbox.org or imap.mailbox.org
A special port can be specified as well (Host:Port).

10 http://Outlook.de
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Accept KIX Header
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Description

If enabled, information from the KIX email headers is applied (e.g.
ticket type, team, priority, etc.).

The email header is accepted, evaluated and the information it
contains is processed, regardless of what is configured in the email
account.

If not enabled: The email header is discarded when the emails are
received and remains unconsidered.

Please note: The emails sent via KIX can be provided with a KIX
header. If necessary, you can read these and use them for actions
based on them.

But: Under certain circumstances, the header information supplied
by KIX may contradict the email handling you have specified and
lead to undesired actions or system errors!

! Therefore, activate this option only if you trust the KIX header
(e.g. from other KIX systems) and know from which senders the
retrieved messages originate.
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Field (selection) Description
Dispatching Select the principle according to which the retrieved emails are to be
distributed:

+ Default Queue (SysConfig)

+ The retrieved emails are distributed to the Postmaster
default team (Default Queue). This is the team that is
stored in the SysConfig key "PostmasterDefaultQueue".
In the delivery state, the default team is "Service Desk".
You can specify a different team in the SysConfig key.

+ Recipient addresses (To, CC, etc.)

+ The distribution of retrieved emails is based on the email
recipient.

+ If the recipient address is created as an email
address in the system, the ticket will be created in
the team that is stored at this system address.

+ If the address is unknown or the email cannot be
assigned to a team, the ticket will be created in
the Postmaster default team.

+ Team

+ If this option is selected, you can specify a team in which
the collected emails will be created as new tickets.

+ All teams created in the system are available for
selection. Teams in light grey are (temporarily) invalid.
They are listed but cannot be selected.

Further information on distribution: see Notes on email
distribution (see page 207)

Validity + valid: The emails will be retrieved and distributed to the assigned
team.

+ invalid/invalid-temporarily: The inbox of the email account will
not (or no longer) be retrieved, meaning no (further) emails will
be received from it. Any emails that have already been retrieved
have been saved as tickets in the system and can be processed.
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KIX checks the content of incoming
emails for known information such
as ticket number and message ID.
Based on this information, KIX
determines whether a new ticket or -
in the case of a reply (follow-up) - an
article is to be created on an existing
ticket.

The search for a possible follow-up
is carried out across all teams. If a
follow-up exists, a new article is
created on the corresponding,

KIX 18 Admin Manual - EN - KIX Start
Communication
Email

Content on this page:

+ Identifying possible follow-ups (see page 207)
+ Extended check for follow-ups (see page 209)
+ Processing of follow-ups (see page 212)
« Email distribution (see page 214)
+ Default Queue (SysConfig) (see page 215)
* Team (see page 215)
+ Recipient addresses (To, CC, etc.) (see page 216)

already existing ticket. If no follow-up is detected, a new ticket is created based on the distribution set on the

account (see below).

Identifying possible follow-ups

Menu

KIX > System > SysConfig

In KIX, the modules listed below check incoming emails for possible follow-ups. If necessary, you can
deactivate/activate the modules and thus determine which email contents are to be checked.

Modul

PostMaster::CheckFollowUpModul
e###0100-Subject

Description

Look for a valid ticket number in the
subject of the email.

Standard

active/valid

The ticket number must always be
preceded by the configured TicketHook
and the TicketHookDivider.

Default is: "Ticket#..."

Must be active so that the ticket number
added in the subject, determined using an
external reference, can be recognised as a
follow-up.
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Modul Description Standard

PostMaster::CheckFollowUpModul  Searches in the "Reply-To" or References active/valid

e###0200-References header for the message ID, which is

stored, for example, in an article of the

system.
PostMaster::CheckFollowUpModul  Searches for a valid ticket number in the inactive/invalid
e###0300-Body email text (body).
PostMaster::CheckFollowUpModul = Searches the content of email inactive/invalid
e###0400-Attachments attachments for a valid ticket number.
PostMaster::CheckFollowUpModul = Searches the raw data (source) of emails inactive/invalid
e###0500-RawEmail for a valid ticket number.

You can define in the module parameters how the respective module is to proceed when a follow-up has
been detected:

+ OnlyFirstMatch:
« if set (1): If several follow-up tickets were detected, only the first ticket is used.
« if not set (0): If multiple follow-up tickets were detected, the email of each detected follow-up
is processed accordingly.
+ StopAfterMatch:
« if set (1): No further call of subsequent modules will be made once a possible follow-up has
been detected by the current module.
+ if not set (0): The next registered module is always called and its detected follow-ups are
added to the list.
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5

SysConfig |
‘PostMaster:CheckFollowUpModules# . <
Process alphanumerically sorted |

~
PostMaster:: Fﬂuwu'lgchm; ‘References 1 PostMaster: FollowUpCheck:: Attachments
PostMaster: FollowUpCheck::Subject PostMaster.:FollowUpCheck: Body PostMaster::F JpCheck::R;

etect possible tickel etect possible tickel
numbers of the numbers ofthe
s

Recognise possible

ticket numbers of the

system in the email
subject

Search for message |IDs from headers
'References’ and 'In-Reply-To" in existing
tickets and enter the corresponding ticket

numbers.

Recognise possible

ticket numbers ofthe

system in the email
text

)

ystem in attachment system in the email
contents source text

Check for possible FollowUps

No

Add all hits to the
result

Add only the first hit to
the result

Yes

nother module
registered?

o e
N
Fig.: Flow chart of the audit according to possible follow-ups
Extended check for follow-ups
Configuration key PostMaster::PreFilterModule###888-ExtendedFollowUp

KIX is delivered with the SysConfig key PostMaster::PreFilterModule###888-ExtendedFollowUp activated by
default. This filter makes it possible to read external identifiers (e.g. the ticket number) in incoming emails
and assign possible follow-ups based on these.

Example: Identifier = 'Sender_A'".

An email is read in that comes from the sender "info@example.de". The subject is "[SMPL::#12345] New
enquiry". The filter recognises from the sender that "Sender_A" is to be used and recognises the external
reference with the number "12345" (-~ ExtendedFollowUp###SenderEmail and
ExtendedFollowUp###ExternalReference).

The recognised number is used to look for a matching ticket in the "ExternalReferenceNumber" dynamic
field. It is also noted that the recognised external reference should be stored in the
"ExternalReferenceNumber" dynamic field, regardless of whether a new ticket is created or another
mechanism recognises a follow-up (- ExtendedFollowUp###DynamicFieldMapping).
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If another email comes from a suitable sender (e.g. from "info@example.de" or "support@example.de")
with the subject "[SMPL::#12345] Request’, KIX recognises the number again and the previously created
ticket is found during the search. In this case, the PostMaster::PreFilterModule###888-
ExtendedFollowUp filter adds the KIX ticket number to the subject.

This allows the "PostMaster::CheckFollowUpModule###0100-Subject" module to recognise the follow-up and
assign the email to the existing ticket.

Configuration key  Description Example

ExtendedFollowUp  Registers (initialises) an identifier for {

###|dentifier use in the SysConfig keys listed below. "10": "Sender_A",
The filter configurations are processed "20": "Sender_B",
according to the keys specified here. "AT11":

Specify a key-value pair: "capeProcessCPNID"
+ Key: Used for alphanumeric sorting ¥
of the filter configurations to be
applied.
+ Value: Is used as the key for the
assignment in the configuration
keys listed below.
ExtendedFollowUp Checks the sender of the incoming e- {
###SenderEmail mail for the specified e-mail domains. "capeProcessCPNID": ".

Specify a key-value pair:

+ Key: Must be one of the identifiers
initialised in
ExtendedFollowUp###ldentifier.

+ Value: Email address or regular
expression as sender, which must
match the "From" of the imported
email.
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Configuration key  Description Example
ExtendedFollowUp  Checks the e-mail subject for the {
###ExternalRefere  specified regular expressions. "CapeProcessCPNID" :
nce Recognises whether one of the Mg ([0-97{6}) 44"

specified references is specified in the " "’\\ [SMPL: :#(.)

enaer . .. .
subject. -
) . \\ 1",
Specify a key-value pair: nSender_B": "\\[T#(.)]"
+ Key: Must be one of the identifiers 1

initialised in
ExtendedFollowUp###ldentifier.

+ Value: Must be a regular expression
that captures the external reference
in the subject. The first
CaptureGroup of the expression is
used as the external reference.

ExtendedFollowUp  Checks for an already noted referencein = {

###DynamicField  the specified dynamic fields and writes "CapeProcessCPNID" :
Mapping the reference found in this field. nCPNID™
)
Specify a key-value pair: "Sender_A":

- Key: Must be one of the identifiers "ExternalReferenceNumber",
initialised in "Sender_B":
EXtendedFO”OWUp###Idenﬁﬁer. "CustomerReferenceNumber"

+ Value: The name of the dynamic }
field.

ExtendedFollowUp  General configuration. Up | Down
###SortByAgeOrd

Sorts the tickets found by age and
controls whether the assignment is in
ascending (Up) or descending (Down)
order.

er

The external reference can be stored on
several tickets. By selecting the sorting,
you can determine whether the follow-
up is assigned to the oldest (Down) or
youngest (Up) ticket.
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Configuration key  Description Example

ExtendedFollowUp  General configuration. 0| 1
###AllTicketState

Specify which types of follow-up tickets
Typesincluded

should be taken into account.

« First viewable tickets (0): Attempts
the assignment first to tickets that
correspond to the status types
specified in the SysConfig key
Ticket::ViewableStateType. If no
such ticket is found, other status
types are also taken into account
(e.g. "closed").

+ Alltickets (1): Considers all tickets
without restriction of the status

type.

@ Info

If "SenderEmail”, "ExternalReference" or "DynamicFieldMapping" is not specified for an identifier, no
processing takes place.

& Please note!

The filter does not overwrite any references already stored in the ticket. Based on the external
reference, the subject is extended by the ticket number including the hook of the ticket with a
matching reference.

The SysConfig key PostMaster::CheckFollowUpModule###0100-Subject must therefore be active
(valid).

Processing of follow-ups
Follow-ups are processed in the order in which they were detected.

1. Check whether the follow-up ticket already contains an article with the message ID of the email just
read in.
1. Yes: No further processing (no article, no ticket, no header evaluation). However, the
postmaster evaluates it as: "Processing as follow-up".
2. No: Continue with 2.
2. Check if follow-up ticket is closed
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If the ticket is not closed, or if the relevant team has the option "Follow Up on Tickets" set to
"possible”, then:
a. afollow-up item is created
b. the follow-up header is processed
c. automatic mechanisms for ticket lock and ticket status take effect.
If the option "Follow Up on Tickets" is set to "reject" at the relevant team, then:
a. the article is deposited
b. the follow-up headers are not processed
c. no automatisms will take effect.
If the option "Follow Up on Tickets" is set to "new ticket" on the relevant team, then:
a. the email is distributed as a new ticket at this point and then linked to the follow-up
ticket.
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Processing the FollowUps
in the order in which they
were detected

SkipTicketlDs Does the

FollowUp contains the
Message-ID

ollowUp Ticke
Team "Follow Up
on tickets'

Processing of possible follow-ups

Yes

i [
reject

v .

\
new ficket

Create FollowUp

Ll

Create Reject

Create a new ticket

Ll

| |

|

v

Fig.: Scheme of processing of follow-ups

Email distribution

Menii

KIX > Communication > Email > Inbox

When creating or editing an email account, you can select the type of distribution. The type of distribution
determines how KIX should proceed with the emails retrieved from the account if

+ no follow-up was found

+ afollow-up goes to an already closed ticket and the option "new ticket" is set in its team configuration

under "Follow Up on Tickets".
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With your selection, you determine in which team the emails are created as new tickets. However, if the
message ID exists in a ticket in a team, no new ticket will be created.
You can define the distribution separately for each email account.
New Mail Account
* User Name: @  support@mailbox.org
* Type: @ IMAP S

*Password: @ eeesesessese

IMAP Folder: @  INBOX

]

* Host: imap.mailbox.og

@

]

Accept KIX Header:

®

* Dispatching:

recipient adresses (To, Cc, etc.)

Default Queue (SysConfig)

@

Comment:
recipient adresses (To, Cc, etc.)

Team

* Validity: @ valid
Fig.: Selecting the distribution of incoming emails

@ Infos

+ Configured email filters override the default behaviour. They have priority over the default.
+ If the email header 'X-KIX-Queue' is set with a valid team, the ticket is created in the specified
team and thus independent of the distribution configuration.

Default Queue (SysConfig)

The emails retrieved from the email account are distributed to the default team. The default team is the team
that is stored in the SysConfig key "PostmasterDefaultQueue”. In the delivery state, this is the "Service Desk"
team. You can define a different team in the SysConfig key.

Team

A new ticket is created in the team that is stored in the mail account.
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Recipient addresses (To, CC, etc.)

The emails retrieved from the email account are distributed according to the email recipient. KIX compares
the recipient list of the retrieved emails with the email addresses (system addresses) created in the system
(see "Evaluation of the mail headers").

If one of the recipient addresses exists as a system address in KIX and a team is stored at this address, the
incoming mail will be created as a ticket in this team. If no team is stored at any relevant system address, the
new ticket will be created in the postmaster default team (default queue).

B Edit Mail Account

* UserMame: T info@maibon.arg

AP Fald INBC
Host: T imap.mailbocorg
Recept KX beader: 7 @0 B Cdit Email Address
* Dispatehing: 7 roclplent adresses [Te. Cc, 462 * Email Address: © sy

" Display Name: @ suppe

*Validity: & o Tear

* Sander Address (Email): 7

Fig.: Scheme of mail distribution according to recipient addresses

The system addresses are created and managed in the menu "Communication > Email > Email addresses".
You can specify a team at each system address. In this team, all incoming emails to the system address are
created as new tickets if "Recipient addresses" is selected as the distribution option in the email account.

& Note

The system does not ensure that the assignment of system address and team matches the system
address stored on the team.
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(@ Notes

If several system addresses exist which refer to the same address, the entry with the lowest ID is
always evaluated for the team assignment.
! We advise against using several system addresses with the same email address.

Evaluation of the mail headers

KIX compares the recipient list of the retrieved emails with the email addresses created in the system
(system addresses). The mail headers listed below are checked and the recipients evaluated.

+ The first header recipient for which a system address with an assigned valid team is found
determines the team in which the ticket is created.

+ If no valid team was found for the recipient, the next header is checked in the same way.

+ If no team was found after all checks, the ticket will be created in the postmaster default team
(default queue).

+ If several email addresses are specified as recipients, the check is carried out for each of these email
addresses in turn.

The mail headers are checked in the specified order:

Resent-To
Envelope-To
To

Cc
Delivered-To
X-Original-To

o s~

Example

The system addresses "projects@kixdesk.com" (without team assignment) and "sales@kixdesk.com" (with
team "Sales") are configured in the system. Postmaster default team is "Projects".

Email to (To) Copy to (Cc): New ticket inteam  Description

no- - Projects No system address available,

systemaddress@doma therefore new ticket in the

in.com standard team "Projects”.

projects@kixdesk.com - Projects No team assignment at system
address,

therefore new ticket in the
standard team "Projects”.
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Email to (To)

sales@kixdesk.com

no-
systemaddress@doma
in.com

sales@kixdesk.com

projects@kixdesk.com

Copy to (Cc):

projects@kixdesk.co
m

projects@kixdesk.co
m

sales@kixdesk.com

New ticket in team

Sales

Projects

Sales

Sales
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Description

Team assignment exists at
system address,

therefore new ticket in team
"Sales".

No system address available for
‘To' and no team stored for 'Cc,
therefore new ticket in the
standard team "Projects”.

Team assignment exists at
system address ('To') and team
is stored at this address,
therefore new ticket in team
"Sales"-

The first hit wins; the check of
the 'Cc' is therefore omitted.

No team assignment available
at system address ('To'),
therefore check next address
(Cc).

Team assignment at 'Cc'
available (= first hit),

therefore new ticket in team
"Sales".
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9.1.2 Outbox

In order for KIX to be able to send emails, you need to set up an SMTP mail server for outgoing mail. The
setup is done either in the setup assistant or in the Communication > Email > Outbox menu. You can change
the mail server at any time, for example after changing the hosting service provider.

You need the system rights READ and UPDATE on / system / config to set up the outgoing mail server.

£, Communication: Email: Outbox
Type o

* Type: @ SMTP
Host: @  smtp.gmail.com
Port: @ 587

6

User: @  john.smith@gmail.com

)

Password: @ 000000000000 00

Envelope o

Envelope From: @
Motification Envelope From: @

Notification Envelope From Fallb...: @

Save

Fig .: Example outgoing mail via Gmail
Have the following information ready:
Credentials for the outgoing mail server:

+ Host of the SMTP server
+ the transmission protocol used including the port used
+ User data and password for the SMTP server

If you use the mail server of a service provider (Gmail, IONQS, Strato etc.), you will receive the necessary
login information from them. If you use your own mail server, you should know the login information.
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How to configure the SMTP mail server for outgoing mail:

1. Navigate to the Communication > Email > Outbox menu. A dialog opens in which you can configure
the outgoing mail server.

2. Enter the server information in the corresponding input fields (see table below).

3. Finally save your entries.

The outgoing mail server is now configured so that KIX can use it to send emails.

The form dialog contains, among other things. the following input fields:

Id

Type

Host

Port

User

Password

Description

Transmission protocol for sending emails (SMTP).
With the selected protocol you determine the transmission method. If necessary, you can
obtain detailed information from your web host.

Supported protocols:

« without encryption: SMTP
+ with SSL encryption: SMTPS
+ with TLS encryption: SMTPTLS

Recommendation: First test SMTP without encryption.

Note: The "DoNotSendEmail" option does not send emails, it can be used for test
systems.

Address to the SMTP interface of the outgoing mail server, e.g. "smtp.mailbox.org"

Port via which the emails with the previously selected "Type" are sent. The port depends
on the selected transmission protocol:

+ SMTP: 25
+ SMTPS: 465
+ SMTPTLS: 587

Username for logging into the outgoing mail server. This often corresponds to the name
of the email account. For example: mustermann@example.de This value can also be
cleared via port 25.

The password of the email account. This value can also be cleared via port 25.
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Description

You can put your outgoing emails in an "envelope" (optional). Only what is written on the
"envelope" can then be recognized by the mail transport.

Envelope from: You can specify a sender who should appear on the "envelope’, e.g.
senders@example.de or mbox / RFC 5321. If no sender is specified, the team's email
address is used as the sender.

Notification Envelope from: You can enter an email address that will be used as the
sender header in outgoing notifications. If no address is given, the header of the
"envelope" is empty.

Notification Envelope from Fallback: If "NotificationEnvelopeFrom" is not specified, this
setting allows you to use the sender address instead of a blank envelope sender (required
in certain mail server configurations).
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9.1.2.1 Configuring the Email Dispatch (SysConfig)
Configuration key: *sendmail*

You can optionally configure the outgoing mail server using the configuration key in the SysConfig menu.
This option is useful if you want to configure server properties that go beyond the initial setup, or if you have
your own mail server and want to directly influence the configuration.

To change a configuration key:

1. Navigate to the System> SysConfig menu.

2. Look for the key "* sendmail *". You will be shown several keys for the mail server configuration.
Grayed out keys are "invalid" and can be set to "valid" if necessary.
Keys with a lock icon are blocked for editing.
Keys marked in orange are security-relevant keys set to "valid".

3. Click on the key to be configured. A form dialog opens in which you can edit the value of the key. The
specific settings depend on the mail server used.

4. Change the value of the key as necessary. If you are using a JSON editor, make sure that all spaces
and line breaks are removed before saving.

5. Save your changes with "Save". The key has now been changed.

The keys listed below are required to configure the sending of emails. Additional Sendmail keys can

optionally be used.

Configuration key Description Example

SendmailModule For specifying which transfer protocol Kernel::System::Email::SMTPS
should be used
(e.g. SMTP | SMTPS | TLS).

SendmailModule::AuthPass  For saving the password of the email My1stMallservErPassWO0rd
word server.

SendmailModule::AuthUser For saving the username for logging in  email@example.com
to the email server.
This is often the name of the email
account.

SendmailModule::Host Enter the address of the email server. smtp.hoster.com
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Example

SendmailModule::Port Enter the port of the email server. The The following ports are
port depends on the selected transfer commonly used:

protocol.

For SMTP: 465
For TLS: 587

Optionally, you can put your outgoing emails in an "envelope”. Only what is written on the "envelope" can then
be recognized by the mail transport. You can use the following keys for an "envelope":

Configuration key

SendmailEnvelopeFrom

SendmailNotificationEnvelopeFrom

SendmailNotificationEnvelopeFromFallback
ToEmailFrom

Description

You can specify a sender who should appear on the
"envelope’, e.g. senders@example.de or mbox / RFC 5321.
If no sender is specified, the team's email address is used
as the sender.

You can enter an email address that will be used as the
sender header in outgoing notifications. If no address is
given, the header of the "envelope" is empty.

If "NotificationEnvelopeFrom" is not specified, this setting
allows you to use the sender address instead of a blank
envelope sender (required in certain mail server
configurations).
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9.1.2.2 Set default addresses

KIX requires at least one valid email address as the default address for outgoing mail. All emails are sent via
this address if no other email addresses have been created or if sending from an email address is not
possible, e.g. because it is set to "invalid".

The initial default email address for the outbox is kix@localhost. Replace this with your own email address!
This can be done directly after the installation in the setup assistant (see page 58) (step "Outbox"):

Motification Envelope From Fallb...: @

System Address

* Email Address: @ | kix@localhost

* Display Name: @  KIX System

Abb.: Changing standard system address in setup assistent

Or navigate to the menu Communication > Email > Email Addresses. There, click on the address
"kix@localhost" and then on "Edit". In the dialog that opens, replace the address specified in the "Email
address" field with your own default address. Note that the email address must match an email account
known in KIX.

= Edit Email Address

* Email Address: @  support@example.arg
* Display Name: @  Support

Comment: ®  Email address for support team

* Validity: @ valid

I I Cancel | v Save

Abb.: Changing standard address in the Email > Addresses menu

Use a placeholder for the domain

You can use a placeholder (see page 750) for the domain name in the default address (<KIX_CONFIG_FQDN>),
then the domain is automatically pulled by the system. Precondition: the complete domain name to the
frontend must be specified in the SysConfig key "FQDN". The FQDN can already be set in the Setup Assistant
under "System".
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* Name:

Description:

* Validity:
Value:

Default Value:

FQDN

Defines the fully qualified domain name of the system. This setting is used as a variable, KIX_CONFIG_FQDN which is found in all forms of
messaging used by the application, to build links to the tickets within your system.

Vi
valid
hostname.example.com
Vi
yourhost.example.com
Vi

Fig.: Changing domain name

P
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Below you will find possible solutions to known problems when sending emails:

Problem

The sent email contains the
FQDN of the KIX18 system in
the MessagelD.

(By default this is
"yourhost.example.com").

1. Ticket notifications do
not go out.

2. Intheitem list, ared
triangle is displayed in
the "Channel" column.

Cause

Outgoing emails from Applicance
Hornet security were blocked:

"Reporting-MTA: dns; mout-
b-203.mailbox.org X-Postfix-Queue-ID:
4CqzHG1CwVzQljX X-Postfix-Sender:
rfc822; Arrival-Date: Tue, 8 Dec 2020
12:59:06 +0100 (CET) Final-Recipient:
rfc822; Original-Recipient: rfc822;
Action: failed Status: 5.6.1 Remote-
MTA: dns; mx14a.antispameurope.com
Diagnostic-Code: smtp; 554 5.6.1 Your
mailheader contains SPAM. To unblock
visit http://antispameurope.com/
unblock?
a=08128b=&d=18e=195.10.208.52-mx-
gate64-hz1"

The log contains the following error
message:

"[Error]
[Kernel::System::Email::SMTP::Send]
[152] Can't send to
‘'empfaenger@company.de’: 5535.7.1
<absender@company.de>: Sender
address rejected: not owned by user
company@kix.cloud"

Issued on: 26.02.2024

Solution

After adjusting the FQDN, the
emails are sent without any
problems (SysConfig key:
"FQDN")

Check and adjust sender email
in the team settings (e.g.:
Team "Service Desk"):

Incorrect:
"sender@company.de” (no
processing possible).
Correct:
"company@kix.cloud"
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Problem

Ticket notifications do not go
out

Cause

1.

The log contains the following
error message:

"[Error]
[Kernel::System::Email::SMTP::Send
][173] Can't send message:
5545.2.0
STOREDRV.Submission.Exception:
SendAsDeniedException.MapiExce
ptionSendAsDenied; Failed to
process message due to a
permanent exception with
message Cannot submit message."

d

2. Email server rejects notifications.
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Solution

Customization of the sender
address for notifications
required:

SysConfig-Key:
"NotificationSenderEmail"
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9.1.3 Email Addresses

Menu KIX > Comunication > Email > Email Addresses

You can create and manage system addresses for email communication. These addresses are the sender
addresses for the emails sent from the respective teams. They thus identify the sender of an email. In
practice, the email addresses are often named after the associated team. For example,
"support@example.de"” for all emails from the "Support" team.

Each team must be assigned an email address that exists in the system so that it can send emails via this
address. Only one email address can be assigned to a team, but one email address can be assigned to
different teams. The assignment is done when creating or editing a team in the menu "Ticket > Teams". It is
therefore recommended to create the email addresses before creating the teams.

Furthermore, these addresses serve the internal distribution of incoming emails to the respective teams. If a
team is stored at an email address, incoming emails can be forwarded to this team. This depends on the
distribution set in the inbox (see page 201) and the configured email filters (see page 231) .

Each email address must match an email account configured in KIX or be retrieved from a collective mailbox
if replies to this address are to arrive at the KIX tickets.

(@ Note

KIX requires at least one valid email address to send, but can work with multiple addresses. KIX is
delivered with a default address (kix@localhost). We recommend that you replace this with your
own default address during the initial setup (Setup Assistant menu). Alternatively, you can set the
initial default address to "invalid" and create your own default address (Communication > Email >
Email Addresses menu).

9.1.3.1 Creating or Editing an Email Address

Create the required system addresses under "Communication >Email > Email Addresses" and then assign
them to the teams under "Ticket > Teams".
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4| © & Admin:Email addre.. X X = New Email Address X >

= New Email Address
* Email Address: ®  support@example.org

* Display Name: ®  Support

Comment: @  Email address for suppoort team

*validity: @ valid

Fig.: Editing an Email Address for Support Team
To create a new email address, proceed as follows:

1. Inexplorer, navigate to Communication > Email > Email Addresses. In the content area, a table listing
all email addresses saved in the system opens.

2. Intable, click "New Address". A form dialog for creating the email address opens.

3. Complete form, set validity to "valid", and click "Save" to save your entries. The email address has now
been created.

4. You can now navigate to Ticket > Teams and assign the email address to a team so that the team can
use this address as the sender address for emails.

To edit an email address, proceed as follows:

1. Inexplorer, navigate to Communication > Email > Email Addresses. In the content area, a table listing
all email addresses saved in the system opens.

2. Intable, click email address to be edited. The zoom view opens.

3. Click "Edit" in title bar of opened zoom view. A form dialog for editing the email address opens.

4. Amend information as required and set validity to "valid". The changes take effect immediately.

To delete an email address, proceed as follows:

1. Inexplorer, navigate to Communication > Email > Email Addresses. In the content area, a table listing
all email addresses saved in the system opens.
2. Place a tick in front of the email address to be deleted. You can select several addresses as well.
Click on "Delete" in the table header. The button is only active if at least one email address is selected.
4. Answer the security question with:
1. "Yes": The email address is deleted and is no longer available.
2. "No": The email address is not deleted and remains ticked.

w

(@ Notes on deleting email addresses:
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« An email address can only be deleted if it is not assigned to a team. If this is the case, you
will receive an error message. Assign a new email address to the teams concerned

beforehand.

- Email addresses that have already been used remain in the ticket as text after deletion (e.g.
"From" or "To" fields in the article).
+ The delete button is only active if at least one account is selected.

The form dialog contains the following input fields, among others:

Field (selection)

Email Address

Display Name

Team

Validity

Description

Enter valid email address. This is the sender address for a team, e.g.:
support@YourCompany.com

This is the name/identifier for the sender, e.g. "ExampleCompany -
Support”

Optionally select a team to which incoming emails and replies to this
email address are forwarded.

The prerequisite is that "Recipient addresses" is set as the
distribution in the inbox account.

@ On the system side, it is not ensured that this assignment of
system address and team matches the system address stored at the
team. Both settings are independent of each other. This setting
concerns the incoming mail, the email address stored for the team
concerns the outgoing mail.

+ valid: The address is active. This address can be used to
send emails.

+ invalid/invalid-temporarily: In order to send an email, KIX
requires at least 1 sender address. Please therefore ensure that
you have set at least the default address saved in the SysConfig
to "valid".
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9.1.4 Email Filters

Menu KIX > Communication > Email > Email Filters

You can set up email filters (so-called postmaster filters) to distribute incoming emails granularly and
specifically in the system on the basis of predefined filter conditions. The distribution of incoming mail via
email filters is independent of the set standard and thus has priority over the standard distribution.

Email filters manipulate the email header and proceed according to the "if-then" scheme: If an incoming
email has certain properties (filter conditions), then the attributes defined in the filter are written into the
email header. Based on these attributes, KIX can assign ticket properties to the incoming mails and create
them as tickets in the respective team folder.

This way, you can e.g. define that the emails of a certain customer are always given the highest priority and
then created as a ticket in a certain team folder. You can also create a so-called blacklist, for example, by
specifying that emails from certain senders are moved to the junk folder. Other use cases include

+ ignoring automatic replies such as out-of-office notifications
forwarding unsolicited emails to a junk folder
+ setting ticket parameters in incoming mail (e.g. priority high, status new, etc.).

email filters can also be useful if you work with several KIX systems. Then you can, for example, give the
tickets parameters that are evaluated and applied in the receiving KIX system. The receiving KIX system
must accept the KIX header. (Checkbox "Accept KIX header" in the menu "Communication > Email > Inbox").
However, please use this option with caution, as otherwise system errors may occur.

A set up, valid filter looks at all incoming emails in the system, regardless of which email account they come
in from. In doing so, it evaluates the specified filter conditions and writes the attributes and values linked to
the condition back into the header. This happens at the moment the email is retrieved. Only then does KIX
convert the email into a ticket, performs the actions specified in the email filters and then creates the ticket
in the assigned team folder.

@ Info

The application of the email filters is based on their order in KIX. Each email passes through the
email filters in the same order as they are listed in the overview of the email filters. The overview
lists the email filters in alphabetical order by name. You can determine the order yourself if you
name the filter with preceding numbers, e.g. "01_Spamfilter".

9.1.4.1 Zoom view of an email filter

You are able to view the details of an email filter. Navigate to Communication > Email > Email Filter. In the
content area, a table listing all email filters saved in the system opens. In table, click email filter to open
associated zoom view.
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The buttons in the title bar of the zoom view allow you to edit, create and duplicate email filters.
4 2 & Admin:EmailFilter ¥ | & TD-EF-001 1st valid em.. X 1 3
TD-EF-001 1st valid email filter & NewFilter
) Duplicate & Edit
Email Filter Information
Name: TO-EF-001 1st valid email filter Changed at: 09/17/2021, 12:45 PM
Stop after match: Yes
Comment: 1st valid email filter for testing purposes
Validity: valid
Created by: not assigned
Created at: 09/17/2021, 12:45PM
Changed by: not assigned
Filter Conditions (2) -
Email Header & Negate Pattern
From v td-ef-001@example.com
Subject TD-EF-001 1st valid email filter
Email Header « Value
X-KIX-Queue Misc

Fig.: Zoom View of an Email Filter

Alongside the lane containing the general email filter information, the zoom view also contains other lanes:

Lane
Filter Conditions

Set Email Headers

11X

Description

List of filter conditions for setting the email header

List of email headers that will be set.
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KIX > Communication > Email > Email Filters

Once a valid filter has been set up, it will take into account all inbound emails coming into the

system, regardless of the account they came from. This means that emails can be precisely assigned to
specific teams. Inbound emails that match the criteria defined in the email filter will be created as tickets
with the set attributes and moved into the relevant team folders.

Sometimes the configurations of the individual email filters differ only slightly. You can therefore duplicate
existing email filters and configure the duplicate differently.

#¥ New Mail Filter

Email Filter Information

* Name:

Comment: @
* validity: @

Filter Conditions

Set Email Headers

®

email filter chemnitz

Stop after match: @ [

valid

Email Header: @

From

Set Email Header: @

X-KiX-Queue

Negate: @  Pattern: @

info@example.com

Set Value: @

Chemnitz

!:’ Cancel j | Save

Fig.: Configuring an Email Filter

To set up a new email filter, proceed as follows:

1. In explorer, navigate to Communication > Email > Email Filter. In the content area, a table listing all

email filters created in the system opens.
2. Intable, click "New Filter". A form dialog for saving the filter criteria opens (also see table below).
3. Asthe last step, click "Save" to save your entries.

The new filter is now active, and inbound emails can be filtered according to the criteria specified in the filter.

To edit an email filter, proceed as follows:

1. In explorer, navigate to Communication > Email > Email Filter. In the content area, a table listing all
email filters created in the system opens.
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2. Intable, click email filter to be edited. A form dialog for changing the information opens.
3. Asthe last step, click "Save" to save your entries.
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To duplicate an email filter, proceed as follows:

1.

5.

In the explorer, navigate to Communication > Email > Email Filters. In the content area, a table listing
all email filters created in the system opens.

Place a tick in front of the email filter to be duplicated. You can only duplicate 1 filter at a time.
Click on "Duplicate" in the table header. The button is only active if at least 1 email filter is selected.
Configure the email filter in the form dialogue that opens. The form fields contain the values of the
source and can be changed.

The name of the duplicate is prefixed with "Copy of". You can give the duplicate a new name.

As the last step, click "Save" to save your entries.

To delete one or more email filters, proceed as follows:

1.

3.
4.

In explorer, navigate to Communication > Email > Email Filter. In the content area, a table listing all
email filters created in the system opens.

By checking off relevant option, select every email filter you wish to delete. You can select one or
more filters.

In table, click "Delete". The button is only active if at least 1 email filter is selected.

To definitively delete filter(s), click "Yes" in prompt. To cancel deletion process, click "No" in prompt.

The form dialog contains the following input fields, among others:

Field Description
(selecti
on)
Name Please note that the email filters will be processed sequentially, from top to bottom.
They will be processed in the sequence stated in the overview of email filters.
The overview lists the created filters by name. If you would not like the email filters to be
processed in alphabetical order, you can prefix the name with a number to define the
sequence yourself.
Stop Check off this option if you would like to stop the processing of the email filters after finding
after a match. Otherwise, all subsequent email filters will be processed until the end or until the next
match "Stop after match".
Validity  valid: The email filter will be applied.

invalid/  The email filter will (temporarily) not be applied and the conditions it has defined

invalid- will not be taken into account.
tempora Invalid filters will be skipped when the email filters are processed.
rily
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Field Description

(selecti

on)

Filter KIX will check the email header for the conditions specified here. If it finds a match, the

Conditio  parameters specified under "Set Email Headers" will be written back to the email header.

ns

You can check the header for several conditions simultaneously. A logical AND operator is

created when this happens. The specified parameters are only written to the email header if all
of the conditions have been met.

Filter Conditions

® Email Header: @ Negate: @ Pattern: @

From info@example.com

Fig.: The condition applies if the email comes from the address info@example.com

Email
Header

Negate

Pattern

Specify the attributes for which you want to check the email header. For example,
the sender of an email (From) or the subject.

All attributes defined in the SysConfig key "PostmasterX header" are available for
selection. If necessary, you can add further individual attributes to the key.

Note: To use mail headers for dynamic fields, the available DF names must be
entered in the SysConfig key "PostmasterX-Header" (format: X-KIX-

DynamicFieldName ).

Check off this option if you would like to check in the email header that certain
values are not present. The condition is considered met if the condition specified
under "Pattern” is NOT included.

Enter the values/pattern that the selected header attribute should match in order
to trigger the filter.

The use of regular expressions (see page 744) is possible, e.g. ".+@example.de'"

for all emails to the domain "example.de".

Using parentheses, a so-called "Capture Group" can be created to determine the
domain part of an email address, e.g. ".+@(.+)". Under "Set Email Header", the
determined pattern (in the example the domain part) can then be set using "[***]".

11 http://example.de
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Description

If all filter conditions apply, KIX will write the parameters specified here (attributes and values)
to the email header. You can write several parameters to the email header (1 attribute per
line).

When converting the email into a ticket, these parameters will be read out and the actions they
define will be executed.

Set Email Headers
@ Set Email Header: © Set Value:

X-KIX-Queus Chemnitz

Fig.: If the selected condition applies, the ticket will be moved in team "Chemnitz".

Set Select which attributes are to be placed in the email header (one attribute per line).
Email All attributes defined in the SysConfig key "PostmasterX header" are available for
Header selection. If necessary, you can add further individual attributes to the key.

Note: To use mail headers for dynamic fields, the available DF names must be
entered in the SysConfig key "PostmasterX-Header" (format: X-KIX-

DynamicFieldName ).

Set Enter the value that the attribute selected under "Set Email Header" should
Value assume.

By means of "[***]" a value previously determined in the filter conditions by means
of regex capture group can be set (see above).
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9.1.4.3 Overview of Usable KIX Email Headers

Below you will find a selection of the available KIX e-mail headers. The attributes listed are stored in the
SysConfig key "PostmasterX header" and can be set in the mail header via the e-mail filter. If required, you
can add further, individual attributes in the SysConfig key.

Attributes
(selection)

X-KIX-
BodyDecrypted

X-KIX-Channel

X-KIX-
SenderType

Description Possible values

Decrypted content of the mail. Only serves as a filter; cannot be set!

Sets the channel of the article to be created from the inbound mail | note
message

Sets the sender type of the article to be created from the inbound agent | external
message. | system

Headers for new tickets

X-KIX-Contact

X-KIX-Ignore

X-KIX-Lock

X-KIX-
Organisation

X-KIX-Owner

X-KIX-OwnerlID

Sets the contact of the new ticket, defined by the corresponding john.doe@com
unigue com email address. pany.com

Discards the mail if the value "yes" is set for the header. No ticket/ yes | no
article is created.

Sets the ticket lock of the new ticket directly. lock | unlock

Assigns the new ticket to the organization as identified by the MY_ORGA
customer number.

Sets the owner of the new ticket by specifying their login name. loginname

Sets the owner of the new ticket by specifying their numerical user 123
ID.
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Attributes
(selection)

X-KIX-Priority

X-KIX-Queue

X-KIX-
Responsible

X-KIX-
ResponsiblelD

X-KIX-SLA

X-KIX-State

X-KIX-State-
PendingTime
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Description

Sets the priority of the new ticket by specifying the internal (i.e.
nonlocalized) priority designation.

Assigns the new ticket to be created to the specified team (queue).
The complete name, including any superordinate teams, must be
entered. Names of superordinate teams are separated by a colon.

If the header 'X-KIX-Queue' is set with a valid team, all tickets will be
created in the specified team. This is independent of the
distribution configuration specified in the email account.

Sets the person responsible of the new ticket by specifying
their login name.

Sets the person responsible of the new ticket by specifying
their numerical user ID.

Sets the SLA of the new ticket to be created, specifying the SLA
name (KIX Pro only)

Sets the state of the new ticket by specifying the internal (i.e. non-
reminder|closed localized) state designation.

The wait time of the associated ticket in seconds, or in the
format "+<INTEGER>s", "+<INTEGER>m" (whole minutes),
"+<INTEGER>h" (whole hours), "+<INTEGER>d"n (whole days).

It is not permitted to combine values from different time units.
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Possible values

1 very high | 2
high | 3 normal |
4 low | 5 very
low

Service Desk |
Junk | Service
Desk::Monitorin

g

loginname

123

Name of the
SLA, e.g. "No
Escalation”

new | open |
closed |
pending
reminder |
closed

86400 |
+86400s |
+1440m | +24h
| +1d
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Attributes
(selection)

X-KIX-
StrictFollowUpl

gnore

X-KIX-Subject

X-KIX-Type
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Description Possible values

If the SysConfig key "PostMaster::StrictFollowUp" is activated, the 011
relevant mail can be handled as if the SysConfig were deactivated
by setting this header.

Sets the title/subject of the new ticket and first article to be created.  some text here
With FollowUp, the header only affects the subject of the article.
The ticket title remains unchanged.

Sets the type of the new ticket by specifying the internal (i.e. non- Incident |

localized) ticket type designation. Service
Request |
Unclassified

Headers for setting dynamic fields on new tickets (generic)

Please note:

+ For array configuration of a Dynamic Field, only the first array entry is set.
+ To use mail headers for dynamic fields, the names of the available dynamic fields must be entered in

the SysConfig key "PostmasterX-Header" (format: X-KIX-DynamicField_DynamicFieldNam e).

+ The following examples use the notation based on the placeholder syntax with underscore
However, the notation with hyphen

is also accepted, e.g. X-KIX-DynamicField-

DynamicFieldName.

X-KIX-
DynamicField_S
omeTextField

X-KIX-
DynamicField_S
omeDateTimeFi
eld

Sets the value of the field "SomeTextField" some text here of the some text here
type "Text" or "TextArea" on the new ticket.

Sets the value of the field "SomeDateTimeField" of the type 2020-12-31
"DateTime" on the new ticket. 23:59:59

In the case of DateTime fields, the format "YYYY-MM-DD hh:mm:ss"

must be used.

Issued on: 26.02.2024 Page 240



Attributes
(selection)

X-KIX-
DynamicField_S
omeDateField

X-KIX-
DynamicField_S
omeSelectionFi
eld
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Description

Sets the value of the field "SomeDateField" on the new ticket.

In the case of DateTime fields, the format "YYYY-MM-DD 00:00:00"
must be used.

For additional form fields, "SomeDateField" must be replaced with
the relevant field name.

Sets the value of the field "SomeSelectionField" on the new ticket.
In the case of single/multiple selection fields, the key of the desired
value must be set, e.g. "1" for "solved (work around)" in the field
"CloseCode".

Setting ticket properties for existing tickets (generic)

X-KIX-FollowUp-
XXXX

X-
KIX_FollowUp-
KeepState

Sets the ticket attribute identified with XXXX if there is an inbound
message for an existing ticket ("Follow Up"). It is used in the same
way as when setting the relevant attribute when creating the ticket.

Examples are: X-KIX-FollowUp-Lock, X-KIXFollowUp-State, X-KIX-
FollowUp-State-PendingTime, and X-KIX-FollowUp-
DynamicField_SomeTextField

If this header is set, a follow up does not lead to a status change of
the ticket and there is no change of the pending time, e.g. after an
automatic reply or an out of office message.
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Possible values

2020-12-31
00:00:00

ltemKeyHere

See information
above

Value: 1
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9.1.5 OAuth2 Profiles

OAuth (Open Authorisation) refers to two
different open protocols for a standardised,
secure API authorisation of desktop, mobile
and web applications.

Content on this page:

+ Step 1: Microsoft Azure Portal (see page 242)

+ Step 2: Create OAuth?2 profile (see page 245)

In order for KIX to be able to retrieve emails + Step 3: Create email account (see page 247)
from or send emails via an Office365 mail - Step 4: Configure email sending (see page 247)
account, for example, OAuth2 authentication

must be applied. In addition, SMTP with

authentication may first have to be activated

on the account at Office365. To provide authentication in KIX, proceed as described below:

(@ Official notice pages from Microsoft

Inbox (IMAP/S, POP3/S): https://docs.microsoft.com/en-us/exchange/clients-and-mobile-in-
exchange-online/pop3-and-imap4/enable-or-disable-pop3-or-imap4-access

Outbox (SMTP): https://docs.microsoft.com/en-us/exchange/clients-and-mobile-in-exchange-
online/authenticated-client-smtp-submission

9.1.5.1 Step 1: Microsoft Azure Portal

1. Signin to the Azure portal.
2. Go to "Azure Active Directory".
3. Goto "App Registrations” in the left action list.
+ Select the item "New registration" in the menu bar.
+ Enter any name for the registry. This is not relevant for KIX later on.
+ In the item "Supported account types", specify who can use the app. Set the selection to "Only
accounts in this organisation directory (only "<company>" - single client)".
@ nstead of "<company>", you should use your own company name.
+ For "Redirection URI", select "Web" in the selection field and enter "<HttpType>://<FQDN>/
oauth2redirect” as the URI. This can also be entered or changed at a later time.
The redirect URI corresponds to the front-end FQDN in KIX, e.g. "https://
myKIXFrontendHost.example.com/oauth2redirect".

@ Info

Microsoft requires that the redirect URI points to HTTPS.

4. Go to "Certificates & Secrets"” in the left action bar.
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Select the item "New client secret" and have the key created in the right sidebar. Remember or
make a note of the key (value), because it will only be partially displayed when called up again
and must otherwise be stored again.

@ Info

It is the administrator's task to ensure that a valid client key (valid for max. 2 years) is
stored in KIX for the mailbox.

5. Forthe inbox:

Go to "API permissions" in the left action bar.

Select the item "Add permissions".

Then select "Microsoft Graph" in the right sidebar.

Select the item "Delegated permissions".

At this point, select "IMAP.AccessAsUser.All" and "offline_access" and confirm the selection.
This is now displayed in a table, whereby the column "Status" remains empty (default value).
Give the administrator's consent for the operation (field "Administrator consent for (your
company)" to the right of field "Add authorisation"). The column "Status" in the table with the
selected permissions now shows a green tick and the addition "granted for 'your company' ".
Optionally, perform these steps again if you want to add permissions, e.g. for outgoing mail.
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6. For outbox:

+ Go to "API permissions" in the left action bar.

+ Then click on "Add permissions".

+ Then select "Microsoft Graph".

+ Select the item "Delegated permissions".

+ Atthis point, select "SMTP.Send", as well as "offline_access" and confirm the selection. This is
now displayed in a table, whereby the column "Status" remains empty (default value).

+ Give the administrator's consent for the process ("Administrator consent for (your company)"
field to the right of the "Add authorisation” field). The column "Status" in the table with the
selected permissions now shows a green tick and the addition "granted for 'your company' ".

+ Optionally, perform these steps again if you want to add permissions, e.g. for the inbox.

7. Select "Overview" in the left action bar.
+ Make a note of the "Application ID (Client)" and the "Directory ID (Client)". You can see the data
in the summary.You must enter this ID in the "Client ID" field when you create an OAuht2
profile in KIX.
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9.1.5.2 Step 2: Create OAuth2 profile

1.

Navigate to Communication > Email > OAuth2 Profiles.
In the overview that opens, you can create or delete profiles or perform a table CSV export. The table
contains all profiles created so far.

Click on "New Profile" to create a new profile. A form dialogue opens in which you can enter the

parameters of the profile.

Fill in all the form fields:

Field

Name

URL Authorization

URL Token

URL Redirect

Client ID

Description

Enter a name for the profile.

Enter the URL for the OAuth2 authorization.

Example for the structure at Office365:
https://login.microsoftonline.com/<Tenant-ID/Directory-ID>/
oauth2/v2.0/authorize

Enter the URL for the OAuth2 Token.

Example for the structure at Office365:
https://login.microsoftonline.com/<Tenant-ID/Directory-ID>/
oauth2/v2.0/token

This field is pre-filled by the system. If the address is not the same
as the one entered in the Azure portal (step 1 - item 3 - subitem 5), it
must be changed accordingly.

The forwarding URL is used as the "return address" for the
authorisation codes from Microsoft. It must match the one in Azure
under "Redirection URI".

Example: https://<myFrontendHost.example.com>/oauth2redirect
<myKIXFrontendHost.example.com> corresponds to the frontend

FQDN that is stored in the Setup Assistant or in the SysConfig key

"FQDN".

Enter the Client ID here.
For Office365 this is the 'Application ID (Client)' from the 'Overview'.
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Client Secret

Scope

Validity

& Note
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Description

Enter the client secret here.
For Office365 this is the 'client key' from 'Certificates & secrets'.

Enter the permissions to be requested here (separated by spaces).
Examples for Office365:

+ "offline_access https://outlook.office.com/SMTP.Send"
+ "offline_access https://outlook.office.com/
IMAP.AccessAsUser.All"

Set the form to 'valid' to use it.

When creating and later authenticating the profile, the user must be created who is to be
used for the mailbox or mail dispatch.

For example, if you want to use a mailbox via 'mail@test.onmicrosoft.com’, authentication
must be carried out via this user. A different admin user (e.g. 'admin@test.onmicrosoft.com’)
has no authorisation to do so.

B Edit Profile

* Name:

* Authorization URL:

* Token URL:

* Redirect URL:

* Client ID:

n Client Secret:
* Scope:

* validity:

4 © & Admin:OAuth2Prof.. X = X[ Edit Profile X

Office365

https://login.microsoftonline.com/bcsdedé4-ecc2-421b-3a91-03bd 113b0d8c/0auth2/v2.0/authorize
https://login.microsoftonline.com/bcsdedé4-ecc2-421b-3a91-03bd113b0d8c/0auth2/v2.0/token
https://myFrontendHost.example.com/oauth2redirect

85c14663-463-4e3e-470a-b3c6-9f210884ec7f

online_access https://outlook.office.com/IMAP.AccessAsUser.All

valid

l:’ Cancel ‘ Save

4. Finally click on "Save" to save the form.

& Important!
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The verification must be carried out with the same user (email account) who collects the
emails. Therefore, use a private browser window when setting up to ensure that the
generated tokens match the mailbox to be retrieved!

If you receive the error message "Error: Could not select: 3 BAD User is authenticated but not
connected’, this indicates that you are already logged in with your Admin Microsoft account.
In this case, cached session cookies or similar ensure that the token for the mailbox that KIX
is supposed to retrieve is not valid.

In the overview of profiles in the column "Renew authorisation”, click on @ After submission, an
automatic forwarding to Microsoft (https connection is mandatory!) takes place to release the
required permissions and request a code to authenticate the system. When authenticating the profile,
the user created above for whom the token was created must be used.

If the permissions have been accepted, you will receive a positive confirmation.

If the token request was successful, there is a tick in the penultimate column of the profile overview. The tick
only indicates that a token (access and/or refresh token) is available, but not whether they are still valid (on
Microsoft's side). If, for example, you change the permissions in Azure, the token request must be carried out

again.

®

Info

The system must be able to access "https://login.microsoftonline.com/". If necessary, a
corresponding system proxy must be configured.

9.1.5.3 Step 3: Create email account

Navigate to Communication >Email > Inbox.

Click on "New account" in the table. A form dialogue opens in which you can create the email
account.

Under "Type", select an option that ends in "_OAuth2".

(Note: IMAPTLS_OAuth2 is no longer supported by Office365).

After this selection, the profile field is displayed. The password field is hidden as it is not required.
Under "OAuth2 Profile", select the profile created in step 2.

Fill in the remaining form fields and save the mail account. If necessary, read up on this under
Inbox (see page 201) .

9.1.5.4 Step 4: Configure email sending

1.

Navigate to Communication > Email > Outbox. A form dialogue opens in which you can configure the
outbox.

2. The form has the properties "SMTP OAuth2", "SMTPS OAuth2" and "SMTPTLS OAuth2" in the "Type"

field.
0 In connection with Microsoft, "SMTPTLS OAuth2" must be used. Other types are not accepted.
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£, Communication: Email: Outbox

Type
* Type: @
* DAuth2 Profile:
Host:
Port:
User:
Envelope

Envelope From: @

Blndi i [ L Erneen: (#

SMTP OAuth2
DoNotSendEmail
SMTP
SMTP DAuth2
SMTPS
SMTPS OAuth2
SMTPTLS

SMTPTLS OAuth2

P

3. As with the Inbox, either the OAuth2 Profile field or the Password field is displayed depending on the
type selected. Select the profile created in step 2.
4. Fill'in the remaining form fields and then click on "Save". If necessary, refer to Outbox (see page 219) .

& Important

The profile is stored in the SysConfig key "SendmailModule::0Auth2_Profile". If the profile is
renamed, the profile must be set again in the configuration of the outbox or directly in the SysConfig!

| "%
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9.1.6 Notes for Exchange/Office 365 Server

When using an Exchange/Office 365 server, a license must be stored in the email account (fetching user) so
that the IMAP and SMTP services are available. The data required for setting up email communication in KIX
can be taken from the user's settings. To do this, log on to the server with the email account and call up the
settings (Options > Mail Accounts > POP and IMAP). Make a note of the information needed for the setup
and store it in the Inbox and Outbox of KIX.

Communication

Email

If no data is available, e.g. because the license is missing, this is marked with "Not available". In this case,

activate the services again.

(© Options

Shortouts
» General

= Mail

» Calendar

Other

D AD .y 3 -
POP and IMAP settings
Use the information on this page if you need to use POP or IMAP to connect your mailbo

POP setting

Mot available

IMAP setting

SEFVEF MBI Frsi|COMDIEo. COm

SMTP setting

Mot available

Fig.: IMAP is active, but SMTP is not

If the license is missing, KIX returns the following error screen:

+ Inbox: After retrieving the emails, KIX reports a successful collection; however, the emails do not
arrive in KIX and remain in the server's mailbox.
+ Outbox: Error message when sending an email:

"[Kernel::System::Ticket::Article::ArticleCreate][699] Impossible to send message to:

empfaenger@company.de (Error: SMTP authentication failed: 5505.2.1 Mailbox cannot be accessed
[AM6P194CA0084.EURP194.PROD.OUTLOOK.COM] 1)."
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9.1.7 SysConfig settings for emails
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Below you will find an overview of selected configuration keys which are relevant for email traffic. You can
find the configuration keys in the menu System > SysConfig using the search function.

SysConfig key

*sendmail*

ContactEmailUniqueCheck

Daemon::SchedulerCronTask
Manager::
Task###MailAccountFetch

FQDN

Description

Set of SysConfig keys for outgoing mail
configuration

Enables/disables the uniqueness check
for contact email addresses.

! Once a validity check has been
deactivated, it MUST NOT be
reactivated!

It is imperative that you observe the
information in the chapter: Allow
contacts without or without a unique
email address.

Defines the time interval for the mail
retrieval.

KIX automatically retrieves the email
accounts at regular intervals. The time
interval is initially 10 minutes. If
necessary, you can change this default
setting in this SysConfig key. To avoid

Page links

Configuring the Email
Dispatch (SysConfig) (see
page 222)

Allow contacts without or
without a unique email
address (see page 566)

too high a system load, the fetch interval

should not be less than 5 minutes. We

therefore recommend that you leave the

interval at 10 minutes.

Complete domain name of the KIX
Frontend
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SysConfig key

PostmasterX-Header

IgnoreEmailAddressesAsReci
pients

PostMaster::CheckFollowUp
Module###.....

PostmasterDefaultQueue

PostMaster::FollowUp::Check
FromOrganisation

PostMaster::MailAccountFetc
h::Debug
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Description

Dynamic fields to be considered in mail
filters

+ X-KIX-DynamicField-DFKeyName:
sets DFKeyName on ticket creation

+  X-KIX-FollowUp-DynamicField-
DFKeyName: sets DFKeyName on
ticket creation on follow up

Contains a RegEx for a blacklist.

The filter checks subsequently, after all
other checks, whether an email address
corresponds to the specified RegEx.

If this is the case, the email is not sent -
regardless of all other settings.

This can be used, for example, to prevent
replies to a "noreply" address.

Checking incoming emails for possible
follow-ups.

Standard team (default queue), in which
the collected emails are created as
tickets

Controls the visibility in the SSP (KIX
Pro).

Checks whether the sender of a follow-
up is contained in the contact database
and is assigned to the same organisation
as the ticket.

Setting a gradual postmaster debug level
for targeted log information.

Issued on: 26.02.2024

Communication
Email

Page links

Overview of Usable KIX
Email Headers (see page 238)
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Inbox (see page 201)
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SysConfig key

PostMasterMaxEmailSize

Ticket::EventModulePost###
900-
ArticleCustomerVisibleByReci
pient

Ticket::EventModulePost###
910-
ArticleCustomerVisibleByRef
erences.
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Description

Maximum size of emails that can be

retrieved via POP3, POP3S, IMAP, IMAPS.

Data in KBytes

Controls the visibility of the article in the
Self Service Portal based on the e-mail
recipient (KIX Pro).

Article event that controls the visibility in
the SSP based on the email reference
(KIX Pro).
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9.2 Web forms

KIX offers you the possibility to generate web forms which you can integrate into your website. Via these
web forms, your customers can send fault reports, feedback or ticket-relevant information directly to KIX. For

each message received via a web form, KIX automatically creates a new ticket.

KIX generates 2 code snippets per web form. Integrate these into your website and thus make the form

available on your website.

Abb.: KIX Webform

The table in the content area lists all the web forms created in the system:

4 & Admin: Webform X & Webform - Incident Me... X b
Ausblenden <€
¥, Communication: Webform (2) ¥ ¥ New Webform
| T || Formtitle & Queue Prio Type State Validity Created at Created by
St At |1 Feedback Service Desk Unclassified 8 new valid 09/23/2021,08:23PM  not assigned w
8 e [l Incident Message Service Desk Unclassified 2 new valid 09/23/2021,08:39 PM  not assigned -
# Automation L4 >
& Communication
Webform

Fig.: Overview Web Forms

@ Tip
Agents can be automatically notified as soon as a ticket has been received via a web form. To do
this, set up a corresponding ticket notification (see page 184) in the Automation > Notifications menu.
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9.2.1 Zoom View for a Web form

You can view the details of a web form. Navigate to Communication > Web Form. A table opens in the
content area listing all the web forms stored in the system. Click on a web form in the table to open its detail
view. Click on "Edit" in the title bar of the detailed view if you want to make changes to a web form.

The buttons in the title line of the detail view allow you to edit and create a new web form.

4 © & Admin: Webform X & Webform - Feedback X

W VVeDTOTM UpTIONS

Name Activate B...: Feedback Use KIX C55: Yes Changed at: 09/23/2021, 08:23 PM
Form title: Feedback Enable attachme__: No

Show title in form: Yes Accepted domains: IATS

Information text: Validity: invalid

Name Submit Bu__- Submit Created by: not assigned

Info after Sending: Thank you for your enquiry! We will contact y¢ Created at: 09/23/2021, 08:23 PM
Start Modal Dial . - No Changed by: not assigned

Queue: Service Desk &

Priority: 3normal

Type: Unclassified T2

State: new 8

Assigned agent: Agent [TD-AUTOJKIX2018-2080

Include this code into the <head> area of your webpage.

Do not forget to replace <YOUR_FRONTEMD_HOST> placeholder.

<script=var kixWebFormURL = "hitps:/<¥ OUR_FRONTEND_HOST=/integrations",</script=
<script src="https://<"OUR_FRONTEND_HOST=/static/integration/kix-form.js"=</script=
<link href="https://<¥OUR_FRONTEND_HOST=/static/integration/kix-form. css™ rel="sty =

Place this code wherever you want to open the webform dialog.

=button class="kix-web-form-start-button” id="18324214083587" disabled-Feedback=/button>

Fig.: Zoom View of a Web Form

The zoom view contains three lanes:

Lane Description

Webform Options General Information about the web form.

Default Values Information passed to the tickets from the form.

Code Code snippets for integrating the form into the website.
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You are able to generate web forms for your website that your customers can use to send fault reports or
feedback directly to KIX. KIX generates two code snippets based on the parameters you set, which you can
integrate into your website. The form is called up from your website via these two code snippets.

£# New Webform

Webform Options

Default Values

Form title: =

Show title in form: &

Name Submit Button:

Information text:

Info after Sending:

Start Modal Dialog:

* Team: =

®

Name Activate Button: @

&

=]

Use KIX €S5: &

* Accepted domains: @

* Validity: @

* Priority: ®

* Type: @

Feedback
Feedback

Submit

Thank you for your enguiry! We will contact you as soon as possible.

Enable attachments: @ -/

A

imvalid

8 Service Desk

3 normal

T L

Fig.: Configuration of a web form

Depending on your requirements, you can create several different forms. You can insert them anywhere on
your website or in different websites. For each form

+ acode snippet is generated for the required scripts, which generate the form at runtime.
a code snippet is generated for the button that triggers the display of the form.

The button can be integrated several times on one or more web pages. The script must be integrated once

on all pages on which the button is located.
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Include this code into the <head> area of your webpage.

Do not forget to replace the <YOUR_FRONTEND_HOST> placeholder (if it is not already).

<script=var kixWWebFormURL = 'https://your-frontend-host.example.com/integrations';</script>
<script src="https://your-frontend-host.example.com/static/integration/kix-form.js"></script>
<link href="https://your-frontend-host.example.com/static/integration/kix-form.css" rel="stylesheet">

Place this code wherever you want to open the webform dialog.

<button class="kix-web-form-start-button" id="1634646885398" disabled>Feedback</button>

Fig.: Code snippet for embedding in the website

To create a new web form, proceed as follows:

1.

w

In explorer, navigate to Communication > Webform. In the content area, a table listing all the web
forms created in the system opens.

In table, click "New Webform". A form dialog for creating the new web form opens.

Complete form (see table below) and set validity to "valid".

Click "Save" to save new web form. The web form has now been created and the code snippets have
been generated.

The code snippets for the script and the button can be found in the zoom view of the web form (in the "Code"
lane). You can copy these to the clipboard and then integrate them into your website.

To integrate a web form into a website, proceed as follows:

1.

In the explorer, navigate to Communication > Web Form. A table opens in the content area listing all
the web forms created in the system.
Select the desired web form by clicking on the corresponding arrow on the right-hand side of the
table. The code snippets open in a dropdown.
Include the scripts and the CSS file in your website:
1. Copy the code snippet beginning with <script> completely to the clipboard.
2. Paste the code snippet from the clipboard into the source code of your website.
Place it in the area between <head> and </head>.
The code snippet must be included once on all pages where the button is located.
3. Replace the placeholder <YOUR_FRONTEND_HOST> with the URL of your KIX frontend
domain.
The code already contains the URL of the KIX frontend domain if it is stored in the Setup
Assistant or in the SysConfig key "FQDN".
4. Optional: replace the line <link href="[...]kix-form.css" rel="stylesheet">
with the file path to your own CSS file if you want to use your own form design.
5. Save the change to the website.
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4. Include the button:
1. Copy the code snippet beginning with <button> in its entirety to the clipboard.
2. Paste the code snippet from the clipboard into the places in the source code of your website
where the button to open the form should be located.
The code snippet creates a button on the website, which opens the form when clicked. Each
button can be integrated several times and on several pages.
The ID of the button is used to reference the respective form (error message or
feedback). Since each button has its own ID, several different buttons can be integrated on
one website and thus several forms can be provided on one website. It is only important that
the associated <script> code snippets (point 3) are integrated once on all these pages. Save
the change to the web page.
5. Upload the changed web pages to your website host. The form can now be used on the website.

1ser Support-Formular.

Suppor tanfrage

1. Wir freuen uns (ber Thre Nachricht.« /g

Fig.: HTML code of a website with integrated form
To edit a web form, proceed as follows:

1. In explorer, navigate to Communication > Webform. In the content area, a table listing all the web
forms created in the system opens.

2. Intable, click web form to be changed. A form dialog for editing the web form opens.

3. Amend information as required and click "Save" to apply changes.

Your changes take effect immediately. You may also need to correct or re-paste the modified code snippets
on your website.

The form dialog contains the following input fields, among others:
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Field (selection)

Name Activate Button

Form title

Show title in form

Name Submit Button

Information text

(X
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Description

The name specified here is shown on the button that calls up the
form, e.g. "Feedback" or "Write message".

Cur Intranet

REPORT ISSUE

dback
EASNC Latest News

The form title is shown in the header of the web form.

Feedback

If you have checked off this option, the text saved in the "Form title"
field will be shown in the header of the web form.

The name specified here is shown on the "Send" button of the form,
e.g. "Send" or "Submit".

Write your feedback.

M concer e

Freely definable text for information in the form.

Write your feedback.

& suomic |
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Field (selection)

Info after Sending

Start Modal Dialog

Use KIX CSS

Enable attatchments

(X

KIX 18 Admin Manual - EN - KIX Start
Communication
Web forms

Description

Freely definable text shown after sending the form, e.g. "Thank you for
your inquiry. We will contact you as soon as possible."

Feedback X

l Thank you for your enguiry! We will contact you as soon as possible.

If you check off this option, the form will open in a lightbox (modal).
The website in the background of the web form will remain inactive
while the dialog is open.

If you check off this option, the web form will be shown in the KIX
design. You can use your own CSS files to design the form. To do so,

modify line of code <link href="[..]/kix-form.css"

rel="stylesheet"> in code snippet by referencing your CSS file.

If you check off this option, users can add attachments to tickets
created via the web form.
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Description

Enter the domain of your website here, e.g. "https://
www.MyHomepage.com". You can specify multiple domains by
separating them with a comma or semicolon.

TIETOA TS

Enable attachments: @

* Accepted domains: @ /%)

* Validity: ® invalid

It is possible to enter regular expressions (RegEx). These must be
placed in slashes ("/"). KIX will check your entries for use of the
correct RegEx syntax. KIX will set any missing slashes and change
your entries into a regular expression that the web form can interpret.
For example, an entry of * or .* or .+ will be changed to /.*/. You
cannot use commas within the RegEx syntax because KIX interprets
them as domain separators.

Entries in the following formats will be ignored and will not be saved,
even if they are part of a list separated with commas or semicolons:

+ / (any number of slashes)

+ Only blanks

+ Combination of slash and blank (e.g. /// or// ///// ot/ /1111 1]/
or//)

« % or .*x or .+ as partof alist; otherwise KIX will automatically
correct the expression (see above)

+ Example: An entry of /my\.domain/;/ /;//;* would be

changedto /my\.domain/

Examples of valid entries:

+ my.domain.com; /test/; /.+\.my\.domain/
. /*/

« %

+ /foo/,/bar/
Examples of invalid entries (invalid RegEx):

+ my.domain.com; /test(123/; /.+\.my\.domain/ (missing closing
bracket)
A
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Field (selection)

Validity

Team

Priority

Type

State

Assigned agent
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Description

(@ Note on existing data

Existing values are prepared internally as RegEx. A validity
check is not performed. A previous value e.g. "my.domain”, "/
test.+123/", "foo", "my.second-domain.com" is changed to the
following regex: "(my.domain|test.+123|foolmy.second-
domain.com)". So KIX takes all the values, removes any
slashes ( /), joins the values with | and puts the expression in
parentheses. This does not represent a migration. The value
is only adjusted in the code, but not stored by the system.
Tip: Since the adjusted value is displayed in the edit dialog, it
only needs to be applied with "Save".

+ valid: The web form is valid and can be used.
+ invalid/invalid-temporarily: The web form is invalid
and (temporarily) cannot be used.

Specify the team that tickets created via the web form should be
assigned to.

Specify the priority that tickets created via the web form should be
assigned.

Specify the type that tickets created via the web form should be
assigned to.

Specify which state is assigned to tickets created via the web form.

In order for tickets to be created in KIX via the web form, an agent
whose role is at least "Ticket Creator" must have been assigned on
the form.

If possible, do this by creating a separate agent that is not a
natural person (user).

Issued on: 26.02.2024 Page 261



Field (selection)

Password

KIX 18 Admin Manual - EN - KIX Start
Communication
Web forms

Description

In this field, save the password of the assigned agent so that tickets
can be created via the web form.

Please note: If you changed the agent's password in the agent's
settings, you will also need to change it here so that the agent
concerned can continue to receive messages via the web form.
However, since the agent's password should be changed at regular
intervals, we recommend creating a separate agent (who is not a
natural person) to receive messages from the web form.
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10 Internationalisation

KIX supports multiple languages. KIX comes supplied with 2 languages: German (de) and English (en_US).
The source language is English. The German language library is additionally supplied for German-
speaking countries, ensuring that the texts and designations for menu entries, buttons, help texts, etc. that
are provided by default are automatically translated into German if "German" has been set as the

user's language. The texts and designations comprise basic character strings, which are also referred to
as patterns.

The menu Internationalisation > Translations enables you to edit and add to the existing patterns in
the system as well as all patterns generated by the user (designations for assets, dynamic fields,
notifications, etc.).

Administration Administration

Setup Assistant T : Setup Assistent
B %, Internationalisation: Translations (2}

+ Assets + Assets
Know*
+ Automation + Automatisierung

+* Communication L || FEtiesnr S8 Internationalisierung

= S ] Kook Ciataba Ty
+ Internationalisation i == Kommunikation
| Kmowledge Database: FAQ Categories
Nutzerverwaltung

Knowledge Database

+ sSystem System
+ Ticket Ticket

+ User Management Wissensdatenbank

Fig.: The use of multiple languages in KIX is managed using translations

The language that has been set for a user is the decisive element determining whether a translation is
used. If a particular basic character string does not have a corresponding character string saved in a
different language, then the system will reference the English language. If a particular basic character string
does

have a corresponding character string saved in a different language, the character string of the

language assigned to the agent will be referenced. This applies to all texts and designations in the system,
and to all content generated by the user (assets, asset classes, dynamic fields, notifications, etc.).

The language used by a user is preset when creating/editing the user (menu User Management > Users). In
their preferences, each agent can choose for themselves which language they would like to use for KIX.
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10.1 Translations

The menu Internationalisation > Translations enables you to add to or change the translations
(patterns) specified by the system. This concerns both existing language schemes and the creation of new
language schemes, such as:

+ the texts and designations in the system (menu entries, buttons, help texts, widget titles, table
headers, etc.)

+ the ticket notifications that you have created

- the designation of the attributes that you use in asset classes (form fields)

+ the designations of the assets, teams, states, priorities, and dynamic fields that you have created

+ and the like.

No translation is provided for signatures. Since they are linked to a team, signatures are generally
also created in the "team's language". Likewise, no translation is provided for text modules either. Instead,
a separate text module is created for each language.

In their preferences, each user (agent or contact) can specify which language they would like to use for
their work in KIX. The language is preselected when creating or editing a user. The language setting
determines not only the designations in the user interfaces, but also the notifications that are used. If the
user has not set a language scheme or if they have not been authenticated yet, the browser's language
identifier will be used. If this cannot be assigned or if no corresponding scheme exists, then the system's
default language (global configuration) will be used.

The table in the Dashboard lists the patterns based on a search term. In search field, enter term to search for
specific patterns. You can use wildcards such as an asterisk (*) to do this, e.g. "ticket*". To display

all patterns, enter only asterisk in search field. It may take a moment for all patterns to load. The

column "Languages" indicates for which languages translations already exist.

£}, Internationalisation: Translations (46) % New Translation
T

ficket* @ Search
Setup Assistant ;
# Assets | A g
# putomation O Ticket
+ Communication || Ticket Agent

Internationalisation
o sk | Ticket Attributes

Translations ; i
|| Ticket body for approval of FAQ article.
+ Knowledge Database
[ Ticket can be edited without internet connection

# Service Catalog

| Ticket Data

= co

Fig.: Overview of selected Patterns
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@ Tip
You can also use the translations function if you prefer to use the term "Queue" instead of "Teams"
or if you prefer the term "Config Items" or "Cl" instead of "Assets". You can save a pattern for this
and thus change the designation in the system.

10.1.1 Creating or Editing Translations

You yourself can maintain the translations for the basic character strings (patterns) used in KIX.

This concerns both existing language schemes (labels, help texts, inscriptions, etc.) and the creation of
new language schemes (attributes in asset classes, designations of dynamic fields, ticket notifications,
etc.). Patterns are basic character strings that can be made up of individual words or entire texts.

£+ New Translation

* pattern: @  myDynamicFieldName

A
English: Name of my Dynamic Field
A
German: Name meines Dynamischen Feldes
A

x R v I

Fig.: New Pattern for Dynamic Field

By using HTML tags, you can format both the texts of the patterns and those of the translations (e.g.
<i>italics</i>). The use of a string placeholder (%s) allows variable text in the pattern.

£+ %s time unit(s) accounted. Now total %s time unit(s). (%s time unit(s) accounted. Now total %s time unit(s).)

* pattern: @ %S time unit(s) accounted. Now total %s time unit(s).

English:

German: %s Zeiteinheit(en) gebucht. Gesamt: %s Zeiteinheit(en).
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To create a new pattern, proceed as follows:

5.

In explorer, navigate to Internationalisation > Translations.

In content area, click "New Translation". A form dialog for creating the pattern and the
corresponding translations opens. A separate text field is available for each language.

Under "Pattern”, enter basic character string requiring translation.

Enter translation for each language into which pattern is to be translated. A separate text field is
available for each language (see info box below).

As the last step, click "Save" to save your entries.

The system can now use the translation of the new pattern. Agents may need to refresh their system for
the translation to take effect for them.

To edit a pattern, proceed as follows:

4.

In explorer, navigate to Internationalisation > Translations.

Enter search term to find required pattern. If necessary, use asterisk (*) for search.

In table, click pattern to be edited. A form dialog for editing the pattern and the
correspondingtranslation opens. A separate text field is available for each language.

Change or add information as required and, as the last step, click "Save" to save your entries.

The system can now use the amended translation of the pattern. Agents may need to refresh their system
for the translation to take effect for them.

®

Note

You can create additional languages in the SysConfig key "DefaultUsedLanguages". For these,
however, the patterns have to be maintained manually.

If you have created additional languages, you can specify the links to the manuals on the welcome
page for each language. Use the following SysConfig keys: KIX::SelfServiceManual, KIX::UserManual,
KIX::AdminManual.
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11 Knowledge Database

The knowledge base contains a compilation of frequently needed information and answers to frequently
asked questions (FAQ). The FAQ articles can cover a wide range of topics: Notes on working with KIX,
product data sheets, installation instructions, special features to be considered on a machine, and much
more. So that all this information does not lie unordered in the system, it is grouped into FAQ categories and
thus structured thematically.

As administrator, you create the FAQ categories and their structure. The individual FAQ articles are
maintained by the authorised agents and assigned to the categories. A FAQ article is assigned to a category
when it is created or edited.

The FAQ categories are created in the Admin module in the menu Knowledge Base > FAQ Categories. When
delivered, KIX already contains the category Misc, to which you can add further categories and
subcategories. By assigning FAQ categories to superordinate FAQ categories, a structure tree is created,
which the agents can find again in the FAQ dashboard to view and edit FAQ articles there.

Administration - @, Knowledge Database: FAQ Categories {3) FAQ Categories " @ Overview FAG (4)
T [ Hame = Comment [ rage Title
show all = .

[ 1 = —
Setun Assistant O 17001 [TO-F-001] FAQ-Artikel filr Obj
¥ doscts o e = . 0 1702 [T0-F-002] Fa-Artikel fior Obj
* Automation O misc 9 Misc articles O 17003 [TD-F-003] FAQ-Artikel fisr Obj

: 7 Misc4)

* communication g [ 17004 [TD-F-004] FAG-Artikel fir Link
#* intemarionalisation
 tinowledg= Database

Fig.: FAQ Categories Shown in FAQ Dashboard

Agents can search for FAQ articles via the complex search and limit their search to a FAQ category. In
addition, the sidebar widget "Recommended FAQ" displays relevant FAQ articles for the ticket. The table
entries in the widget initially result from the keywords entered in the ticket subject/title plus the relevant
assets selected in the ticket. You can change this configuration. (see page 480)

11.1 Creating or Editing a FAQ Category

To create a new FAQ category, proceed as follows:

1. In explorer of the admin module, navigate to Knowledge Database > FAQ Categories. In the content
area, a table listing all FAQ categories created in the system opens.

2. Intable, click "New Category". A form dialog for creating a new FAQ category opens.

Complete form, select icon if required, and set validity to "valid".

4. If required, select existing FAQ category in selection field "Parent Category" in order to assign new
FAQ category to it as a sub-category.

5. Click "Save" to save new FAQ category.

w

The new FAQ category has now been created and is available to agents in the FAQ explorer for creating FAQ
articles.
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To edit a FAQ category, proceed as follows:

1. In explorer of the admin module, navigate to Knowledge Database > FAQ Categories. In the content
area, a table listing all FAQ categories created in the system opens.

2. Intable, click FAQ category to be changed. The zoom view for the category opens.

In opened zoom view, click "Edit". A form dialog for editing the FAQ category opens.

4. Amend information as required and click "Save" to apply changes. The changes take effect
immediately.

w

To delete a FAQ category, proceed as follows:

1. In explorer of the admin module, navigate to Knowledge Base > FAQ Categories. A table will open in
the content area listing all FAQ categories created in the system.

2. Place a tick (1st column) on each category to be deleted.

3. Click on "Delete" in the table header. The button is only active if at least 1 category is selected.

4. Confirm the security query with "Yes" to carry out the deletion process.

Note: FAQ categories are deleted recursively, i.e. including all subcategories. Categories can only be deleted
if they do not contain FAQ articles. If necessary, assign the articles to another category. As an alternative to
deletion, you can also set FAQ categories to "invalid" (see table below).

The form dialog contains the following input fields, among others:

Field (selection) Description

Name Give the category a meaningful, unique name so that agents
can sensibly assign the FAQs.

Icon The icon is used to graphically identify the category. It is used, for
example, in the explorer of the FAQ Dashboard and in the overview
of FAQ categories in the Admin Dashboard.

You can choose an icon from one of the provided libraries or
upload a graphic file.

Parent Category By selecting a parent category, you can generate a tree structure
like the one used in an explorer. If possible, do not break down the
categories too far, so as to maintain a clear structure.
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Description

+ valid: FAQ articles can be assigned to this category and are
available in the explorer of the FAQ dashboard.

+ invalid/temporarily invalid: No FAQ articles can be assigned to
the category. The category is no longer listed in the explorer of
the FAQ dashboard. The FAQ articles of this category can now
only be found via the complex search.
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12 System

KIX enables you to intervene directly in the system configuration and the core. As a result, you can tailor
the system to meet the specific needs of your company and, if required, also execute commands at
command line level. Please do not hesitate to contact us if you require any assistance. We would be glad to
help you.

© Attention!

Commands that you execute via the console are considered fundamental interventions in KIX, as are
changes to the system configuration. We would like to highlight that you should only use

these functions if you have sufficient expertise and provided that you take great care. Otherwise,
these actions may result in serious system errors or even complete system failure.

Dynamic Fields

The menu System > Dynamic Fields enables you to create the specific input fields and selection
fields and checklists you need in order to expand the information that can be saved for a ticket.

By Configuration of User Interface (GUI) (see page 327), the dynamic fields created here are integrated
into the program interface (menu System > SysConfig).

Console

The menu System > Console contains a command console with a graphical user interface for executing
predefined commands at command line level. However, this is predominantly reserved for our Support
team, to ensure that they can intervene in the KIX core if required.

Logs
KIX logs all system messages and saves them in what are known as log files. The log files are available
at System > Logs. You can view and download them at any time, e.g. for troubleshooting purposes.
SysConfig
The menu System > SysConfig contains the system configuration, which is where you can configure

general settings in order to tailor KIX to your needs. For example, you can

+ save the default team for receiving new tickets

+ save the default email address from which all outbound emails are sent

- amend the program interface (GUI configuration), by e.g. integrating dynamic fields or
+ changing views and widgets as required

+ amend the widgets in the sidebar

+ connect an LDAP/AD server to manage users.
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In the System > Console menu you will find a graphical user interface for executing system commands on
command line level. Here you can select from predefined commands and execute them. The console allows
you to import, create and save complete data packages and to migrate from KIX 17 to KIX 18.

‘ & Admin: Console X

Ausblenden <<

Administration Execute console command

-
»

[ Console:Command::Admin:Role:List... help

Setup Assistant Commands :

+ Assets

Conscle::Command: :Admin::Article::StorageSwitch
+ Automation Congole: :Command : : Addmin: : Contact : : Add
::Admin::Contact::List
::Admin::Daemon: :Reload
::hdmin: :FAQ: : Import
::Admin: :ITSH figitem::Delete
::hdmin::ITSM figitem::ListDuplicates
::Admin: : ITSM
::Admin:: TT5M: : ImportExport: :Export
::Admin: : TT5M: : ImportExport: : Import
::Admin::ITSM: :IncidentState: :Recalculate
::Admin: : ImportExport: :ListMapping:

. Conscle: :Ci
+ Communication

#+ Internationalisation Conscle::

* Knowledge Database Conscle
Console
n = System Eazel

Console

Console
Console::Cx

Dynamic Fields Consgle::

TportExport: : AutoCreateMapping

Execute

Fig.: Console

© Attention!

Once a command has been started, it must be executed! It can neither be aborted nor undone.
Commands executed via the console are a fundamental intervention in the core area of KIX. The
console is therefore mainly reserved for our support or only for very experienced administrators.
We would like to point out that you should only use the console with sufficient knowledge and with
caution. Otherwise, serious system errors or even system failure may result.

Please do not hesitate to contact us if you need assistance. We will be glad to help you.

12.1.1 Using the Console

The command console in the menu System > Console enables you to execute predefined console commands
using a graphical user interface. Only use the console if you have sufficient expertise in how to use it!

Only use the console if you have sufficient knowledge!

Execute console command 2

1 @ help 3

Conmands :

crageSwitch

[

Fig.: Console Structure
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Field

Description

Choose a command.

Select command to be executed from
selection field.

Help button

Clicking the Help button displays
information to assist you. If no command
has been selected, the info area shows all
commands that can be executed.
Alternatively, you can also execute the
command "help". If a command has been
selected, the info area shows the
arguments and parameters for

the selected command.

For entering a command

Enter command to be executed here. Then
click "Execute" to start execution of
command. The info area shows the result
of the execution.

Info area

Displays the possible commands
and parameters as well as the result of
the execution.
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Figure

Execute console command

Y

[0 Console::=Command:-Admin::Article:-StorageSwitch
[ Console:sCommand:=Admin:Contact:-Add
[l Conscle::Command::Admin::Contact: List

[ Console::=Command:-Admin::FAQ:import

Execute console command

[3 console::Command::Admin::Role::Lis...

Command:

Conscle: :Command: :Admin: :Rols

Execute console command

|§] help

Commands :

Execute console command
) Conssle-Commang-admi:Roke:Liz [B] -rale ramelTo-R-a20] Griiah FAQ Edikor ~m-ansi

& :Oormand: dnin: Bele: sLintlanss --role-case[T3-0-020] |initial) FAJ Editer —oo-ansi

Evecute console command

[ Comobe Command: Admin: bol: L.

[@] ~rote-nanmeiTo--0z0] tinkfal) G Editor ~no-an
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Field Description

5 "Execute" button

Click button to start execution of
command.

@ Tip

Execute the console command Console: :Command: :Lis tto get a list of all console

commands including explanations.

Figure
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Execute
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12.2 Dynamic Fields

You can integrate additional input and selection fields into the program interfaces and thus store individual
information at an object. These additional fields are called dynamic fields in KIX.

It is thus possible to store additional information on tickets, organisations or contacts, for example:

+ Date of commissioning

+ Serial numbers

« Customer and vendor numbers
+ Status of AV agreements

+ VIP identifier

+ newsletter subscriptions

+ extended notes

+ and much more.

This information is then available when editing, viewing and using organisations, contacts and tickets.

Dynamic fields can be included in the following objects:

« all ticket-relevant interfaces (e.g. dialogs "new ticket" and "edit ticket")
+ FAQ articles

+ Organisations

+ contacts.

The values stored in dynamic fields are directly linked to the object. This makes it possible to search
specifically for this information, evaluate it, and display it in overviews, detailed views, and in the sidebar.

Dynamic fields are first created and configured in the System > Dynamic Fields menu. Then, the Dynamic
Fields are integrated into the user interface at the desired location by configuring the corresponding system
keys (System > SysConfig menu).

Each Dynamic Field can be integrated at several places, so that the data stored in it is available at all relevant
places. For example, a dynamic field that is integrated into the ticket creation screen can (and should) also
be integrated into the ticket editing screen, and the values entered in the dynamic field can be displayed in
the ticket detail view.

Furthermore, dynamic fields are used in jobs and ticket notifications. In a job, for example, it can be defined
that a predefined value is set in a dynamic field under certain conditions. In ticket notifications, for example,
the value of a dynamic field can be read out and communicated in the message.

The values of dynamic fields can be referenced via KIX placeholder. Use the following syntax for this:
<KIX_[KIX-OBJECT]_DynamicField_[DynamicFieldName]_[Value]>. Examples:
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<KIX_TICKET_DynamicField_AffectedAsset> or <KIX_TICKET_DynamicField_AffectedAsset_ObjectValue>. In
the appendix you can find an overview of possible KIX placeholders.

KIX Pro users can additionally use dynamic fields in ticket actions or in ticket templates.

A complex search for the contents of a dynamic field is also possible. Dynamic fields can also be made
available in the Self Service Portal, so that your customers can save information on the ticket and see the
saved information.

Attachments: @ | & | Select file -
Account Time: & o Minutes
Cwner:
* Priority: 3 normal
* State: = open

Serial number:

! ’ Cancel | . Save

Fig.: Dynamic Field as Additional Input Field in Ticket Creation Screen

() Note

Invalid and temporarily invalid dynamic fields are not used and considered when executing:
+ Ticket notifications
+ Search and filter tickets
*+ injobs
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12.2.1 Creating, Editing and Incorporating Dynamic Fields

Before a Dynamic Field can be included in the program interface, it must be created and configured in the
System > Dynamic Fields menu. You can create different types of Dynamic Fields, depending on the type of
data you want to capture. You can choose between

+ Single-line and multi-line text fields

+ Select fields (dropdown with single and multiple selection)
+ Date and date-time fields

+ Checklists and

+ Asset reference fields

+ Ticket reference fields (KIX Pro).

See the Object and Field Types of Dynamic Fields (see page 281) chapter for an overview of these.

‘ Z & Admin: Dynamic Fie.. X ¥ © New Dynamic Field X

¥ MNew Dynamic Field

*Name: @ DfFSerialNumber

* Label: ®  Serial number
* Field Type: ® - Text
* Object Type: @ T Ticket

Enable for Self Service Portal: ®

B Valdty: 0 i

* Configuration: @

Count Min

1
The minimum number of items which are available for input if field is shown in edit mode.
Count Max

1
The maximum number of array or selectable items for this field. if field is shown in edit mode.
Count Default

1
If field is shown for display and no value is set, CountDefault numbers of inputs are displayed.

Item Separator

If field contains multiple values, single val d by this symbol/s.

Dhofoul

Fig.: Creating a Dynamic Field of the Type "Text" (Example)

To create a new dynamic field, proceed as follows:

1. In explorer, navigate to System > Dynamic Fields. In the content area, a table listing all the dynamic
fields created in the system opens.

2. Intable, click "New Field". A form dialog for creating a new dynamic field opens.

3. Complete the form (see table below) and configure field parameters (also see "Object and field types
of dynamic fields (see page 281) ").

4. Set validity to "valid" and click "Save" to save new dynamic field.
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The dynamic field is now created and can now be integrated into the program interfaces via the
configuration of the corresponding keys in the System > SysConfig menu. The chapter "Configuration of the
user interface (see page 327) " is dedicated to this topic in detail.

To edit a dynamic field, proceed as follows:

1. Inexplorer, navigate to System > Dynamic Fields. In the content area, a table listing all the dynamic
fields created in the system opens.

2. Intable, click dynamic field to be changed. A form dialog for editing the parameters of the dynamic
field opens. However, you cannot change the field type or object type, as doing so would remove the
underlying basis for the data that was previously saved.

3. Amend information as required and click "Save" to apply changes.

The changes are now effective.

To incorporate a dynamic field in the program interface, proceed as follows:

After creating a dynamic field, you can incorporate it in all ticket-related program interfaces. This
is done by editing the configuration keys in the menu System > SysConfig. To do this, please
read chapter "Integrating a Dynamic Field (see page 423) ".

The form dialog contains the following input fields, among others:

Field (selection)

Name

Label

Field Type

Description

The name acts as an internal identifier and is only used in the Admin area.

The system permits uppercase and lowercase letters, and numbers, but

not blanks or special characters. Each dynamic field is incorporated in the
program interface by referencing its name. Therefore, please use

a meaningful, unique name. If you change the name retrospectively (which is
not recommended), you will also need to change all interfaces,

jobs, notifications, etc. which reference the field.

The label is shown in front of the field. It describes the expected content of
the dynamic field.

The field type depends on what information is stored in the dynamic field.
For detailed information on the field types and their configuration, see Object
and field types of dynamic fields (see page 281)

AssetReference Generates a selection field for selecting multiple
assets.
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Field (selection)

Description

Checklist

Date

DateTime

FAQ Article
Reference (KIX Pro)

Contact Reference
(KIX Pro)

Organisation
Reference (KIX Pro)

Selection

Table

Text

Text Area

Ticket Reference
(KIX Pro)
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Generates a list of tasks in the form of a
checklist, which users can answer and comment on.

Date field; enables the user to enter a date.

Date and time field; enables the user to enter the
date and time.

Creates a selection field for selecting FAQ entries.

Creates a selection field for selecting Contacts.

Creates a selection field for selecting Organisations.

Selection field; contains a list of predefined values
that an agent can choose from.

Table; enables data in a ticket to be entered in
tabular form.

Single-line text field; for recording a word or a line of
text.

Multi-line text field; for recording a longer text.

Creates a selection field for selecting Tickets.

Issued on: 26.02.2024 Page 278



Field (selection)

Object Type

Description
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Your selection determines where or in which context the dynamic field can
be included. The selected object type is binding for the dynamic field.

For example, a dynamic field of the "Ticket" object type can only be included
in ticket-relevant interfaces, but not in FAQs or organizations, for example.
For detailed information on the object types and their use, see Object and
field types of dynamic fields (see page 281) .

Contact

FAQ

Organization

Ticket

The dynamic field can be included in contacts. This
allows

+ the contact data available in KIX can be
supplemented with additional, individual data

+ extended contact data from other systems are
also available in KIX.

The dynamic field can be included in FAQ articles.

In connection with the field type "AssetReference”,
assets can be referenced to FAQs so that, for
example, instructions, product data sheets, etc. can
be displayed in the sidebar when an asset is
selected ("RelatedAssets" dynamic field).

The Dynamic Field can be integrated into
organizations. This allows

+ the existing organizational data in KIX can be
supplemented with additional, individual data

+ extended organizational data from other
systems are also available in KIX

The dynamic field can be integrated in all ticket-
relevant interfaces (e.g. ticket creation mask, ticket
edit mask, lane "ticket information’, etc.).
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Show in Self Service
Portal

Validity

Configuration
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Description

You can specify whether a dynamic field that has been incorporated into the
user interface should also be available in the self-service portal. If you check
off this option, customers, too, will be able to enter data into this field and
view the information saved therein. If you do not check off this option, then
the dynamic field will only be available in the agent portal.

valid: The dynamic field is active; agents can
save information in it and the values can be used for
analyses.
invalid/ The dynamic field is not shown anywhere. However,
invalid-temporarily: any values that were already saved remain "hidden"

in the system

so that you can run an Advanced Search for these
values. In the Admin module you can also select
invalid fields, which means you can create elements
as part of preparatory work, for example.

After selecting a field type, the corresponding configuration options are
loaded. An overview of the configuration options is provided in "Object and
field types of dynamic fields (see page 281) "
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12.2.2 Object and field types of dynamic fields

When creating Dynamic Fields, you must select both an
object type and a field type. Your selection determines the
context in which a Dynamic Field is used, as well as its
appearance and behavior.

Object type

The selection of the object type depends on where the
Dynamic Field is to be included. It is binding for the
dynamic field. Dynamic fields of the "Ticket" object
type can only be included in ticket-relevant interfaces
(dialogs "New ticket", "Edit ticket", zoom view, etc.), but
not in FAQ articles or in organizations, for example.

Regardless of the object type, the values stored in the
dynamic fields can be displayed to the sidebar
widgets.

Field type

The selection of the field type depends on what
information is stored in the Dynamic Field. Different
configuration options are available depending on the
selected field type. The configuration of a Dynamic
Field determines its display and behavior in the
interfaces.
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Content on this page:

+ Object types (see page 282)
+ Field types KIX Start (see page

284)

All field types (see page
284)

Text and Textarea (see
page 289)

Selection (see page 289)
Date and Date/

Time (see page 292)
Checklist (see page 293)
AssetReference (see
page 297)

Table (see page 300)

+ Field types KIX Pro (see page

303)

TicketReference (see
page 303)
OrganisationReference
(see page 305)
ContactReference (see
page 306)
FAQArticleReference
(see page 308)
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The following overviews provide you with an overview of the possible object and field types as well as their

use and configuration options.

12.2.2.1 Object types
Object type

Contact

FAQ

Description

The dynamic field can be included in contacts.
Dynamic fields of this object type allow e.g.

+ the addition of further, individual data to the contact data available in
KIX (e.g. separate address)

+ information about the origin of the data record, e.g. from which of
the connected Active Directories

+ that extended contact data from other systems are also available in
KIX

+ individual identifiers such as participation in the newsletter, priority
identifier ("A customer"), VIP identifier.

Scheme for placeholder: <KIX_CONTACT_DynamicField_XYZ> (XYZ
= name of dynamic field)

The dynamic field can be included in FAQ articles and in the sidebar.

In connection with the field type "AssetReference", assets can be
referenced to FAQs, so that, for example, instructions, product data
sheets, etc. can be displayed in the sidebar when an asset concerned is
selected ("RelatedAssets" dynamic field).

Scheme for placeholder: <KIX_FAQ_DynamicField_XYZ> (XYZ =
name of the dynamic field)
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Organisations

Ticket
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Description

The dynamic field can be integrated into organizations.
Dynamic fields of this object type allow e.g.

+ the recording of extended information such as organization type
(supplier, customer, third party)

+ the addition of further, individual data to the organizational data
available in KIX

+ information about the origin of the data record, e.g. from which of
the connected Active Directories

+ that extended organizational data from other systems are also
available in KIX

+ individual identifiers such as the existence of an AV contract, priority
identifier ("A customer"), VIP identifier.

Scheme for placeholder: <KIX_ORG_DynamicField_XYZ> (XYZ =
name of dynamic field)

The Dynamic Field can be included in all ticket-relevant interfaces (e.g.
ticket creation mask, ticket edit mask, lane "ticket information” etc.), but
not in articles, organizations, contacts or FAQ.

Scheme for placeholder: <KIX_TICKET_DynamicField_XYZ> (XYZ=
name of the dynamic field).
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12.2.2.2 Field types KIX Start

All field types
The following configuration options apply to all field types except type "Checklist" and "Table".

Configuration options
Option Description

Name Unique identifier of the Dynamic Field.
The name is used in KIX placeholders to reference the dynamic field, e.g.
<KIX_TICKET_DynamicField_DFSerialNumber>.
The name is also used when you integrate the dynamic field into the interfaces
(e.g. dialogue "new ticket" or ticket details).

{
"id": "ticket-new-form-group-data”,
"name": "Translatable#Ticket Data”,
"fieldConfigurationIds™: [],
"separatorstring”: null,
"formFields": [
{
"id": "ticket-new-form-field-serialnumber”,
"label™: null,
"property”: "DynamicFields",
"inputComponent™: null,
"required”: false,
"hint™: "Translatable#Hzlptext”,
"options”: [
{
"option™: "FIELD MAME",
"value™: "DFSerialNumber”

}
1

"defaultvalue™: {1},
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Label

Field type

Object type

Show In Customer
Portal

Validity
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Description

Labelling of the dynamic field in the interfaces.

The label is placed in front of the dynamic field. It serves as orientation for the
user as to which entries are expected in the dynamic field or which data can be
selected.

The integration of the dynamic field in templates or actions and the use in
filters of jobs is based on the label.

£+ New Job
Filter
1 4 e >
Filter: ®
seria
Serial numb@gr 1 4 e >
Filter

The field type determines the data basis of the dynamic field (see top of page).

Defines the context in which the dynamic field is used (see top of page).

Check the box if the dynamic field should also be available in the Self Service
Portal.

This is particularly necessary when you create templates or actions for the
Self Service Portal. If the tick is not set, the field is not displayed in the Self
Service Portal.

+ valid: The dynamic field is active and can be used according to its
configuration.

+ (Temporarily) invalid: Invalid and temporarily invalid fields are not
displayed in the interfaces and cannot be used by actions, jobs or similar.
Data already stored on the object is retained and is available again in the
event of reactivation.
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Configuration

Description
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The configuration options available here depend on the selected field type.
However, some options are valid for all field types except checklist and table:

Count Min

The number entered specifies the minimum
number of times that the field should be included in
the form.

"0" - The field is not shown when loading the form,
but can be displayed by clicking "+"

"1" — The field is contained once in the form.

"2" — The field is contained twice in the form (etc.)

Exception: In selection fields (e.g. types Selection),
this specifies the minimum number of values to be
selected. This means that the field becomes a
mandatory field if the value is > 0.

Examples:

« CountMin = 1, CountMax = 2: In the dialog, at
least one of the maximum 2 possible selection
fields is shown.

+ CountMin = 0, CountMax = 1, CountDefault = 0:
In the dialog, only the label is shown, without
the selection field. The "+" symbol for
displaying the selection field is provided.
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Description

Count Max

Count Default
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The number entered specifies the maximum
number of times that the field is permitted to
appear in the dialog. If it is permitted to appear
several times, a plus and a minus symbol will be
shown after the field so that the field can be
duplicated for further entries. However, this
number specifies the maximum number permitted.

"0" - The field is not permitted to be duplicated.
"1" - The field is permitted to appear only once.
"2" — The field is permitted to be supplemented by
one more field.

"3" - The field is permitted to be supplemented by
two more fields. (etc.)

Owmer Information:
Assigned Organisation:
Assigned Contact:

Assigned Contact:

Example: Field "Assigned Contact" When Creating a
New Asset

Exception: In selection fields (e.g. Selection or
AssetReference types), this number specifies the
maximum number of selectable values. If you enter
a number > 1, the selection field will become a
multiple selection field.

The number entered here specifies how often the
field is shown initially when the form is called up.

Example: CountMax = 5, CountDefault = 5: Initially,
all 5 input fields are shown at the same time in the
form.
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Description

Item Separator

Default Value
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Separator symbol for displaying multiple values on
a single line (generally a comma or semicolon).

If several values are entered into the field (e.g.
multiple selection for the "Select" and
"AssetReference’ fields), the individual values will
be concatenated with this separator symbol if the
values are being shown on a single line (e.g. in
tables).

Preassigned value in the field. The field is
populated with this default value if no other value is
entered.

Exception: In the field types "Date" and "Date /
Time", the time is predated in this way (current +
number of seconds).
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In single-line text fields of the type "Text", you are only able to enter a word or sentence.

Country:

In multi-line text fields of the type "Textarea", you are able to save longer texts.

Comment: @

Configuration options (selection)

Option

RegEx List

Selection

Description

Regular expressions (RegEx) can be used to check whether the entries in
text fields are valid. For example, they allow you to specify that certain
expressions in the text will not be accepted, or that certain characters
are essential (e.g. the @ character in email addresses). A small selection
of regular expressions is available in the appendix at: Regular
Expressions (see page 744) .

Click "Add item" to save one or more regular expressions and
the associated error messages (optional).

RegEx: Here, enter regular expression against which entered text should
be checked. You can use multiple regular expressions.

E.g.." "[A-Za-z0-9]+$ "to permit a character string of any length
comprising letters and numbers.

RegExErrorMessage: Here, enter text displayed as error message if text
entered in text field contradicts regular expression.

The field type "Selection" generates selection fields for both single selections and multiple selections.
The values to be selected are specified when creating the dynamic field.
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Access: @

Agent Portal

Self Service Portal

[[] Select all

Submit

Configuration options (selection)

Option

CountMin

CountMax

Translatable

Values

Description

The number entered specifies the minimum number of selectable values.
If the value is > 0, the field becomes a mandatory field.

Indicates how many values can be selected simultaneously.

Entering a value > 1 will generate a multiple selection field. At the same
time, the value entered corresponds to the maximum number of
selectable values.

Examples:

Count Max > 1: A maximum of "Count Max" selection values can be
selected (multiple selection field with maximum selection).

Count Min > 0: At least the "Count Min" number of values must be
selected.

Count Max < 0: Any number of selection values can be

selected (multiple selection field)

Count Max ==1 OR Count Max ==0 or Count Max == NULL:
Precisely one value can be selected (single selection)

If you check off this setting, the values will be translated into the user's
language.

Please note: You may need to manually add the translations to the
translation files.
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Possible
Values
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Description

Here, save the possible selection values that are listed in the

selection field. Click "Add item" (several times if required) to save these
values as key value pairs.

Click "Delete item" to delete selection value from selection field.

Key: internal value for processing the selection value. This value is only
permitted to occur once in the selection field. A key must be specified.

Value: value displayed; the agent sees this when they open the selection
field.
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Dynamic fields of the types "Date" and "Date/Time" generate date fields in the form. You can use them to
save scheduled completion dates or agreed delivery dates in the ticket, for example.

In fields of the type "Date", the date can be entered in the format "DD.MM.YYYY".

Warranty Expiration Date:

TT.MM . 1)

In fields of the type "Date/Time", the date and time can be entered in the format "DD.MM.YYYY" and "hh:mm".

Plan Begin: 11.01.2021

15:30

Date and DateTime fields do not support dates beyond the year 2200.

Configuration options (selection)

Option

Default Value

Years in Future

Years in Past

Description

Initial preassigned value for the time. If you do not enter a value,
the current date will be shown.

Type "Date": 0 = current date, 1 = tomorrow, 2 = day after
tomorrow

Type "Date Time": If you enter a number in seconds, it will

be added to the current time (3600 = current + 1 hour; 86400 =
current + 1

day).

Number in years
Specify how many years in the future the calendar should
stretch, starting from the current date.

Number in years
Specify how many years in the past the calendar should stretch,
starting from the current date.
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Option Description

Date Restriction none: No restrictions apply when selecting a date.
DisableFutureDates: Stops the user entering dates that are in the
future, starting from the current date.

DisablePastDates: Stops the user entering dates that are in the
past, starting from the current date.

Checklist

Checklists enable you to integrate a list of predefined tasks in the ticket. For example, service

technicians can use them as a guideline for ensuring they provide the service in full and thus comply with
quality standards. Service technicians can work through and answer the checklist items one by one and add
a comment for specific items if required.

Checklists could also be used to create a conversation guideline to help the agent ask targeted questions in
order to localize the reported damage and find out the specifics. In this case, the conversation guideline
could, if required, be shown via a template in or action on the ticket, for example, and used (KIX Pro).

A progress bar shown in the ticket screens and on the Dashboard indicates how much of the checklist the
user has worked through. However, checklists could also be used for other workflows, such as for putting
together all documents required to deliver a machine, or the completion of interdisciplinary tasks.

The status of a checklist can also be displayed in tables. An example of the integration can be found under:
Configuration of dashboard tables (see page 497) .

TTIOTTLY- 3 TICTITaT

* State: & open
Checklist 01: ¥ com— > 2/5 -
Announce shut off f
I Nok 4
1  Identify energy source(s) @ PENDING

Isolate energy source(s) @z PENDING

g
B

Isolation by Ak

Lock & Tag energy source(s)

Ensure that equipment isclation Is effective

Fig.: Example of a Checklist
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Note: The configuration options Count (min), Count (max), Count (default) etc. are not available in checklists.

Option

ID

Title

Description

Input

Value

Sub

Add ltem

Delete Item

Description

Any desired value for internal processing purposes (optional).
The ID is only permitted to occur once in the checklist. If no ID
is entered, it will be automatically assigned by the system.

The title identifies a checklist entry "1

More accurate description of the checklist entry (optional) 2

Specifies whether a selection field or text field is shown to answer the
checklist item.

Text: The system shows a single-line text field in which the user
can save notes, for example. E.g. issues that occurred when

performing work . "3

Textarea: A multiline text field is displayed where users can enter
longer texts including line breaks.

ChecklistState: The system shows a selection field enabling the state
of the checklist item to be selected: 4

+ Completed/OK (OK)

+ Not completed/not OK (NOK)
+ Waiting (Pending)

- Not specified (n. a.)

+ Not required

Preset value (optional). The field is pre-populated with this value or
text.

Creates further sub-items for a checklist entry, thereby generating a
hierarchical tree structure for the checklist.

Adds further checklist entries.

Deletes the checklist entry including any sub-items.
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Advanced configuration option

Checklists can also be created or assigned via automation (macro action "Set dynamic field"). In this way, a
checklist field can be used in multiple forms and multiple configuration is avoided. The following example
shows the complete value to be assigned in a macro action.

Example of checklist content Preboarding when hiring new employees (technical)

[
{
Il-idll: "100"’
"title": "Send informationen",
"description": "Send/call a welcome and information email before First Day.

Provide important information: where, when, expected by

whom, corporate mission statement, organizational chart or communication
guidelines. Aim: to clarify general questions in advance.",

"input": "ChecklistState",

llvaluell: n_n
}s
{
ll-idll: "200",
"title": "Get documents",
"description": "Demand the involvement of the employee. Social security card,

health dinsurance, income tax card, tax ID. Target:
Avoidance of organizational questions in the first week.",
"input": "ChecklistState",

llvaluell: n_n
}s
{
ll—idll: |l300|l’
"title": "Name contact person",
"description": "Fixed contact person who is at your side - also with inquiries of

all kinds in advance - aka mentor / godfather / buddy.",
"input": "ChecklistState",

llvaluell: ll_ll’
"sub": [
{
ll—idll: |l310|l’

"title": "Buddy",
"input": "Text",

llvaluell: nn
}

]
}s
{

Il-idll: II4OOII’

"title": "Setup workspace",

"description": "The workplace must be set up on the First Day. These -include:

provision of passwords, printer access, telephone,
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Office chair/desk, other aids. Goal: Avoid technical blockers in the first

week.",

for

"input": "ChecklistState",

"Value”: n_n

Hid": HSOOH’

"title": "Create an induction plan",

"description": "Must be early, before starting work. Content: detailed work plan

the first week; Tasks; future projects. Goal: prevent
chaos and idle time.",
"input": "ChecklistState",

”Value”: H_H’
"sub": [
{
Hid": H510H’

"title": "URL-induction plan",
"input": "Text",

”Value”: nn
}
]
Hid": H600H’
"title": "Organize the search for accommodation",
"description": "Support for outsiders in finding accommodation, moving or dealing

with authorities. Goal: Avoiding distraction, enabling

]

Concentration on familiarization.",
"input": "ChecklistState",
”Value”: n_n

References:

General use of checklists: Use of checklists

+ Application example: Configuring and providing checklists
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AssetReference

Dynamic fields of the type "Asset Reference" create selection fields in which one or more assets (up to a
maximum of 15) can be linked to a ticket or FAQ article. Such dynamic fields are, for example, the selection
fields "Affected Asset" in tickets and "Related Assets" in FAQ articles. It is possible to adapt the configuration
of these Dynamic Fields to the company's own requirements and to create further Dynamic Fields of the type
"Asset Reference".

Dynamic fields of type "AssetReference" reference one or more assets. When used, the objects available for
selection depend on the authorisations of the logged-in user and the field configuration (e.g. restriction to
certain deployment states).

With KIX placeholders you can directly address each of these assets as well as attributes.'For notes on this,
see Overview KIX Placeholders (see page 750) (section: Placeholders for referencing dynamic fields).

5
T New Ticket

* Contact: @

*]

* Organisation: @
Affected Asset: @

* Type: thin ~

. B A#174000277 - ThinClient251 i
* Assign Team / Queue:

B A#174000278 - ThinClient252

% -
Channel: B A#174000279 - ThinClient253

Enable for Self Service Portal: & A#174000281 - ThinClient255

i B A#174000282 - ThinClient256
* Subject:
B A#174000283 - ThinClient257

. .
Ticket Description: g 4174000784 - Thinclient75a v

] selectall L Submit

Fig.: Field "Affected Asset" as Example of Dynamic Field of Type "AssetReference”
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CountMin

CountMax

Deployment
States

ITSMConfig-
ItemClasses
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Description

The number entered specifies the minimum number of selectable values.
If the value is > 0, the field becomes a mandatory field.

Indicates how many values can be selected simultaneously. Entering a
value > 1 will generate a multiple selection field. At the same time, the
value entered corresponds to the maximum number of selectable values.

Save one or more deployment states for assets here.

The form field will then only show assets for selection if they have the
deployment state specified here.

To do this, click "Add item" (several times if necessary). Click "Delete
item" to delete selection value.

If no DeploymentStates are selected, there will be no restrictions and the
form field will take into account all deployment states.

Save one or more asset classes here. In the form field, only the assets

of the asset classes specified here will then be available for selection. To
do this, click "Add item" (several times if necessary). Click "Delete item"
to delete asset class from selection. If no ITSMConfigltemClasses are
selected, there will be no restrictions and the form field will allow the
user to select the assets of all asset classes created in the system.
However, the maximum limit is 15 assets.

Placeholder for Asset Reference Fields

You can access the assets selected in the dynamic field as well as their attributes via KIX placeholders. This
allows you to reference this information in jobs or actions, for example, and make it available to other
objects. How you can use the placeholders can be found in the overview of KIX Placeholders. (see page 750)
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Linking assets to the ticket

The assets selected in a field of the type "AssetReference" are initially linked to the ticket as "Relevant to".
The SysConfig key "Ticket::EventModulePost###ITSMConfigltemLinkAdd" enables you to change the type of
link.

{
"Event": "(TicketDynamicFieldUpdate_AffectedAsset)",
"LinkType": "RelevantTo", //DependsOn|RelevantTo|RequiredFor|normal
"Module'": "Kernel::System::Ticket::Event::ITSMConfigItemLinkAdd"

}

+# Link Asset

-

Hit List (0)

Depends on

[]  SLA Criteria iceet#

Nothing found. Required for
< Relevant to
MNormal
Link Type:
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Table

Dynamic fields of the type "Table" create tables in order to be able to save values in tabular form on the
ticket. For example, to record the quantity, item and shelve number as well as a comment for inventory. The
column headers are predefined when the dynamic field is created and cannot be changed in the editing
screens.

[ FTIGIY. Fnormal
* State: & open
Inventory: @ !:l Remove table ‘
Numbers Item number Shelve number Note Action
5 A-4711 Cc125 Tili
22 A-4712 €300 -+
! l Cancel ‘ , Save

Fig.: A dynamic field of the type "Table" in the new ticket dialog

Issued on: 26.02.2024 Page 300



Configuration options (selection)
Option

Columns

Number of rows (min)

Number of rows (init)

Number of rows (max)

Translate Table Columns

Integrating into the interfaces
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Description

Define the columns including headings here.
Click on "Add item" to create further columns. Write the column
heading in the text field of the item.

Minimum number of table rows to be displayed. Values <1 are
not possible.

Number of table lines to be displayed initially. This way, you
determine that, for example, the table is available with 3 lines
when creating a new ticket.

Maximum number of table lines. You thus specify that the table
may contain a maximum of 5 lines, for example. The user
cannot add more lines by clicking on the plus symbol.

If activated, the column headings are translated into the
language used by the user. Provided that the corresponding
patterns have been stored under Internationalisation >
Translations.

The integration of the table into the KIX Start interfaces is basicly done as described under Integrating a
Dynamic Field (see page 423) . In KIX Pro, the tables can be provided comfortably via templates and actions.

Tables can be declared as mandatory fields:

+ KIX Start: Set the "required” parameter to "true".
+ KIX Pro: Activate the checkmark in front of the dynamic field when creating the action or template.

If the table is declared as a required field, the table must not contain any empty rows and the table cannot be

removed or shown.
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In order to display the table in the ticket details, you can insert the following code block into the key "ticket-
details-info-card" (KIX Pro: Ticket Info Widget). Proceed as described under Displaying Values of Dynamic
Fields (see page 442) . Replace the exemplary descriptions "Inventory" or "DFInventoryList" with the real
descriptions.

{
"title": "Translatable#Inventory",
"style": "",
"separator": true,
"values": [
[
{
"componentId": "dynamic-field-value",
"componentData": {
"name": "DFInventoryList"
Iy
"conditions": [
{
"property": "DynamicFields.DFInventoryList",
"operator": '"NE",
"value": null,
"useObjectService": false,
"useDisplayValue": false
}
]
}
]
]
}s
KIX Placeholder

To access the data of the table, you can use the following placeholders:

+ <KIX_TICKET_DynamicField_TableFieldKey>: displays the table in a plain text representation.
+ <KIX_TICKET_DynamicField_TableFieldKey_Short>: represents the table in the form "X rows" (X =

number of rows).
+ <KIX_TICKET_DynamicField_TableFieldKkey_HTML>: represents the table with heading and values in

the body of the notification/article/email.
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12.2.2.3 Field types KIX Pro

KIX Pro contains additional field types for the configuration of referencing dynamic fields. The placeholders
for these fields return an array whose individual values can be addressed concretely. For notes on this, see
Overview KIX Placeholders (see page 750) (section: Placeholders for referencing dynamic fields).

TicketReference

Dynamic fields of the type "TicketReference" create selection fields in which one or more tickets can be
referred to (e.g. field "Related tickets"). The input behaviour corresponds to that of a "Select" field.

When used, the objects available for selection depend on the permissions of the logged in user and the field
configuration (e.qg. restriction on ticket types and status). Searching for tickets corresponds to a full-text
search by ticket number or ticket title. You can also enter the username to search for tickets from that user.

Dynamic fields of the type "Ticket Reference” can be used, for example, to assign parent/child tickets, to
establish structures for main/subtasks, dependencies or other references. The fields "Parent Tickets", "Child
Tickets" and "Related Tickets" are delivered pre-configured. To use parent/child tickets, the fields must be
added in the configuration of the input masks (see Actions).

Entering values in these fields automatically adds links between the current ticket and the tickets referenced
in the fields according to the configuration of the dynamic field.

S5ign Team / (queue: [TD-TEAM-001] Lst level team (vall

SLA/Service Agreement: @
hannel: @
Channel ‘#‘ ‘.'!‘

Account Time: @ Minutes

Related Tickets: @

Owner: @ | 20°
| T Ticket#2021091517000073 - [TD-T-007] 4. Ticket zum Tests won Obiekt-Verknipfungen ~
Responsible: @
T Ticket#2021091517000082 - [TD-T-008] Ungelesene Artikel
o e
Priority: @ | ¢ ret42021091517000162 - [TD-T-016] Kompressor meldet Fehler 0815
*Gtate: @ | T Ticket#2021091517000224 - [TD-T-022] Icon hangt schief
T Ticket#2021091517000233 - [TD-T-023] Fehlermeldung 'Die ist eine Nichtfunktion'
Plan Begin:
T Ticket#2021091517000331 - [TD-T-033] Technisches Gerit ist defekt
Plan End: T Ticket#2021091517000359 - [TD-T-035] Gabelstapler-Terminal meldet Fehler auf Layer &

T Ticket#2021091517000377 - ITN-T-0371 Pritfuns Armatur 13 bt

Select all Submit

Fig.: The field "Related tickets" in ticket edit dialog as an example for a dynamic field of the type
"TicketReference

Configuration options (selection)
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CountMin

CountMax

Ticket
States

Ticket-Types

Link Type

KIX 18 Admin Manual - EN - KIX Start

Description

With the entered number you define the minimum number of selectable
values. The field becomes mandatory if the value is >0.

Indicates the maximum number of values that can be entered in a field. If
a value >1 is set, a multiselect field is created.

Hinterlegen Sie hier einen oder mehrere Ticketstatus. Bei Eingabe
werden dann nur Status dieser Typen betrachtet. Werden keine
Ticketstatus ausgewabhlt, gibt es keine Einschrankung und im
Formularfeld werden alle Verwendungsstatus beriicksichtigt.

Enter one or more ticket types here. Only tickets of the corresponding
ticket types can be selected in the form field. If no ticket types are
selected, there is no restriction and tickets of all types can be selected in
the form field.

Defines which link is created between the current object (ticket) and the
target ticket. The target ticket is <link type> of the source ticket. Without
specification, no link will be established.

Important: The dynamic field must be stored in the SysConfig key
"Ticket::EventModulePost###900-AddTicketReferencelink" so that links
to other tickets can be created.

*MName: @  Ticket::EventModulePost###900-AddTicketReferenceLink

Create link between ticket and another ticket on DynamicFieldUpdate (This event only create links, links
can only be deleted manually).

Description: @
A
* Validity: @ valid

{"Event":"TicketDynamicFieldUpdate_(ParentTickets |ChildTickets|RelatedTickets | DFmyTicketReference)”
,"Module":"KIXPro::Kernel::System:: Ticket::Event::AddTicketReferenceLink "}

Value: @

A

{"Event":"TicketDynamicFieldUpdate_(ParentTickets | ChildTickets| RelatedTickets)","Module":"KIXPro::Ke
rnel::System::Ticket::Event::AddTicketReferenceLink"}

Default Value: @

A

Fig.: Depositing a dynamic field of the type TicketReference in the event
handler
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System
Dynamic Fields

Possible
Values

0..n

new | open |
pending
reminder |
pending auto
| closed | ...

Unclassified
| Incident |
Service
Request]| ...

Parent | Child
| Normal
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OrganisationReference

Dynamic fields of the type "OrganisationReference" refer to organisations. They create selection fields for
selecting one or more organisations. The input behaviour corresponds to that of a "Select" field. In the
configuration, you can define, among other things, which organisations are available to the user for selection
and with which organisation the field is to be preset (multiple selection possible). In addition, the objects
available for selection depend on the authorisations of the logged-in user.

T Ticket
* Title:
* Organisations:

Channel: my 9!1

# My Organisation (MY_ORGA)

Enable for Self Service Portal:; [] Select all Submit

* Subiect: @

Fig.: A dynamic field of the type "OrganisationReference" in a ticket template

Configuration options (selection)

Option Description

Count Min Defines the minimum number of organisations that must be selected.
The field becomes mandatory if the value is >0.

Count Max Sets the maximum number of organisations that can be selected.

Default Value Specifies the organisation with which the dynamic field is to be preset.
Specify the IDV of an organisation.
The pre-selection made here can be changed by the user by selecting
other organisations.
If no default value is defined, the field is displayed without
preassignment (empty).
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Option Description

Organisation Restriction of the organisations available for selection. Only the
organisations specified here are available for selection in the field.
To do this, click (several times if necessary) on "Add Item" and enter the
IDY of an organisation in each item.
If nothing is specified here, all organisations are available for selection.

) You can find the ID in the footer of your browser if you move the mouse pointer over an organisation in the
overview of organisations.

ContactReference

Dynamic fields of the type "ContactReference" create selection fields for selecting one or more contacts on
the ticket. It is thus possible to add further contacts to a ticket. The input behaviour corresponds to that of a
"Select" field.

In the field configuration, you can restrict the selection of contacts to selected organisations and specific
user groups (agents, customers). Only the contacts that fulfil the criteria defined here are then available for
selection in the interfaces. The contacts available for selection also depend on the authorisations of the
logged-in user.

T Ticket
* Title:
* Contacts:
Channel: tyle
© Rose Tyler (contact009) @
Enable for Self Service Portal: (7] Select all Submit
* Cuihinet. ()

Fig.: A dynamic field of the type "ContactReference" in a ticket template

Using KIX placeholders, dynamic fields of the type "ContactReference" can also be set as additional
recipients in ticket notifications. The ticket notification can thus be sent variably to the respective contacts
set in the ticket. The email address of the contact is taken from the placeholder so that you can use the
parameters _Short, _Value and _HTML:

+ <KIX_TICKET_DynamicField_myDFContactReference_Value> : "Last Name, First Name" <email>
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+ <KIX_TICKET_DynamicField_myDFContactReference_Short> : email
+ <KIX_TICKET_DynamicField_myDFContactReference_HTML> : "Last Name, First Name" <email> (as

"mailto-HREF")

A prerequisite for correct use is that a valid and syntactically correct email address is stored in the dynamic

field in the ticket.

Configuration options (selection)

Option

Count Min

Count Max

Item Separator

Default Value

Organisations

Beschreibung

Defines the minimum number of contacts that must be selected. The
field becomes mandatory if the value is >0.

Sets the maximum number of contacts that can be selected.

Separator between the individual contacts if several contacts can be
selected in the field (usually comma or semicolon).

& Important!

The separator must be a comma if the field is referenced in the
additional recipients of ticket notifications (see page 184) .

Specifies the contact with which the dynamic field is to be preset.
Specify the ID?) of a contact. The pre-selection made here can be
changed by the user by selecting other contacts.

If no default value is defined, the field is displayed without
preassignment (empty).

Note: If the default value is not compatible with the organisation or
context usage set in the configuration, the respective contact is not set.

Restriction of the contacts available for selection.

Only the contacts of the organisations selected here are available for
selection. To do this, click (several times if necessary) on "Add Item" and
enter the ID? of an organisation in each item.

If nothing is specified here, all contacts are available for selection
(possibly depending on the selected context of use).
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Option Beschreibung

Usage Context Restricts the selection based on the context of use. To do this, click on
"Add ltem". One context of use can be selected per item.

+ Agent: Only users who have access to the Agent Portal can be
selected.

+ Customer: Only users who have access to the Self Service Portal can
be selected.

The combination of the usage context agent and customer is possible. If
nothing is defined, there is no restriction to users, so that contacts
(without access to the Agent or Self Service Portal) can also be selected.

2) You can find the ID in the footer of your browser if you move the mouse pointer over a contact in the
overview of contacts.

FAQArticleReference

Dynamic fields of the type "FAQArticleReference" create selection fields for selecting one or more FAQ
entries. They are used to create simple references to FAQ entries in order to initialise templates and actions
with them.

Alink is created between the ticket and the referenced FAQ entries, which is particularly helpful for
application scenarios such as maintenance planning or in connection with the Field Agent App.

In this way, you can store FAQ entries (manufacturer's notes, product data sheets, etc.) in templates for
maintenance plans, for example, so that they are automatically available on the ticket when it is created.

The input and selection behaviour corresponds to that of a select field. When used, the FAQ entries available
for selection depend on the authorisations of the logged-in user and the field configuration (e.g. limiting the
FAQ entries to selected categories and languages).

Configuration options (selection)
Option Description

Count (min.) Defines the minimum number of FAQ entries that must be selected. The
field becomes mandatory if the value is >0.

Count (max.) Defines the maximum number of FAQ entries that can be selected.
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Item Separator

Default Value

FAQ Categories

FAQ Languages

FAQ Customer Visible

Link Type

3)

overview of contacts.
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Description

Separator between the individual FAQ entries, if more than one can be
selected in the field (usually comma or semicolon).

Specifies which FAQ article the dynamic field should be pre-populated
with. Enter the ID® of the FAQ article. The pre-selection made here can
be changed by the user by selecting other FAQ articles.

If no default value is defined, the field is displayed without a default value

(empty).

Restrict the FAQ entries available for selection to FAQ categories.
In the dynamic field, only those FAQ entries are displayed that are
assigned to the FAQ categories specified here.

If necessary, click on "Add ltem" several times and select the
corresponding FAQ categories.

Restrict the FAQ entries available for selection to the languages specified
here.

If necessary, click on "Add ltem" several times and select the
corresponding languages.

Restricts the FAQ entries available for selection in the field based on the
set visibility in the Self Service Portal.

+ Only visible in the Self Service Portal: Only FAQ entries with the
"Show in customer portal" option activated are available for
selection.

+ Only not visible in the Self Service Portal: Only FAQ entries with the
"Show in customer portal” option deactivated are available for
selection.

« Both: The FAQ entries visible and not visible in the Self Service Portal
are available for selection.

Select the link type with which the object type and FAQ entry/entries are
to be linked.

You can find the ID in the footer of your browser if you move the mouse pointer over a contact in the
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FKIX is initially delivered with the dynamic fields used by the system. You can adjust the configuration of
these fields if necessary. However, do not change the field labels. Otherwise the fields cannot be correctly

referenced and used by the system.

Note the object type when integrating dynamic fields! The object type defines the context in which the
dynamic field can be used. Dynamic fields of the "Ticket" object type can only be integrated into ticket-
relevant interfaces, but not, for example, in FAQs or organisations.

The following overview lists the dynamic fields initially delivered with KIX Start. Additional initial dynamic
fields are delivered with KIX Pro.

The following dynamic fields are delivered with KIX:

Field name

AffectedAsset

MobileProcessi
ngState

Field type

AssetReferen
ce

Selection

Object type

Ticket

Ticket

Description

Is required for the
selection of affected
assets in the ticket.

The configuration defines

the selection options in

the "Affected asset" field.

Is required for the Field
Agent App.

Contains the processing
status of the ticket in the
Field Agent App (accepted
| rejected | finished | etc.)
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Configuration options

Limit the number of
selectable assets
(Count Max);
Maximum: 15
Limitation of the
selectable assets to
certain usage states
(deployment state)
Limitation of the
selectable assets to
certain asset
classes
(ITSMConfigltemCla
Ss)

Change of names
Addition and
removal of (un)
required processing
status
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Field name Field type Object type Description Configuration options
PlanBegin/ Date/Time Ticket Used to record planned + Limitation of the
PlanEnd times in the ticket. calendar

+ Adjustment of the

The configuration defines )
automatically set

the preset value in the

fields and defines the times
possible calendar period
RelatedAssets AssetReferen  FAQ Used for selecting assets + Limit the number of
ce in FAQ. selectable assets

(Count Max);

+ Limitation of the
selectable assets to
certain usage states
(deployment state)

+ Limitation of the
selectable assets to
certain asset
classes
(ITSMConfigltemCla
Ss)

The configuration defines
the selection options in
the "Related Asset" field in
the FAQ article.
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Field name

Source

Field type

Text

Object type

Contact
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Description Configuration options

Is used to provide not mandatory
individual contact entries

from LDAP/AD directory

services.

The field can be specified
in the UserSyncMap in
order to include contact
attributes from the LDAP/
AD.

If the field contains a
value, this is displayed in
the contact detail view.

The field thus offers the
possibility, for example.

+ to store in a contact
entry from which AD
the contact originates

+ to provide the
identifiers for contact
data of other systems
in KIX as well.
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Field name Field type

Typ Selection

System Monitoring Connection

Object type

Organisation
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Description Configuration options

Is used to provide + Define the number
organisational data and is of selectable entries
included in the interfaces + Define the

for creating/editing selectable entries
organisations. If the field

contains a value, this is

displayed in the detail

view of the organisation.

The field can be specified
in the UserSyncMap, for
example, in order to record
organisational data from
the LDAP/AD. So it is
possible

+ to deposit at an
organisation from
which AD the
organisation
originates

*+ to provide the
identifiers for
organisational data of
other systems in KIX.

The following dynamic fields of the field type "Text" and object type "Ticket" exist for the connection to
system monitoring systems (e.g. Nagios):

+ AcknowledgeName
+ SysMonXAlias

+ SysMonXAddress
+ SysMonXHost

+ SysMonXService

+ SysMonXState

For instructions on how to use it, see: System Monitoring (see page 736) .
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12.3 Logs

KIX creates a log for all important system messages and saves
this in so-called log files (log files). Among other things, this
allows the causes of problems to be discovered. The log files are
saved as text files in the menu System > Logs and contain the
data from the KIX system log. The overview contains the last 50
log entries, which corresponds approximately to a period of 2

days.

If required, you can download the log files or open them for
viewing in a new KIX tab. To download a log file, click on it in the
table. Afterwards, the browser functions for opening and saving are available. To view the log file directly in
KIX, click on the eye symbol belonging to the log file in the column "View". The selected log file will be
opened in a new KIX tab. You can filter the display of the logfile.

Option

Log Level

Tail Lines

Refresh Interval (sec)

Wrap Lines

Filter

Description

Limits the display to the selected
categories.

Limitation of the number of lines
displayed in the log. The last n lines are
displayed.

The number of lines always refers to the
selected log level, e.g. the last 10 error
lines.

Determines every how many seconds
the display should be completed.

Switching line breaks on and off

Filtering on specific entries (full text
search).

RegEx are supported.

The filter refers exclusively to the
current display in the log.
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Content on this page:

+ Refreshing Log Files (see
page 315)

+ Debug level setting for
postmaster (see page 316)

Possible values

Debug | Error | Info | Notiz

Number of lines

Default: 100

Unlimited number of lines: 0 or
empty

Number in seconds
Default: 10
Deactivation Refresh: 0 or empty

yes|no

e.g. "Auth” or "System" or "Nov
24"

Page 314



KIX 18 Admin Manual - EN - KIX Start
System
Logs

4 & Admin:logs X | ® ViewlogFile X [ 3

View Log File: kix.log.2021-11

Refresh )
Log Level Tail Lines = Wrap Lines Filter
intervallsec)

Debug Error Info Natice 50 © systemn

Mpdule: Kernel::System::Daemon::DzemonModules::SchedulerTaskWorker::Run Line: 2335
[Wed Nev 24 12:30:11 2021] [Error] [Kernel::System::MailAceccunt::DPOF3::Fetch] [144] POP3: Can't connect to pop3.example.com
111 2021] [Error] [Kernel: :System: :Daemon: :DaemonModules: -BaseTaskiorker::_HandleError] [56] There was an error executing Execute() in

onsole::Command: :Maint::PostMaster: :MailAecountFetch: ERR0R: kix Console_pl-Maint::PostMaster::MailRecountFetch-17 Perl: 5.28.1 O5: linux Time: Wed
::System::MailRecount::POD3: :Feteh Line: 144
::System: :MailRccount::MailAccountFetch Line: 531
n ::8ystem: :Console: :Command: :Maint: :PestMaster: :MailkecountFetch: :Run Line: 36
::5ystem::Console::BaseCommand: :Execute Line: 456
::8ystem: :Deemon: :DaemonModules: : SchedulerTaskWorker: :Cron: :Run Line: 131
Module: System::Daemon: :DaemonModules: : SchedulerTaskiorker::Run Line: 233

[Med Hov 24 12 2 2021] (Error] [Keznel::System: :MailAccount::POP3::Fetch] [144] POP3: Can't connect to pop3.example.com

[Wed Nov 24 :12 2021] [Errox] [Kernel::System: :Daemon: :DaemonModules::BaseTaskiWorker::_HandleError] [56] There was an error executing Execute() in
onsole: :Command: :Maint::PostMaster: :MailAccountFetch: ERROR: kix.Conscle.pl-Maint::PostMaster::MailhccountFetch-17 Perl: 5.28.1 03: linux Time: Wed

Kernel: :Syst:
Nov 24 12:40 021
Module: Kernel::System::MailRccount::POP3::Fetch Line: 144
Module: Kernel::System::MailRecount::MailkccountFetch Line: 531
Module: Kernel::System::Console::Command::Maint::PostMaster::MailkecountFetch: :Run Line: 36
Module: Kernel::System::Console::BaseCommand::Execute Line: 458
Module: Kernel::System::Daemon::DaemonModules::SchedulerTaskWorker::Cron::Run Line: 131
Module: Kernel::System::Daemon::DaemonModules::SchedulerTaskWorker::Run Line: 233

Fig.: A filtered log file

12.3.1 Refreshing Log Files

You are able to clear the log files of your KIX environment or have them explicitly rotated. This enables you to
free up storage space and obtain log files of a manageable size.

To clear log files:

Navigate to System > Console and execute console command "Maint::Log::Clear". This clears all log files
of the current KIX environment.

To rotate log files:

Navigate to System > SysConfig. You can define the rotation behaviour in the following SysConfig keys:

Key Possible Values Description

LogModule::LogFile::Rota  never, hourly, daily, weekly, Defines the interval at which the log files
te: monthly should be rotated.

Default: onthly
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Key Possible Values Description
LogModule::.LogFile::Kee ~ Numerical entry Defines the number of old files
p Default: 12 that entry should be retained. Only

applies if the value

Default: 12

"File" (Kernel::System::Log::File)
has been selected in the
SysConfig key "LogModule".

"12" by way of example: The 12
most recent log files are not

deleted.

"0" by way of example: No files

are deleted.
LogModule::LogFile::Max  10M, 5K, 3G oder Max. size indicated in bytes. The
Size 10m, 5k, 3g unit can be specified in

either uppercase or lowercase
letters, but must come directly
after the number (no blank)!

If the files are rotated by size,
all log files will be shifted by 1 and
the current file suffixed with "_1"

() Please note

The changes do not affect Daemon debug logs as they have their own setting
(key "Daemon::Log::DaysToKeep").

12.3.2 Debug level setting for postmaster
SysConfig key PostMaster::MailAccountFetch::Debug

In the SysConfig key "PostMaster::MailAccountFetch::Debug" you can set the debug level for Postmaster
incrementally. The setting can be set independently of other or global debug options so that you get targeted
debug information for mail fetching in the log. The debug level is observed for postmasters with mail
retrieval and email filtering mechanisms (Email Filter, SysMonX Filter).

4 levels can be set:
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Level Description
0 Off
1 Info (active)

Activates the debug output for MailAccount and PostMaster (lowest level).

The debug information from the IMAP/POP3 connections is output.

This includes basic information about PostMaster FollowUp, Reject, DestQueue
and NewTicket as well as some PostMaster filter information.

2 On (general)

Extends the debug outputs with further PostMaster information, especially
PostMaster filters.
They depend on the respective PostMaster filter.

3 On (with Get Header parameters)

Extends the debug output with further PostMaster information, such as
"PostmasterX header".

The configuration only applies to the MailAccountFetch and is in 2nd place. This means: if a debug (via
console command) is already active, then this is preferred.

@ Info

Debugging is dependent on the set Minimum Log Level. Therefore, set the value "debug" in the
SysConfig key "MinimumLogLevel".
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12.4 SysConfig

The menu System > SysConfig contains the KIX system configuration (hereinafter referred to as SysConfig).
This is where you can make changes to the basic KIX settings and configure the program interface. As a
result, you are able to tailor KIX precisely to suit your company's specific needs. All changes to the system
configuration are made by changing the values of a system key. Virtually all configuration parameters of the
central framework and additional modules can be changed. For example, you can

save the default team (see page 625) for receiving new tickets, unless specified otherwise in the email
accounts.

save the default email address (see page 224) from which all outbound emails are sent, provided that no
other email address has been specified in the team settings.

amend the user interface (see page 327) (GUI) by e.g. integrating dynamic fields, changing table
columns, changing the default values in fields

customise the display in the sidebar widgets (see page 412) and much more.

© Attention!
Changes made to the system configuration always constitute a fundamental intervention into
the central KIX system. We would like to highlight that making careless or ill-considered changes to
the configuration files can cause serious system errors and even complete system failure. Please do
not hesitate to contact us if you require any assistance. We would be glad to tailor KIX to your needs
or help you to configure the system.

& Important!

Make changes to the system configuration at a time when the system is not being used. This
will prevent potential conflicts in the system.
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() Please note

+ Some of the terms used in the KIX frontend are aimed specifically at Technical Service.
However, ITSM-compliant terms are used internally within KIX. The following terms are
affected:

+ Team => Queue

+ Asset(s) => Cl/Config Item(s)

+ Asset database => CMDB

+ Organization/Organisation => Customer

+ The SysConfig keys for your own organisation use the English notation with "z" (e.qg.
OrganizationAddress).

If you are using our KIX Cloud and need to access a software backup, KIX Cloud users can contact
our Support team as provided for in the support contract. If you are hosting the system yourself, you
will need to access your own backup.
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12.4.1 Table in Dashboard

The table in the Dashboard lists the configuration keys of KIX based on a search term. In search field, enter
name to search for specific keys. You can search through the properties in the columns "Name", "Context",
and "Metadata". If you are only searching for part of a name, it must be placed in * (wildcard search, e.g.
"ticket-new*"). To display all keys, enter only asterisk in search field. It may take a moment for all keys to

load. You can also use the search functions and filters within the table to search for a specific key.
The configuration keys can be marked as follows:

+ Modified keys are marked with a check mark in the "Modified" column.

+ To find all modified keys, enter "modified" in the search field. To find all keys that have not been
modified, type "!modified".

+ Keys set to "invalid" are displayed in light gray.

+ Keys marked with a lock icon are locked for editing in SysConfig.

+ Keys highlighted in orange are security-relevant keys set to "valid".

Click on a key to open it for editing.

d o & ndmin: syscookig X »
Q. bystem: Sywonfe (16) o baload Fruvtan...
T Beket-rew”
Swtum Aasistart
o A 7] mame - Hodificd Contenn. Matadaa ALt L. Validity ko Changed ar Changad by
B it ] Fcbet-new-sifeched-assed-tickets Kin 3wt rorbend \Wiet intrmal i {77 gkt e ffected-asset Scket ™ mame™., /2773021, 08:80 et ansianed
* Communicasion (] cicket-new-contact-cand-widgst kint8-web-frontend Widget Internal valid {7id": Yicket- new-contact-card-wideet”,“name":"_. not assigned
S ] ticket-new-contact-tickets kin18-web-frontend Widget internal valld {7id": ticket new-contact-tickets",“rame”™: Ticke... not assgned
n # kaowkidee Datahro | Echet-reewdiakog-suggestec-tag-widget kixiS-wolrfrontend Wwidgat intarsed valid "y -ra-disogsuggestod-fag-widget”, . ot assignaed
ey 1 cchet-new-diabog-widgat kit wobrfromband Widgat intarea valid I thckot-new dislog-widges", “nama":"lew T... roit assignad
;:‘ e o O] ccket-new-foms. Ein18-wetrrontend Form interral vl i “okat-rewfonm”rame” Translaablesn, not assigned
T ] rcket-new-fomedlekd-channel Kinid-web-frontend Formield interral vl {70 thoket- rerw Fronm-Hiedd-charnmed ™, "label T, it assigned
SexCone 1 ticket-new-form-field-contact kin1f-met-frontend Formeieid Intera it T et rem-form-fiedr-contact” Tabel*:Tr..  ORIZTV202], 0900 A root aesbamed
* Ticks 1 Fcket-new-formmfskd-npanisation kin 13wt frorkend Formeield intereal walid r t-reew-form-fsld-oopeisation” “lobel.,  ©R/Z7/2021, 050 &M ot asshmed
® L Manapement 7] ochet-new-formfickd-ownar kint&-wab-frontond FormFleld Intarmal vald "y t-nerw-form-Held-comar . label - “Tra.. not assignad
1 cicket-new-form-eld-priorey kintG-web-frontend FormFleid interral vald {71 ticket-rew-form-tedd-prorey”, label*: ... OF/27/2021, 00: 30 AM  not assigned
J cchet-new-fomeleld-gueue kixiS-wabr-frostand FormEisld intareal vailid {7 ookt reea-form-fedid-quaa ™, "laba ™ T, C/27/2001, 08:30 AM (ot assigned
C] cchet-naw-fomerlakd-state kintS-wolrfrostand Forméisld intarol walid I - fors-tadd-stata ™, "labed ™ Teans..  O9/27/2021, (8:30 AM im0t assigned
1 cicker-new-Torme-lekd-typs Kin15-wet-Trontand Formeied intersal vaili 170 Whcket-rera-form-tisid-fype”, Tabel™: Trans. not assigned
] rcket-new foemergrou proata ki 1d-metrfrontend For mroun intenea valid {70 ookt rew form-group-iata ™, name ™ Tia not assigned
[]  ccket-new-formrpage kin18-meb-fronbend FormPage: Internal vald (" okt revw-form-page’”,“namse”: “Translata, OR/ZTF202), 00:30 AN ot asslnad
Fig.: Table in Dashboard Contains the KIX Configuration Keys
-
Column Description
Name Name of the key.
Keys marked with a lock icon are already preconfigured and locked for editing in
SysConfig.
Modified Indicates whether a key has been modified. The system checks whether the key differs

from the original configuration.

Issued on: 26.02.2024 Page 320



Column

Context

Metadata

Access Level

Validity

Value

Changed at:

Changed by:
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Description

Keys are that relevant for configuring the user interfaces contain the entry "kix18-web-
frontend".

Additional information on the key.

agent-portal-configuration: Key for the settings of the agent portal

Chart: Key for the content in a chart widget (e.g. displayed state in widget "Ticket by
state")

ChartWidget: Key for a chart widget (e.g. widget "Tickets by state")

Form: Key for a form (e.qg. ticket creation screen)

FormField: Key for a form field (e.g. field "Organisation” in ticket)

Security level and access permission for a key.

public: Unrestricted access
confidential: security-critical key; requires the role "System Admin"
internal: Key for internal technical use

Keys of the access level "confidential" are highlighted in orange font if they are "valid".
They require the "Superuser” and "System Admin" roles for editing. A user with the
"Agent User" role - without "Superuser" and without "System Admin" - can therefore not
read out any configurations for authentication and connection of third-party systems
from SysConfig.

Keys generated manually or by development, such as "Authentication##[...]", are
assigned to the "confidential" access level.

Indicates whether a key has been set to "valid" or "invalid (temporarily)". Invalid keys are
shown in light gray.

Short form of JSON string used to define the key.

Time when the key was last changed.

User who last changed the key.
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12.4.2 Editing a SysConfig Key

You can change the configuration keys in order to configure KIX to meet the needs of your industry

and company. Although KIX offers you the option of resetting keys back to their original value, please take
great care when making any changes because making changes constitutes a direct intervention in the
system!

To make it easier to edit the value of a key, you can copy it to a JSON editor (e.g. https://

www.jsonformatter.io ), edit it there, and then copy it back in minified form, i.e. without blanks or line breaks.

Changes made to the system configuration are retained after updating the system. Despite this, it may
be necessary to reconfigure individual keys. To ensure the system remains secure, you cannot add any
of your own keys.

© Attention!

Changes to the configuration keys can lead to serious errors and even system failure!

You should therefore have sound knowledge of the system and in dealing with source code -
especially with JSON - when making changes. Feel free to contact our support if you need help or if
you want us to customize the user interface.

To configure a key, proceed as follows:

1. In explorer, navigate to System > SysConfig.

2. In search field, enter character string of required key. You can use wildcards, e.qg. ticket-new-form*. In
the content area, the table lists all the keys that were found as the result of your search.

3. If necessary, filter table further.

4. Intable, click key to be edited. A form dialog for configuring the key opens.

5. If necessary, activate or deactivate key by specifying its validity.

6. Change value of key as required. If you are using a JSON editor, make sure to delete all blanks and

line breaks before saving.
7. Click "Save" to save your changes. The key has now been changed.

& Important!

After changing the user interface, e.g. after integrating a dynamic field, you will need to reload
the frontend. To do so, click "Reload Frontend" button.

To configure several keys at the same time, proceed as follows:

1. In explorer, navigate to System > SysConfig.

2. Insearch field, enter character string of required key. You can use wildcards, e.g. sendmail*. In the
content area, the table lists all the keys that were found as the result of your search (in this
example this is all SysConfig keys that are relevant for setting up email accounts).

Issued on: 26.02.2024 Page 322


https://www.jsonformatter.io

7.

KIX 18 Admin Manual - EN - KIX Start
System
SysConfig

If necessary, filter table further.

Select all keys to be edited by checking them off. Click "Edit" button. A form dialog for configuring the
keys opens. You can use the navigation buttons to switch between the selected keys K “ec 3|
If necessary, activate or deactivate key by specifying its validity.

Change value of key as required. If you are using a JSON editor, make sure to delete all blanks and
line breaks before saving.

Click "Save" to save your changes. The key has now been changed.

To reset a key to the original value (default state), proceed as follows:

1.
2.

AL

o

In explorer, navigate to System > SysConfig.

In search field, enter character string of key. You can use wildcards, e.g. "ticket-new-form*". In

the content area, the table lists all the keys that were found as the result of your search.

If necessary, filter table further. Modified keys are shown with a check mark in the column "Modified".
In table, click key to be reset. A form dialog for resetting the key opens.

Click "Reset to Default". The default value is applied to the field "Value".

Click "Save" to apply your changes. The key has now been reset to the default state.

Tip
After changing the GUI configuration (e.g. after integrating dynamic fields), you can copy
correctly functioning keys to a text document and save this document as a local backup copy. This

will enable you to access the document easily if required, negating the need to reconfigure the entire
key.

The form dialog contains the following input fields, among others:

Fields (selection) Description

Name Name of key (cannot be changed)

Description Explanation of key (cannot be changed)

Validity + valid: The key will be used
invalid/invalid-temporarily: The key will (temporarily) not be
used.

Value The JSON string defines the key. Edit string to change

configuration of key.

Make sure to use the correct syntax and spelling for the attributes,
and if required delete blanks and line breaks. Please do not
hesitate to contact us if you require any assistance.
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Default Value

"Reset to Default"
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Description

The original value of the key (cannot be changed). You can copy it
and paste it into the field "Value" to reset the key.

Button for resetting the value to the default value. Also click "Save"
to save your change.
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13 System settings

In the system settings part you will find a selection of different use cases for working with KIX.

© Attention

This manual contains configuration examples to explain the respective topics. If you transfer these
examples to your system, you do so at your on own responsibility. We do not assume any liability for
this.

+ Configuration of User Interface (GUI) (see page 327)
+ Basics of GUI Configuration (see page 330)
+ The configuration of widgets (see page 336)
+ The chart widget (see page 344)
+ The object-information-card-widget (see page 355)
+ The table widget (see page 393)
+ Configuration of Sidebar (see page 412)
+ Configuration examples of GUI configuration (see page 422)
+ Integrating a Dynamic Field (see page 423)
+ Displaying Values of Dynamic Fields (see page 442)
+ Configuring an object-information-card-widget (see page 473)
+ Configuration of table widget "Suggested FAQ" (see page 480)
+ Adding a widget to the dashboard (see page 485)
+ Configuration of dashboard tables (see page 497)
+ Adding a Widget to the Sidebar (see page 501)
+ Settings for tickets (see page 507)
+ Adapting the Kanban Board (see page 508)
+ Calendar configuration (see page 513)
+ Changing the display of the article list (see page 518)
+ Configuration PDF printing (see page 523)
+ Display asset attributes in ticket zoom view (see page 559)
+ Generate ticket numbers (see page 563)
+ Settings for organisations and contacts (see page 565)
+ Allow contacts without or without a unique email address (see page 566)
+ Automatic assignment of the organisation to a contact (see page 567)
+ Provide dynamic fields to organisations (see page 571)
+ Control the search for organisations and contacts (see page 588)
+ Settings for FAQ (see page 590)
+ Linking FAQs and Tickets (see page 591)
+ Cross-object settings (see page 592)
+ Individualize display values for objects (see page 593)
+ Configuring the CKEditor (see page 598)
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+ Use URL of the browser (see page 605)
+ Display of support information (see page 607)
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13.1 Configuration of User Interface (GUI)

KIX allows to customize the configuration of the user interface (GUI configuration). It is therefore possible

add dynamic fields to input masks

display the values of dynamic fields in overviews and widgets

remove and insert columns in overview tables

remove the widgets contained in the sidebar or integrate your own widgets into the sidebar
configure the content to be displayed in widgets

etc.

The possibility of GUI configuration is therefore a very powerful gadget to build a KIX perfectly adapted to the
needs of your industry and especially your company.

T Hew Ticket

* Contact: o 2
* Organisation:
Affected Asset:
* Type:

* Queue:

SLA Criterion - SLA/Service Agre...

* Channel: ‘ -I! ”

Account Time: @ 2 Minutes
Owner:
* Priority: 3 normal
* State: & open

Serial number:

l I Cancel Save

Fig.: A Dynamic Field Integrated into the Ticket Creation Screen

© Attention!

Making changes to the GUI configuration can cause serious errors in the KIX system. For this
reason, you must have sound knowledge of the system and JSON in order to work on the GUI
configuration.

Please do not hesitate to contact our Support team if you need help or would like us to modify the
user interface.
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Almost all elements in KIX (widgets, lanes, charts, tables, forms, form fields, etc.) can be customised. The
configuration is done in the SysConfig key of the respective element (menu System > SysConfig). Each
element defines itself via the JSON string in its key ("Value" field). All properties and parameters of the
element are defined in the JSON string. For better editing, you can copy the string into an external JSON
editor (e.g. https://www.jsonformatter.io) and copy it back into the key after editing.

Tip: KIX Pro users can comfortably customise the user interface in the menu System > GUI Configuration >
Agent Portal.

For example, to include a dynamic field in the "New ticket" dialogue, open the configuration key of this
dialogue (ticket-new-form-group-data) and add the name and parameters of the dynamic field to the value.
After reloading the frontend, the dynamic field will be available in the ticket creation screen.

4 b scmmapcore X | F 0 B Spaniy X »

" “Hickat-mawdorm Fuid-typ”,“tickat pevdor- el quess”, Skt neveform-feid chamal* “fikst.

Dalaul Vahia: 5 [

aggabioslelh® falus “defadttind™ " Tracals

Fig.: The value of the SysConfig key "ticket-new-form-group-data" defines the structure and content of the
dialog "new ticket"

If you make any mistakes while editing the JSON string, you can restore the default configuration of the key.
To do this, click "Reset to default". This writes the initial JSON string contained in the "Default value" field
back into the "Value" field. However, this function does not release you from your duty of care when
configuring the user interface!

@ Tip
After changing the GUI configuration (e.g. after integrating dynamic fields), you can copy
correctly functioning keys to a text document and save this document as a local backup copy. This

will enable you to access the document easily if required, negating the need to reconfigure the entire
key.

13.1.1 Personalising the Home Dashboard

The "Customise Dashboard" button allows agents to personalise their home dashboard. Among other things,
they can determine the widgets to be displayed and adapt the display in the tables to their personal needs.

As an administrator, you can create the basis for these selections. You can configure which widgets with
which content are available to all agents. And you can define the content to be displayed in the dashboard
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tables. The agent can then define for himself which of the widgets his personal dashboard should contain
and which of the table columns he needs with which properties.

You can define the widgets available in the dashboard in the SysConfig key "home" by integrating additional
widgets into the dashboard (see page 485) or removing widgets that are included. The contents to be displayed
in the widgets are defined in the SysConfig key of the respective widget.

You define the basic configuration of a dashboard table (see page 497) in the key of the respective table. There
you can, for example, insert further table columns, remove table columns that are not required or define the
data to be displayed by modifying the search in the table (see page 480) .

You can reset the personal widget settings of a user. To do this, select the relevant user(s) under User
Management > Users and click on the "Reset User Widgets" button. You can also reset the widget settings in
the detailed view of a user.

usbienden o

0. Lser Managesnant: Lsers (3] O vewlss [ cowbaprt Ba et isar widg
T
=y Bla]

» B | Lo Hame = Flst Hame et Hame SerSeni. ©  ApetLogn T Phone Mabie Email
BTN @ sk con
s mustarmann ks com
amationaication O] contacsaal Pl Mustermann - +a9 1238567 B 447 170111222 333 contactilEnomail.ong

Eronled g Data s

Fig.: Reset User Widgets
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13.1.2 Basics of GUI Configuration

Content on this page:

Configuration Hierarchy (see page 330)
Context (see page 331)
ConfiguredWidget (see page 332)
WidgetConfiguration (see page 333)

13.1.2.1 Configuration Hierarchy

All elements of the user interface are arranged hierarchically - analogous to the "matryoshka principle”. The
hierarchy must be adhered to when configuring the user interface. The hierarchy is achieved by nesting the
individual SysConfig keys. The form fields in the form dialogs (“New Ticket”, “Edit Ticket”, etc.) are always
child elements of groups. Groups are always child elements of pages. Pages are in turn child elements of
forms etc. Therefore, a dynamic field must be integrated into the group "ticket-[new|edit]-form-group-data”.
Every page must always have a group in order to be able to accommodate form fields. At the same time, the
widgets, tables and lanes in the frontend are always child elements of a ConfiguredWidget. The
ConfiguredWidget, in turn, is a child element of the context (sidebar, lane, explorer, etc.). You can find out
which hierarchy level a SysConfig key belongs to in the "Metadata” column in the overview of the SysConfig
keys.
Structure of the hierarchy
context
+ widget
+ table widget
+ table configuration
+ table column configuration
object information card widget
linked objects widget
help widget
slider widget
+ ticket overview widget
+ tab widget
asset overview widget
main menue
« formular
site
group
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Form (z. B. ,ticket-new-form*)

n,n "

{"id":"ticket-new-form","name":"Translatable#New Ticket","pageConfigurationlds":["ticket-new-form-page"],"objectType":[...]}

Page (z. B. ,ticket-new-form-page”)

IRl "o "o 1

{"id":"ticket-new-form-page","name":"Translatable#New Ticket","groupConfigurationlds":["ticket-new-form-group-data"],[...]}

Group (z. B. ,ticket-new-form-group-data®“)

{"id":"ticket-new-form-group-data", "name":"Translatable#Ticket Data", "fieldConfigurationlds":["ticket-new-form-field-
contact”,"ticket-new-form-field-organisation”, "ticket-new-form-field-type,,, [...I}

Field (z. B. ,ticket-new-form-field-contact”)

" nn

{"id":"ticket-new-form-field-contact”,"label":"Translatable#Contact"," property":“ContactID,[...]}

Field (z. B. ,ticket-new-form-field-organisation”)

., LRl n.n

{"id":“ticket-new-form-field-organisation”,"label":"Translatable#Organisation”,"property":"OrganisationID",[...]}

Field (z. B. ,ticket-new-form-field-type”)
{"id":“ticket-new-form-field-type","label":"Translatable#Organisation","property":“TypelD",[...]}

Fig.: Configuration Hierarchy in the form

13.1.2.2 Context

The linchpin for the pages in the interface are always the contexts. A context can be, for example, a
dashboard, a detail page or a dialog. This context is always based on a configuration. Part of this
configuration are various lists with widgets, which are then displayed accordingly in the interface. The lists
are divided, for example, into:

+ sidebars
+ explorer
+ lanes

« content
+ others

Within these lists are the respective configurations for the sidebar, the explorer, the lanes, the dashboard and
so on. If you want to integrate an additional widget into the sidebar, this is done in the respective context
(e.g. ticket details) in the list "sidebars". If you want to integrate an additional table in the ticket dashboard,
this is done in the context "ticket dashboard" in the list "content”, etc.
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"id": "ticket-details",
"name": "Ticket Details"”,
"type": "Context”,
"contextId": "ticket-details”,
"sidebars": [[],
"explorer": [],

"lanes": [[C ],
"content™: [ ],
"generalActions™: [C],
"actions™: [ ],
"overlays": [[C],
"others": [ ],
"dialogs": [],
"customizable": false

13.1.2.3 ConfiguredWidget

KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

An object "ConfiguredWidget" is expected in the lists. This forms the frame for the concrete widget,

which is given by configuration.

A Configured Widget has the following relevant properties:

+ instanceld: Unique string (context-wide), which is needed to identify the concrete widget instance.

configurationld: Reference ID to a concrete widget configuration.

+ configuration: If no reference is used, then the configuration can be specified directly here.
permissions: permissions necessary for the widget to be displayed in the interface (e.g. READ on /

tickets)

size: display size of the widget (large = large widget, small = small widget).
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"id": "ticket-details”,
"name": "Ticket Details”,
"type": "Context",
"contextId": "ticket-details",
"sidebars": [[C ],

"explorer": [],

"lanes": [C],
"content”: [
{
"instanceId": "ticket-details-article-list
-widget”,
"configurationId”: "ticket-details-article

-list-widget",
"configuration™: null,
"permissions™: [],
"size": "large”

¥
1,
"generalActions™: [ ],
"actions": [,
"overlays": [[C],
"others™: [[C ],
"dialogs": [1,
"customizable": false

13.1.2.4 WidgetConfiguration

This configuration in turn expects a so-called WidgetConfiguration. This configuration is used to configure

the widget in its concrete form:

+ widgetld - id of the widget which should be displayed (see examples)

« title - the title text of the widget

+ icon - the icon to be displayed in the header
actions - actions to be displayed in the widget header

* minimized - minimized true/false
minimizable - true/false

+ subConfigurationDefinition - reference to a subconfiguration
configuration - the concrete configuration of the widget*.

+ (contextDependent) - depends on the context
(contextObjectDependent) - depends on the object of the context

+ (formDependent) - dependent on a form
(formDependencyProperties) - form values on which the widget depends
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"id": "ticket-details-article-list-widget”,
"name”: "Article List Widget”,
"type": "Widget",
"widgetId": "table-widget”,
"title": "Translatable#Article Overview",
"actions": [],
"subConfigurationDefinition™”: {
"configurationId": "ticket-details-article-list
-table-config",
"configurationType™”: "Tablellidget"
1
"configuration": null,
"minimized": false,
"minimizable": true,
"icon™: null,
"contextDependent”: true,
"contextObjectDependent”: false,
"formDependent”: false,
"formDependencyProperties™: []

The widget has its own configuration (subConfigurationDefinition). This contains the individual
configurations of the individual widgets. For example, the table widget contains the specific table
configuration at this point:

+ Context (e.g. Sidebar, Lane, Explorer, etc.)
+ Content (list of content widgets)

- ConfiguredWidget (widget shell)

- table widget (e.g. ticket table, recommended FAQ, etc.)

+ TableConfiguration (concrete widget content)
+ Configuration of table columns
- object-information-card-widget (e.g. Contact Information widget, Ticket Information
lane, Help widget, etc.)

+ configuration of avatar and rows

- object-dialog-form-widget (e.g. dialogs New Ticket, Edit Ticket, etc.)

+ Form
+ Page
+ Group
+ Field
+ Field

+ [Field] ...
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"id": "ticket-details-article-list-table-config”,
"name": "Article Table",
"type": "TableWidget",
"objectType": "Article”,
"tableConfiguration”: {
"id": "ticket-details-article-list-table”,
"name": "Article Table",
"type": "Table",
"objectType": "Article”,
"loadingOptions": null,
"displayLimit": 18&,
"tableColumns™: null,
"tableColumnConfigurations™: null,
"enableSelection”: null,
"toggle™: true,
"toggleQptions”: {1},
"headerHaight": 2.25,
"rowHeight": 1.75,
"emptyResultHint": "Translatable#® data sets found.”,
"fixedFirstColumn™: false,
"additionalTableObjectsHandler™: [],
"intersection”: true,
"searchId": null
Fa
"headerComponents™: [
"article-attachment-count™

1

showFilter”: true,
"shortTable™: false,
"predefinedTableFilters™: [],
"cache": false,
"resetFilterOnReload™”: true

@ Tipp
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You can also find a technical description for configuring the KIX frontend at: https://github.com/kix-

service-software/kix-frontend/tree/master/doc.

You can view the HTML view of this description at: https://github.com/kix-service-software/kix-
frontend/blob/master/doc/doc.tar.gz herunterladen (Klick auf Download-Button).
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13.1.2.5 The configuration of widgets

A widget consists of the widget itself (1)
and the content to be displayed in it ("2 ).
Both have their own configuration block

Contents on this page:

+ Types of Widgets (see page 337)

+ Basic configuration of a widget (see page 337)
+ The widget content (see page 338)

+ General widget attributes (see page 339)

+ Widgets implementation types (see page 340)
+ Fixed implemented (see page 341)
+ Flexibly implemented (see page 342)

(" configuration":{...}).The
configuration block of the widget contains the
configuration block of the widget content.

1
% Contact Information -

William Anderson

#% Active Connect Data Center

Lopl () +49 12345678

= contact037@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

Fig.: Widget and widget content using the object-information-card-widget "Contact information” as an example
In the configuration block of the widget are defined among other things:

+ the properties and behavior of the widget
+ widget title and widget type
+ Configuration of the widget content.

In the configuration block of the widget content are defined among others

+ the content to be displayed in the widget (placeholders, table definitions, dynamic fields, etc.)
+ Conditions for displaying the content

+ links and routing information

+ etc.
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Types of Widgets
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The most commonly used widgets in the GUI configuration are object-information-card-widget and table-

widget.

| £ Contact Information -

ﬁ William Anderson

=E %% Active Connect Data Center
e

Y ) s910345678

= contact037@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

page 355) ".

| T Tickets for Contact (9) i

Title
[TD-T-001] Testing neuer Artikel und E-Mail-Versand

[TD-T-003] Ticket mit vielen Anh3ngen

[TD-T-008] Ungelesene Artikel
[TD-T-042] Zielticket fir Ticket-Merge
[TD-T-043] Testing-Ticket mit SLA

[TD-T-002] Wasserdurchlaufzihler meldet Fehler 0...

[TD-T-004] 1. Ticket zum Tests von Objekt-Verknopf...
[TD-T-005] 2. Ticket zum Tests von Objekt-Verknipf...
[TD-T-004] 3. Ticket zum Tests von Objekt-Verknapf...

Basic configuration of a widget

The object-information-card-widget is a card widget with
object information displayed by rows and columns. The object
information configured in the widget can be of different types
(formatted text, icon, links, dynamic fields). Object-
information-card-widgets are, for example, the Contact
Information widget or the ticket information in the ticket
details (as part of the lane). For configuration information
about this widget, see "The object-information-card-widget (see

The table-widget is a table widget for displaying individual
object tables. The content displayed in the table can be
designed dynamically. Table-widgets are, for example, the
ticket and item overview in the home dashboard or the
widgets "Suggested FAQ", "Tickets to Assets" and "Tickets to
Contact". For configuration information about this widget, see

"The table widget (see page 393) " .

The following code example shows the basic structure in a simple object-information-card-widget.

//creates an 1instance of the widget
"instanceId": "name-of-widget-instance"

//Widget configuration

"configuration":{

"id": "ID od widget",

"name": "name-of-widget",

"type'": "Widget | TableWidget",
"widgetId": "table-widget | object-information-card-widget",
"title": "Translatable#translatable widget title",

"actions": [],

"subConfigurationDefinition": null,
// Configuration of the widget content

"configuration": {

//Configuration of the avatar

3 " 4
i 7%
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"avatar": {string | ObjectIcon},
//Defines which contents are displayed per line
"rows": [
{... see the widget content...}
1,
}
//properties/behavior of the widget
"minimized": false,
"minimizable": false,
//Icon in the title bar
"jcon": "kix-icon-man-house",
"contextDependent": false

1,
"permissions": [],
"sijze'": "large"

I

The widget content

The widget content is based on the values of search results. Therefore, you can freely configure the content
to be displayed.

In object-information-card widgets, depending on the object attributes, almost all types of information can be
displayed (regardless of the object type). You can find an example in the chapter Configuring an object-
information-card-widget (see page 473) .

+ Dynamic field values

« external links (URL, e-mail, phone, web CRM)

+ internal links and quick clicks (tickets, contacts, etc.)
+ image files (icons, avatars)

+ placeholders

+ dynamic and static parameters

+ conditional contents

.+ ete.

The display in table widgets can be configured so that the table content changes dynamically. For this
purpose, you can control the search mechanisms and use filters in the configuration. You can find an
example in chapter Configuration of table widget "Suggested FAQ" (see page 480) .

Simplified basic structure of the widget content in an object-information-card widget

"avatar": {string | ObjectIcon},
"rows": [
{//content of a line
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"margin": true | false,
"values": [
{
"icon": string | ObjectIcon,
"text": string,
"1inkSrc": string,
"routingConfiguration": RoutingConfiguration |
DialogRoutingConfiguration,
"routingObjectId": string
}
]
}
{//optional content of further lines
"margin": true | false,
"values": [...]

General widget attributes

Attribute Description Example

id Unique ID of the object in KIX

name Name of the object of widget

type Type of the object of widget Context | Widget | TabWidget
| HelpWidget

widgetID Type of the widget object-information-card-

widget | table-widget

title Widget title in the widget header; KIX "Contact Information”
placeholders can be used.

actions Ticket actions to be available initially "Edit", "Duplicate", "new
(optional) Article", "CSV-Export" etc.
subConfigurationDefinition optional sub-cononfiguration
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Attribute

configuration

minimized

minimable

icon

contextDependent

contextObjectDependent

formDependent

formDependencyPropertys

Widgets implementation types

Description

content of widget

Specifies whether the widget is
displayed minimized (collapsed).

Specifies whether the widget can be
minimized. If true, then it contains small
arrow buttons for collapsing

optional configuration of the icon which
is displayed next to the widget title

Controls the dependence on the context

Controls the dependency on the object
of the context

This can be used, for example, in table
widgets to control that the loading of
the table contents is not done by the
table but by the context.

Controls the dependency on the form

Form values on which the widget
depends

Widgets can be implemented in the sidebar in 2 ways:

Issued on: 26.02.2024
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Example

+ Integration of additional
widgets

+ Configuration of widget
content (avatar/rows or
table configuration)

true | false

true | false

+ "kix-icon-man-house" |
"fas fa-phone-volume"

+ Configuration block of an
Objecticon

true | false

true | false

true | false

"DynamicFields.myDynamicFi
eldName"
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Fixed implemented

These widgets are permanently implemented in the sidebar. They have no central configuration. Their
configuration is specified directly in the widget and can therefore vary in each instance. If a general behavior
of the widget is to be changed, it must be changed in all instances. However, this also makes it possible, for
example, to specify a different help text in each help widget. However, permanently implemented widgets
can be

+ be shown or hidden via the configuration of the context.
+ By copying and pasting their instance, they can also be permanently implemented in other sidebars.
For example, to additionally display the "Notes" widget in the ticket details.

Widgets permanently implemented in the sidebar are for example:

+ Notes (Home Dashboard)
+ Time booking (KIX Pro)

Instance of a permanently implemented widget (here: widget "Time booking" in KIX Pro)

{

"instanceId": "ticket-details-simple-time-accounting-widget",

"configurationId": "ticket-details-simple-time-accounting-widget",

"configuration": {
"id": "ticket-details-simple-time-accounting-widget",
"name": "Simple Time Accounting",
"type": "Widget",
"widgetId": "ticket-simple-time-accounting-widget",
"title": "Translatable#Simple Time Accounting",
"actions": [],
"subConfigurationDefinition": null,
"configuration": null,
"minimized": false,
"minimizable": true,
"jcon": "kix-icon-time",
"contextDependent": false,
"contextObjectDependent": false,
"formDependent": false,
"formDependencyProperties": []

b
"permissions": [],
"size": "large"

I
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Flexibly implemented

Flexibly implemented widgets have a central configuration in their own configuration key. They are
implemented by reference to their configuration key. This allows them to be flexibly integrated not only in the
sidebar, but in almost all interfaces.

Since these widgets have a central configuration, changes to the configuration are applied to all instances of
this widget - regardless of the context in which the widget is included. They therefore have a greater
configuration diversity than permanently implemented widgets.

The content to be displayed in the widget can be dynamically designed by using placeholders, filters and
conditions. Since the content is based on search results and only the result values are displayed, almost all
types of information - regardless of the object type - can be integrated. It is thus possible, for example:

+ integrate an additional widget for displaying SLA information in the sidebar

- display a photo (avatar) of the contact person or customer, if a picture of the contact/customer is
stored)

+ to link the contact address for display in online map services

+ display the values of dynamic fields - regardless of the object type

+ to link to external URLs (e.g. to external web pages, to content in a web CMS)

+ link to e-mail addresses and phone numbers to open them in an external program,

- quick clicks on internal links (e.g. create new asset, go to contact, etc.)

« display additional information, such as the number of assigned assets or open tickets,

+ use KIX placeholders to display content dynamically,

+ display conditional content, i.e. display content only when certain properties are present on the
contact or customer,

+ etc.

Flexible widgets include:

« Contact information

+ Tickets to assets

+ Suggested FAQ

+ Tickets to Contact

+ Open child tickets (KIX Pro)

Example of flexibly implemented widgets in the ticket details sidebar

{ ...
//Sidebar in the ticket details
"sidebars": [
{ //instance of the Contact Information widget
"instanceld": "ticket-details-contact-card-widget",
"configurationId": "ticket-details-contact-card-widget",
"permissions": [],
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b
{ //instance of the widget suggested faq

"instanceId": "ticket-details-suggested-fagq-widget",
"configurationId": "ticket-details-suggested-faq-widget",
"permissions": [],

"sjze": "large"

I
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"sjze": "large"

{ //instance of the widget affected assets

I

"instanceld": "ticket-details-affected-asset-tickets",
"configurationId": "ticket-details-affected-asset-tickets",
"permissions": [],

"sjze": "large"

{ //instance of the widgetTickets to contact

1,

"instanceld": "ticket-details-contact-tickets",
"configurationId": "ticket-details-contact-tickets",
"permissions": [],

"sjze": "large"
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The chart widget
Configuration Key

Chart widgets can display
statistics graphically. The
display can be a bar chart, pie
chart or line chart.

A report definition serves as the
data basis for the chart

widget. Their last created report
is displayed as a statistic.The
prerequisite for this is that CSV
is defined as the output format
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home

Content on this page:

+ Stucture of a chart widget (see page 345)

+ Configuration parameters of the chart widget (see page 347)
« Parameters of the chart configuration (see page 348)

+ Widget configuration in KIX Pro (see page 350)

+ Display your own report in the chart widget (see page 351)

in the report definition. In KIX Pro, JSON is also possible. Other output formats cannot be processed by the

Chart Widget.

The periodic creation of the reports and thus the updating of the statistics is done by the initial job "Periodic
Reports (see page 170) ". The charts in the Home Dashboard are also generated in this way.

n Number of apen tickets by priority

&0

Number of open tickets by state Number of tickets created within the last 7 days

100

Fig.: The initial chart widgets in the Home Dashboard

The statistics are not displayed if the report cannot be evaluated.

Number of open tickets by priority

No report available

Reasons for this can be:

+ No report exists for the selected report definition.

+ The permissions for the report are missing.

+ The report data could not be evaluated.

+ The report is not available in CSV format (or JSON).
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Stucture of a chart widget

The initial chart widgets are embedded in the configuration of the Home Dashboard (SysConfig key "Home").
They are located within the configuration block " content: [...] ". Each chart widget consists of a widget
frame and the widget configuration, which in turn contains the configuration of the chart widget together
with information on the data basis (report definition) and the formatting of the chart (CSV mapping).
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"lanes": [],
"content": [
3

"instanceId": "home-dashboard-ticket-chart-widget-priorities”, W":Iget Frame
"configurationId": null, .
"configuration": { ) ) )

"id": "home-dashboard-ticket-chart-widget-priorities”, W|dg€t Conflguratlon

"name": "Priority Chart Widget",

"type": "Widget",

"widgetId": "report-chart-widget",

"title": "Translatable#Number of open tickets by priority",
"actions": [],

"subConfigurationDefinition"”: null,

(“conftiguration”: { . 3
"id": "home-dashboard-ticket-chart-widget-priorities-chart”, Chal’t Wldget
"name": "Translatable#Priority Chart",

"configuration": {
"id": "home-dashboard-ticket-chart-widget-priorities-config",
"name": "Translatable#Priority Chart",
"type": "Chart",
“chartlontiguration™: {
"type": "bar",
"options": {
"legend": {
"display": false

i
"scales": {
"wihxes": [

"ticks": {
"beginiAtZero"”: true,
"maxTicksLimit": &

}

}
1
}

1

o’
T
"reportDefinitionId": 4,
"reportOutputFormat": "Csv",
"formatConfiguration™: {

"datasetProperties": [ CcsvV Mapplng

P—
1,

"labelProperty"”: "name",

"valueProperties": [
"count"

1,

"textSeparator": "\"",

"wvalueSeparator": ","

},

"useReportTitle”: true,
"type": "ChartWidget"

Wl
J

2

"minimized": false,
"minimizable": true,

"icon™: null,
"contextDependent™: false,
"contextObjectDependent”: false,
"formDependent": false,
"formDependencyProperties": []

A
"permissions": [CJ],
"size": "small"
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Fig.: Configuration of the chart widget "Number of open tickets by priority" in the configuration key of the Home

Dashboard

Configuration parameters of the chart widget

The configuration of the chart widget requires the following parameters:

"content": [
{
"instanceld": "home-dashboard-ticket-chart-widget-priorities”,
“configurationId”: null,
"configuration™

"id": "h ha idget-priorities”,
“name™ : N

"type": "Wic

“widgetId":

“title®: "Trar ity”,

"actions": [],
“subConfigurationDefinition”: null,
"configuration™: {
"id": "home-dashboar
“name": “Translatabl ority Chart®,
“configuration”:
“reportDefinitionId"”:
“reportoutputFormat”:
“formatConfiguration”: {
“datasetProperties™: [
‘name”
1.
"labelPraperty”: "name”,
“valuePraoperties”: [
‘count”

1.

“textSeparator”: "\"",

"walueSeparator”: "’
3
"useReportTitle”: true,
"type": "ChartWidget’

s

"minimized": falsae,
"minimizahle™: true,
"icon™: null,
"contextDependent”: false,
“contextObjectDependent”: false,
"formDependent™: false,
"formDependencyProperties™: []

A

Fig.: Configuration parameters in the Chart Widget

Parameters Description

reportDefinitionl
d

reportOutputFor
mat

useReportTitle

The ID of the report definition (data basis of the chart).

+ KIX Start: You can change the ID to refer to your own report. Enter the ID of the
corresponding report definition.

+ KIX Pro: Changing the ID is not necessary to refer to another report. All reports
readable by the Chart Widget can be selected in the dashboard personalization.

The output format of the report to be used according to the report definition.

Use the name of the report definition as widget title, otherwise title from widget
configuration
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Parameters Description

formatConfigura  Specific configuration for the output format.

tion The information requires detailed knowledge of the report definition (e.g. result of the
report, which data is contained in which form)
Following for CSV:

datasetPropertie  Name of the columns in the CSV that are to be displayed in the

s chart as a dataset.

labelProperty Name of the column in the CSV that contains the label of the Y-
axis.

valueProperties Designation of the columns containing the values of the datasets

textSeparator Separator, which is used for character strings in the CSV.

valueSeparator Separator for values in CSV

Info: The parameters (attributes) of the widget configuration can be found under: The configuration of
widgets (see page 336)

Parameters of the chart configuration

The chart configuration defines the display of the chart. Listed below are the configuration parameters used
initially. Further parameters can be found on Chart.js: https://www.chartjs.org/docs/latest/configuration/.
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"configuration”:
"id": "hol

Ttitdes ranslatable k open tickets by priority”
“actions®: [],
“subConfigurationDefinition™: null,
"configuration":
"id": “h
“name™: "Tr
"configuration
"id": "home-dashboard-tic
"name”: "Tra blatt
“type": "Cha 4
“chartConfiguration”: {
"type": "bar",
"options™: {
“legend”: {
"display": false

le#Priority Chart”,

})
"scales™: {
“yhxes": [
{

"ticks": {
"beginAtiero™: true,
"maxTicksLimit": &

}

}
1
}
}
}

X
b
"reportDefinitionId”: 4,
"reportOutputFormat™: "CsV™,
"formatConfiguration”: {
"datasetProperties™: [
“name”

ticket-chart-widget-priorities-chart

idget-priorities-c

onfig",

Fig.: Parameters of the chart configuration

Parameter  Description
s
type Specifying the diagram type
+ bar: bar diagram
+ pie: pie diagram
+ line: line diagram
+ bubble: bubble diagram
+ polar: polar diagram
+ radar: radar diagram
options

Further parameters are possible.

legen
d false)

scales

Information on the scaling of the X- and Y-axis
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Contains options for displaying the legend in the widget and for scaling the X/Y axes.

Determine whether the legend should be displayed in the chart (display: true |
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(@ Note

The colours used in the charts are based on the random principle and can currently not be adjusted.

Widget configuration in KIX Pro

Each agent can define the display and presentation of the chart widgets for himself via the personalization of
the Home Dashboard. After clicking on "Advanced"’, both the configuration parameters for the widget and
those for the chart are available.

General information on personalising the Home Dashboard can be found in the KIX Start User Manual in the
chapter Home Dashboard > Personalize your Home Dashboard.

T
“content”: [
{ . s

“instanceld": jashboard-ticket-chart-widget-priorities”, Suchvorlagen Ver

"configurationId ’

"configuration": | |
"id®: "home-d —

Widget hinzufigen

slatabl priority", Number of open tickets by prioril £, Standard x
"actions": [],
"subConfigurationDefinition”: null,
"configuration”: {
"id": "home-dashboard-ticket-chart-widget-priorities-chart”,
"name": “Translat i t", Option Wert
"configuration": {C},
“reportDefinitiontd”:
"reportoutputFformat™: "Csv",
"formatConfiguration™: {0}, Kleines Wid...

Minimierbar

Widget-Konfiguration

Aktionen

"type": "ChartWidget
< e
"minimized”: false, e O
"minimizable”: true,
"icon": null,
"contextDependent”: false, Chart Widget
"contextobjectDependent”: false,
"formDependent”: false,

"formDependencyProperties”: [] Option Wert
" ermissions®: [=J iNn..  Number of open tickets by priorit
permissions™: [], Reportdefin mber of open tickets by priority
"size™: "small” T @

),
Fig.: Configuration parameters of the widget with selection of the report definition as data basis for the chart
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subconrlguratlonﬂ'eﬂn1t10n :onuli,

"configuration”: { Chart Widget
"id"™: "home-dashboard-ticket-chart lget-priorities-chart”,
“name™: “Tran ble#Priority ct -
"configuratiol Option Wert
"id": "home-c xrd-ticket-chart-widget-priorities-config”, = z :
“name®: “Tran ablespriority Chart”, Reportdefin... rurmber of apen tickets by priority
"type": "chart",
"chartconfiguration™: { Use Report ...
“type”: “bar", CSV Mapping
"options™: {
"legend”: { i
"display”: false Option Wert

"gcales": {— Dataset Pro...  name

}

} Label Prope...  name
s
"reportDefinitionId": 4, Value Prop... count
"reportOutputFormat™: "Csv",
"formatconfiguration™: { Tk Semara
“datasetProperties”: [ Ehald.

e Value Separ...
"labelProperty”: “"name”, - -
"valueProperties": [ Chart Configuration

"count”
¥ Option Wert
“textseparator®: "\"",

“valueseparator": "," Chart Type Bar
"useReportTitle™: true, Legende
"type": "ChartWidget”
Stacked Data

L
"minimized": false,
"minimizable": true,

Fig.: The configuration of the chart display

Display your own report in the chart widget

You can create your own reports and make them available as statistics in a chart widget. To do this,
configure a report definition (see page 710) with the output format CSV.

+ If the report is to be created and updated automatically at regular intervals, activate the checkbox
"Periodic creation" in the report definition.
Initially, periodic reports are created by the "Periodic Reports" job. Alternatively, you can create a
separate job for this purpose.
If the checkbox is not activated, the report must be created and updated manually or by another
event- or time-based job.

+ Specify in the report definition under "Max. reports" how many reports are to be kept. This will
automatically delete surplus, older reports.

Which report is displayed in which chart widget and how the graphical representation is done is defined in
the configuration of the respective widget:

+ KIX Start: The personalization of the Home Dashboard in KIX Start does not allow the selection of the
reports to be displayed. To display custom reports, the configuration of one of the existing chart
widgets must therefore be changed manually:

1. Navigate to KIX > System > SysConfig and open the configuration key "Home".
For easier editing, you can copy the content of the field "Value" into an external JSON editor.

2. Navigate in the configuration block " content: [...] "to the configuration block of one of
the 3 chart widgets
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+ Open tickets by priority: "instanceld": "home-dashboard-ticket-chart-widget-
priorities" [...].

+ Open tickets by status: "instanceld": "home-dashboard-ticket-chart-widget-
states" [...]

+ Tickets created within the last 7 days: "instanceId": "home-dashboard-

ticket-chart-widget-new" [...]

3. Change the ID (number) of the report definition within the chart widget configuration.
To do this, enter the ID of the report definition whose data is to be displayed in the chart at the
parameter " reportDefinitionID ". This will change the reference to the data basis of the
chart.

Tarnes 1,
"content™: [
{
"instanceId": "home-dashboard-ticket-chart-widget-priorities”,
"configurationId”: null,
"configuration": {
"id": "home-dashboard-ticket-chart-widget-priorities”,
"name"”: "Priority Chart Widget",
"type": "Widget",
"widgetId": "report-chart-widget”,
"title": "Translatable#Number of open tickets by priority”,
“actions”: [],
"subConfigurationDefinition™: null,
"configuration™: {
"id": "home-dashboard-ticket-chart-widget-priorities-chart”,
"name": "Translatable#Priority Chart”,
"configuration": {1},
"reportDefinitionId": 4,
"reportOutputFormat"”: "CSV",
"formatConfiguration": {

© Important!

By specifying the ID in the parameter " reportDefinitionID ", a global reference is
made to a report definition without checking authorisations. The administrator or the
report manager is responsible for making the data available to authorised groups of
people!

For more important information on roles and permissions for reports,

see: Reporting (see page 702)

You can find the ID of a report definition in the status bar in the footer of your browser window.
To do this, move the mouse pointer over a report definition.
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€ Ubersicht Berichtsdefinitionen (9)

[] Name « Datenquelle Kommentar

[]  Number of open tickets by priority GenericSQL Lists open tickets by

O | Nur ope t GenericSQL Lists open tickets by

[J  Number of open ticI Number of open tickets by state FSQL Lists open tickets by

[] Number of open tickets in teams by pri...  GenericSQL Lists open tickets in
n [l Number of tickets closed within the last... GenericSQL Lists closed tickets

[] Number of tickets created withinthe la...  GenericSQL Lists tickets created
§ Jundefined/5 KIX 18 (Build: 3962-0.1601-0) | Angemeldet:

4. Optionally, you can change the display of the chart in the parameter

'chartConfiguration:{...}" . The configuration parameters can be found on this page

in the section: Parameters of the chart configuration (see page 348)
"configuration": {
"id": "home-dashboard-ticket-chart-widget-priorities-chart”,
"name"”: "Translatable#Priority Chart”,
"configuration™: {
"id": “home-dashboard-ticket-chart-widget-priorities-config”,
"name"”: "Translatable#Priority Chart”,
"tvpe"”: "Chart”,
"chartConfiguration™: {
"type": "bar",
"options™: {
"legend": {
"display": false

})
"scales™: {
"yAxes": [
{
"ticks™: {

"beginAtZero™: true,
"maxTicksLimit": &

——

5. Optionally, you can adjust the CSV mapping in the section " formatConfiguration:
{...} " The configuration parameters for reports in CSV format can be found in the section
Configuration parameters of the Chart Widget (see page 347)

6. Minimise the source code in the JSON editor and copy it back into the "value" field of the
configuration key.

7. Save your changes and click "Reload front-end configuration” in the configuration key overview
to refresh the view in the Home Dashboard.
After that, the Chart Widget can display the report as statistics.

+ KIX Pro: Via the personalization of the Home Dashboard, agents can customise the initial chart

widgets. Each agent can define for himself which report he would like to have displayed as statistics
and how it should be displayed. Thus, you only need to create one or more report definition(s) (see page
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702) with output format CSV or JSON and, if possible, periodic creation, so that agents can select the
report as a statistic in the Home Dashboard.
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The object-information-card-widget

Object-information-card-widgets show different object information in

rows and columns, regardless of the type of information. For example: Content on this page:

+ static texts + Basic structure of
+ Texts with placeholders the widget (see page
« Avatars and icons 355)
+ individual Ul components (e.g. for displaying dynamic fields) + The Avatar (see page
+ internal and external hyperlinks 357)
You can also * lcon (see page
364)
+ Conditions are specified which must apply in order for « Internal
information to be displayed. links (see
+ individual CSS style information for icons and texts can be
e page 365)
specified. o B
Object-information-card-widgets are for example the widget "Contact links (see
information" or the ticket information in the ticket details (as part of page 366)
the lane). * Specify
. . . conditions
The widgets can be used in all contexts; the limits here are the
(see page
placeholder support.
367)
The icons in the widget also support placeholders so that they can be « Attributes of an
used dynamically. object-information-

card-widgets
(selection) (see page

A configuration example can be found at: Configuring an object-
information-card-widget (see page 473)

368)
4 Contact Informa - | - Configuratio
o n examples
William Anderson
for
e #% Active Connect Data Center "value": (see

M () +4912345678 page 388)

= contact037@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

Fig .: The widget "Contact information" as an example of an object information card widget.
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(@ Notes for displaying the content in the widget:

+ If the information requested with the configuration is not available at runtime, this
information will not be displayed.

+ If the contact of a ticket is not known, the links "New Organization" and "New Contact" are
displayed.

+ If the contact of a ticket is known, the links "Open organization” and "Open contact" are
displayed.

Basic structure of the widget

Each widget has its own individual configuration. This configuration can bring specific settings (sub-
configurations) for the content.

The configuration of an object information card widget is structured as follows:

"avatar": {string | ObjectIcon},
"rows": [
{ //Content of a row
"separator": true | false,
"values": [

{

"icon": string | ObjectIcon,
"text": string,
"linkSrc": string,
"routingConfiguration": RoutingConfiguration |
DialogRoutingConfiguration,
"routingObjectId": string
}
]
}

{ //optional content of another row
"separator": true | false,
"values": [...]
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% Contact Information i

William Anderson
l* "",l #4 Active Connect Data Center
P () +4912345678

= contact037@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

The Avatar

The avatar is a photo or icon of a contact person or organization. This can be stored when creating or editing
a contact or an organization. If an avatar is stored for the contact or the organization, this is automatically
displayed in the "Contact information” widget. If this is not desired, you can remove the code block
"avatar: {...} "inthe source code of the Contact Card widget.

% Contact Information i

William Anderson
l* "",l #4 Active Connect Data Center
) T g () +4912345678

= contact037@nomail.org

Fig .: The avatar in the "Contact Information" widget

If you want to integrate an avatar into your own widget, for example, copy the following code block into the
"configuration"{...}" block of the widget content. The following data types are permitted:

+ String (e.g. " avatar": "kix-icon-gear ")
+ Objecticon (icon from / system / objecticons)

Initially, the avatar has a fixed height of 98px, the width is adjusted according to the image format. We
recommend using square or portrait images.
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Standard Codeblock for the Avatar

"avatar":

{

"displayValues": [],
"KIXObjectType": "OBJECT_ICON",
"ObjectId": "<KIX_CONTACT_ID>",
"Object": "Contact",
"ContentType": null,

"Content": null,

"fallbackIcon": "kix-icon-man"

I

Rows

KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

Rows are the lines that contain the information to be displayed. Each line within the Rows block begins and
ends with a curly bracket. Within the individual lines there are one or more values that are placed in square
brackets. The definition of the individual values are in turn placed in curly brackets.

separator: optional horizontal dividing line between the lines

+ values: the actual information values; multiple values can be specified.

Example code: Structure of rows with groups and values

"rows": [

{

"'separator":false,

"values": [

[
{value 1},
{value 2},
{Value 3}
1,
[
{Value 4}
]
]
1,
{
"values": [
[
{Value 5}
1,
[
{Value 6}
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{Value 7}
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The example code delivers the following result:

Value 1 Value 4

Value 2

Value 3

Value 5 Value 6 Value 7
Values

Values define the content of the line.

% Contact Information i

William Anderson
l* "",l #4 Active Connect Data Center
) T g ¢) +4912345678

= contact037@nomail.org

T Open Tickets of Contact

T Open Tickets of Organisation

Values are a property of rows. They are a list of groups. A group is a list of values. A value has the following
properties:

Attribute Descripon Example

icon Icon in front of the object (see also "Jcon": "kix-icon-mail"
Icons (see page 364) )

iconStyle CSS styling for the icon "jconStyle": "margin:0.5em"
text Information text (can contain "text": "Dynamic Field
placeholders) Checklist"
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Attribute

textPlaceholder

textStyle

linkSrc

routingConfigura
tion

routingObjectld

Descripon

List of placeholder values for the text

CSS styling for the text

HTML href-Specification (see
also External Link (see page 366) )

system-internal linking (see also Internal

Link (see page 365) )

ID of the object to be linked to (can also

contain placeholders)

12 http://example.de

| "%
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Example

"textPlaceholder": [

"<KIX_TICKET_AccountedTime>"

]

"textStyle":

"color:#5b5b5b; font-
style:italic",

"1linkSrc" "http://
www . example.de"
"linkSrc":

"mailto:max.mustermannl@
example.de’?"
"linkSrc":"tel:037112343"
"linkSrc":"https://

www . kixdesk.com"

"routingConfiguration":

}

"routingObjectId":
"<KIX_TICKET_OrganisationID>"
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Attribute

conditions

componentld

componentData

Descripon

Sets the conditions for displaying the
values. The values are only displayed if
the conditions are fulfilled.

(see also: Conditions (see page 367) )

Conditions can be defined based on
object properties or based on values.

Note: The attribute "propertyValue" is no
longer supported. Instead, only "property”
is used.

ID of the display component to be used,
e.g.

* object-avatar-label (e.g. for
information stored on the ticket
(ContactID, QueuelD etc.)

» dynamic-field-value (e.g. for dynamic
fields of the type checklist or table)

Parameters for the selected display
component.

Each component has individual
parameters that are given as

componentData:

+ object-avatar-label expects the
parameter "property".

+ dynamic-field-value expects the
parameter "name”.
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KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

Example

"conditions": [
{
"property":
"DynamicFields.DFText",
"operator": "NE",
"value": null,

"useObjectService":

false,
"useDisplayValue":
false
}
]
+ "componentId": "object-
avatar-label"
+ "componentId": "dynamic-
field-value"
+ "componentId": "object-

avatar-Tlabel",
"componentData": {
"property":
"DynamicFields.CloseCode"
}
+ "componentId":

field-value",

"dynamic-

"componentData": {

"name": "DFTable"
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Attribute Descripon

detailViewWidthF
actor

Extending the display width over several
columns (see examples below).
Maximum value: 4

Can be used, for example,

+ to display long email addresses in
the contact details in full,

« fully display the "Work order" field in
the ticket details.

+ Display dynamic field of type "Table"
completely.

[

"rows":

"separator": false,
"values": [

[

"Jcon":
"text":
"1inkSrc":

null,

null

"Jcon": {

"displayValues": [],

KIX 18 Admin Manual - EN - KIX Start
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Example

"componentId":
field-value",
"detailViewWidthFactor":

{
"DFTable"

"dynamic-

l|3ll,
""componentData":

"name":

"<KIX_CONTACT_Firstname> <KIX_CONTACT_Lastname>",

"KIXObjectType": "OBJECT_ICON",

"ObjectID": "<KIX_ORG_ID>",
"ObjectId": "<KIX_ORG_ID>",
"Object": "Organisation",
"ContentType": null,
"Content": null,
"fallbackIcon":

1,

"text": "<KIX_ORG_Name>",

"linkSrc": null

1,
References:

Further information can also be found on GitHub:
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+ https://github.com/kix-service-software/kix-frontend/tree/master/doc
+ https://github.com/kix-service-software/kix-frontend/commit/
492f279a5013222c544fech338a084003008dc72

Icon

Icons are symbols that can be placed in front of information and the widget title.

Lo —

William Anderson

i #4 Active Connect Data Center

c-& +419 123 45 67 B

= contact037@nomail.org

If the widget title is preceded by an icon, this can also be found on the button for showing and hiding the
sidebar. Icons are integrated either of the data type string or ObjectIcon.

Data type ObjectIcon : Use this data type to display the avatar (picture / icon) stored on a contact, user or
organization.

icon": {
"displayValues": [],
"KIXObjectType'": "OBJECT_ICON",
"ObjectId": "<KIX_ORG_ID>",
"Object": "Organisation",
"ContentType": null,
"Content": null

I
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Data type string : Use this data type to display a KIX icon or another font icon (e.g. fontawesome.com™).

{
"margin": true,
"values": [{
"jcon": "far fa-address-card",
[...]
]
I
{
"margin": true,
"values": [{
"jcon": "kix-icon-mail",
[...]
]
I
Internal links

You can create internal links, e.g. to open the organization details or to open the dialog for creating a new
asset.

% Contact Information i

William Anderson

i % Active Connect Data Center

c-& +419 123 45 67 B

= contact037@nomail.org

The configuration takes place via the specifications of "routingConfiguration": {...}.

With " routingObjectId " you can specify the ID for the object to which a link should be made. You can
also use placeholders here.

13 http://fontawesome.com
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"routingConfiguration":

{
"contextId": "contact-details",
"objectType": "Contact",
"contextMode": "DETAILS",
"objectIdProperty": "ID",
"history": false,
"resetContext": true,
"contextType'": "MAIN"

I

"routingObjectId": "<KIX_CONTACT_ID>"

External links

You can link to external URLs, for example to

« call up the URL to an external web CMS
+ go to the customer's website

KIX 18 Admin Manual - EN - KIX Start
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+ link the email address and telephone number in order to open them with an external communication

program
+ and much else

% Contact Information i

William Anderson

i #4 Active Connect Data Center

c-& +419 123 45 67 B

= contact037@nomail.org

To do this, enter the link under " 1inkSrc "e. g.:

Linktyp Beispiel
URL "linkSrc"
Email (static) "1inkSrc"

"http://www.example.de"

"mailto:info@mailadresse.de"

Email (dynamic with placeholders) "linkSrc"

"mailto:<KIX_CONTACT_Email"

AX Issued on: 26.02.2024
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Linktyp Beispiel

Telefon (static) "linkSrc" : "tel:+49123456789"
Telefon (dynamic with placeholders) "linkSrc" :  "tel:<KIX_CONTACT_Phone"
{

"margin": false,
"values": [

{
"icon": null,
"text": "<KIX_CONTACT_Email>",
"1inkSrc": "mailto:<KIX_CONTACT_Email>"
}

]
I

Specify conditions

You can specify conditions. For example, to define which conditions must be met for an information to be
displayed in the widget.

In the following code example, an additional text "VIP contact” is displayed in red font in the widget if the
comment field of the contact contains the entry "VIP". If this entry is missing in the comment field or the
entry in the comment is not identical to the string "VIP", this line will not be displayed in the widget.

"text": "Translatable#VIP Contact",
"textStyle": "font-weight:bold;margin-bottom:0.5rem;color:red",
"conditions": [
{
"property": "<KIX_CONTACT_Comment>",
"operator": "EQ",
"value": "VIP"

}

The conditions can be defined based on object properties or based on values.

If the property references an existing property, then the value of this property is used.
If the property references a non-existing property, then an attempt is made to replace the placeholder.

The value specified under "property" is always the initial value to be checked against. E.G.:

+ DynamicFields.myDynamicFieldName - Value of a Dynamic Field
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+ "QueuelD" - specification of a property that exists on the ticket, for example.
« "<KIX_TICKET_QueuelD>" - placeholder, which will be resolved
+ "Any value:" - specification of a fixed string.

Items 3 and 4 can also be mixed with this: "Any value <KIX_TICKET_...>"
Note: The attribute "propertyValue" is no longer supported. Instead, only "property" is used.

Possible comparison operators can be found in the table below: Operator (see page 380)

Attributes of an object-information-card-widgets (selection)

The configuration of an object-information-card-widget contains, among other things. the following
attributes:

Keyword Descri Examples and Hints
ption

avatar {...} Sectio Datatypes: string | ObjectIcon
n for
the
config + ObjectIcon :the avatar stored for the contact /

uratio organization (Icon aus /system/objekticons)

+ string: "kix-icon-gear" or "fas fa-phone-volume"

n of
the
avatar
(conta
ct
photo
).
Sever
al
avatar
s can
be
config
ured.
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Keyword

conditions [...]

| "%

Descri
ption

Condi
tions
(see
page
367)
under
which
a
value
isto
be
displa
yed.

Condi
tions
can
also
be
applie
dto
dyna
mic
fields.
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Examples and Hints

Condition: Is executed if the dynamic field is not empty

"conditions": [

{

"property":"DynamicFields.myDynamicFieldName",
"operator":"NE",

"value":null

}
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Keyword Descri Examples and Hints
ption

Hiding
blank
values
depen
dson
the
displa
y
comp
onent
used
and is
only
possi
ble to
a
limite
d
extent
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Keyword Descri Examples and Hints
ption

< If
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di
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Keyword Descri Examples and Hints
ption

® 3 0T 3o o o

1

® 3 O T 3 0 o o

>
—
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Keyword Descri Examples and Hints
ption

«Q
=

O o w & T T © O
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Keyword

configuration {...}

\F
| %

Descri
ption
. If
a
lin
e
h
a
s
n
o]
gr
o]
p
S,
it
is
n
ot
in
c
u
d
e
d.
Contai
ns the
config
uratio
n
block
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Examples and Hints

"configuration": {

"id" : "1632723315884",
"name" : "1632723315884",
"type" : "null",

"avatar" : {...},

"rows" : [...]

}
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Keyword

configurationId

fallbackIcon

e

Descri
ption

ID of
the
config
uratio
n

Icon
thatis
displa
yed if
the
icon
specif
ied
under
“icon”
canno
tbe
displa
yed,
e.g.
"Kix-
icon-

man

Examples and Hints

"name-of-my-own-widget"

Data type: string

Issued on: 26.02.2024
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Keyword

icon {...}

Descri
ption

Icon
which
is
place
din
front
of
infor
matio
n(e.g.
"Kix-
icon-
men"
Also
define
s the
icon
next
to the
widge
t title
and
on the
button
for
showi
ng
and
hiding
the
widge
1.

KIX 18 Admin Manual - EN - KIX Start
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Examples and Hints

Data types: string | ObjectIcon
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Keyword

iconStyle

instanceId

linkSrc

Descri

ption

CSS
style
for
forma
tting
the
icon

Creat
esan
instan
ce of
the
widge
1.

HTML
linkin
g of
extern
al
URLs,
KIX
URLs,
email
addre
sses,
teleph
one
numb
ers,
web
CRM
etc
You
can
link to
a URL

KIX 18 Admin Manual - EN - KIX Start
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Examples and Hints

"jconStyle": "color:#ffoeoe0",

"name-of-my-own-widget"

Datentyp: string

URL: "1linkSrc": "https://www.domainname.de/

optionalerPfad"
KIX-URL: "1inkSrc": "https://kixURL.de/search?
search=%7B%22objectType%22:% [ ... ]

name%22:null%7D"
Email: "1inkSrc":
"mailto:max.mustermann@company.de"

Telephone: "1inkSrc":"tel:+49123456789"
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Keyword

Descri Examples and Hints
ption

gener
ated
by KIX
in
order
to call
up a
specif
ic
page
in the
KIX
(e.g.a
searc
h
result,
a
specif
ic
ticket
ora
view).
To do
this,
copy
the
URL
of the
page
and
link it
with
"linkSr

c.
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Keyword

margin

minimizable

minimized

name

Descri
ption

Creat
esa
space
upwar
ds if
true

Define
s
wheth
er the
widge
t can
be
minim
ized.

Define
s
wheth
er the
widge
tis
displa
yed
minim
ized.

Name
of the
widge
1

Examples and Hints

true | false

true | false

true | false

"My Own Widget",

Issued on: 26.02.2024
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Keyword

operator:

Descri
ption

Opera
torin
condit
ions

Define
s how
the
value
and
prope
rty of
a
condit
ion
are
comp
ared.

ot

al
to

KIX 18 Admin Manual - EN - KIX Start
System settings
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Examples and Hints

"conditions": [

{
"property": "QueueID",
"operator": "EQ",
"value": "2"

}
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Keyword Descri Examples and Hints
ption

—

ss
th

al
to

Gr
at

er
th

A dx Issued on: 26.02.2024 Page 381



Keyword

\F
| %

Descri
ption

G
E
Gr
e
at
er
th

Examples and Hints
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4 Configuration of User Interface (GUI)
Keyword Descri Examples and Hints
ption
+ IN
lo
gi
c
al
IN
+ C
0
N
T
Al
N
S
c
nt
ai
n
S
permissions: Roles "permissions": [
/ {
permi "target": "system/slas",
ssion L
s for "permissions": [
the 2
displa 1,
y "OR": false,
"permissionCheckMaxLayer": "Resource",
"value": 2
}
1,

7
P9 Issued on: 26.02.2024 Page 383
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Keyword Descri Examples and Hints
ption

routingConfiguration intern

{...} al
linkin
g,eg.
on
conta
ct
detail
s

routingObjectId IDof  Datatype: string
the
object
to be
linked
to
(can
contai
n
place
holder
s),
e.g.
<KIX_
CONT
ACT_I
D>
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Keyword Descri Examples and Hints
ption

rows {...} Rows  Has the following properties:
area
list of
rows
(conte
nt
block)

+ values - values of the row

« title - line title, fixed left lettering

+ style - individual CSS styling for the line

+ separator - horizontal dividing line for the line

Contai
ns all
infor
matio
n that
shoul
d be
displa
yed in
the
widge
1.

separator Creat true | false
esa

horizo
ntal
separ
ator if
true
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Keyword

text

textStyle

| "%

Descri
ption

Infor
matio
n text
(can
contai
n
place
holder

s)

CSS
styles
for
text
forma
tting

KIX 18 Admin Manual - EN - KIX Start
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Configuration of User Interface (GUI)

Examples and Hints

Data type: string

"textStyle": "color:#ffoeo0",

Issued on: 26.02.2024
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Keyword

title

Descri
ption

Title
of the
widge
tin
the
fronte
nd; Kl
X
place
holder
scan
be
used.
“Trans
latabl
e#"
make
s the
title
transl
atable
A
corres
pondi
ng
patter
n
must
be
stored
in the
Intern
ationa
lizatio
n
menu.
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Examples and Hints

Translatable#Simple Time Accounting
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Keyword

type

values [...]

Configuration examples for "value":

Descri
ption

Type
of
integr
ated
eleme
nt

Value
s are
a list
of
group
s for
displa
ying
values
(icon,
text,
linkSr
C,
routin
gConf
igurati
on,
etc.)

KIX 18 Admin Manual - EN - KIX Start
System settings
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Examples and Hints

Widget | TableWidget

+ Widget: simple map widget like "contact information”
+ TableWidget: Table widget like "Tickets to Contact"

"values": [

{
"icon": null,
"text": "<KIX_CONTACT_ID>",
"linkSrc": null

+
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g

Example

Use of free text with
placeholders

(see also configuration
in "ticket-details-
contact-card-widget"):

Use of a component for
value representation

(Avatar with attribute
and name)

\F
| %

KIX 18 Admin Manual - EN - KIX Start
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Codeblock lllustration
'ﬂmMMmmu -
Willan anderson
ﬁ? This is free test {with placefolder) Owner: Suzy
{ ‘:\/{‘ & Murple & fesponsible: Anne Wisbster
- #4 Actue Connect Data Center

"avatar": [], (9 s z3asere
"rows": [

{

B contactna? @ nomailarg

"Style": "N’
"'separator": true,
"values": [

[

"jcon": "kix-icon-man",
"text": "This 1is free text
(with placeholder) Owner: {0} &
Responsible: {1}",
"textPlaceholder": [
"<KIX_TICKET_Owner>",

"<KIX_TICKET_Responsible>"
1,
"textStyle":

weight:bold; font-

style:italic;color:red;"

"font-

}
]
]
}
]
}
Organisation
Active Connect Data Center
{
"componentId": "object-avatar-label",
"componentData": {
"property": "OrganisationID"
}
}
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Example Codeblock

Using a component to

display anicon {
"componentId": "dcon",
"componentData": {
"Jcon": {
"displayValues": [],
"KIXObjectType": "OBJECT_ICON",
"ObjectId": "<KIX_CONTACT_ID>",
"Object": "Contact",
"ContentType": null,
"Content": null,
"fallbackIcon": "kix-icon-man-
bubble"

},
"style": "width:
5rem;height:5rem; font-size:5rem;"
}
}

[IX Issued on: 26.02.2024
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lllustration

% Contact Information
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Example

Use of a component to
display a dynamic field
(including conditions)
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Codeblock lllustration

"text": "Mobile Processing Checklist
010",

"textStyle'": "font-
weight:bold;margin-bottom:0.5rem",

"jcon": "kix-icon-ci",

"componentId": "dynamic-field-value",
"componentData": {
"name":
"MobileProcessingChecklist010"
1,
"conditions": [
{

"property":
"DynamicFields.MobileProcessingCheckli
ste10",

"operator": "NE",

"value": null,
"useObjectService": true,
"useDisplayValue": null,
"propertyValue": null

"text": "Affected Assets",
"textStyle": "font-
weight:bold;margin-bottom:0.5rem",
"icon": "kix-icon-ci",
"componentId": "dynamic-field-
value",
"componentData": {
"name": "AffectedAsset"
1,
"conditions": [
{
"property":
"DynamicFields.AffectedAsset",
"operator": "NE",
"value": null,
"useObjectService": true,
"useDisplayValue": null,
"propertyValue": null
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Example

Extension of the display
width by means of
"detailViewWidthFactor"

KIX 18 Admin Manual - EN - KIX Start

System settings

Configuration of User Interface (GUI)

Codeblock

Full display of long email addresses in the contact

details.
(SysConfig key: "contact-details-info-widget")

{

"componentId": "object-avatar-
label",

"detailViewWidthFactor": 2,

"componentData": {

"property": "Email"
}

}

Complete display of the field "Work order" in the

ticket details
(SysConfig key: "ticket-details-info-card")

{

"componentId": "dynamic-field-
value'",

"detailViewWidthFactor": 4,

"componentData": {

"name": "WordkOrder"
I

"conditions":[{...}],

}

Issued on: 26.02.2024
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The table widget

The table
widget is used
to display
individual
object tables.
Table widgets
are, for
example, the
ticket and
article
overview in
the home
dashboard or

KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

Contente on this page:

+ Basic structure of the table widget (see page 394)
+ Table configuration attributes (selection) (see page 394)
« Attributes of the configuration of the table content (selection) (see page 396)
+ Attributes of the LoadingOptions (see page 399)
+ Special feature in the table widget "Assigned Assets": (see page 406)
+ Attributes of TableColumns (see page 406)
« Example Configuration of the table widget "Tickets for Contact” (see page 408)

the "Recommended FAQ", "Tickets to assets", "Assigned Assets" and "Tickets to contact" widgets.

T Tickets for Contact (10) -

Title Type
[TD-T-0041] Testing neuwer Artikel und E-Mail-Versand T
[TD-T-002] Wasserdurchlaufzihler meldet Fehler 0... T
[TD-T-003] Ticket mit vielen Anhangen T
[TD-T-004] 1. Ticket zum Tests von Objekt-Verkniipf... T
[TD-T-005] 2. Ticket zum Tests von Objekt-Verkniipf... T

Fig .: The widget "Tickets to Contact" as an example of a table widget

The values in a table widget always result from a configured search. The result of this search is displayed in
the table configured in the widget. In the table configuration you can, among other things, define:

+ which object is referenced (object type). . E. which data is displayed in the table (data from tickets,
assets, FAQ, contacts or organizations)

+ which columns should be displayed

+ the table properties (initial sorting, fixing of the 1st column, row height)

+ Widget title and icon of the widget

+ Behavior (can be minimized / minimized)

+ Filters and Actions

+ selection

- toggle (expanding a line)

+ etc.

u ﬁé
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The configuration of the widget allows the specification of:

+ fixed values of the ticket search
+ the use of placeholders to use dynamic values of the current object for the search.

Basic structure of the table widget

Each widget has its own individual configuration. This configuration can bring specific settings (sub-
configurations) for the content. In the table widget, these are the settings for the table to be displayed.

Vereinfachter Aufbau eines Tabellenwidgets

Widget {
Widget configuration {
Table in the widget {
Table configuration{
LoadingOptions: {
filter,
sort,
limit
}s
tableColumns: [
{Configuration Column 1},
{Configuration Column 2},
{Configuration Column 3},
{etc.}
}s
optional ObjectHandlers[],

Table configuration attributes (selection)

The table is configured within the widget configuration (code block "configuration {...}"). This configuration
defines the object to be referenced, the table properties and the behavior of the table.

It also contains a configuration block in which the table content (table columns to be displayed along with
properties, filters and loading options) are specified (code block "tableConfiguration {...}").
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Attribute

id

name

type

objectType

sort

subConfigura
tionDefinition

tableConfigur
ation {...}

headerComp
onents

showfFilter

predefinedTa
bleFilters

KIX 18 Admin Manual - EN - KIX Start
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Description Example

Unique ID within the configuration "ticket-new-ticket-affected-asset-
table-widget"

Name of the widget "Asset Tickets"

Type of the widget "TableWidget"

The type of object to be displayed in the table. Ticket | Configltem (Asset) | FAQ
[ ...

initial sorting of the table "Age","Up" (ascending by age)

optional sub-configuration

Contains the specific configuration of the table in
the widget (see below)

Additional components for the widget header

Defines whether the filter (funnel) should be true | false
displayed in the header

Predefined filters that are available for selection in
the header dropdown.

e. g. in the ticket dashboard:

T Overview Tickess {38)

e i Courar "bhncu.,uu e
wathet Tickets
[ 20711004170004E 557, custam. & opan
Lniacied Tichets
[ ] 0211004170004 LA by affec., @ open
Locked Tickets

2110041700042 sLa n
L Resporeibie Ticksts -

n] L B 09
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Attributes of the configuration of the table content (selection)
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The table configuration is defined under " tableConfiguration {...} " (optional). If this configuration

is removed, a standard table for the objectType is used.

Attribute

objectType

loadingOptions {...

}

displayLimit

tableColumns{...}

Description

Object type to be loaded in the
table

Specific loading options for the
objects to be loaded (API filter)
Defines the table columns and

their properties (see below)

Display limit for the number of
table rows; determines the
maximum height of the widget.

The specification defines the
default value. In the
"Personalisation of the Home
Dashboard", the agent can set the
display limit himself by specifying
the parameter "Table Height".

Defines which columns should be
displayed (see below).

One configuration block is
specified for each column. If
nothing is specified, a standard
configuration is used for this
object.

Example

ticket | asset | configltem | ...

10

T New Tickets (10/20)

[J  SLAKriterien Prio
[ O

O
O
O
B
£ ]
O
O
O
&

Ticket#

[ ] 2023040517000311
2023040517000258
[ ] 2023040517000196
] 2023040517000187
2023040517000178
2023040517000169
2023040517000151
[ | 2023040517000141
2023040517000089
@ 2023040517000025

—
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Attribute

tableColumnsConf
igurations

enableSelection

toggle

toggleOptions

sortOrder

headerHeight

rowHeight

emptyResultHint

fixedFirstColumn

Description

Configuration of individual
columns (optional.

If not specified, standard columns
are used.

Activate / deactivate selection in
the table

Defines whether lines can be
expanded (e.g. show article
content)

Defines what should be displayed
when a line is expanded
(individual Ul component)

Defines the sorting of the table
contents when the table is loaded

Height of the header in pixels

Height of the table rows in pixels

Defines the text to be displayed
when no lines are available.

If true, the first column is fixed and
does not scroll horizontally

Issued on: 26.02.2024
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Example

null

1.75 (with dot)

1.75 (with dot)

“No data found"

true | false
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Attribute

additionalTableObj
ectsHandler

Description

List of the handler configurations
that determine further objects for
the table (optional).

The determination depends on the
handler.

KIX 18 Admin Manual - EN - KIX Start
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Example

The following attributes are possible:

id: Unique identifier for internal
processing.

name: name (description)
handlerConfiguration: specific options of
the handler.

For example, the SuggesteFAQHandler
currently supports:

+ minLenght: Indicates how long
the words in the title / subject
must be at least (separated by
spaces) so that they can be used
for the search (default: 3).

+ onlyValid: Indicates whether
only valid objects are determined
(default: false).

dependencyPropertys: List of object
properties (attributes) which are taken
into account for the search.

The information is relevant for the
handler. For example, the
SuggestedFAQHandler uses it to
determine the properties of the words.
The list also determines whether this
configuration makes it necessary to
reload the table in the event of changes in
the dialog/form.

It is used to avoid unnecessary searches
for the handlers involved. If this list is not
available, the table is reloaded with each
change.
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Attribute Description

intersection Defines how the search is carried

out and how the results are
combined in the display (true |
false)

Notes can also be found

under: Configuration of table
widget "Suggested FAQ" (see page
480)

Attributes of the LoadingOptions

KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

Example

+ true = intersection
Searches, for example, for keywords in
the ticket subject / title AND for affected
assets. Both must be specified, otherwise
the table is empty

+ false (default)= combine = all results
(without duplications)
Searches, for example, for keywords in
the ticket subject / title OR for the assets
concerned. One of the two must be
specified.

By specifying the LoadingOptions, you can define which properties an object (Ticket/Asset/FAQ/...) must
have in order for it to be loaded. A corresponding filter can be defined for each property (attribute) of the

object.

By using placeholders in the LoadingOptions, it is possible to refer to the currently displayed object and thus
to design the display in the tables dynamically. The agents can thus be provided with the following
information in a table, for example:

the open inquiries of an organization
all closed or open child tickets

open tickets of the team, which are of the same type

the contacts of the current organization

new tickets from an organization that are of the same type

Assets associated with the current contact
etc.

You can configure separate LoadingOptions for each context for each object type. This is possible in the:

Context
Ticket Dashboard tickets
Ticket-List Context (the toolbar ticket-list

icons at the top)

Configuration key (KIX Start) Configuration key (KIX Pro)

Ticket Dashboard Configuration

User Ticket List
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Context Configuration key (KIX Start) Configuration key (KIX Pro)
FAQ Dashboard faq faq

Organisation/Customer organisations organisations

Dashboard

Asset Dashboard. cmdb cmdb

In this way, for example, the organisations and contact table in the organisations dashboard or the table in
the ticket dashboard can be presorted and the maximum number of entries to be loaded can be determined.

The LoadingOptions then consist of nested arrays specifying the object and the LoadingOptions relevant for
the object. The first value is the relevant object type (e.g. ticket) and the second value contains the definition
of the LoadingOptions (limit, searchLimit, sortOrder, etc.).

"loadingOptions": [

L
"Ticket",
{
"searchLimit": 300,
"limit": 5,
"sortOrder": "Ticket.-Age:numeric"
}

1,

If you have changed the LoadingOptions of a context (1), you should then remove the sorting in the
subordinate Widget Settings (2) (lines: "sort":["Age", "Up"], delete). Otherwise, the configuration
set in the context does not apply; the widget settings have priority. After changing the configurations, click on
"Reload Fontend Configuration”.

Note: After changing the LoadingOptions, clear the cache in the System > Console menu with the command:

Console: :Command: :Maint: :Cache: :Delete.
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£k, System: GUI Configuration: Agent Portal
| ticket dashboard | T
1~ {
& Context 2 "id": "tickets",
& %" Ticket Dashboard Configuration (modified) 1 2 “name": ,,TleEt Eashboar‘d Configuration®,
4 type": "Context",
= Content (4) 5 "contextId": "tickets",
6 "sidebars™: [],
= T Ticket List Widget 7+  "explorer": [E],
- X ) . . 35 "lanes": [],
BB Ticket Table Widget Settings (modified) 2 . "content”: (B3],
BB Ticket Dashboard Table COnfiguration 166 "generalActions": [],
187 "actions™: [],
188 "overlays": [],
109+ “others": [ED],
344 "dialogs™: [],
345 "customizable": false,
346 "valid": true,
347 ~ "loadingOptions": [
348 ~ [
349 "Ticket",
350 * {
351 "searchLimit": 309, 1
352 "limit": 25,
353 "sortOrder": "Ticket.-Age:numeric"
354 }
355 ]
356 1,
357 "application": "agent-portal”
358 }

Fig.: Sorting the table in descending order according to the age of tickets (newest first) with limited display
quantity

Attribute Description Example

expands Resolves the object IDs received Further information can be found at:
with "includes" to obtain their https://github.com/kix-service-software/kix-
objects. backend/blob/master/doc/API/V1/KIX.html
To do this, specify the same term (Right click on "Download" > use "Link | Save
as for "includes". target as..." in the context menu)
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Attribute

filter

includes

Description

Specification of filter conditions
for specifying the objects to be
displayed.

In the example, the table contains
all open tickets of the contact.

& Please note!

In the backend, the status
type ( StateType ==
Open ) is_.automatically
added when searching for
a ticket!

This affects both the
complex search and all
configurations that do not
have any restrictions on
the status type in the filter
or have a specific status,
e.g. Ticket tables or
individually created/
modified widgets and
tables.

Receiving further information on
the requested objects, such as
links, dynamic fields or existing
sub-resources (e.qg. articles or
history of tickets).

For some 'includes’, not objects are

delivered but only the respective

IDs (e.g. for "links"). These IDs can

be resolved with "expands" to get
their objects.
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Example

"filter": [
{
"property": "StateType",
"operator": "EQ",
"type": "STRING",
"filterType": "AND",

"value": "Open"

b

{
"property": "ContactID",
"operator": "EQ",
"type": "NUMERIC",
"filterType": "AND",
"value":

"<KIX_TICKET_ContactID>"
}

Further information can be found at:
https://github.com/kix-service-software/kix-
backend/blob/master/doc/API/V1/KIX.html
(Right click on "Download" > use "Link | Save
target as..." in the context menu)
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Attribute

limit

| "%

Description

Number of objects contained in
the API response (see info box
below).

The specified limit controls the
size of the "Page" (display limit of
the table) and how many data
records are reloaded using the
"Load More" button.

An existing sort order will not be
changed during reloading, but will
be applied to the reloaded data.

Default: 20, if no limit is specified.

The specified limit influences the
performance. Select a value that is
optimal for you, depending on the
number of data records in the
system.

With your specification, you define
a system-wide default limit. Each
agent can define the table
properties for themselves in the
customization of the home
dashboard.

Issued on: 26.02.2024
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O

O0O0O0OO0OO0OO0OOO

T New Tickets (10,22)

] SLA Kriterien Prio Ticket#

[ ] 2023040517000311
2023040517000258
[ ] 2023040517000196
B 2023040517000187
2023040517000178
2023040517000169
2023040517000151
[ | 2023040517000141
2023040517000089
m 2023040517000025
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Attribute

searchLimit

Description

Limits the entire search query at
database level (see info box
below).

It defines the maximum number of
records to be loaded from the
database. The first n records are
fetched from the database.

The specified limit influences the
performance. Select a value that is
optimal for you, depending on the
number of data records in the
system.

With your specification, you define
a system-wide default limit. Each
agent can define the table
properties for themselves in the
customization of the home
dashboard.
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Example

100

T New Tickets (10,22)

[J  SLAKriterien Prio Ticket#

O [ ] 2023040517000311

Info on the illustration: The database contains
only 22 data records.

Therefore, only a maximum of 22 tickets will
be displayed, even if a higher value is set for
the searchLimit.
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Attribute Description Example
sortOrder Defines the sorting of the table * null | "Age","Up" |
contents when the table is loaded. "ID", "Down"
If nothing is specified, the initial + Ticket.-Age:numeric
sorting is in descending order: (The object must be specified; the data

type (e.g. numeric) can be specified.
Specifying the minus sign (-) causes the
sorting to be reversed).

+ for tickets: creation time
+ for assets: asset name, asset
number
+ for organisation: name of the
organisation, customer
number
+ for contact: by surname, first
name
+ Dynamic fields
+ Text, Textarea, Date,
Date/Time: by value
+ Selection: by key
+ Array values: Sorting
the keys within the
array and using the first
key for sorting the
ticket
+ Other types of dynamic
fields cannot be sorted.

The entire requested list
(SearchLimit) is sorted.

@ Info

Limit and SearchLimit have an effect on performance. The higher the values, the longer the
loading times may be.
Example:
Given are:
+ Number of records in the database: 200
« limit: 10
+ searchLimit: 100
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The first 100 records are retrieved from the database. Of these, 10 are displayed in the table. If the
agent clicks on the "Load more" button, the next 10 of 100 records in the table are reloaded. This
means that the agent can click on "Load more" 10 times to display a maximum of all 100 data
records in the table. If the record being searched for is not among these 100 records, the agent can
use the search options of the full-text search and the complex search B

Special feature in the table widget "Assigned Assets":
SysConfig-Key: ticket-new-assigned-assets

The table widget shows the assets that are assigned to the selected contact. For this purpose, the filter in the
LoadingOptions uses the search attribute "AssignedContact”, which expects a ContactID. Initially, this is
determined by a placeholder (<KIX_TICKET_ContactID>).

The first column of the table allows an interaction with the dynamic field "Affected Asset" (in "New Ticket"
and "Edit Ticket"). If an asset is selected by a tick, this asset will automatically be set as "Affected asset" on
the ticket. This interaction is controlled by "add-to-affected-assets-cell" in the attribute "componentID". The
column can also be implemented on other asset tables if required.

Attributes of TableColumns

The table columns are defined in the code block "tableColumns {..}". Each column begins and ends with a
curly bracket: {...}. The attributes of the table column, including their values, are specified within the brackets.

The basis of the values in the table columns is the respective referenced object (ticket / asset / FAQ/ ...) and
its attributes (properties such as ID, name, title / subject, priority, status, etc.)

Attribute Description Example

id Specification of the column ID; if not null
defined: null

name Specification of the column name null

(belonging to the ID); if not defined: null

type Specification of the column type; if not null

defined:

null
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Attribute

property

showText

showlcon

showColumnTitle

showColumnlcon

size

sortable

filterable

hasListFilter

dataType

resiziable

Description

Attribute (property) of the object

Defines which attribute is displayed in
the column

Defines whether a text is displayed for
the value of the attribute (true | false)

Defines whether an icon is displayed for
the value of the attribute (true | false)

Defines whether the name of the
attribute is displayed in the column
header (true | false)

Defines whether the icon of the
attribute is displayed in the column
header (true | false)

Size of the column in pixels

Defines whether the column is sortable

Defines whether the column can be
filtered (filter symbol in the column
header)

Defines whether a selection list of all
values available in the column is
offered for filtering (otherwise free text)

Data type of the attribute (the property)

Defines whether the user can change
the column size

Issued on: 26.02.2024
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Example

Title / TicketNumber / OwnerID /
DynamicFields.myDynamicFieldN
ame

new | open | closed | ...

Icon of State

State

Icon of State

320

true | false
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Attribute Description Example

componentID Defines whether an individual Ul Possible values (selection of the
component is used in the content of the  most important):

cell to represent the value. - Value of a dynamic field:

Note: The ComponentID can also be set "dynamic-field-value"
in the advanced configuration mode of - Progress bar of a checklist:
the dashboard personalisation. "dynamic-field-

(go to: Home Dashboard > Customise
Dashboard > "Advanced" button >
"Component ID" column).

checklist-cell"
« Label of an SLA criterion:

"sla-criteria-cell"

defaultText Text that is used as a column heading if
no specific property of the object is
represented in the column.

translatable Defines whether the attribute values in
the cells should be translated
automatically

If necessary, the corresponding
patterns must be stored under
Internationalization> Translations.

titleTranslatable Defines whether the column title should
be translated automatically

If necessary, the corresponding
patterns must be stored under
Internationalization> Translations.

useObjectServiceForFilter  For internal use only.

(Defines whether the table uses an
object service or not.)

Example Configuration of the table widget "Tickets for Contact"

"id": "ticket-details-contact-tickets",
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"name": "Tickets for Contact",
"type" : "W'idget" s
"widgetId": "table-widget",
"title": "Translatable#Tickets for Contact",
"actions": [],
"subConfigurationDefinition": null,
"configuration": {
"id": "ticket-details-contact-ticket-widget",
"name": "Contact Tickets",
"type": "TableWidget",
"objectType": "Ticket",
"sort": null,
"subConfigurationDefinition": null,
"tableConfiguration": {
"jd": "ticket-details-contact-tickets-table-config",
"name": "Contact Tickets",
"type" : "Table" s
"objectType": "Ticket",
"loadingOptions": {
"filter": [
{
"property": "StateType",
"operator": "EQ",
"type": "STRING",
"filterType": "AND",

"value": "Open"
1,
{
"property": "ContactID",
"operator": "EQ",
"type'": "NUMERIC",
"filterType": "AND",
"value": "<KIX_TICKET_ContactID>"
1,
{
"property": "TicketID",
"operator": '"NE",
"type": "NUMERIC",
"filterType": "AND",
"value": "<KIX_TICKET_TicketID>"
}
1,
"sortOrder": null,
"limit": 100

1,

"displayLimit": 10,

"tableColumns": [

{

"id": null,
"name": null,
"type": null,
"property": "Title",
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"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": false,
"size": 320,

"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "TypeID",
"showText": false,
"showIcon": true,
"showColumnTitle": true,
"showColumnIcon": false,
"size": 50,

"sortable": true,
"filterable": true,
"hasListFilter": true,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

1,
"tableColumnConfigurations": null,
"enableSelection": false,
"toggle": false,
"toggleOptions": null,
"sortOrder": null,
"headerHeight": 1.75,
"rowHeight": 1.75,
"emptyResultHint": "Translatable#0 data sets found.",
"fixedFirstColumn": false,
"additionalTableObjectsHandler": [],
"intersection": true,
"searchId": null

b

"headerComponents": null,
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"showFilter": false,
"shortTable": false,
"predefinedTableFilters": null,
"cache": false,
"resetFilterOnReload": true
1,
"minimized": false,
"minimizable": true,
"jcon": "kix-icon-ticket",
"contextDependent": false,
"contextObjectDependent": true,
"formDependent": false,
"formDependencyProperties": [
"DynamicFields.myDynamicFieldName"

]
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13.1.2.6 Configuration of Sidebar

The right sidebar (') is available in
all ticket-relevant interfaces. It can be
configured separately for each
context (see page 330) in which it is
located (home dashboard, ticket
details, dialogs, etc.). This means that
the sidebar can contain other widgets
("2') - each with different content - in
every context. You can define yourself
which widgets with which content are
to be displayed in which sidebar. The
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Content on this page:

+ Overview of the configuration keys (see page 412)
+ Configuration key of the widgets (see page 413)
+ The basic configuration of the sidebar (see page 414)
+ Configuration options (see page 416)
+ Attributes of the sidebar configuration (see page 417)

sidebar and the individual widgets are configured in the "System> SysConfig" menu.
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Fig .: The ticket details with the configured sidebar

Overview of the configuration keys

The configuration keys to be used for the sidebar depend on the context in which the sidebar is integrated.
The configuration keys of the sidebar widgets also depend on the context of the sidebar.

The following are the most important configuration keys for the sidebar configuration and the widgets
initially contained therein. You can use the asterisk wildcard (*) to search for the configuration key, e.g. *
card * to search for the object-information-card-widget "contact information”.

\F
| %
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Configuration key of the sidebar

Sidebar

Ticket details

Dialog "New Ticket"

Dialog "Edit Ticket"

Dialog "New Article"

KIX 18 Admin Manual - EN - KIX Start

System settings

Configuration of User Interface (GUI)

Configuration key

ticket-details

new-ticket-dialog-context

edit-ticket-dialog-context

new-ticket-article-dialog-context

Configuration key of the widgets

Widget

Contact

informationen

Recommended FAQ

Tickets to assets

Tickets to contact

Open child tickets
(KIX Pro)

Configuration key

Ticket details

ticket-details-contact-
card-widget

ticket-details-suggested-
fag-widget

ticket-details-affected-
asset-tickets

ticket-details-contact-
tickets

ticket-details-child-tickets

Dialog "New Ticket"

ticket-new-contact-card-
widget

ticket-new-dialog-
suggested-fag-widget

ticket-new-affected-
asset-tickets

ticket-new-contact-
tickets
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Dialog "Edit Ticket"

ticket-edit-contact-card-
widget

ticket-edit-dialog-
suggested-fag-widget

ticket-edit-affected-
asset-tickets

n.a.

n.a.
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Widget Configuration key
Ticket details Dialog "New Ticket" Dialog "Edit Ticket"
Time Accounting (KIX  without n.a. n.a.
Pro) The configuration is

directly in the sidebar
implemented (key: ticket
details)

The basic configuration of the sidebar

A Contact Information

|H
»

The sidebar consists of the sidebar itself ('* ) and

William Anderson

m the widgets contained therein ("2 ). Each context
| o Active Connect Data Center has its own sidebar and contains the code block
<@ €? +49 12345678 "sidbars ":[...] in its configuration key. A list of
= contact037@nomail.org widget configurations can be specified in this code
@ Melvillest. 2 block in order to define the content to be displayed

in the sidebar.
M3 6DH Salford

GB KIX Start initially contains the following widgets in
Al S i R I the ticket details sidebar:

@ Ticket is older than 5h. + Contact information
a8 GotoContact + Recommended FAQ

+ Tickets to assets

I B Create a new Asset
+ Tickets to contact

# My Own Widget

88 2

& Description:WilliamAnderson

I

9 Suggested FAQ

|

Example 1: Configuration of sidebar in the

Title 2 ticket zoom view
Nothing found.

‘

T Tickets for Assets { //Configuration of the "Ticket
Details" context
"id": "ticket-details",
"name": "Ticket details",
"type'": "Context",
"contextId": "ticket-details",

Fig .: The sidebar with widgets
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// Sidebar in the ticket details (contains flexibly implementable widgets)
"sidebars": [
{ //Instance of the Contact Information widget

"instanceId": "ticket-details-contact-card-widget",
"configurationId": "ticket-details-contact-card-widget",
"permissions": [],

"sjze": "large"

{ //Instance of the Recommended FAQ widget
"instanceId": "ticket-details-suggested-faq-widget",
"configurationId": "ticket-details-suggested-fagq-widget",
"permissions": [],

"sjze": "large"

s

{ //Instance of the Tickets to Assets widget
"instanceld": "ticket-details-affected-asset-tickets",
"configurationId": "ticket-details-affected-asset-tickets",
"permissions": [],
"sjze": "large"

s

{ //Instance of the widget ticket to contact
"instanceld": "ticket-details-contact-tickets",
"configurationId": "ticket-details-contact-tickets",
"permissions": [],
"sjze": "large"

}

1,

The sidebar of the ticket details in KIX Pro also contains the widgets:

+ Time tracking
+ Open child tickets

Example 2: Configuration of sidebar in the ticket zoom view (KIX Pro)

{ //Configuration of the "Ticket Details" context

//Configuration of the sidebar
"sidebars": [
{ //KIX-Start-Sidebars },
{
//Instance of the "Time booking" widget (permanently implemented)
"instanceId": "ticket-details-simple-time-accounting-widget",
"configurationId": "ticket-details-simple-time-accounting-widget",
"configuration": {
"id": "ticket-details-simple-time-accounting-widget",
"name": "Simple Time Accounting",
"type": "Widget",
"widgetId": "ticket-simple-time-accounting-widget",
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"title": "Translatable#Simple Time Accounting",
"actions": [],
"subConfigurationDefinition": null,
"configuration": null,

"minimized": false,

"minimizable": true,

"jcon": "kix-icon-time",
"contextDependent": false,
"contextObjectDependent": false,
"formDependent": false,
"formDependencyProperties": []

1,
"permissions": [],
"sjze": "large"

1,
{

//Instance of the "Open Child Tickets" widget
"instanceld": "ticket-details-child-tickets",
"configurationId": "ticket-details-child-tickets",
"permissions": [],
"sjze": "large"
}
1,

Configuration options

You have the following configuration options:

1.

You can reconfigure the configuration of the widgets initially contained in the sidebar, for example by
specifying the required permissions for displaying the widget (" permissions " [])
If necessary, you can change the global configuration directly in the configuration key of the widget
(see configuration example: Configuring an object-information-card-widget (see page 473))
You can find an overview of possible attributes under:

1. Basics of GUI Configuration (see page 330)

2. The object-information-card-widget (see page 355)

3. The table widget. (see page 393)

You can remove unwanted widgets by deleting the widget's code block from the sidebar.

You can reintegrate an instance of a widget into the sidebar at any time. To do this, copy one of the
basic configurations under " sidebars ": [ and adapt it accordingly.

You can use example 1 (see page 414) above as a guide.

You can add further widgets to the widgets contained in the sidebar whose configuration key already
exists in the system (see example: Adding a Widget to the Sidebar (see page 501))
1. To do this, look for the corresponding widgets in the SysConfig key table and make a note of
their exact designation.
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2. Duplicate a configuration block (several times if necessary) and replace the values of
"dinstancelD "and" configurationID " with the respective ID of the widget to be
inserted.

You can use the existing sidebar configuration as a guide.

4. You can integrate your own, individual widgets into the sidebar. However, these must be permanently
implemented directly in the sidebar. You can use example 2 (see page 415) as a guide.
(see also implementation types widgets (see page 336) )

Attributes of the sidebar configuration

The following is a selection of possible attributes for use in the sidebar configuration:

Keyword

avatar {...}

conditions [...]

configuration {...}

configurationId

fallbackIcon

Beschreibung

Avatar (see page
355) configuration
section (contact
photo)

Conditions (see page
355) for when a
value should be
displayed

Contains the
configuration block

Configuration ID

Icon (see page

355) that is
displayed if the
icon specified
under "icon" cannot
be displayed, e.g.
"kix-icon-man"

Issued on: 26.02.2024

Beispiele und Hinweise

Data types: string | ObjectIcon

+ string: "kix-icon-gear" oder "fas fa-phone-
volume"

+ ObjectIcon :derdem Kontakt/Organisation
hinterlegte Avatar (Icon aus /system/
objekticons)

"name-of-my-own-widget"

Data type: string
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Keyword

icon

iconStyle

instanceld

1linkSrc

margin

Beschreibung

Icon which is
placed in front of
information (e.g.
"kix-icon-men")
Also defines the
icon next to the
widget title and on
the button for
showing and hiding
the widget.

CSS style for
formatting the icon

Creates an instance
of the widget.

HTML linking (see
page 355) of external
URLs, KIX URLs, e-
mail addresses,
telephone numbers,
web CRM, etc.

You can link to a
URL generated by
KIX in order to call
up a specific page
inthe KIX (e.g. a
search result, a
specific ticket or a
view). To do this,
copy the URL of the
page and link it with
"linkSrc".

Creates a space
upwards if true
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Beispiele und Hinweise

Data types: string | ObjectIcon

"jconStyle": "color:#ffoeo0",

"name-of-my-own-widget"

Data type: string

fir URL: "1inkSrc": "https://

www . domainname.de/optionalerPfad"
fir KIX-URL: "1inkSrc": "https://
kixURL.de/search?
search=%7B%22objectType%22:%

[ ... ] name%22:null%7D"

fir E-Mail: "1inkSrc":
"mailto:max.mustermann@company.de"
fur Telefon: "1linkSrc":"tel:
+49123456789"

true | false
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Keyword

minimizable

minimized

name

operator:

permissions:

routingConfiguration

{...}

Beschreibung

Defines whether
the widget can be
minimized.

Defines whether
the widget is
displayed
minimized.

Name of the widget

Operator in
conditions

Roles / permissions
for the display

internal linking (see
page 355), €.g. On
contact details
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Beispiele und Hinweise

true | false

true | false

"My Own Widget",

+ EQ - Equal to

+ NE - Not equal to

+ LT - Lessthan

+ LE - Less than or equal to

+ GT - Greater than

+ GE - Greater than or equal to
+ AND - logical AND

+ OR - logical OR

+ IN - logisches IN

+ CONTAINS

"permissions": [

{
"target": "system/slas”,
"permissions": |

2

],
"OR": false,
"permissionCheckMaxLayer": "
"value": 2

Resource”",

Page 419



Keyword

routingObjectId

rows {...}

text

textStyle

title

Beschreibung

ID of the object to
be linked to (can
contain
placeholders), e.g.
<KIX_CONTACT_ID

>

Content block;
contains all
information that
should be displayed
in the widget

Information text
(can contain
placeholders)

CSS styles for text
formatting

Title of the widget
in the frontend; KIX
placeholders can
be used.
"Translatable #"
makes the title
translatable.

A corresponding
pattern must be
stored in the
Internationalization
menu.
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Beispiele und Hinweise

Data type: string

Data type: string

"textStyle": "color:#ffeo00",

Translatable#Simple Time Accounting
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Keyword

type

values [...]

Beschreibung

Type of integrated
element

Contains the
information values
foricon, text,
linkSrc,
routingConfiguratio
n, routingObjectlid,
conditions etc.
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Beispiele und Hinweise

Widget | TableWidget

+ Widget: simple map widget like "contact
information"

+ TableWidget: Table widget like "Tickets to
Contact"

"values": [{
"icon": null,
"text": "<KIX_CONTACT_ID>",
"linkSrc": null

]

Issued on: 26.02.2024 Page 421



KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

13.1.3 Configuration examples of GUI configuration

In the following chapters you will find a number of configuration examples. These are only intended to serve
as suggestions, assistance and orientation and to familiarise you with the configuration of the user interface.
If you use the configuration examples and code blocks, you must adapt them to your specific needs.

Integrating a Dynamic Field (see page 423)

Displaying Values of Dynamic Fields (see page 442)
Configuring an object-information-card-widget (see page 473)
Configuration of table widget "Suggested FAQ" (see page 480)
Adding a widget to the dashboard (see page 485)
Configuration of dashboard tables (see page 497)

Adding a Widget to the Sidebar (see page 501)
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13.1.3.1

Dialog

New Ticket

Ticket edit

New FAQ Article

Edit FAQ Article

New Contact

Edit Contact

New Organisation

(Key depends on the information
block in the form)

Edit Organisation

(Key depends on the information
block in the form)

Integrating a Dynamic Field

Configuration key

ticket-new-form-group-data

ticket-edit-form-group-data

fag-article-new-form-group-data

fag-article-edit-form-group-data

contact-new-form-group-
information

contact-edit-form-group-
information

organisation-new-form-group-
information
organisation-new-form-group-
address
organisation-new-form-group-
other

organisation-edit-form-group-
information
organisation-edit-form-group-
address
organisation-edit-form-group-
other

KIX 18 Admin Manual - EN - KIX Start
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Required object type of the
dynamic field

Ticket

Ticket

FAQ

FAQ

Contact

Contact

Organisation

Organisation

Dynamic fields (see page 274) are individual input and selection fields. If they are integrated into the program
interface, additional information can be stored in them.

Dynamic fields can be integrated in various places of the program interface, e.g. in the "New" and "Edit"
dialogs of

+ Tickets
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+ FAQ articles
+ Contacts and Organizations.

Note: Dynamic fields cannot be deployed to assets. However, you can add custom fields to an asset class
definition (see alsoEditing a Class Definition (see page 130) ).

The object type selected in the Dynamic Field configuration determines the object to which the Dynamic Field
can be attached. This means: If a dynamic field is assigned to the object type "Ticket", it can only be
integrated in ticket-relevant interfaces, but not in contacts or organizations.

The integration of a Dynamic Field is done in the System > SysConfig menu by adding a code block to the
respective configuration key. The table above contains a selection of the most important configuration keys.
The procedure for integration is the same in all keys.

Dynamic fields can only be integrated in system configurations of the type "FormGroup", because only these
contain the parameter "formFields". Info about this is provided by the column "Metadata" in the overview of

the SysConfig keys and/or the search for " xform-groupx ".

Integration in the Dialog "New Ticket"
Configuration key ticket-new-form-group-data

In the following description, we will limit ourselves to the integration of a dynamic field in the "New ticket"
dialog as an example. The dynamic field is to be a single-line text field for storing the serial number in the
ticket.

The integration of a dynamic field in other dialogs (e.g. "Edit ticket" or "Edit contact") is done in the same way
in the corresponding SysConfig keys (see table above).

@ Info

The following description is valid for KIX Start!

KIX Pro first uses the "Default - New Ticket Template" template for the ticket creation screen for the
"New Ticket" dialog and only uses the (modified) SysConfig key as a fallback. KIX Pro users should
therefore integrate dynamic fields directly in the template (Workflow > Templates menu).

The dialog "Edit ticket" is a ticket action in KIX Pro (Ticket Edit). This can be opened for editing in the
Workflow > Actions menu to conveniently include dynamic fields via drop-down selection.
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To integrate a dynamic field in the ticket creation dialog, proceed as follows:

1.

Create a dynamic field of the field type "Text field" under System > Dynamic fields (if not already
available).

Select the object type "Ticket", as the dynamic field is to be integrated into a ticket-relevant interface.
Make a note of the name of the dynamic field. You will need it to reference it (see step 5).

4 # Home X | 2 & Admin: DynamicFi.. X

Ausblenden <«
Administration i L, System: Dynamic Fields (66)
T e Al Field Type Object Type Internal a8 valid

et Pasistant DFserialNumber Serial number Text Ticket No v wvalid

+ Assets

Alternative:

Select a different field type, if necessary, depending on what type of Dynamic Field you need.

If necessary, select a different object type, depending on the object (contact, organization, asset, etc.)
where you want the Dynamic Field to be available.

Navigate to System > SysConfig. Open key "ticket-new-form-group-data". This key defines the structure
of the ticket creation screen.

£, System: Sysconfig (1)
ticket-new-form-group* Search
MName & Modified Context Metadata Access Le. Walidity Value
ticket-new-form-group-data kix18-web-frontend FormGroup internal valid {"id":"ticket-1
< >
Alternative:

Select another SysConfig key if necessary (see table above). The selection depends on the interface
into which the dynamic field is to be integrated.

Open key and copy source code from "Value" field to JSON editor. To make it easier to edit the code,
the right-hand column contains the source code in maximized format.
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Upload (.json/.txt) Clear Live format Download Copy Minify Prettify
{"id":"ticket-new-form-group {

,"fieldConfigurationIds": "id": "ticket-new-form-group-data”,
-form-field-organisation” t "name”: "Translatable#Ticket Data”,

fi 1 P -new-form-fisld ,tickst "fieldConfigurationIds”: [

1d-channel cket-new-form-field-ouner","ticket-new "ticket-new-form-field-contact”,
-form-field-priori cket-new-form-field-state” eparatorString™ " t-new-form-field-organisation”,
tnull, "formFields”:[{"id": "ticket-new-form-field-affactedasset” t-new-form-field-affectedasset”,
,"label"”:null,"property”:"DynamicFields", "inputComponent” :null t- d-type",
,"reguired”:false, "hint" t- eld-queus”,
:"Translatable#Helptext Tickets TicketCreate AffectedAsset”,"options” t- eld "
s[{"opticn":"FIELD_NAME","value":"AffectedAsset"}], "defaultvalue" t- eld
c{"value":null, "valid":true, "errorMessages”:[]} t- eld
,"fieldConfigurationIds”:[], "children”:[], parentInstanceId”:null t-new-form-field-
,"countDefault”:null, "countMax" :null,"countMin”:null, "maxLength”:null 1.
,"regEx":null, "regExErrorMessage” :null, "empty”:false, "asStructure” "separatorString™: null,
:false, "readonly”:false, "placeholder” :null, "existingFieldId":null "formFields": [
,"showLabel”:true,"name":null,"draggableFields" :false, "defaultHint" {
:"Translatable#Helptext_Tickets_TicketCreate_ AffectedAsset”,"type"” ° "id": "ticket-new-form-field-affectedasset”,
:"FormField”,"visible":true,"translatelabel”:true,"instanceId":null} "label”: null,

,"draggableFields":false, "type":"FormGroup”} "property”: "DynamicFields",
"inputComponent”: null,
"required”: false,
"hint": "Translatable#Helptext_Tickets_TicketCreate_affectedh

sset”,
"options”: [
{
"option”: "FIELD_MAME",
"value": "AffectedAsset”
}

Insert the following source code (without comments!) into the code block under "formFields:
[...] " Place it before or after an existing code section (e.g. " ticket-new-form-field-
affectedasset"[...]).

To include several dynamic fields, insert the source text several times. Separate the individual code
sections with commas.

Tip: With the code section " ticket-new-form-field-affectedasset"[...], the selection
field "Affected Assets" is integrated into the ticket creation screen, which is also a Dynamic Field. You
can optionally change the parameters for the field or remove the field from the ticket creation screen.
You can also use the code block as a template for integrating your own dynamic fields by duplicating
the code block and adjusting the configuration.

N

"id": "ticket-new-form-field-dfserialnumber", //unique ID of the
DF in the key

3 "label": null,
4 "property": "DynamicFields",
5 "inputComponent": null,
6 "required": false,
7 "hint": "Translatable#Seriennummer des Gerats",
8 "options": [
9 {
10 "option": "FIELD_NAME",
11 "value": "DFSerialNumber" //Name of the DF as created 1in
the system
12 }
13 1,
14 "defaultValue": {
15 "value": null,
16 "valid": true,
17 "errorMessages": []
18 },
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19 "fijeldConfigurationIds": [],
20 "children": [],
21 "parentInstanceId": null,
22 "countDefault": null,
23 "countMax": null,
24 "countMin": null,
25 "maxLength": null,
26 "regEx": null,
27 "regExErrorMessage": null,
28 "empty": false,
29 "asStructure": false,
30 "readonly": false,
31 "placeholder": null,
32 "existingFieldId": null,
33 "showLabel": true,
34 "name": null,
35 "draggableFields": false,
36 "defaultHint": "Translatable#optionaler_ Hilfetext",
37 "type": "FormField",
38 "visible": true,
39 "translatelLabel": true,
40 "instanceId": null
41 | 1,
Alternative:

You can also use the source code in the other configuration keys mentioned above.
Always insert the source code between the square brackets of the "formFields" parameter. Depending
on the configuration key, this parameter may be initially empty (e.g. in the "Edit Contact" dialog).

{

"id": "contact-edit-form-group-information™,

"name”: "Translatable#Contact Information”,

"fieldConfigurationIds™: [
"contact-edit-form-field-title"”,
"contact-edit-form-field-firstname™,
"contact-edit-form-field-lastname”,
"contact-edit-form-field-organisation™,
"contact-edit-form-field-primary-organisation”,
"contact-edit-form-field-communication-container”,
"contact-edit-form-field-address-container”,
"contact-edit-form-field-other-container”

],

"separatorString”: null,

“"formFields™: [ I

"draggableFields": false,

"type": "FormGroup”,

"valid": true,

"application™: "agent-portal”

5. Give the dynamic field an ID. To do so:

.{'5:
| %

1.

meaningful ID.

Replace example ID " ticket-new-formfield-dfserialnumber " with your own

You can use any name you like for the ID, but it must only occur once in the entire form and

must not be identical to the value set under "value".
That is why we recommend you use a meaningful ID.
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2. Under "value", replace the example value "DFserialNumber" with the name of the dynamic field

to be included (from step 1). The name of the dynamic field defined under System > Dynamic
Fields must be entered.

6. Add the ID of the dynamic field (from 5a) to the code block " fieldConfigurationIDs ". The order
of the field IDs determines the order of the form fields in the ticket creation screen.
In the example, the dynamic field will be included in the third place - between "Organisation" and
"Affected asset" in the form.
If you do not enter an ID here, the dynamic field will always be included at the last position in the form,

in the order in which the fields in the code block " formFields[...] "areincluded.

{

"id": “"ticket-new-form-group-data”,
"name": "Translatable#Ticket Data”,
“fieldConfigurationIds": [
"ticket-new-form-field-contact”,
“ticket-new-form-field-organisaticon”,
"ticket-new-form-field-serialnumber” .
"ticket-new-form-field-affectedassat™,
“ticket-new-form-field-type",
"ticket-new-form-field-queus",
"ticket-new-form-field-channel”,
"ticket-new-form-field-owner",
"ticket-new-form-field-pricrity”,
"ticket-new-form-field-state”
1,
"separatorString”: null,
“formFields": [
i
"id": "ticket-new-form-field-serialnumber", //unique ID of the DF in the ke
"label": null,
“"property”: "DynamicFields”,
"inputComponent”: null,
"required”: false,

"hint": "Translatable#Serial number™,
"options": [
{

"option": "FIELD_MAME",
"value™: "DFSerialNumber" /Name of the DF (how in KIX created
¥
]!
"defaultvalue": {
"walue": null,
"walid": true,
"errorMessages”: []

T
"fieldConfigurationIds": [].
"children": [],

"parentInstanceld”: null,
LTI Ja P ST LU T i

| "%
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Important: Minify source code to remove superfluous blanks and line breaks and copy source code

to clipboard.
Download Minify Prettif;
{
"id™: “"ticket-new-form-group-data”,
"name": "Translatable#Ticket Data”,
MEialdran i guearianTdets T

Paste source code from clipboard back into "Value" field and click "Save" to apply changes.

Click "Reload Frontend Configurations" to update fields of ticket creation screen. If you do not do this,

the dynamic field will not be displayed.

& System: Sysconfig (11)

tcked-new-form”

[] Name = sndifiad Context

[ ticket-new-foem kix18-web-frontend

1 ticl 4 field-channsl ki1 f-webfrr

Metadata Accessie.. Walidity

Form Internal waliel

internal alicl

v Reload Fronten...

o search

valus Changed at Changad by

form® "namar"

{id""ticket: M. 09/27/2021, 08110 AM ot assigned

173"l Id-chaneal™ “lahal™ "y 0937091 OA0 AR rat accigned

The dynamic field will be displayed when opening the ticket creation screen. The serial number can

now be saved directly in the ticket.

T New Ticket
* Contact: &
* Organisation: @
Serial number: @
Affected Asset: @
* Type:

* Assign Team / Queue:

* Channel; @ ! I "

Tip

In the Admin Manual of KIX Pro you will find a detailed description of how to provide and display

checklists.

Configuration examples

Below you will find examples of already modified configuration keys for your information. To do so, expand

the respective area.

A Please note that the following are configuration examples. We do not assume any liability if you
transfer the configurations 1:1 into your system.
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Dialog "Neues Ticket" (ticket-new-form-group-data)
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25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49

X

"jd": "ticket-new-form-group-data",
"name": "Translatable#Ticket Data",
"fieldConfigurationIds": [

1,

"ticket-new-form-field-contact",
"ticket-new-form-field-organisation",
"ticket-new-form-field-myDynamicField",
"ticket-new-form-field-affectedasset",
"ticket-new-form-field-type",
"ticket-new-form-field-queue",
"ticket-new-form-field-channel",
"ticket-create-form-field-timeunit",
"ticket-new-form-field-owner",
"ticket-new-form-field-priority",
"ticket-new-form-field-state"

"separatorString": null,
"formFields": [

{
"id": "ticket-new-form-field-myDynamicField",
"label": null,
"property": "DynamicFields",
"inputComponent": null,
"required": false,
"hint": "Translatabl#Ubersetzbarer Hinweistext",
"options": [
{
"option": "FIELD_NAME",
"value": "SomeDynamicField"

1,
"defaultValue": {

"value": null,

"valid": true,

"errorMessages": []
1
"fjeldConfigurationIds": [],
"children": [],
"parentInstanceId": null,
"countDefault": null,
"countMax": null,
"countMin": null,
"maxLength": null,
"regEx": null,
"regExErrorMessage": null,
"empty": false,
"asStructure": false,
"readonly": false,
"placeholder": null,

Issued on: 26.02.2024 Page 430



KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

50 "existingFieldId": null,

51 "showLabel": true,

52 "name": null,

53 "draggableFields": false,

54 "defaultHint": "Translatable#optionaler_ Hilfetext",

55 "type": "FormField",

56 "visible": true,

57 "translatelLabel": true,

58 "instanceIld": null

59 1,

60 {

61 "id": "ticket-new-form-field-affectedasset",

62 "label": null,

63 "property": "DynamicFields",

64 "inputComponent": null,

65 "required": false,

66 "hint":
"Translatable#Helptext_Tickets_TicketCreate_AffectedAsset",

67 "options": [

68 {

69 "option": "FIELD_NAME",

70 "value": "AffectedAsset"

71 1

72 1,

73 "defaultValue": {

T4 "value": null,

75 "valid": true,

76 "errorMessages": []

7 3,

78 "fieldConfigurationIds": [],

79 "children": [],

80 "parentInstanceId": null,

81 "countDefault": null,

82 "countMax": null,

83 "countMin": null,

84 "maxLength": null,

85 "regEx": null,

86 "regExErrorMessage": null,

87 "empty": false,

88 "asStructure": false,

89 "readonly": false,

90 "placeholder": null,

91 "existingFieldId": null,

92 "showLabel": true,

93 "name": null,

94 "draggableFields": false,

95 "defaultHint":
"Translatable#Helptext_Tickets_TicketCreate_AffectedAsset",

96 "type": "FormField",

97 "visible": true,

98 "translatelLabel": true,

99 "valid": true,

100 "application": "agent-portal",
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"instanceId": null

"id": "ticket-create-form-field-timeunit",

"label": "Translatable#Account Time",

"property": "TimeUnit",

"inputComponent": "number-input",

"required": false,

"hint": "Translatable#Helptext_Tickets_TicketCreate_TimeUnit",
"options": [

{
"option": "STEP",
"value": 1
1,
{
"option": "EXCEPTS_EMPTY",
"value": true
1,
{
"option": "UNIT_STRING",
"value": "Translatable#Minutes"
}

1,

"defaultValue": null,
"fieldConfigurationIds": null,
"children": null,
"parentInstanceId": null,
"countDefault": null,
"countMax": null,

"countMin": null,

"maxLength": null,

"I"egEX": IIA_?\\d+$Il’
"regExErrorMessage": "Translatable#Account time has to be an
)

"empty": false,

"asStructure": false,
"readonly": false,
"placeholder": null,
"existingFieldId": null,
"showLabel": true,

"name": "Translatable#Account Time",
"draggableFields": false,
"defaultHint":

"Translatable#Helptext_Tickets_TicketCreate_TimeUnit",

1,

"type": "FormField",
"visible": true,
"translatelLabel": true,
"valid": true,

"application": "agent-portal",
"instanceId": null

"draggableFields": false,
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152 "type": "FormGroup",

153 "valid": true,

154 "application": "agent-portal"
155 }
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Dialog "Ticket bearbeiten" (ticket-edit-form-group-data)
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"jd": "ticket-edit-form-group-data",
"name": "Translatable#Ticket Data",
"fieldConfigurationIds": [

1,

"ticket-edit-form-field-title",
"ticket-edit-form-field-contact",
"ticket-edit-form-field-organisation",
"ticket-edit-form-field-myDynamicField",
"ticket-edit-form-field-affectedasset",
"ticket-edit-form-field-type",
"ticket-edit-form-field-queue",
"ticket-edit-form-field-channel”,
"ticket-edit-form-field-owner",
"ticket-edit-form-field-responsible",
"ticket-edit-form-field-priority",
"ticket-edit-form-field-state"

"separatorString": null,
"formFields": [

{

"jd": "ticket-edit-form-field-planbegin",
"label": null,
"property": "DynamicFields",
"inputComponent": null,
"required": false,
"hint": null,
"options": [

{

"option": "FIELD_NAME",
"value'": "PlanBegin"

}
1,
"defaultValue": {

"value": null,

"valid": true,

"errorMessages": []
3,
"fieldConfigurationIds": [],
"children": [],
"parentInstanceId": null,
"countDefault": null,
"countMax": null,
"countMin": null,
"maxLength": null,
"regEx": null,
"regExErrorMessage": null,
"empty": false,
"asStructure": false,
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"readonly": false,
"placeholder": null,
"existingFieldId": null,
"showLabel": true,
"name": null,
"draggableFields": false,
"defaultHint": null,
"type": "FormField",
"visible": true,
"translatelLabel": true,
"valid": true,
"application": "agent-portal",
"instanceId": null

"id": "contact-edit-form-field-myDynamicField",
"label": null,
"property": "DynamicFields",
"inputComponent": null,
"required": false,
"hint": "Translatabl#Ubersetzbarer Hinweistext",
"options": [
{
"option": "FIELD_NAME",
"value": "SomeDynamicField"
}
1,
"defaultValue": {
"value": null,
"valid": true,
"errorMessages": []
3,
"fieldConfigurationIds": [],
"children": [],
"parentInstanceId": null,
"countDefault": null,
"countMax": null,
"countMin": null,
"maxLength": null,
"regEx": null,
"regExErrorMessage": null,
"empty": false,
"asStructure": false,
"readonly": false,
"placeholder": null,
"existingFieldId": null,
"showLabel": true,
"name": null,
"draggableFields": false,
"defaultHint": "Translatable#optionaler_ Hilfetext",
"type": "FormField",
"visible": true,
"translatelLabel": true,
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102 "instanceIld": null

103 1,

104 {

105 "id": "ticket-edit-form-field-planend",
106 "label": null,

107 "property": "DynamicFields",
108 "inputComponent": null,

109 "required": false,

110 "hint": null,

111 "options": [

112 {

113 "option": "FIELD_NAME",
114 "value": "PlanEnd"
115 }

116 1,

117 "defaultValue": {

118 "value": null,

119 "valid": true,

120 "errorMessages": []

121 1,

122 "fieldConfigurationIds": [],
123 "children": [],

124 "parentInstanceId": null,
125 "countDefault": null,

126 "countMax": null,

127 "countMin": null,

128 "maxLength": null,

129 "regEx": null,

130 "regExErrorMessage": null,
131 "empty": false,

132 "asStructure": false,

133 "readonly": false,

134 "placeholder": null,

135 "existingFieldId": null,
136 "showLabel": true,

137 "name": null,

138 "draggableFields": false,
139 "defaultHint": null,

140 "type": "FormField",

141 "visible": true,

142 "translatelLabel": true,

143 "valid": true,

144 "application": "agent-portal",
145 "instanceIld": null

146 1,

147 {

148 "id": "ticket-edit-form-field-affectedasset",
149 "label": null,

150 "property": "DynamicFields",
151 "inputComponent": null,

152 "required": false,

153 "hint": "Translatable#Helptext_Tickets_TicketEdit_AffectedAsset",
154 "options": [
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155 {

156 "option": "FIELD_NAME",

157 "value": "AffectedAsset"

158 }

159 1,

160 "defaultValue": {

161 "value": null,

162 "valid": true,

163 "errorMessages": []

164 1,

165 "fieldConfigurationIds": [],

166 "children": [],

167 "parentInstanceId": null,

168 "countDefault": null,

169 "countMax": null,

170 "countMin": null,

171 "maxLength": null,

172 "regEx": null,

173 "regExErrorMessage": null,

174 "empty": false,

175 "asStructure": false,

176 "readonly": false,

177 "placeholder": null,

178 "existingFieldId": null,

179 "showLabel": true,

180 "name": null,

181 "draggableFields": false,

182 "defaultHint":
"Translatable#Helptext_Tickets_TicketEdit_AffectedAsset",

183 "type": "FormField",

184 "visible": true,

185 "translatelLabel": true,

186 "valid": true,

187 "application": "agent-portal",

188 "instanceIld": null

189 }

190 1,

191 "draggableFields": false,

192 "type": "FormGroup",

193 "valid": true,

194 "application": "agent-portal"

195 }
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Dialogue "Edit contact" (contact-edit-form-group-information)
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"jd": "contact-edit-form-group-information",
"name": "Translatable#Contact Information",
"fieldConfigurationIds": [
"contact-edit-form-field-title",
"contact-edit-form-field-firstname",
"contact-edit-form-field-lastname",
"contact-edit-form-field-organisation",
"contact-edit-form-field-primary-organisation",
"contact-edit-form-field-communication-container",
"contact-edit-form-field-address-container",
"contact-edit-form-field-other-container",
"contact-edit-form-field-myDynamicField"
1,
"separatorString": null,
"formFields": [
{
"id": "contact-edit-form-field-myDynamicField",
"label": null,
"property": "DynamicFields",
"inputComponent": null,
"required": false,
"hint": "Translatabl#Ubersetzbarer Hinweistext",
"options": [
{
"option": "FIELD_NAME",
"value": "SomeDynamicField"

1,
"defaultValue": {

"value": null,

"valid": true,

"errorMessages": []
3,
"fieldConfigurationIds": [],
"children": [],
"parentInstanceId": null,
"countDefault": null,
"countMax": null,
"countMin": null,
"maxLength": null,
"regEx": null,
"regExErrorMessage": null,
"empty": false,
"asStructure": false,
"readonly": false,
"placeholder": null,
"existingFieldId": null,
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49 "showLabel": true,

50 "name": null,

51 "draggableFields": false,
52 "defaultHint": "Translatable#optionaler_ Hilfetext",
53 "type": "FormField",

54 "visible": true,

55 "translatelLabel": true,
56 "instanceId": null

57 }

58 1,

59 "draggableFields": false,

60 "type": "FormGroup",

61 "valid": true,

62 "application": "agent-portal"
63 }
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"id": "organisation-edit-form-group-information",
"name": "Translatable#Organisation Information",

KIX 18 Admin Manual - EN - KIX Start

"fieldConfigurationIds": [
"organisation-edit-form-field-cno",
"organisation-edit-form-field-name",
"organisation-edit-form-field-type",
"organisation-edit-form-field-url",

"organsiation-edit-form-field-myDynamicField"

1,

"separatorString": null,
"formFields": [

{

"id": "organisation-edit-form-field-myDynamicField",

"label": null,

"property": "DynamicFields",
"inputComponent": null,
"required": false,

"hint": "Translatabl#Ubersetzbarer Hinweistext",

"options": [

{

"option": "FIELD_NAME",
"value": "SomeDynamicField"

}
1,
"defaultValue": {

"value": null,

"valid": true,

"errorMessages": []
3,
"fieldConfigurationIds": [],
"children": [],
"parentInstanceId": null,
"countDefault": null,
"countMax": null,
"countMin": null,
"maxLength": null,
"regEx": null,
"regExErrorMessage": null,
"empty": false,
"asStructure": false,
"readonly": false,
"placeholder": null,
"existingFieldId": null,
"showLabel": true,
"name": null,
"draggableFields": false,

"defaultHint": "Translatable#optionaler_ Hilfetext",
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49 "type": "FormField",
50 "visible": true,

51 "translatelLabel": true,
52 "instanceId": null

53 }

54 1,

55 "draggableFields": false,

56 "type": "FormGroup",

57 "valid": true,

58 "application": "agent-portal"
59 }
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13.1.3.2 Displaying Values of Dynamic Fields

Widget Configuration key Required object type of the
dynamic field

Ticket Information ticket-details-info-card Ticket
Contact Information contact-details-info-widget Contact
Organisation Information organisation-details-info-widget Organisation
FAQ Information fag-article-info-widget FAQ

If an agent stores information in a dynamic field, this information is stored directly on the object (ticket,
contact, etc.). This makes it possible to read out this content specifically and display it at the desired
location.

The description below is a continuation of the example from chapter "Integrating a Dynamic Field (see page
423)". The serial number is now to be displayed in the "Ticket information". It is assumed that you have
already created a dynamic field for the serial number and integrated it into the ticket creation screen, and
that the serial number is specified on a ticket (the dynamic field is filled with a value).

The display of a Dynamic Field in other detail views (e.g. Contact Details) is done in the same way in the
corresponding SysConfig keys (see table above).

- @ P T a w - # & nk - =)
Bl 7 et information
Summary Orgarvzation Contoct
ﬁ [TD-ORGANSATION-001] Springhield Nucicar Plant ﬂ Charles Monsgamery Burns
T o ah
Assignees Rezaansibl D
[ QRS-

Fig.: Value of a Dynamic Field Displayed in Ticket Information

@ Tip

KIX Pro users can conveniently integrate dynamic fields via the integrated JSON editor in the menu
System > GUI Configuration > Agent Portal. See also: GUI Configuration in the Admin Manual of KIX
Pro.

Show value of a dynamic field in ticket details
Configuration key: ticket-details-info-card

To display the values of a dynamic field in the ticket information, proceed as follows:
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1. Navigate to System > SysConfig and search for key "ticket-details-info-card".
This is the key of the object-information-card-widget to display the "Ticket Information”.
Optionally, use another SysConfig key (see table above) to display the value of the dynamic field in
another detail view.
2. Open the key and copy the source code in the "Value" field into a JSON editor for easier editing.
3. Copy the following code block into a values block at the desired position.
Your placement determines where in the widget the value of the dynamic field is displayed.
To include several dynamic fields, insert the source text several times. Separate the individual code
sections with commas.
1. Inthe conditions code section you can specify conditions under which the Dynamic Field
is displayed (optional). In the example, the dynamic field will only be displayed if it also has a
value. This means that if no serial number is specified on the ticket, the dynamic field will not
be displayed in the ticket details. If no conditions are noted, the field is always displayed.
2. As an alternative to the object-avatar-label component, you can also use dynamic-
field-value, especially if multi-line texts, checklist or table values are to be displayed (see

variant below).
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"componentId": "object-avatar-label",
"componentData": {
"property": "DynamicFields.DFserialNumber"
1,
"conditions": [
{
"property": "DynamicFields.DFserialNumber",
"operator": '"NE",
"value": null

3

KX Issued on: 26.02.2024 Page 444



KIX 18 Admin Manual - EN - KIX Start

== System settings
AJ Configuration of User Interface (GUI)
{
"id": "ticket-details-info-card”,
"name": "Ticket Info Widget",
"type": "Widget",
"widgetId": "object-information-card-widget”,

"title": "Translatable#Ticket Information”,
"actions™: []1,
"subConfigurationDefinition™: null,
"configuration": {

"id": "1643814545149",

"name": "1643014545149",

"type": null,
"avatar": [],
"rows": [
{
"title": "Translatable#Summary",
"style™: "7,

"separator": true,
"values": [
[,
EC]],
{3},
{3},
{
"componentId": "object-avatar-label”,
"componentData": {
"property": "DynamicFields.DFSerialNumber”

¥
"conditions": [
{
"property”: "DynamicFields.DFSeriallNumber",
"operator™: "NE",
"value": null
}
]
),
{
"componentId": "object-avatar-label”,
"componentData": {
"property": "DynamicFields.AnonymiseTicket"

Replace the Dynamic Field Name (DFSerialNumber) used in the sample code with the name of your
own Dynamic Field. The Dynamic Field Name defined under System > Dynamic Fields must be
entered. Use the following syntax: DynamicFields.NameDynamicField.

If you have included several dynamic fields, replace these names in the same way.
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5. Minify source code to remove superfluous blanks and line breaks and copy source code to clipboard.

Download Copy Minify Prettify

{"id":"ticket-details-info-card”,"name":"Ticket Info Widget","type":"Widget","widgetId":"object-information
-card-widget","title":"Translatable#Ticket Information"”,"actions":[],"subConfigurationDefinition”:null
,"configuration”:{"avatar":[],"rows":[{"title":"Translatable#Summary"”,"style":"", "separator”:true, "values"

[[{"componentId”:"object-avatar-label"”, "componentData”:{"property"”:"OrganisationID"}
,"routingConfiguration”:{"contextId":"organisation-details","objectType":"Organisation”, "contextMode”
:"DETAILS","objectIdProperty”:"ID", "history":false, "resetContext":true,"contextType":"MAIN"}
,"routingObjectId":"<KIX_TICKET_OrganisationID>"},{"componentId":"object-avatar-label”,"componentData”
{"property”:"TypeID"}}],[{"componentId"”:"object-avatar-label”,"componentData”:{"property"”:"ContactID"}
“roptinoConfignrotion® - I enntowt TA" - "rontort _dotodilc™ "nAhdortTuna™-"Contart” "rontowibMode®™ - "OETATI S

6. Paste source code from clipboard back into "Value" field and click "Save" to apply changes.

7. Click "Reload Frontend Configurations” to update display of fields in lane. If you do not do this, the
dynamic field will not be displayed.

%4, System: Sysconfig (1) + Reload Fronten...
ticket-details-info* Search
[ Name ¥ Meodified Context Metadata Access Le... Validity Value
[J ticket-details-info-card v kix18-web-frontend Widget internal valid {"id":"ticket-details-info-card","n

8. The serial number saved in the ticket will now also be displayed in the "Ticket Information” lane.

 MEEE @ FedHTom @ NewuTEE v Cse  #  ENT gP LN 0 warh & P
Il 7 ricet iormation
Summary Orgarisatior -
B o oncamsmon o spingtos et Y
) [
Assignees
‘ ot azsigned ot assigned

@ Tip
In the Admin Manual of KIX Pro you will find a detailed description of how to provide and display
checklists.

Alternative variant

You can display the value of the dynamic field in a separate content block.
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- T Ticket Information Iuwm I History
Summary ﬁ Organisation 9 Contact
c.a.p.e. IT GmbH Séren Wollenda
T Type Priority
? Unclassified 3 normal

Serialnumber/s

Assignees

Scheduling

A123-45678
A345-67890
B901-23456

& Responsible
Agent [TD]hhaupt

@ Accounted Time: Oh Om

6 Owner
Agent [TD]hhaupt

Created by Agent [TDlhhaupt at 01/24/2022, 04:34 PM. Last change by Agent [TD]hhaupt at 01/24/2022, 04:34 PM

Q State
open

Queue
[TD-TEAM-D01] 1st level team (valid)

Fig.: Value of a dynamic field (multi-line display)

To do this, insert the following code block under " rows[...] ". Again, the placement in the code

determines the placement in the GUL.

The variant uses dynamic-field-value as componentID . This component offers individual

components for dynamic field values, based on their dynamic field type. It thus enables the output of

formatted text, e.g. with line breaks in a multi-line text field. In contrast, the component object-avatar-

label only provides a single-line value (see also: https://github.com/kix-service-software/kix-frontend/

blob/master/doc/components/widgets/object-information-card-widget.md).

The parameters specified under conditions are optional.

"title": "Translatable#Serialnumber/s",

"componentId": "dynamic-field-value",
"componentData": {

"name" :

"DFSerialNumber"

"conditions": [

"property":

"operator": '"NE",
"value": null

{
llstylell . nmn ,
"'separator": true,
"values": [
{
}
{
}
]
}
]
}

"DynamicFields.DFSerialNumber",
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"id": "ticket-details-info-card”,
"name": "Ticket Info Widget”,
"type": "Widget",
"widgetId": "object-informaticn-card-widget",
"title": "Translatable#Ticket Information”,
"actions": [],
"subConfigurationDefinition": null,
"configuration": {

"id": "1643014545149",

"name": "1643014545149",

"type": null,

“avatar™: [],

"rows": [
{
"title": "Translatable#Summary”,
Ilstylell: n II,

"separator™: true,
"values": [

[ )

[,

[l

P

"title": "Translatable#Serialnumber/s",
"style": "7,
"separator”: true,
"values": [
{
"componentId”: "dynamic-field-value",
"componentData®™: {
"name™: "DFSerialNumber”
¥,
"conditions": [

{

"operator”: "NE",
"value™: null

"title": "Translatable#Description”,
Il_l‘_.tylell: mn II,
"separator”: true,
"values": [
r

"property”: "DynamicFields.DFSerialNumber"”,

Fig.: Code block for displaying the value of a dynamic field
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Configuration examples

Below you will find examples of already modified configuration keys for your information. To do so, open the

respective area.

& Please note!

Please note that the following are configuration examples. We do not assume any liability if you
transfer the configurations 1:1 into your system.

Zoom view of ticket (Ticket Information)

o ~NoO U WN R

Jﬁé

"id": "ticket-details-info-card",
"name": "Ticket Info Widget",
"type": "Widget",
"widgetId": "object-information-card-widget",
"title": "Translatable#Ticket Information",
"actions": [],
"subConfigurationDefinition": null,
"configuration": {
"id": "1692622169146",
"name'": "1692622169146",
"type": null,
"valid": true,
"application": "agent-portal",
"avatar": [],
"rows": [
{
"title": "Translatable#Summary",
"style": "",
"separator": true,
"values": [

[

"componentId": "object-avatar-label",

"componentData": {

"property": "OrganisationID"

},

"routingConfiguration": {
"contextId": "organisation-details",
"objectType": "Organisation",
"contextMode": "DETAILS",
"objectIdProperty": "ID",
"history": false,

"externalLink": null,
"replaceObjectId": null,
"resetContext": true,
"params": null,
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"additionalInformation": [],
"contextType'": "MAIN"

3,
"routingObjectId": "<KIX_TICKET_OrganisationID>"
"componentId": "object-avatar-label",

"componentData": {
"property": "TypeID"
1

"componentId": "object-avatar-label",

"componentData": {

"property": "ContactID"

3,

"routingConfiguration": {
"contextId": "contact-details",
"objectType": "Contact",
"contextMode": "DETAILS",
"objectIdProperty": "ID",
"history": false,
"externalLink": null,
"replaceObjectId": null,
"resetContext": true,

"params": null,
"additionalInformation": [],
"contextType'": "MAIN"

3,
"routingObjectId": "<KIX_TICKET_ContactID>"
"componentId": "object-avatar-label",

"componentData": {
"property": "PriorityID"
1

"componentId": "object-avatar-label",
"componentData": {

"property": "StateID"
}

"componentId": "object-avatar-label",
"componentData": {
"property": "DynamicFields.DFSerialNumber"

3

"conditions": [
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91 {
92 "property": "DynamicFields.DFSerialNumber",
93 "operator": "NE",
94 "value": null
95 }
96 ]
97 1,
98 {
99 "componentId": "object-avatar-label",
100 "componentData": {
101 "property": "DynamicFields.CloseCode"
102 1,
103 "conditions": [
104 {
105 "property": "DynamicFields.CloseCode",
106 "operator": '"NE",
107 "value": null,
108 "useObjectService": false,
109 "useDisplayValue": false
110 }
111 ]
112 1,
113 {
114 "componentId": "object-avatar-label",
115 "componentData": {
116 "property": "DynamicFields.AnonymiseTicket"
117 1,
118 "conditions": [
119 {
120 "property": "DynamicFields.AnonymiseTicket",
121 "operator": '"NE",
122 "value": null,
123 "useObjectService": false,
124 "useDisplayValue": false
125 }
126 1
127 }
128 ]
129 ]
130 },
131 {
132 "title": "Translatable#Description",
133 "style": |ll|,
134 "separator": true,
135 "values": [
136 [
137 {
138 "componentId": "dynamic-field-value",
139 "detailViewWidthFactor": "4",
140 "componentData": {
141 "name": "WorkOrder"
142 1,
143 "conditions": [
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144 {

145 "property": "DynamicFields.WorkOrder",
146 "operator": "NE",

147 "value": null,

148 "useObjectService": false,
149 "useDisplayValue": false
150 }

151 1

152 }

153 ]

154 ]

155 },

156 {

157 "title": "Translatable#Assignees",

158 "style": |ll|,

159 "separator": true,

160 "values": [

161 [

162 {

163 "componentId": "object-avatar-label",
164 "componentData": {

165 "property": "QueueID"

166 }

167 }

168 1,

169 [

170 {

171 "componentId": "object-avatar-label",
172 "componentData": {

173 "property": "LockID"

174 }

175 }

176 1,

177

178 {

179 "componentId": "object-avatar-label",
180 "componentData": {

181 "property": "OwnerID"

182 1,

183 "conditions": [

184 {

185 "property": "OwnerID",
186 "operator": "NE",

187 "value": 1,

188 "useObjectService": false,
189 "useDisplayValue": false
190 }

191 1

192 }

193 1,

194 [

195 {

196 "componentId": "object-avatar-label",
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"componentData": {
"property": "ResponsibleID"

3
"conditions": [
{
"property": "ResponsibleID",
"operator": "NE",
"value": 1,
"useObjectService": false,
"useDisplayValue": false
}
]
}
]
]
3
{

"title": "Translatable#Checklists",
llsty'Lell : nn 5

"separator": true,

"values": [

[

"text": "Mobile Processing Checklist 010",
"textStyle": "font-weight:bold;margin-bottom:0.5rem",
"jcon": "kix-icon-ci",
"componentId": "dynamic-field-value",
"componentData": {
"name": "MobileProcessingChecklist010"
3,
"conditions": [
{
"property":
"DynamicFields.MobileProcessingChecklist010",
"operator": '"NE",
"value": null,
"useObjectService": false,
"useDisplayValue": false

"text": "Mobile Processing Checklist 020",
"textStyle": "font-weight:bold;margin-bottom:0.5rem",
"jcon": "kix-icon-ci",
"componentId": "dynamic-field-value",
"componentData": {

"name": "MobileProcessingChecklist020"
I
"conditions": [

{
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249 "property":
"DynamicFields.MobileProcessingChecklist020",

250 "operator": "NE",

251 "value": null,

252 "useObjectService": false,

253 "useDisplayValue": false

254 }

255 ]

256 }

257 1

258 ]

259 },

260 {

261 "title": "Translatable#References",

262 "style" AL ,

263 "separator": false,

264 "values": [

265 [

266 {

267 "text": "Translatable#Affected Assets",

268 "textStyle": "font-weight:bold;margin-bottom:0.5rem",

269 "jcon": "kix-icon-ci",

270 "componentId": "dynamic-field-value",

271 "componentData": {

272 "name": "AffectedAsset"

273 1,

274 "conditions": [

275 {

276 "property": "DynamicFields.AffectedAsset",

277 "operator": '"NE",

278 "value": null,

279 "useObjectService": false,

280 "useDisplayValue": false

281 }

282 ]

283 }

284 1,

285 [

286 {

287 "text": "Translatable#Affected Services",

288 "textStyle": "font-weight:bold;margin-bottom:0.5rem",

289 "jcon": "kix-icon-ci",

290 "componentId": "dynamic-field-value",

291 "componentData": {

292 "name": "AffectedServices"

293 },

294 "conditions": [

295 {

296 "property": "DynamicFields.AffectedServices",

297 "operator": '"NE",

298 "value": null,

299 "useObjectService": false,

300 "useDisplayValue": false
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301 }

302 ]

303 }

304 1,

305 [

306 {

307 "text": "Translatable#Merged into the Ticket",
308 "textStyle": "font-weight:bold;margin-bottom:0.5rem",
309 "jcon": "kix-icon-ticket",

310 "componentId": "dynamic-field-value",
311 "componentData": {

312 "name": "MergeToTicket"

313 1,

314 "conditions": [

315 {

316 "property": "DynamicFields.MergeToTicket",
317 "operator": '"NE",

318 "value": null,

319 "useObjectService": false,

320 "useDisplayValue": false

321 }

322 ]

323 }

324 ]

325 ]

326 1,

327 {

328 "title": " ",

329 "separator": true,

330 "values": [

331 [

332 {

333 "text": "Translatable#Related Tickets",
334 "textStyle": "font-weight:bold;margin-bottom:0.5rem",
335 "jcon": "kix-icon-ci",

336 "componentId": "dynamic-field-value",
337 "componentData": {

338 "name": "RelatedTickets"

339 },

340 "conditions": [

341 {

342 "property": "DynamicFields.RelatedTickets",
343 "operator": "NE",

344 "value": null,

345 "useObjectService": false,

346 "useDisplayValue": false

347 1

348 ]

349 }

350 ]

351 ]

352 1,

353 {
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354 "title": "Translatable#Scheduling",

355 "separator": false,

356 "values": [

357 [

358 {

359 "text": "Translatable#Accounted Time: {0}",
360 "textPlaceholder": [

361 "<KIX_TICKET_AccountedTime>"

362 1,

363 "jcon": "kix-icon-time",

364 "conditions": [

365 {

366 "property": "AccountedTime",

367 "operator": '"NE",

368 "value": null,

369 "useObjectService": false,

370 "useDisplayValue": false

371 1

372 ]

373 }

374 1,

375

376 {

377 "text": "Translatable#Pending until: {0} ({1})",
378 "textPlaceholder": [

379 "<KIX_TICKET_PendingTime>",

380 "<KIX_TICKET_UntilTime>"

381 1,

382 "jcon": "kix-icon-time-wait",

383 "conditions": [

384 {

385 "property": "StateType",

386 "operator": "CONTAINS",

387 "value": "pending",

388 "useObjectService": false,

389 "useDisplayValue": false

390 }

391 ]

392 }

393 1,

394 [

395 {

396 "text": "Translatable#Plan: {0} - {1}",
397 "textPlaceholder": [

398 "<KIX_TICKET_DynamicField_PlanBegin>",
399 "<KIX_TICKET_DynamicField_PlanEnd>"
400 1,

401 "jcon": "kix-icon-time-back",

402 "conditions": [

403 {

404 "property": "DynamicFields.PlanBegin",
405 "operator": '"NE",

406 "value": null,
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"useObjectService": false,
"useDisplayValue": false

}
]
}
]

]
3
{

lIt-‘I t'LelI: Illl,

llsty'Lell : mnn 5

"separator": false,
"values": [

[

"jcon": null,

"jconStyle": "",

"text": "Translatable#Created by {0} at {1}. Last

change by {2} at {3}",

"textPlaceholder": [
"<KIX_TICKET_CreateBy>",
"<KIX_TICKET_Created>",
"<KIX_TICKET_ChangeBy>",
"<KIX_TICKET_Changed>"

1,

"textStyle": "color:#5b5b5b;font-style:italic",

"linkSrc": null

]
3,
"minimized": false,
"minimizable": false,
"jcon": "kix-icon-ticket",
"contextDependent": false,
"contextObjectDependent": false,
"formDependent": false,
"formDependencyProperties": [],
"valid": true,
"application": "agent-portal"

Zoom view of Contact (Contact Information)

a b wNBRE

(X

"id": "contact-details-info-widget",

"name": "Contact Info Widget",

"type": "Widget",

"widgetId": "object-information-card-widget",
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6 "title": "Translatable#Contact Information",
7 "actions": [],
8 "subConfigurationDefinition": null,
9 "configuration": {
10 "jd": "1691394743446",
11 "name'": "1691394743446",
12 "type": null,
13 "valid": true,
14 "application": "agent-portal",
15 "avatar": [],
16 "rows": [
17 {
18 "values": [
19 [
20 {
21 "componentId": "dicon",
22 "componentData": {
23 "jcon": {
24 "propertyBindings": [],
25 "Links": [],
26 "LinkTypeName": null,
27 "ChangeBy": null,
28 "ChangeTime": null,
29 "CreateBy": null,
30 "CreateTime": null,
31 "ValidID": 1,
32 "Comment": null,
33 "DynamicFields": [],
34 "LinkCount": 0,
35 "displayValues": [],
36 "displayIcons": [],
37 "KIXObjectType'": "OBJECT_ICON",
38 "ObjectID": "<KIX_CONTACT_ID>",
39 "ObjectId": "<KIX_CONTACT_ID>",
40 "Object": "Contact",
41 "ContentType": null,
42 "Content": null,
43 "fallbackIcon": "kix-icon-man-bubble"
44 3,
45 "style": "width: 5rem;height:5rem;font-size:5rem;"
46 }
47 1
48 1,
49 [
50 {
51 "componentId": "object-avatar-label",
52 "componentData": {
53 "property": "Title"
54 }
55 }
56 1,
57
58 {
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1,
{
}
1,
[
{
1,
{
}
]
1,
"title":
"style":
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"componentId": "object-avatar-label",
"componentData": {

"property": "Firstname"
}
"componentId": "object-avatar-label",
"componentData": {

"property": "Lastname"
}
"componentId": "object-avatar-label",
"componentData": {

"property": "PrimaryOrganisationID"
}
"componentId": "object-avatar-label",

"componentData": {
"property": "ValidID"
1

null,

nn
)

"separator": true

"values":

[

[
"componentId": "object-avatar-label",
"componentData": {
"property": "UserLogin"
}
"componentId": "object-avatar-label",

"componentData": {
"property": "USER_ACCESS"

"componentId": "object-avatar-label",
"componentData": {
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112 "property": "UserLanguage"
113 }

114 1

115 ]

116 1,

117 "title": null,

118 "style": null,

119 "separator": true

120 1,

121 {

122 "values": [

123 [

124 {

125 "componentId": "object-avatar-label",
126 "componentData": {

127 "property": "Phone"

128 }

129 }

130 1,

131 [

132 {

133 "componentId": "object-avatar-label",
134 "componentData": {

135 "property": "Mobile"

136 }

137 }

138 1,

139

140 {

141 "componentId": "object-avatar-label",
142 "componentData": {

143 "property": "Fax"

144 }

145 }

146 1,

147 L

148 {

149 "componentId": "object-avatar-label",
150 "componentData": {

151 "property": "Email"

152 1,

153 "conditions": null,

154 "jcon": null,

155 "jconStyle": "",

156 |ltextll: |lll,

157 "textPlaceholder": null,

158 "textStyle": "",

159 "detailViewWidthFactor": "2"
160 }

161 1,

162 [

163 {

164 "componentId": "object-avatar-label",
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"componentData": {
"property": "Emaill"

3,
"conditions": [
{
"property": "Emaill",
"operator": "NE",
"Value": "H’
"useObjectService": false,
"useDisplayValue": false
}
1,
"jcon": null,
"jconStyle": "",
Htext": H",
"textPlaceholder": null,
"textStyle": "",

"detailViewWidthFactor": "2"

"componentId": "object-avatar-label",
"componentData": {
"property": "Email2"

3,
"conditions": [
{
"property": "Email2",
"operator": '"NE",
"Value": "H’
"useObjectService": false,
"useDisplayValue": false
}
1,
"jcon": null,
"jconStyle": "",
Htext": H",
"textPlaceholder": null,
"textStyle": "",

"detailViewWidthFactor™: "2"

"componentId": "object-avatar-label",
"componentData": {
"property": "Email3"
1,
"conditions": [
{
"property": "Email3",
"operator": '"NE",
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"Value": "H’
"useObjectService": false,
"useDisplayValue": false

}
1,
"jcon": null,
"jconStyle": "",
Htext": H"’
"textPlaceholder": null,
"textStyle": "",

"detailViewWidthFactor": "2"

"componentId": "object-avatar-label",
"componentData": {
"property": "Email4"

3,
"conditions": [
{
"property": "Email4",
"operator": '"NE",
"Value": "H’
"useObjectService": false,
"useDisplayValue": false
}
1,
"jcon": null,
"jconStyle": "",
Htext": H",
"textPlaceholder": null,
"textStyle": "",

"detailViewWidthFactor™: "2"

"componentId": "object-avatar-label",
"componentData": {
"property": "Email5"

3,
"conditions": [
{
"property": "Email5",
"operator": '"NE",
"Value": "H’
"useObjectService": false,
"useDisplayValue": false
}
1,
"jcon": null,
"jconStyle": "",
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"text": "",
"textPlaceholder": null,
"textStyle": "M,

"detailViewWidthFactor": "2"

]
1,
"title": null,
"style": null,
"separator": true

3,
{
"title": "Info",
"style": "",
"separator": true,
"values": [
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "DynamicFields.MyDynamicField"
}
}
]
]
3,
{
"values": [
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "Street"
}
}
1,
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "Zip"
}
}
1,
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "City"
}
}
1,
[
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324 {

325 "componentId": "object-avatar-label",
326 "componentData": {

327 "property": "Country"

328 }

329 }

330 ]

331 1,

332 "title": null,

333 "style": null,

334 "separator": true

335 },

336 {

337 "values": [

338 [

339 {

340 "componentId": "object-avatar-label",
341 "componentData": {

342 "property": "CreateTime"

343 }

344 }

345 1,

346 [

347 {

348 "componentId": "object-avatar-label",
349 "componentData": {

350 "property": "CreateBy"

351 }

352 }

353 1,

354

355 {

356 "componentId": "object-avatar-label",
357 "componentData": {

358 "property": "ChangeTime"

359 }

360 }

361 1,

362 [

363 {

364 "componentId": "object-avatar-label",
365 "componentData": {

366 "property": "ChangeBy"

367 }

368 }

369 1,

370 [

371 {

372 "componentId": "object-avatar-label",
373 "componentData": {

374 "property": "DynamicFields.Source"
375 1,

376 "conditions": [
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377 {

378 "property": "DynamicFields.Source",
379 "operator": "NE",

380 "value": null,

381 "useObjectService": false,
382 "useDisplayValue": false
383 }

384 ]

385 }

386 ]

387 1,

388 "title": null,

389 "style": null,

390 "separator": true

391 1,

392 {

393 "values": [

394 [

395 {

396 "componentId": "object-avatar-label",
397 "componentData": {

398 "property": "Comment"

399 }

400 }

401 ]

402 ]

403 }

404 ]

405 },

406 "minimized": false,

407 "minimizable": true,

408 "jcon": null,

409 "contextDependent": false,

410 "contextObjectDependent": false,

411 "formDependent": false,

412 "formDependencyProperties": [],

413 "valid": true,

414 "application": "agent-portal"

415 }

Zoom view of organisation (Organisation Information)

"id": "organisation-details-info-widget",

"name": "Organisation Info Widget",

"type" : "Widget" ,

"widgetId": "object-information-card-widget",
"title": "Translatable#0Organisation Information",
"actions": [],

"subConfigurationDefinition": null,
"configuration": {

OWoOo~NoOubhWNE
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10 "d": "1692622104699",

11 "name'": "1692622104699",

12 "type": null,

13 "valid": true,

14 "application": "agent-portal",

15 "avatar": [],

16 "rows": [

17 {

18 "style" AL ,

19 "separator": true,

20 "values": [

21 [

22 {

23 "componentId": "dicon",

24 "componentData": {

25 "jcon": {

26 "propertyBindings": [],

27 "Links": [],

28 "LinkTypeName": null,

29 "ChangeBy": null,

30 "ChangeTime": null,

31 "CreateBy": null,

32 "CreateTime": null,

33 "ValidID": 1,

34 "Comment": null,

35 "DynamicFields": [],

36 "LinkCount": 0,

37 "displayValues": [],

38 "displayIcons": [],

39 "KIXObjectType'": "OBJECT_ICON",
40 "ObjectID": "<KIX_ORGANISATION_ID>",
41 "ObjectId": "<KIX_ORGANISATION_ID>",
42 "Object": "Organisation",

43 "ContentType": null,

44 "Content": null,

45 "fallbackIcon": "kix-icon-man-house"
46 1,

47 "style": "width: 5rem;height:5rem;font-size:5rem;"
48 }

49 }

50 1,

51 [

52 {

53 "componentId": "object-avatar-label",
54 "componentData": {

55 "property": "Number"

56 }

57 }

58 1,

59 [

60 {

61 "componentId": "object-avatar-label",
62 "componentData": {
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63 "property": "Name"
64 }
65 }
66 1,
67 [
68 {
69 "componentId": "object-avatar-label",
70 "componentData": {
71 "property": "DynamicFields.Type"
72 }
73 }
T4 1,
75
76 {
7 "componentId": "object-avatar-label",
78 "componentData": {
79 "property": "Url"
80 }
81 },
82 {
83 "componentId": "object-avatar-label",
84 "componentData": {
85 "property": "ValidID"
86 }
87 }
88 ]
89 ]
90 3
91 {
92 "style" o onn ,
93 "separator": true,
94 "values": [
95 [
96 {
97 "componentId": "object-avatar-label",
98 "componentData": {
99 "property": "Street"
100 }
101 }
102 1,
103 [
104 {
105 "componentId": "object-avatar-label",
106 "componentData": {
107 "property": "Zip"
108 }
109 }
110 1,
111
112 {
113 "componentId": "object-avatar-label",
114 "componentData": {
115 "property": "City"
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}
}
1,
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "Country"
}
}
]
]
"Style": H",

"title": "Info",
"separator": true,
"values": [

[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "DynamicFields.MyDynamicField"
}
}
]
]
"style": H",

"separator": true,
"values": [

[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "CreateTime"
}
}
1,
[
{
"componentId": "object-avatar-label",
"componentData": {
"property": "CreateBy"
}
}
1,
[
{
"componentId": "object-avatar-label",

"componentData": {
"property": "ChangeTime"
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169 }

170 }

171 1,

172

173 {

174 "componentId": "object-avatar-label",
175 "componentData": {

176 "property": "ChangeBy"
177 }

178 }

179 1

180 ]

181 1,

182 {

183 "style": un,

184 "separator": false,

185 "values": [

186 [

187 {

188 "componentId": "object-avatar-label",
189 "componentData": {

190 "property": "Comment"
191 }

192 }

193 ]

194 ]

195 }

196 ]

197 1,

198 "minimized": false,

199 "minimizable": true,

200 "jcon": null,

201 "contextDependent": false,

202 "contextObjectDependent": false,

203 "formDependent": false,

204 "formDependencyProperties": [],

205 "valid": true,

206 "application": "agent-portal"

207 }

Zoom view of FAQ (FAQ Information)

"id": "fag-article-info-widget",

"name": "FAQ Article Info",

"type”: "Widget”,

"widgetId": "object-information-card-widget",
"title": "Translatable#FAQ Information",
"actions": [],

"subConfigurationDefinition": null,
"configuration": {

OWoOo~NoOubhWNE
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10 "d": "1692622173540",

11 "name'": "1692622173540",

12 "type": null,

13 "valid": true,

14 "application": "agent-portal",

15 "avatar": [],

16 "rows": [

17 {

18 "style": Illl,

19 "separator": true,

20 "values": [

21 [

22 {

23 "componentId": "object-avatar-label",
24 "componentData": {

25 "property": "CategoryID"

26 }

27 }

28 1,

29 [

30 {

31 "componentId": "object-avatar-label",
32 "componentData": {

33 "property": "CustomerVisible"

34 }

35 b

36 {

37 "componentId": "object-avatar-label",
38 "componentData": {

39 "property": "DynamicFields.MyDynamicField"
40 3,

41 "conditions": [

42 {

43 "property": "DynamicFields.MyDynamicField",
44 "operator": '"NE",

45 "value": null

46 }

47 ]

48 }

49 1,

50 [

51 {

52 "componentId": "object-avatar-label",
53 "componentData": {

54 "property": "ValidID"

55 }

56 }

57 1

58 ]

59 3,

60 {

61 "style": Illl,

62 "separator": true,
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[

"title":
"style":
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L

"componentId": "object-avatar-label",
"componentData": {

"property": "Created"
}

"componentId": "object-avatar-label",
"componentData": {

"property": "CreatedBy"
}

"componentId": "object-avatar-label",
"componentData": {

"property": "Changed"
1

"componentId": "object-avatar-label",
"componentData": {

"property": "ChangedBy"
}

"Translatable#References",
nn
)

"separator": false,

"values":

[

L

"text": "Translatable#Related Assets",
"textStyle": "font-weight:bold;margin-bottom:0.5rem",
"detailViewwidthFactor": "1",
"jcon": "kix-icon-ci",
"componentId": "dynamic-field-value",
"componentData": {
"name": "RelatedAssets"
3,
"conditions": [
{

"property": "DynamicFields.RelatedAssets",
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116 "operator": "NE",
117 "value": null,
118 "useObjectService": false,
119 "useDisplayValue": false
120 }

121 ]

122 }

123 ]

124 ]

125 }

126 ]

127 1,

128 "minimized": false,

129 "minimizable": true,

130 "jcon": null,

131 "contextDependent": false,

132 "contextObjectDependent": false,

133 "formDependent": false,

134 "formDependencyProperties": [],

135 "valid": true,

136 "application": "agent-portal"

137 }
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13.1.3.3 Configuring an object-information-card-widget
Configuration key: ticket-details-contact-card-widget

The right sidebar in the ticket details contains the widget "Contact information". You can reconfigure its
content individually. The following example shows changes to the configuration of this widget of the type
object-information-card-widget. You can use this example as a guide if you want to configure other widgets
of this type, for example, the ticket information in the ticket zoom view.

The basics of this widget type can be found in the chapter: The object-information-card-widget. (see page 355)
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Fig.: The configured widget "Contact information" in the sidebar of the ticket details

The default configuration of the "Contact Information” widget generates the following content:

+ Avatar

+ First name, last name

+ Primary organisation with icon

+ Phone number (as URL) with icon

+ Email address with icon

+ Address as text with link to online map service

+ Link to open tickets of the contact and the organisation

Added in the example:

+ external linking to a web CRM

+ Display of tickets older than 5 hours
+ internal link to open the contact

+ internal link to create a new asset

Not included in the example:
+ Link to open tickets of the contact and the organisation.
To configure the widget "Contact Information" in the ticket details, proceed as follows:

1. Inexplorer, navigate to System > SysConfig.
2. Search for key "ticket-details-contact-card-widget". This key defines the structure of the widget
"Contact Information" for the ticket zoom view.
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3. Open key and copy source code from "Value" field to JSON editor (e.g. https://
www.jsonformatter.io).To make it easier to edit the code, the right-hand column in the editor contains
the source code in maximized format.

4. Edit source code as required (see example configuration below).

5. Minify edited source code to remove superfluous blanks and line breaks and copy source code to
clipboard.

6. Paste source code from clipboard back into "Value" field and click "Save" to apply changes.

7. Click "Reload Frontend Configurations” to update KIX user interface.

Edit the source code

The source code in the configuration key contains a block " configuration":{...}. Inside this blockis
the configuration of the widget content.

The widget content defines the avatar ( "avatar":{...} ) and the content to be displayed row by row
"rows":[{...}] ).

A row consists of the defined distance to the previous element (("margin": true | false) and the values to be
displayed in the row ("values": [{...}]). By specifying further attributes, the display of the value can be
influenced. An overview of possible attributes can be found in the basics of sidebar configuration.

Example configuration:
In the example configuration below, the contact address has been linked and various items of additional

information have been entered and linked:

Figure of "Contact Information” Image Description and line number in source
Widget Number code (see below)

1 Avatar (ines: 1010 17)

John Doe

2 2
\'/: My Organisation
8% | wsanzrsrs 2 Last name and first name of contact (lines
3
= john.doe@myexample.org 19 '[0 28)
@ 123 Msinstrect Organization of the contact (lines: 29 to 45)
M1 1 AN Manchester 4
i 3 Linked telephone number of contact (lines
282 Show InformationinCRM | 5 46 to 55)
# Ticket is older than 5h. . .
o W Email address of contact (lines 56 to 65)
282 Go to Contact 7
B Create a new Asset 8

4 Opens the address for searching in
an online card service.
(lines 66 to 75 and 76 to 85 as well as 86 to
95)

Issued on: 26.02.2024 Page 474


https://www.jsonformatter.io

Figure of "Contact Information”
Widget

Image
Number

without

KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

Description and line number in source
code (see below)

Opens an external website in a new
browser tab.

Is displayed if there is a value in the
comment for a contact.

(lines 96 to 114).

Is displayed if the ticket is older than
5 hours.
(lines 115to 134)

Internal link to details page for contact.
(lines 135 to 154)

Internal link; opens a dialog for creating a
new asset.
(lines 155 to 176)

Widget behavior and icon in widget title
(lines: 177 to 184)
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"jd": "ticket-details-contact-card-widget",

"name": "Contact Info Widget",
"type": "Widget",

"widgetId": "object-information-card-widget",

"title": "Translatable#Contact Information",

"actions": [],
"subConfigurationDefinition": null,
"configuration": {

"avatar": {

"displayValues": [],
"KIXObjectType'": "OBJECT_ICON",
"ObjectId": "<KIX_CONTACT_ID>",
"Object": "Contact",
"ContentType": null,

"Content": null
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"text": "<KIX_CONTACT_Firstname> <KIX_CONTACT_Lastname>",

1,
"rows": [
{
"margin": false,
"values": [
{
"jcon": null,
"linkSrc": null
}
]
3,
{
"margin": false,
"values": [
{
"jcon": {
"displayValues": [],
"KIXObjectType": "OBJECT_ICON",
"ObjectId": "<KIX_ORG_ID>",
"Object": "Organisation",
"ContentType": null,
"Content": null
1,
"text": "<KIX_ORG_Name>",
"linkSrc": null
}
]
3,
{

"margin": true,
"values": [
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{
"jcon": "fas fa-phone-volume",
"text": "<KIX_CONTACT_Phone>",
"linkSrc": "tel:<KIX_CONTACT_Phone>"
}
]
3
{
"margin": false,
"values": [
{
"jcon": "kix-icon-mail",
"text": "<KIX_CONTACT_Email>",
"linkSrc": null
}
]
3
{

"margin": true,
"values": [
{
"jcon": "kix-icon-compass",
"text": "<KIX_CONTACT_Street>",
"1inkSrc": "https://www.google.de/maps/place/
<KIX_CONTACT_Street>+<KIX_CONTACT_Zip>+<KIX_CONTACT_City>"
}
]
3,
{
"margin": false,
"values": [
{
"jcon": null,
"text": "<KIX_CONTACT_Zip> <KIX_CONTACT_City>",
"1inkSrc": "https://www.google.de/maps/place/
<KIX_CONTACT_Street>+<KIX_CONTACT_Zip>+<KIX_CONTACT_City>"
}
]
3,
{
"margin": false,
"values": [
{
"jcon": null,
"text": "<KIX_CONTACT_Country>",
"1inkSrc": "https://www.google.de/maps/place/
<KIX_CONTACT_Street>+<KIX_CONTACT_Zip>+<KIX_CONTACT_City>"
}
]
3,
{
"margin": true,
"values": [
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99 {
100 "icon": "kix-icon-men",
101 "text": "Show Information in CRM",
102 "linkSrc": "https://your.crm.example?

param@=<KIX_CONTACT_Firstname>;paraml=<KIX_CONTACT_Laststname>;param2=<KIX
_CONTACT_Email>",

103 "conditions": [

104 {

105 "property": "<KIX_CONTACT_Comment>",
106 "operator": "NE",

107 "value": "",

108 "useObjectService": null,
109 "useDisplayValue": null
110 }

111 ]

112 }

113 ]

114 1,

115 {

116 "margin": true,

117 "values": [

118 {

119 "jcon": "kix-icon-fire'",

120 "text": "Ticket is older than 5h.",
121 "linkSrc": null,

122 "textStyle": "color:#ffoo00",
123 "conditions": [

124 {

125 "property": "Age",

126 "operator": "GT",

127 "value": 300,

128 "useObjectService": false,
129 "useDisplayValue": false
130 }

131 ]

132 }

133 ]

134 1,

135 {

136 "margin": true,

137 "values": [

138 {

139 "jcon": "kix-icon-men",

140 "text": "Go to Contact",

141 "linkSrc": null,

142 "routingConfiguration": {

143 "contextId": "contact-details",
144 "objectType": "Contact",

145 "contextMode": "DETAILS",
146 "objectIdProperty": "ID",
147 "history": false,

148 "resetContext": true,

149 "contextType": "MAIN"
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150 1,

151 "routingObjectId": "<KIX_CONTACT_ID>"
152 }

153 ]

154 1,

155 {

156 "margin": true,

157 "values": [

158 {

159 "jcon": "kix-icon-ci",

160 "text": "Create a new Asset",
161 "linkSrc": null,

162 "routingConfiguration": {
163 "contextId": "new-config-item-dialog-context",
164 "objectType": "Configltem",
165 "contextMode": "CREATE",
166 "objectIdProperty": null,
167 "history": false,

168 "resetContext": false,
169 "contextType": "DIALOG",
170 "resetForm": false

171 1

172 3

173 ]

174 }

175 ]

176 1,

177 "minimized": false,

178 "minimizable": true,

179 "jcon": "kix-icon-man-house",

180 "contextDependent": false,

181 "contextObjectDependent": false,

182 "formDependent": false,

183 "formDependencyProperties": []

184 }
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13.1.3.4 Configuration of table widget "Suggested FAQ"

Configuration Dialog "New ticket-new-dialog- Contents on this page:
key: ticket" suggested-fag-widget
» Search basics (see
Dialog "Edit ticket-edit-dialog- page 480)
ticket" suggested-fag-widget * Combined or
simple search (see
Ticket details ticket-details-suggested- page 481)
. + Configure the
fag-widget

search for the

5 ted FAQ affected assets (see
LgEES

Title X + Configure search
for keywords (see

General information on how to work with KIX ... page 483)
Wie suche ich in KIX 187

How to search in KIX 187

CICINCIN IS
- ]

Ausgewidhlte Ticketfunktionen

The widget "Suggested FAQ" displays relevant FAQ articles for a ticket. It is an initial component of the
sidebars in the ticket details and in the dialogues "New ticket" and "Edit ticket". Agents can view the FAQ
articles displayed in the widget in a short preview and transfer them to an article with one click.

The widget "Suggested FAQ" is a table widget. The configuration differs only slightly in the attribute values of

formDependent, formDependencyProperties, contextObjectDependent in the individual
contexts (ticket details, dialogs "New ticket" and "Edit ticket"). An overview of the widget attributes used in
the configuration as well as information on the basic configuration of a table widget can be found in the
chapter: The table widget (see page 393).

In the following sections you will find specific configuration options for the widget "Suggested FAQ".

Search basics

The FAQ articles displayed in the table widget are based on a search for the keywords entered in the ticket
subject/title and/or the affected assets selected in the ticket. With each change to the ticket subject/title or
in the "Affected assets" field, the FAQ will be searched and the table content of the widget will be updated
based on the search result.

To search for keywords, a ticket subject/title must be specified in the ticket. A full text search is performed in
all FAQ information (keywords, title, number, symptom, cause, solution, etc.). Irrelevant words are filtered
out.

Issued on: 26.02.2024 Page 480



KIX 18 Admin Manual - EN - KIX Start
System settings
Configuration of User Interface (GUI)

@ Tip

You can edit the list of irrelevant words in the SysConfig key "Ticket::Searchindex::StopWords*"
separately for each language created in KIX.

To search for the affected assets, at least one affected asset must be selected in the ticket and assets must
be stored at FAQ entries.

4 vrmax | K9 rmax

9 FAQ
*Title: @  Product specification
*Category: @ {3} Product spezificatons
Enable for Self Service Portal: @

n * Language: @ English

Tags: @  Printers HP

Related Assets: B A#174000014 - chnb016 B A#174000015 - chnb017 B A#174000016 - chnb018
Attachments: | & | Select file
Symptom: B I USHXx x|TI, 12 as (99| &2 & = = | [ Source

Fig .: Store assets in FAQ articles

Combined or simple search

You can control the search behaviour and thus the result of the search by specifying how the search is
performed and how the results are combined for display in the table. This is done in the respective
SysConfig keys (see table above) by specifying " intersection : true|false" inthe section

"Configuration{...}".

+ true =intersection
+ Search for keywords in the ticket subject / title AND for the assets concerned. Both must be
specified, otherwise the table is empty.
+ Only FAQ articles are displayed that match at least one of the assets concerned and one of the
keywords specified in the subject / title.
+ Important: Make sure that the search returns at least 1 result (1 FAQ) when you configure the
search. Otherwise no intersection can be formed and displayed.
- false (default) = combine = all results (without duplications)
+ Search for keywords in the ticket subject / title OR for the assets concerned. One of the two
must be specified.
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+ The FAQ articles are displayed that are linked to at least one of the assets concerned or that
contain one of the keywords specified in the ticket subject / title.

T T Ee

"resetFilteronReload”: true,

"configuration™: {
"id": "ticket-details-suggested-fag-table-config"”,
"name": "Suggested FAQ",
"type": "Table",
"objectType": "FAQArticle",
"loadingOptions”: {3},
"displayLimit™: 1@,
"tableColumns™: [CJ],
"tableColumnConfigurations™: null,
"enableSelection”: false,
"toggle": false,
"toggleoptions": null,
"sortOorder"”: null,
"headerHeight™: 1.75,
"rowHeight": 1.75,
"emptyResultHint": "Translatable#e data sets found.”,
"routingConfiguration”: null,
"fixedFirstColumn”: null,
"additinnalTahl nnhj aerteHandler™: [[:]] ,
"intersection”: false,
"searcnid™y null,
"valid": true,
"application": "agent-portal”

3
Maen ] 3 A deymage

Fig .: Control of the display in the widget with the "intersection" attribute

Configure the search for the affected assets

In the code block " filter":[{Filter 1}, {Filter 2},

. ] "itis defined which asset information

is taken into account in the search. In the standard configuration, all valid FAQs to which the asset selected

in the ticket is assigned as a related asset are loaded into the table.

You can adjust the filter so that different or additional asset information is included in the search. You can
enter FAQ attributes and your own dynamic fields. Note that these are not filters that further restrict the

result, but rather necessary search criteria.

If no filters are specified, all FAQs are displayed.

Make sure with your configuration that at least 1 FAQ is returned if you have set "intersection":true.

Default configuration of asset filter

"loadingOptions":{
"filter": [
{
"property": "DynamicFields.RelatedAssets",
(here: RelatedAssets)
"operator": "IN",
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"type'": "NUMERIC",
"filterType": "AND",

"value": "<KIX_TICKET_DynamicField_AffectedAsset_ObjectValue>" //
Placeholder; contains the value of the dynamic field
}s
{
"property": "ValidID",
"operator": "EQ",
"type": "NUMERIC",
"filterType": "AND",
"value": 1
}
1,
"sortOrder": null,
"limit": 100, //Limitation of the search result
"includes": [
"Votes"
]
}s

Configure search for keywords

You can adjust the configuration of the object handlers to control the search for the keywords specified in
the ticket subject / title.

The code section additionalTableObjectsHandler:[...] contains a list of the handler
configurations that determine further objects for the table. The determination depends on the handler. The
following attributes are possible:

Attribute Description

id Unique identifier for internal processing.
name Name (description)

handlerld Specifies which handler should be used.

Currently only "SuggestedFAQHandler"

handlerConf  specific options of the handler. The SuggesteFAQHandler currently supports:

iguration + minLenght: Indicates how long the words in the title / subject must be at least

(separated by spaces) so that they can be used for the search (default: 3).
« onlyValid: Indicates whether only valid objects are determined (default: false).
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Properties

determine the properties of the words.

List of object properties (attributes) which are taken into account for the search.

The information is relevant for the handler. The SuggestedFAQHandler uses it to
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The list also determines whether this configuration makes it necessary to reload the table

in the event of changes in the dialog / form.

It is used to avoid unnecessary searches for the handlers involved. If this list is not

available, the table is reloaded with each change.

Default configuration of object handler

"additionalTableObjectsHandler": [

{
"id": "ticket-new-suggested-fag-handler-config",
"name": "FAQs by ticket title or subject",
"handlerId": "SuggestedFAQHandler",
"handlerConfiguration": {
"minLength": 3,
"onlyValid": true
1,
"dependencyProperties": [
"Title",
"Subject"
1,
"type": "AdditionalTableObjectsHandler"
}
1,
@ Info

the affected assets (only useful if "intersection":false).
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13.1.3.5 Adding a widget to the dashboard

You can add custom widgets to the home dashboard. By personalizing the dashboard, agents can define
which widgets should be displayed in their personal dashboard.

n Search Templates Available Dashboard Widgets

+| Add widazt +| 2dd Widpet

T custom Ticket List

Custorn Tiekat Lict

Overview Ticket Priorities |8 Advanced x Owerview Ticket States [ Aadvanced | =% New Tickets recent 7 days) |8,

T My Opan Tickets N Advanced x

Table Widget

Table Configuration

Option Value

Fig .: Selection of the (table) widgets to be displayed in the home dashboard

How to integrate another widget into the home dashboard:

1. Navigate to the menu System> SysConfig open the key "home"

2. For better editing, copy the content of the "Value" field into a JSON editor (e.g. https://
www.jsonformatter.io)

3. Paste one of the following code blocks (without comments) into the editor. Place it, for example,
between 2 existing widgets. The insertion position defines where in the dashboard the widget is
displayed by default. The position can be changed by the agent in the course of personalizing the
dashboard.

4. Adapt the examples to your needs by for example

1. change the ID and name of the Object-information-card-widget according to the widget to be
displayed
2. adapt the ID, name and parameters of the table configuration according to your needs.

5. Minimize the source code and copy it back into the "Value" field of the configuration key and save
your changes.

6. Inthe configuration key overview, click on "Reload frontend configuration”.

The widget is now included in the dashboard. Agents may need to refresh their browser display.
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Tickets by Priorities ¥ Tickets by States X MNew Tickets {recent 7 days)
0 40
& \ 30
: 20
k2 | 10
o L - - - -
7 v i & i
0 il e iy
: - - & e & =
Sverylow  Alow  3noomal  2high 1 very high
T Custom Ticket List (45) | T i L)
[l prio Ticket# & Title state Queue Respansible Cumer Organisation =
O [ ] FOPIOG27ITO00014  [TO-T-001] Testing never Artikel und E-M... @ open o [TOTEAM-D.. ot assigned nat assigned |[TD-CRGAMISATION-D..
O [ | 2021092717000023  [TD-1-002] Wasserdurchlaufzablar meld... & open - [TO-TEAM-O...  not assigned not assigned [TD-ORGAMNISATION-...
) 2020092747000032  [TD-T-004] Tickst mit vielen Anhangen - open ' [TO-TEAM-0..  not assigned not assignad [TD-ORGANISATION-0L. w
O m i 2021092717000087  [TDT-008] Ungelesens Artikel B new &  [TDTEAMO..  not assigned not assigned [TD-ORGANISATION-..
0O m 2021092717000094  [TD-T-009] Drucker druckt nicht 8 new o [TO-TEAM-O..  Agent [TD[Tich Agent [TO|Tic |To-0 ON-0L. ¥
O B 2021092717000103  [TD-T-010] AAA #++ Band 3 steht still & opEn -] [TO-TEAM-0..  Agent [TD|TicketReader Agent [TD|TicketAgent  [TD-ORGAMISATION-OL. »
< >
T My Open Tickets (10} | X 8= aulncton B
I Prio Ticket# Title State Queue Responsible Cwmer ‘Organisation
0 - SO0 TN A IToe T ] Toeting ron Arbilol sornd Cokd i oo 3 TN TEARAD ot ipngrl ool g kin®a’ ([ I=0] =

Fig.: A table widget integrated into the dashboard

Example code block for inserting an object card widget

"instanceId": "name-of-info-widget",
"configurationId": "name-of-info-widget",
"configuration": null,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value": 2
}
1,
"size": "small"

I

Sample code block for inserting a table widgets

{ //Create an instance of your own table widget
"instanceId": "home-dashboard-custom-ticket-list",
"configurationId": null,

"configuration": {
"id": "home-dashboard-custom-ticket-list",
"name": "Custom Ticket List",
"type": "Widget",
"widgetId": "table-widget",
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"title": "Custom Ticket List",
"actions": [
"bulk-action",
"csv-export-action"
1,
"subConfigurationDefinition": null,
"configuration": {
"jd": "home-dashboard-ticket-custom-ticket-table-widget",
"name": "Custom Tickets Table Widget",
"type'": "TableWidget",
"objectType": "Ticket",

"sort": [
"TicketNumber",
”Up"
1,
"subConfigurationDefinition": null,
//tableConfiguration
"tableConfiguration": {
"id": "home-dashboard-ticket-table-new",
"name": "New Tickets Table",

"type" . "Table" s

"objectType": "Ticket",

//Definition of the content to be loaded

"loadingOptions": {

"filter": [
{

"property": "StateType",
"operator": "EQ",
"type”: HString”’
"filterType": "OR",
"value": "Open"

1,

"Timit": 30,

"includes": [
"Watchers",
"DynamicFields"

3
"displayLimit": 10,
//Definition of the table columns
"tableColumns": [
{
"id": null,
"name": null,
"type": null,
"property": "PriorityID",
"showText": false,
"showIcon": true,
"showColumnTitle": true,
"showColumnIcon": false,
"size": 65,
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"sortable": true,

"filterable": true,
"hasListFilter": true,

"dataType": "STRING",

"resizable": true,

"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "TicketNumber",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 135,

"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "Title",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 463,

"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false
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"id": null,

"name": null,

"type": null,

"property": "QueueID",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 175,

"sortable": true,
"filterable": true,
"hasListFilter": true,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "DynamicFields.AffectedAsset",
"showText": true,

"showIcon": false,

"showColumnTitle": true,
"showColumnIcon": false,

"size": 200,

"sortable": true,

"filterable": true,

"hasListFilter": true,

"dataType": "STRING",

"resizable": true,

"componentId": "label-list-cell-content",
"defaultText": null,

"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

1,
"tableColumnConfigurations": null,
"enableSelection": true,
"toggle": true,
"toggleOptions": {
"componentId": "ticket-article-details",
"inputPropertyName": "article",
"actions": [],
"toggleFirst": true,
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"data": {},
"toggleAll": false
}s
"headerHeight": 2.25,
"rowHeight": 1.75,
"emptyResultHint": "Translatable#No tickets available.",
"fixedFirstColumn": false
1,
"headerComponents": null,
"showFilter": true,
"shortTable": false,
"predefinedTableFilters": [],
"cache": false,
"resetFilterOnReload": true
}s
"minimized": false,
"minimizable": true,
"jcon": "kix-icon-ticket",
"contextDependent": false

1,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value": 2
}
1,
"sijze": "large"

Complete code example: Home dashboard with additional table widget "home-dashboard-custom-
ticket-list"

{
"id": "home",
"name": "home",
"type'": "Context",
"contextId": "home",
"sidebars": [
{
"instanceld": "home-dashboard-notes-widget",
"configurationId": "home-dashboard-notes-widget",
"permissions": [],
"size": "large"
}
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1,

"explorer": [],
"lanes": [],
"content": [

{
"instanceld": "home-dashboard-ticket-chart-widget-priorities",
"configurationId": "home-dashboard-ticket-chart-widget-priorities",
"configuration": null,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value'": 2
}
1,
"sjze'": "small"
b
{
"instanceId": "home-dashboard-ticket-chart-widget-states",
"configurationId": "home-dashboard-ticket-chart-widget-states",
"configuration": null,
"permissions'": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value'": 2
}
1,
"sjze'": "small"
b
{
"instanceld": "home-dashboard-ticket-chart-widget-new",
"configurationId": "home-dashboard-ticket-chart-widget-new",
"configuration": null,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value'": 2
}
1,
"sjze'": "small"
I
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{ //eigenes Tabellenwidget
"instanceld": "home-dashboard-custom-ticket-list",
"configurationId": null,
"configuration": {
"id": "home-dashboard-custom-ticket-list",
"name": "Custom Ticket List",
”type": ”Widget",
"widgetId": "table-widget",
"title": "Custom Ticket List",
"actions": [
"bulk-action",
"csv-export-action"
1,
"subConfigurationDefinition": null,
"configuration": {
"jd": "home-dashboard-ticket-custom-ticket-table-widget",
"name": "Custom Tickets Table Widget",
"type'": "TableWidget",
"objectType": "Ticket",

"sort": [
"TicketNumber",
llUpll

1,

"subConfigurationDefinition": null,
"tableConfiguration": {
"id": "home-dashboard-ticket-table-new",
"name": "New Tickets Table",
”type": ”Table”,
"objectType": "Ticket",
"loadingOptions": {
"filter": [
{
"property": "StateType",
"operator": "EQ",
"type'": "String",
"filterType": "OR",
"value": "Open"

1,

"Timit": 30,

"includes": [
"Watchers",
"DynamicFields"

3
"displayLimit": 10,
"tableColumns": [
{
"id": null,
"name": null,
"type": null,
"property": "PriorityID",
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"showText": false,
"showIcon": true,
"showColumnTitle": true,
"showColumnIcon": false,
"size": 65,

"sortable": true,
"filterable": true,
"hasListFilter": true,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "TicketNumber",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 135,

"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,
"property": "Title",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 463,
"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
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"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "QueuelID",
"showText": true,
"showIcon": false,
"showColumnTitle": true,
"showColumnIcon": true,
"size": 175,

"sortable": true,
"filterable": true,
"hasListFilter": true,
"dataType": "STRING",
"resizable": true,
"componentId": null,
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

"id": null,

"name": null,

"type": null,

"property": "DynamicFields.AffectedAsset",
"showText": true,

"showIcon": false,

"showColumnTitle": true,
"showColumnIcon": false,

"size": 200,

"sortable": true,

"filterable": true,

"hasListFilter": true,

"dataType": "STRING",

"resizable": true,

"componentId": "label-list-cell-content",
"defaultText": null,

"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

1,

"tableColumnConfigurations": null,
"enableSelection": true,

"toggle": true,
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"toggleOptions": {
"componentId": "ticket-article-details",
"inputPropertyName": "article",
"actions": [],
"toggleFirst": true,
"data": {3},
"toggleAll": false
3
"headerHeight": 2.25,
"rowHeight": 1.75,
"emptyResultHint": "Translatable#No tickets available.",
"fixedFirstColumn": false
1,
"headerComponents": null,
"showFilter": true,
"shortTable": false,
"predefinedTableFilters": [],
"cache": false,
"resetFilterOnReload": true
3
"minimized": false,
"minimizable": true,
"jcon": "kix-icon-ticket",
"contextDependent": false

1,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value": 2
}
1,
"sijze": "large"
3
{
"instanceId": "home-dashboard-myOpenTickets-widget",
"configurationId": "home-dashboard-myOpenTickets-widget",
"configuration": null,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value": 2
}
1,
"sijze": "large"
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b
{
"instanceld": "home-dashboard-new-tickets-widget",
"configurationId": "home-dashboard-new-tickets-widget",
"configuration": null,
"permissions": [
{
"target": "tickets",
"permissions": [
2
1,
"OR": false,
"value'": 2
}
1,
"sijze'": "large"
}

1,

"generalActions": [],
"actions": [],
"overlays": [],
"others": [],
"dialogs": [],
"customizable": true
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13.1.3.6 Configuration of dashboard tables

This is how you add a table column:

home-dashboard-ticket-table-new

You can customise the tables in the home or ticket dashboard as required. It is possible to insert additional
table columns or to remove unneeded table columns. The adjustment of the tables is done via the
configuration keys in the menu System > SysConfig. In the following example, the table "New tickets" in the
home dashboard is extended by the table column "Contact", in which the name of the customer contact is
displayed. For this, the configuration key "home-dashboard-ticket-table-new" is adapted accordingly. If you
want to configure a different table, please search for the corresponding key in the SysConfig menu and
change it.

Navigate to System > SysConfig. Locate the key "home-dashboard-ticket-table-new". This key defines

the structure of the table.

Open the key and copy the source code from the "Value" field into a JSON editor. The right column

contains the source code in maximised view for easier editing.

JSONFormatter

Upload ( json/txt

{"id": "home-dash
,"loadingOptions
,"sortOrder”: "Ti
inull, "name":nul
,"shouColumnIcon
,"resizable”:true, "componentId”:"sla-crit

FilterType": "0
118, "tableColumns
a", : ,"showColumnTit
filterable”:true, “hasListFilter”:true, “dataType”:null
el1","defaultText":null,"translatable”:true, "titleTranslatable”
:true, "useObjectServiceForFilter”:fals null,“name”:null, “type":null, "property”: ,"showText"
:false, "showIcon”: true, "showColumnTitle" : true, “shouColumnIcon”: false, “size": 65, "sortable” : true, "filterable": true
,"hasListFilter”:true, "dataType”:"STRING", “resizable”:true, "componentId”:null,"defaultText":null, “translatable”
:true,"titleTranslatable":true, "useGbjectServiceForFilter”: false},{"id" :null, "name”:null,"type":null, “property”
:"TicketNumber","shouText" :true, "showIcon":false, "showColumnTitle”: true, "showColumnIcon”:true, "size": 135
,"sortable”:true,"filterable":true, "hasListFilter”:false, "dataType":"STRING", "resizable":true, “componentId”:null
,"defaultText":null, "translatable” :true, "titleTranslatable”: true, “useObjectServiceForFilter” :false},{"id":null
“name”:null,“type”:null, "property”:"Title", “shouText":true,"shoulcon”:false, "showColumnTitle" true

"loadingOptions™: { .
"filter": [

“property”: "StateID",
“operator”
“type": "NUMI
“filterType": "OR",
"value": 1

Insert the following code block (without comments!) into the source code on the right-hand side of
the editor. Place it at the desired position between two already existing table columns. A table column

usually starts and ends with {"id":[...] "useObjectServiceForFilter": true |

falsel}.

Configure the inserted code block as required:

+ Enter the ticket attribute to be displayed in the table column under "property". Here the
attribute "ContactID" for the customer contact. You can find an overview of the ticket

attributes in the appendix (see page 875).

+ If you want to include a Dynamic Field, use the syntax: " DynamicFields.FieldName ". The

name defined under System > Dynamic Fields must be specified.

+ If you want to display the progress bar of a dynamic field of the type "Checklist" of the table

column, enter the value " dynamic-field-checklist-cell "under" componentID ".
+ If you do not know the data type of the attribute to be included, note the value "null" under

"dataType "
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« For an overview of the attributes used, see: The table widge (see page 393) t.

"id": null,
"name": null,
"type": null,
"property": "ContactID",
column
"showText": true,
"showIcon": false,
"showColumnTitle":
"showColumnIcon":
"size": 225,
"sortable": true,
"filterable": true,
"hasListFilter": false,
"dataType": "STRING",
"resizable": true,
"componentId": null,
field-checklist-cell
"defaultText": null,
"translatable": true,
"titleTranslatable": true,
"useObjectServiceForFilter": false

true,
true,

I

//ticket attribute to be displayed in the

//or value for a progress bar: "dynamic-

","resizable":true, "componen

ServiceForFilter”:false},{"id" :null,"name”:null, "type" :null, "property” %’
se, "showColumnTitle": true, "showColumnIcon":true,"size" , "sortable” T 1
alse,"dataType"”:"DATETIME", "resizable”:true, " componentId”:null

"StatelD", opera TETATICTERT T TOIT;
1568, "includes” “translatabla": true,
"SLACriteri "showText":true, "showIcon":false,"showColumnTitle":true ::titlET_"a”ShtE_'hlE": t‘r‘ue, .
true, terable”:true, "hasListFilter” :true,"dataType”:null usedbjectServiceForfilter”: false
cell”,"defaultText":null,"translatable":true,"titleTranslatable"” 1
tnull, "name" :null, "type” :null, "property”:"Pri D", "showText" T 1 —
true, "showColumnIcon”:false,"size":65, "sortable ,"filterable": true id : r:\ull,
,'resizable”:true, "componentId”:null, "defaultText":null, "translatable” "name” : null,
ServiceForfilter":false},{"id":null, "name":null, "type”:null, "property" "type : ”‘L_'nl“ .
":false,"showColumnTitle"”:true, "showColumnIcon”:true,"size": 135 "pmper‘ty" ContactID”,
stFilter":false,"dataType”:"STRING","resizable":true, "componentId”:null L\@ "Ehm"TEXt‘_ true,
titleTranslatable”:true, "useCbjectServiceForfFilter”:false},{"id":null "showIcon : falsﬁ,
e","showText":true, "showIcon":false,"showColumnTitle": true "Ehm"CDIum"Tltlf : true,
le":true,"filterable":true, "hasListFilter”:false, "dataType": "STRING" "sr.wowsolumnIcon : true,
aultText":null,"translatable”:true,"titleTranslatable™:true e 2%5’
tnull, "name”:null, "type":null, "property”:"QueusID", "showText" 1true "st?r*table :”true,
"showColumnIcen":true,"size":175,"sortable" :true,"filterable" :true .'Fllt?rah!e : :[Ir'ue,
,"resizable”:true, "componentId”:null,"defaultText":null,"translatable” .,haSLlstFiltﬁ" : fa}se,
ServiceForfilter":false},{"id":null, "name":null, "type”:null,"property] "dat..aType N STRING”,
rtrue, "showIcon”:false,"showColumnTitle": "showColumnIcon™:false "r"esuable .”tr‘ue,
true, "haslListFilter":true, "dataType": ', "resizable":true "(umpuneﬂtld” : null,
"defaultText":null,"translatable”:true,"titleTranslatable”:true "defaultText null,
:null, "name”:null, "type"”:null, "property”:"OrganisationID", "showText" :true "tr:anslatable : t":'E’
"showColumnIcon”:true,"size":225,"sortable” itrue,"filterable”:true "t:LtleTr‘anslat..ahle : Frue, N
":null, "defaultText":null,"translatable” useObjectServiceForfilter”: false

4. Minimise the source code to remove unnecessary spaces and line breaks and copy the source code

to the clipboard.
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ype":"Ticket"
lterType":"0R","value™:1}]
8, "tableColumns”:[{"id"
5" showColumnTitle"”: true
ue, "dataType” null

rue, "titleTranslatable"
"PriorityID", "showText"
e":true,"filterable":true
ext":null,"translatable"”
1,"type":inull, "property”
"itrue,"size":135

Blog A

Download

Copy Minify Prettify

{"id":"home-dashboard-ticket-table-new", " name”
»"loadingOptions™:{"filter":[{"property”
,sortorder” " Ticket.Age:numeric”,"1imit
:null, "name” :null, "type" rnull, "property”
,'showColumnIcon™:false, "size":228,

"Mew Tickets Table","type":"Table"”,"objectType":"Ticket"”

10", "operator”:"EQ", "type"”: "NUMERIC","filterType":"0OR","val

SLacriteria”,"showText":true, "showIcon":false, "showColumnTitle":
"sortable”:true,"filterable":true, "hasListFilter"”:true,"dataType”:null

s"resizabla":true, "componentId”:"sla-criteria-cell”, "defaultText":null, "translatable” :true, "titleTranslata
:true, "useObjectServiceForFilter”:false},{"id":null,"name" :null,"type”:null, "property”:"ContactID"”, "shouTe
»"showIcon™:false, "showColumnTitle":true, "showColumnIcon”:true,"size":225," "sortable”:true, "filterabla":tru
,"hasListFilter":false,"dataType":"STRING", "resizable" rtrue, "componentId”:null, "defaultText":null, "transla
:true, "titleTranslatable” :true, "usedbjectServiceForFilter” :false}, {"id" :null, "name” :null, "type" :null, "prop
:"PriorityID", "showText":false,"showlcen” rtrue, "showColumnTitle" :true, "showColumnIcon™:false,"size":65,"

5. Paste the source code from the clipboard back into the "Value" field and apply the changes with

uSaveu
" Mames ¥ home-dashboard-toket-table-ne
Descriptions & Mew Tickets Table
I
* validity: vald s
Value: 7760y home-dashboard-tiket-tabie-new’,"name"Wew Tickets Table', type”: Tabde™ "objectType™ Ticket”, Toachngoptions™[ fiter :
[ propesty™: Statel 0, " pperator™: Q" Type" NUMERIC", "Nt Type™"0R", "value":1]]."somOrder ™ Ticket Age:mameric”, limit”:500, incudes™] ‘Watchers[],"displayUmit": 10, tableColumns™
i null,“name:nuil, ‘typa“:nuil,“property ":“SLACritera”, “showText “:true, “showicon “faka, “showColumnTitla “trus, “showCaluimnicon false, “size 230, sortable”tnus, “fitterabie™-true,hastistFilter“:true, “dataType “:null “resizabie “itr
e, ‘companentld ;" da-criteria-cell”, defaultTest null,” “itrue, “rtnen, “usedh| ter”ifaksel,
i :nuil, "name"null, type":rull,"property”™: "ContactiDf',"showText " Arue, "showicon " false, "showCchumnTitlk":true,"showlokimnicon™:tue, "sine™: 205, "sortabie” true, "RHerable" true, haslistFilier dalse, "data Trpe™:"STRING®,"resizable:
“ibrue,"companentic il “defaulTest null, translatabie"irrue, THTeTranslatabie™ e, "useObi ectierviceForF e ta el -
Defaalt Value: & +*hame-dashbaard-tickat-tank-new”, name ;" New Ticats Table", bype™: Table","chjectType ™ Tickst, Inacngaptians [ filter -
Ty SLAeID, " operatnr B, type™HUMERICT, Miter Type™"OR”, "vatue™:1]1."sortOrder ™ TicketAge:pumeric™, Tinmit incudes™] Watchers™|], " displaLimit 20, tableCalumins™:
ruall,"name* il ‘troe i nuil “progerty”: SLACteria", “showTe e showlcan " false,” shawColumnTitle " true, “showColumaleon ' false. “slze” 250, sortable” true. filberable™:true, hasistFilte it nae, “dataTyps " mal “resizable ity

6. Click on "Load Frontend Configuration" to update the table in the Home Dashboard. The agents must
also reload their frontend.

7.

Ty System: Sysconfig {3 W' Foload Frontan,
home-dashboarcHickat-table® search

Tl hame = aadified Comtest BT frgess La walichity vahie Changed a1 Changed by

] hame-dashicard-tickot-tabla-rmy CpanTickats kbe18-web-frontand Tabla intarnal vald {d":"home-dashboard-ticket-table-myOpenTic...  09/27/2021, OBADAM  not assigned

Tl hame-dashicarg tickot o Tickess widget Kix b frontene infemal i) [l home- dachbosrd-tcket-tabl T DO/P7/ 200, QR0 AR 608 pesignad

The name of the customer contact is now displayed in the dashboard table.

o ]

T e Tickets (21)

[ seawitarien

& often & ot asigned ot asignad [To-oRGAsIE w
17080571 Seeind 5.8-Aanet
[ ] WAUITIOIT  [TO-T-043 Testing-Ticket bir 559 custon.. & offen & [TTERMO, ok msimed ot msigned EmeneFima w
T
Hontakt & g Tckat? Thal Taam Batreflones 4ot Kunda !
Musstairian Mas Horvis AHIFAROAOE  [TE-T-040] Testtichst 2u g v {DFRast) im JRETEE [FLrOROAMEATION001] 5p W
P s " FINATICOCINE  [E-T-a] St Ak nkche [rE-TeAM ] dat ki L. [T-ORIAMEATICN 00| 3§ %
Ais R B E0117I000089  (TD-T-038] Nemzagang shr Lngsam [TO-TEAM-0] 1st kvl E..

ETT RS
C000UATI0008E  [TO-T-0 Tesing-Tckst sit SLA by Afc... Peaa., AR

[FLrOROAMEATION-001] 5p W

This is how you remove a table column:

1. Navigate to System > SysConfig.
2. Search for the configuration key of the table you want to edit, for example, "home-dashboard-ticket-

table-new".

You can use the asterisk (*) as a wildcard for the search.
3. Open the key and copy the source code from the Value field into a JSON editor. The right column
contains the source code in maximized view for easier editing.
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Remove the unneeded table column from the source code. A table column usually starts and ends
with {"4id":[...] "useObjectServiceForFilter": true | false}.
Minimize the source code to remove unnecessary spaces and line breaks and copy the source code

to the clipboard.
Paste the source code from the clipboard back into the "Value" field and apply the changes by clicking

"Save".
Click "Load Frontend Configuration” to update the table in the home dashboard. Agents will need to

reload their frontend as well.
The column is now removed from the dashboard table.
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13.1.3.7 Adding a Widget to the Sidebar

The following description relates to the configuration of the ticket details sidebar. You can do the same for

all other sidebars.

Your own widgets must be implemented directly in the sidebar. Proceed as follows:

1.

Navigate to the System > SysConfig menu and look for the desired configuration key (here: ticket-
details)
You can use the asterisk (*) as a wildcard for your search.

Click the